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Manual Purpose and Structure

Manual Purpose and Structure

Windows Users
The documentation explains and describes how to use the TASKING ARM toolset to program a ARM processor.

You can use the tools either with the graphical Altium Designer or from the command line in a command prompt window.

Structure

The toolset documentation consists of a user’s manual (Using the ARM Embedded Tools), which includes a Getting Started
section, and a separate reference manual (this manual).

Start by reading the Getting Started in Chapter 1 of the user’s manual.
The other chapters in the user’s manual explain how to use the compiler, assembler, linker and the various utilities.

Once you are familiar with these tools, you can use this reference manual to lookup specific options and details to make full use
of the TASKING toolset.

The reference manual describes the C++ language implementation, the C language implementation and the assembly
language.

Vii
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Short Table of Contents

Chapter 1: C Language

The TASKING C compilers are fully compatible with ISO-C. This chapter describes the specific target features of the C
language, including language extensions that are not standard in ISO-C. For example, pragmas are a way to control the
compiler from within the C source. The following language extensions are described:

* Data types

* Keywords

* Function qualifiers
* Intrinsic functions

* Pragmas

* Predefined macros

Chapter 2: C++ Language

Describes the C++ language implementation. The C++ language itself is not described.

Chapter 3: Libraries

Contains overviews of all library functions you can use in your C source. First libraries are listed per header file that contains the
prototypes.These tables also show the level of implementation per function. Second, all library functions are listed and
discussed into detail.

Chapter 4: Assembly Language

Describes the specific features of the assembly language as well as 'directives’, which are pseudo instructions that are
interpreted by the assembler.

Chapter 5: Run-time Environment

Describes the startup code used by the C compiler, the vector table, the stack layout and the heap.

Chapter 6: Tool Options

Contains a description of all tool options:
e C compiler options

* C++ compiler options

* Assembler options

* Linker options

* Control program options

* Make utility options

e Librarian options

Chapter 7: List File Formats

Contains a description of the following list file formats:

e Assembler List File Format
* Linker Map File Format

Chapter 8: Object File Formats

Contains a description of the following object file formats:

* ELF/DWARF 2 Object Format
e Motorola S-Record Format
* Intel Hex Record Format

Chapter 9: Linker Script Language

Contains a description of the linker script language (LSL).

viii
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Chapter 10: CERT C Secure Coding Standard

Contains an overview of the supported CERT C Secure Coding Standard recommendations and rules.

Chapter 11: MISRA-C Rules

Contains a description the supported and unsupported MISRA-C code checking rules.

Conventions Used in this Manual

Notation for syntax

The following notation is used to describe the syntax of command line input:

bold Type this part of the syntax literally.
italics Substitute the italic word by an instance. For example:
filename

Type the name of a file in place of the word filename.

{} Encloses a list from which you must choose an item.
[] Encloses items that are optional. For example
carm[-?]

Both carm and carm -? are valid commands.
Separates items in a list. Read it as OR.

You can repeat the preceding item zero or more times.

Example
carm [option)... filename

You can read this line as follows: enter the command carm with or without an option, follow this by zero or more options and
specify a filename. The following input lines are all valid:

carm test.c
carm -g test.c
carm -g -s test.c

Not valid is:
carm -g

According to the syntax description, you have to specify a filename.

Icons

The following illustrations are used in this manual:

@ Note: notes give you extra information.

A Warning: read the information carefully. It prevents you from making serious mistakes or from loosing information.
@? This illustration indicates actions you can perform with the mouse. Such as Altium Designer menu entries and dialogs.
Command line: type your input on the command line.

% Reference: follow this reference to find related topics.



ARM Embedded Tools Reference

Related Publications

C Standards

ISO/IEC 9899:1999(E), Programming languages - C [ISO/IEC]

More information on the standards can be found at http://www.ansi.org
DSP-C, An Extension to ISO/IEC 9899:1999(E),

Programming languages - C [TASKING, TK0071-14]

C++ Standards

The C++ Programming Language (second edition)

by Bjarne Straustrup (1991, Addison Wesley)

ISO/IEC 14882:1998 C++ standard [ANSI]

More information on the standards can be found at http://www.ansi.org

The Annotated C++ Reference Manual
by Margaret A. Ellis and Bjarne Straustrup (1990, Addison Wesley)

CERT C Secure Coding Standard

The CERT C Secure Coding Standard
by Robert C. Seacord (October 2008, Addison Wesley)

The CERT C Secure Coding Standard web site http://www.securecoding.cert.org/
For general information about CERT secure coding, see http://www.cert.org/secure-coding

MISRA-C

Guidelines for the Use of the C Language in Vehicle Based Software [MIRA limited, 1998]

See also http://www.misra.org.uk

MISRA-C:2004: Guidelines for the use of the C Language in critical systems [MIRA limited, 2004]
See also http://www.misra-c.com

TASKING Tools

Using the ARM Embedded Tools
[Altium, GUO116]

ARM

ARM Architecture Reference Manual - ARM DDI 0100l

[2005, ARM Limited]

ARM v7-M Architecture Application Level Reference Manual - ARM DDI 0405A-01
[2006, ARM Limited]



1 C Language

Summary This chapter describes the target specific features of the C language, including
language extensions that are not standard in ISO-C. For example, pragmas are a
way to control the compiler from within the C source.

1.1 Introduction

The TASKING C compiler fully supports the ISO C standard but adds possibilities to program the special functions of the ARM.

In addition to the standard C language, the compiler supports the following:

intrinsic (built-in) functions that result in target specific assembly instructions
pragmas to control the compiler from within the C source

predefined macros

the possibility to use assembly instructions in the C source

attribute to specify absolute addresses

keywords for inlining functions and programming interrupt routines

libraries

All non-standard keywords have two leading underscores (_ ).

In this chapter the target specific characteristics of the C language are described, including the above mentioned extensions.

1-1
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1.2 Data Types
The TASKING C compiler for the ARM architecture (carm) supports the following data types:
Size | Align .
Type C Type (bit) (bit) Limits
Boolean _Bool 8 8 Oor1
Character clllar 8 8 -27 .. 271
signed char
unsigned char 8 8 0. 28-1
Integral Slllort 16 16 -215 [ 2151
signed short
unsigned short 16 16 0. 2161
enum 32 32 -231 2311
int
stgned int 32 32 231 2811
long
signed long
unsigned int 32 | a2 0..2%2_1
unsigned long
tong tong 64 | 64 ~263 _ 263_1
signed long long
unsigned long long 64 64 0. 2641
Pointer pointer to function or data 32 32 0..2%2-1
Floating-Point . . -3.402E+38 .. -1.175E-38
float (23-bit mantissa) 32 32 1.175E-38 .. 3.402E+38
double 64 64 -1.798E+308 .. -2.225E-308
long double (52-bit mantissa) 2.225E-308 .. 1.798E+308
_Imaginary float 32 32 -3.402E+38i .. -1.175E-38i
1.175E-38i .. 3.402E+38i
_Imaginary double 64 64 -1.798E+308i .. -2.225E-308
_Imaginary long double 2.225E-308i .. 1.798E+308i
_Complex float 64 32 real part + imaginary part
_Complex double X .
128 64 real part + imaginary part
_Complex long double

Table 1-1: Data Types for the ARM

1.2.1 Changing the Alignment: __unaligned, __packed__ and __align()

Normally data, pointers and structure members are aligned according to the table in the previous section.

Suppress alignment

With the type qualifier __unaligned you can specify to suppress the alignment of objects or structure members. This can be
useful to create compact data structures. In this case the alignment will be one bit for bit-fields or one byte for other objects or
structure members.

At the left side of a pointer declaration you can use the type qualifier __unaligned to mark the pointer value as potentially
unaligned. This can be useful to access externally defined data. However the compiler can generate less efficient instructions to
dereference such a pointer, to avoid unaligned memory access.
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Example:

struct

{
char c;
__unaligned int i; /* aligned at offset 1 ! */

}osi
__unaligned int * up = & s.i;

Packed structures

To prevent alignment gaps in structures, you can use the attribute __packed__. When you use the attribute __packed
directly after the keyword struct, all structure members are marked __unaligned. For example the following two
declarations are the same:

struct _ packed

{
char c¢;
int * i;
} sl;
struct
{
char _ unaligned c;

int * _ unaligned i; /* _ unaligned at right side of ’'*’ to pack pointer member */
} s2;

The attribute __packed__ has the same effect as adding the type qualifier __unaligned to the declaration to suppress the
standard alignment.

You can also use __packed__in a pointer declaration. In that case it affects the alignment of the pointer itself, not the value of
the pointer. The following two declarations are the same:

int * _ unaligned p;
int * p _ packed__;

Change alignment

With the attribute __align(n) you can overrule the default alignment of objects or structure members to n bytes.

1.3  Placing an Object at an Absolute Address: at()

With the attribute __at () you can specify an absolute address.

Examples
unsigned char Display[80*24] _ at( 0x2000 );

The array Display is placed at address 0x2000. In the generated assembly, an absolute section is created. On this position
space is reserved for the variable Display.

int i _ at(0x1000) = 1;
The variable i is placed at address 0x1000 and is initialized at 1.
void f(void) _ at( OxfOff + 1 ) { }

The function £ is placed at address 0xf100.

Restrictions

Take note of the following restrictions if you place a variable at an absolute address:

e The argument of the _ at () attribute must be a constant address expression.

1-3
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* You can place only global variables at absolute addresses. Parameters of functions, or automatic variables within functions
cannot be placed at absolute addresses.

* Avariable that is declared extern, is not allocated by the compiler in the current module. Hence it is not possible to use the
keyword __at () on an external variable. Use __at () at the definition of the variable.

* You cannot place structure members at an absolute address.

* Absolute variables cannot overlap each other. If you declare two absolute variables at the same address, the assembler and
/ or linker issues an error. The compiler does not check this.

1.4 Using Assembly in the C Source: asm()

With the __asm keyword you can use assembly instructions in the C source. Be aware that C modules that contain assembly
are not portable and harder to compile in other environments.

Furthermore, assembly blocks are not interpreted by the compiler: they are regarded as a black box. So, it is your responsibility
to make sure that the assembly block is syntactically correct.

General syntax of the __asm keyword

__asm( ”instruction_ template”
[ : output param list
[ : input_param_ list
[ : register save_list]]] );

instruction_template Assembly instructions that may contain parameters from the input list or
output list in the form: %eparm_nr

Yeparm_nr[.regnum] Parameter number in the range 0 .. 9. With the optional .regnum you can
access an individual register from a register pair.

output_param_list [[ ”=[&]constraint_char”(C_expression)],...]
input_param_list [[ "constraint_char”(C_expression)],...]
& Says that an output operand is written to before the inputs are read, so
this output must not be the same register as any input.
constraint _char Constraint character: the type of register to be used for the
C_expression.
C _expression Any C expression. For output parameters it must be an Ivalue, that is,
something that is legal to have on the left side of an assignment.
register_save_list [[’register_name™),...]
register_name:q Name of the register you want to reserve.

char a, b;
int result;

void main(void)

{

a = 3;

b = 4;

__asm( "ADD %0,%1,%2"” : "=r”(result): "r”(a), "r”"(b) );
}

%0 corresponds with the first C variable, $1 with the second and so on.

1-4
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Generated assembly code:

main: .type func

1dr rl,.L2
mov r0,#3
strb r0,[rl,#0]
mov r2,#4
strb r2,[rl,#1]
ADD r0,r0,r2
str r0,[rl,#4]
bx 1r
.size main,$-main
.align 4

.L2:
.dw a

Specifying registers for C variables

With a constraint character you specify the register type for a parameter. In the example above, the r is used to force the use of
registers (Rn) for the parameters a and b.

You can reserve the registers that are already used in the assembly instructions, either in the parameter lists or in the reserved
register list (register_save_list, also called "clobber list”). The compiler takes account of these lists, so no unnecessary register
saving and restoring instructions are placed around the inline assembly instructions.

Constraint | Type Operand Remark
character
R general purpose | r0 .. r11 Thumb mode r0 .. r7
register (64 bits) Based on the specified register, a register pair is formed
(64-bit). For example rOr1.
r general purpose | rO..r11,1Ir Thumb mode r0 .. r7
register
i immediate value | #value
I label label
m memory label variable stack or memory operand, a fixed address
number other operand same as %number Input constraint only. The number must refer to an output
parameter. Indicates that %enumber and number are the same
register.
Use %number.0 and %number.1 to indicate the first and
second half of a register pair when used in combination with R.

Table 1-2: Available input/output operand constraints for the ARM

Loops and conditional jumps

The compiler does not detect loops that are coded with multiple __asm statements or (conditional) jumps across __asm
statements and will generate incorrect code for the registers involved.

If you want to create a loop with __asm, the whole loop must be contained in a single __asm statement. The same counts for
(conditional) jumps. As a rule of thumb, all references to a label in an ___asm statement must be contained in the same

statement.

Example 1: no input or output

A simple example without input or output parameters. You can use any instruction or label. Note that you can use standard C
escape sequences.

__asm( "nop\n\t”
” nop ” ) ;

1-5
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Generated code:

nop
nop

Example 2: using output parameters

Assign the result of inline assembly to a variable. A register is chosen for the parameter because of the constraint r; the
compiler decides which register is best to use. The %0 in the instruction template is replaced with the name of this register.
Finally, the compiler generates code to assign the result to the output variable.

char out;

void main(void)
{
__asm( "mov %0,#0xff” : ”"=r”(out));

}
Generated assembly code:

mov r0,#0xff
ldr rl,.L2
strb r0,[rl,#0]
bx 1r
.size main,$-main
.align 4

.L2:
.dw out

Example 3: using input and output parameters

Add two C variables and assign the result to a third C variable. Registers are used for the input parameters (constraint r, %1 for
a and %2 for b in the instruction template) and for the output parameter (constraint r, $0 for result in the instruction template).

The compiler generates code to move the input expressions into the input registers and to assign the result to the output
variable.

char a, b;
int result;

void main(void)

{

a = 3;

b = 4;

__asm( "ADD %0,%1,%2” : "=r”(result): "r”(a), "r”(b) );
}

Generated assembly code:

main: .type func
1dr rl,.L2

mov r0,#3
strb r0,[rl,#0]
mov r2,#4
strb r2,[rl,#1]
ADD r0,r0,r2
str r0,[rl,#4]
bx 1r
.size main,$-main
.align 4

L2:
.dw a

1-6



C Language

Example 4: reserve registers

Sometimes an instruction knocks out certain specific registers. The most common example of this is a function call, where the
called function is allowed to do whatever it likes with some registers. If this is the case, you can list specific registers that get
clobbered by an operation after the inputs.

Same as Example 3, but now register RO is a reserved register. You can do this by adding a reserved register list (: "R0"). As
you can see in the generated assembly code, register RO is not used (the first register used is R1).

char a, b;
int result;

void main(void)

{

a = 3;

b = 4;

__asm( "ADD %0,%1,%2” : "=r”(result): "r”(a), "r”(b) : "RO0”" );
}

Generated assembly code:

main: .type func
1dr r2,.L2
mov rl,#3
strb rl,[r2,#0]
mov r3,#4
strb r3,[r2,#1]
ADD rl,rl,r3
str rl,[r2,#4]
bx 1r
.size main,$-main
.align 4

L2
.dw a

Example 5: input and output are the same

If the input and output must be the same you must use a number constraint. The following example increments the value of the
input variable invar and returns this value to outvar. Since the assembly instruction has to use only one register, the return
value has to go in the same place as the input value. Parameter 0 corresponds to outvar. To indicate that invar uses the
same register as outvar, the input constraint ‘0’ is used which indicates that invar also corresponds to %0.

int outvar;

void increment(int invar)

{
__asm ("add %0, %1, #1”: ”"=r”(outvar): "0”(invar) );

}

Generated assembly:

increment: .type func
add r0, r0, #1

ldr rl,.L2
str r0,[rl,#0]
bx 1r
.size add32,$-add32
.align 4
LL2:
.dw outvar

1-7



ARM Embedded Tools Reference

1.5 Pragmas to Control the Compiler

Pragmas are keywords in the C source that control the behavior of the compiler. Pragmas overrule compiler options. Put
pragmas in your C source where you want them to take effect. Unless stated otherwise, a pragma is in effect from the point
where it is included to the end of the compilation unit or until another pragma changes its status.

For example, you can set a compiler option to specify which optimizations the compiler should perform. With the #pragma
optimize flags you can set an optimization level for a specific part of the C source. This overrules the general optimization
level that is set in the C compiler Optimization page in the Project Options dialog (command line option --optimize (-0)).

The general syntax for pragmas is:
#pragma pragma-spec [ON | OFF | DEFAULT | RESTORE]
or:
_Pragma( "pragma-spec [ON | OFF | DEFAULT | RESTORE]” )
Pragmas marked with (*) accept the following special arguments:
default set the pragma to the initial value
restore restore the previous value of the pragma
Pragmas marked with (+) are boolean flags, and accept the following arguments:
on switch the flag on (same as without argument)
off switch the flag off

The compiler recognizes the following pragmas, other pragmas are ignored.

alias symbol=defined symbol

Define symbol as an alias for definined_symbol. It corresponds to an equate directive (.equ) at assembly level. The symbol
should not be defined elsewhere, and defined_symbol should be defined with static storage duration (not extern or
automatic).

% See assembler directive .EQU in section 4.8.2, Assembler Directives, in Chapter Assembly Language.

call {near|far} (*)

By default, functions are called with 26-bit PC-relative calls. This near call is directly coded into the instruction, resulting in
higher execution speed and smaller code size. The destination address of a near call must be located within +/-32 MB from
the program counter.

The other call mode is a 32-bit indirect call. With far calls you can address the full range of memory. The address is first
loaded into a register after which the call is executed.

% See C compiler option --call (-m) in section 6.1, C Compiler Options, in Chapter Tool Options.

extension isuffix (*) (+)

i
|

Enables a language extension to specify imaginary floating-point constants. With this extension, you can use an ”i” suffix on

a floating-point constant, to make the type Imaginary.

extern symbol

Force an external reference (.extern assembler directive), even when the symbol is not used in the module.

% See assember directive .EXTERN in section 4.8.2, Assembler Directives, in Chapter Assembly Language.
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inline
noinline
smartinline

Instead of the qualifier inline, you can also use pragma inline and pragma noinline to inline a function body:
int w,x,y,2z;

#pragma inline
int add( int a, int b )
{

int i=4;

return( a + b );

}

#pragma noinline

void main( void )

{

add( 1, 2 );
z = add( x, ¥y );

=
I

}

If a function has an inline or _ noinline function qualifier, then this qualifier will overrule the current pragma setting.

% See section 1.8.3, Inlining Functions: inline /__noinline.

By default, small fuctions that are not too often called (from different locations), are inlined. This reduces execution speed at
the cost of code size (C compiler option -0i). With the pragma noinline / pragma smartinline you can temporarily
disable this optimization.

With the C compiler options --inline-max-incr and --inline-max-size you have more control over the automatic function
inlining process of the compiler.

See for more information the C compiler options --inline-max-incr and —--inline-max-size in section 6.1, C Compiler
Options in Chapter Tool Options.

macro
nomacro (*) (+)

Turns macro expansion on or off. By default, macro expansion is enabled.

message “message” ...
Print the message string(s) on standard output.
optimize flags (*)
endoptimize
You can overrule the compiler option -O for the code between the pragmas optimize and endoptimize. The pragma

works the same as compiler option -O.

% See section 2.6, Compiler Optimizations in Chapter Using the Compiler in the user’s manual.
See C compiler option --optimize (-0) in section 6.1, C Compiler Options, in Chapter Tool Options.

profile [flag,...] (*)
endprofile

Control the profile settings. The pragma works the same as compiler option —-profile (-p). Note that this pragma will only be
checked at the start of a function. endprofile switches back to the previous profiling settings.

% See C compiler option —-profile (-p) in section 6.1, C Compiler Options, in Chapter Tool Options.
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profiling (*) (+)

If profiling is enabled on the command line, C compiler option —-profile (-p), you can disable part of your source code for
profiling with the pragmas profiling off and profiling.

protect (*) (+)
endprotect

With these pragmas you can protect sections against linker optimizations. This excludes a section from unreferenced section
removal and duplicate section removal by the linker. endprotext restores the default section protection.

runtime [flag,...] (*)

Check for run-time errors. The pragma works the same as compiler option —-runtime (-r).

% See C compiler option —-runtime (-r) in section 6.1, C Compiler Options, in Chapter Tool Options.

section [name=|{suffix |-fl-m|-fm} (¥

endsection
Rename sections by adding a suffix to all section names specified with name, or restore default section naming. If you
specify only a suffix (without a name), the suffix is added to all section names.

See C compiler option --rename-sections in section 6.1, C Compiler Options in Chapter Tool Options.
See assembler directive .SECTION (Start or continue section), in section 4.8.2, Assembler Directives, in Chapter
Assembly Language.

section_code_init (*) (+)
section_no_code_init
Copy or do not copy code sections from ROM to RAM at application startup.
section_const_init (*) (+)
section_no_const_init

Copy or do not copy read-only data sections from ROM to RAM at application startup.

source (*) (+)
nosource

With these pragmas you can choose which C source lines must be listed as comments in assembly output.

% See also C compiler option --source (-s)

stdinc (*) (+)

This pragma changes the behavior of the #include directive. When set, the C compiler options --include-directory and
--no-stdinc are ignored.

linear_switch
jump_switch
binary_switch
smart_switch
tbb_switch
tbh_switch
no_tbh_switch

With these pragmas you can overrule the compiler chosen switch method:

linear switch Force jump chain code. A jump chain is comparable with an if/else-if/else-if/else construction.



C Language

jump_switch Force jump table code. A jump table is a table filled with jump instructions for each possible
switch value. The switch argument is used as an index to jump within this table.

binary switch Force binary lookup table code. A binary search table is a table filled with a value to compare
the switch argument with and a target address to jump to.

smart_switch Let the compiler decide the switch method used

tbb_switch Force use of the tbb instruction. Uses a table of 8-bit jump offsets.

tbh_switch Force use of the tbh instruction. Uses a table of 16-bit jump offsets.

no_tbh switch Same as smart_switch, but do not use the tbh instruction.

% See Section 1.7, Switch Statement.

tradeoff level (*)

Specify tradeoff between speed (0) and size (4).

% See also C compiler option --tradeoff (~t)

warning [number,...] (*)

With this pragma you can disable warning messages. If you do not specify a warning number, all warnings will be suppressed.

% See also C compiler option --no-warnings (-w)

weak symbol

Mark a symbol as "weak” (.weak assembler directive). The symbol must have external linkage, which means a global or
external object or function. A static symbol cannot be declared weak.

A weak external reference is resolved by the linker when a global (or weak) definition is found in one of the object files.
However, a weak reference will not cause the extraction of a module from a library to resolve the reference. When a weak
external reference cannot be resolved, the null pointer is substituted.

A weak definition can be overruled by a normal global definition. The linker will not complain about the duplicate definition,
and ignore the weak definition.

% See assembler directive .WEAK in Section 4.8.2, Assembler Directives, in Chapter Assembly Language.
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1.6 Predefined Preprocessor Macros

In addition to the predefined macros required by the ISO C standard, suchas _ DATE and _ FILE ,the TASKING C
compiler supports the predefined macros as defined in the table below. The macros are useful to create conditional C code.

Macro Description

__ARM Expands to 1 for the ARM toolset, otherwise unrecognized as macro.

__ BIG_ENDIAN Expands to 1 if big-endian mode is selected (--endianness=big), otherwise unrecognized as
macro.

___BUILD Identifies the build number of the compiler, composed of decimal digits for the build number, three
digits for the major branch number and three digits for the minor branch number. For example, if
you use build 1.22.1 of the compiler, __ BUILD__ expands to 1022001. If there is no branch
number, the branch digits expand to zero. For example, build 127 results in 127000000.

__CARM Expands to 1 for the ARM toolset, otherwise unrecognized as macro.

__CPU__ Expands to the ARM architecture name (option --cpu=arch ).

__CPU_arch__ A symbol is defined depending on the option --cpu=arch. The arch is converted to uppercase.
For example, if -—cpu=ARMVAT is specified the symbol _ cPU_ARMV4T _is defined. When no
--cpu is supplied, symbol __ CPU_ARMV4T__is the default.

__ DOUBLE_FP___ Expands to 1 if you did not use option --no-double (Treat 'double’ as ‘float’), otherwise

unrecognized as macro.

__ LITTLE_ENDIAN

Expands to 1 if little-endian mode is selected (--endianness=little), otherwise unrecognized as
macro. This is the default.

__REVISION Identifies the revision number of the compiler. For example, if you use version 1.0r2 of the
compiler, __ REVISION__ expands to 2.

___SINGLE_FP___ Expands to 1 if you used option --no-double (Treat ’double’ as ‘float’), otherwise unrecognized
as macro.

___TASKING Identifies the compiler as a TASKING compiler. Expands to 1 if a TASKING compiler is used.

__ _THUMB___ Expands to 1 if you used option --thumb, otherwise unrecognized as macro.

__VERSION_ Identifies the version number of the compiler. For example, if you use version 1.0r2 of the

compiler, __ VERSION___ expands to 1000 (dot and revision number are omitted, minor version
number in 3 digits).

Table 1-3: Predefined preprocessor macros

Example

#ifdef _ CARM

/* this part is only compiled for the ARM */

#endif
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1.7 Switch Statement

The TASKING C compiler supports three ways of code generation for a switch statement: a jump chain (linear switch), a jump
table or a binary search table.

A jump chain is comparable with an if/else-if/else-if/else construction. A jump table is a table filled with jump instructions for
each possible switch value. The switch argument is used as an index to jump within this table. A binary search table is a table
filled with a value to compare the switch argument with and a target address to jump to.

#pragma smart_switch is the default of the compiler. The compiler tries to use the switch method which uses the least
space in ROM (table size in ROMDATA plus code to do the indexing).

For a switch with a long type argument, only binary search table code is used.

For an int type argument, a jump table switch is only possible when all case values are in the same 256 value range (the high
byte value of all programmed cases are the same).

Especially for large switch statements, the jump table approach executes faster than the binary search table approach. Also the
jump table has a predictable behavior in execution speed: independent of the switch argument, every case is reached in the
same execution time.

With a small number of cases, the jump chain method can be faster in execution and shorter in size.
For ARMv7M a switch using the tbh instruction gets priority over a normal switch table implementation.

You can overrule the compiler chosen switch method by using a pragma:

#pragma linear switch force jump chain code

#pragma jump_ switch force jump table code

#pragma binary switch force binary search table code

#pragma smart switch let the compiler decide the switch method used

#pragma tbb_switch force use of tbb instruction (uses a table of 8-bit jump offsets)
#pragma tbh_switch force use of tbh instruction (uses a table of 16-bit jump offsets)
#pragma no_tbh switch same as smart_switch, but do not use tbh instruction

Using a pragma cannot overrule the restrictions as described earlier.

The switch pragmas must be placed before the function body containing the switch statement. Nested switch statements use
the same switch method, unless the nested switch is implemented in a separate function which is preceded by a different
switch pragma.

Example

/* place pragma before function body */
#pragma jump switch

void test(unsigned char val)
{ /* function containing the switch */
switch (val)

{
/* use jump table */
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1.8 Functions

1.8.1 Parameter Passing

A lot of execution time of an application is spent transferring parameters between functions. The fastest parameter transport is
via registers. Therefore, function parameters are first passed via registers. If no more registers are available for a parameter, the
compiler pushes parameters on the stack. See the table below.

Parameter Type Parameter Number

1 2 3 4
_Bool r0 r1 r2 r3
char r0 r1 r2 r3
short r0 ri r2 r3
int / long r0 r1 r2 r3
float r0 r1i r2 r3
32-bit pointer r0 r1 r2 r3
32-bit struct r0 r1i r2 r3
long long ror1 rir2 r2r3 r3
double ror1 rir2 r2r3
64-Dit struct ror1 rir2 r2r3

Table 1-4: Register usage for parameter passing

@ If a register corresponding to a parameter number is already in use the next register is used.

Example with three arguments
funcl( int a, int b, int *c )
* a (first parameter) is passed in register r0.
* Db (second parameter) is passed in register r1.
* ¢ (third parameter) is passed in register r2.

Example with one long long/double arguments and one other argument

func2( long long d, char e )

* d (first parameter) is passed in register r0 and r1
* e (second parameter) is passed in register r2.

Example with two long long/double arguments and one other argument

func3( double f, long long g, char h )
» £ (first parameter) is passed in register r0 and r1
* g (second parameter) is passed in register r2 and r3.
* h (third parameter) cannot be passed through registers anymore, and is passed via the stack.

1.8.2 Function Return Types

The C compiler uses registers to store C function return values, depending on the function return types.

Return Type Register
_Bool ro
char r0
short ro
int/long ro
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Return Type Register
float r0

32-bit pointer r0

32-bit struct r0

long long ror1
double ror1
64-bit struct ror1

Table 1-5: Register usage for function return types

Objects larger than 64 bits are returned via the stack.

1.8.3 Inlining Functions: inline / __noinline

With the C compiler option —-optimize=+inline, the C compiler automatically inlines small functions in order to reduce
execution time (smart inlining). The compiler inserts the function body at the place the function is called. The C compiler decides
which functions will be inlined. You can overrule this behavior with the two keywords inline (ISO-C) and _ noinline.

With the inline keyword you force the compiler to inline the specified function, regardless of the optimization strategy of the
compiler itself:

inline unsigned int abs(int val)

{
unsigned int abs val = val;
if (val < 0) abs val = -val;
return abs val;

}

If a function with the keyword inline is not called at all, the compiler does not generate code for it.

You must define inline functions in the same source module as in which you call the function, because the compiler only inlines a
function in the module that contains the function definition. When you need to call the inline function from several source
modules, you must include the definition of the inline function in each module (for example using a header file).

With the _ noinline keyword, you prevent a function from being inlined:

__noinline unsigned int abs(int val)

{
unsigned int abs val = val;
if (val < 0) abs val = -val;
return abs val;

}

Using pragmas: inline, noinline, smartinline
Instead of the inline qualifier, you can also use #pragma inline and #pragma noinline to inline a function body:

#pragma inline
unsigned int abs(int val)

{
unsigned int abs val = val;
if (val < 0) abs val = -val;
return abs val;

}

#pragma noinline
void main( void )
{

int 1i;

i = abs(-1);
}

If a function has an inline/__noinline function qualifier, then this qualifier will overrule the current pragma setting.
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With the #pragma noinline/#pragma smartinline you can temporarily disable the default behavior that the C compiler
automatically inlines small functions when you turn on the C compiler option —--optimize=+inline.

1.8.4 Intrinsic Functions

Some specific assembly instructions have no equivalence in C. Intrinsic functions give the possibility to use these instructions.
Intrinsic functions are predefined functions that are recognized by the compiler. The compiler generates the most efficient
assembly code for these functions.

The compiler always inlines the corresponding assembly instructions in the assembly source (rather than calling it as a
function). This avoids parameter passing and register saving instructions which are normally necessary during function calls.

Intrinsic functions produce very efficient assembly code. Though it is possible to inline assembly code by hand, intrinsic
functions use registers even more efficiently. At the same time your C source remains very readable.

You can use intrinsic functions in C as if they were ordinary C (library) functions. All intrinsics begin with a double underscore
character.

The TASKING ARM C compiler recognizes the following intrinsic functions:

__alloc
void * volatile  alloc( _ size t size );
Allocate memory.

Returns: a pointer to space in external memory of size bytes length. NULL if there is not enough space left.

__free
void volatile _ free( void *p );
Deallocates the memory pointed to by p. p must point to memory earlier allocated by acallto __alloc().

Returns: nothing.

—_nop

void _ nop( void );
Generate NOP instructions.
Returns: nothing.

Example:

__nop(); /* generate NOP instruction */

__get_return_address
__codeptr volatile _ get return_address( void );
Used by the compiler for profiling when you compile with the --profile (-p) option.

Returns: return address of a function.

__getspsr
unsigned int volatile _ getspsr( void );
Get the value of the SPSR status register.

Returns: the value of the status register SPSR

__setspsr
unsigned int volatile _ setspsr( int set, int clear);
Set or clear bits in the SPSR status register.

Returns: the new value of the SPSR status register.
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Example:

#define SR _F 0x00000040
#define SR_I 0x00000080

i = setspsr (0, SR F | SR I);

if (i & (SR_F | SR I))

{
exit (6); /* Interrupt flags not correct */
}
if (_ getspsr () & (SR F | SR I))
{
exit (7); /* Interrupt flags not correct */
}
__getcpsr

unsigned int volatile _ getcpsr( void );
Get the value of the CPSR status register.

Returns: the value of the status register CPSR

__Setcpsr
unsigned int volatile __ setcpsr( int set, int clear);
Set or clear bits in the CPSR status register.

Returns: the new value of the CPSR status register.

__getapsr
unsigned int volatile _ getapsr( void );
Get the value of the APSR status register.

Returns: the value of the status register APSR

@ This intrinsic is only available for the ARMv6-M and ARMv7-M (M-profile architectures).

___Setapsr
unsigned int volatile __ setapsr( int set, int clear);
Set or clear bits in the APSR status register.

Returns: the new value of the APSR status register.

@ This intrinsic is only available for the ARMv6-M and ARMv7-M (M-profile architectures).

__getipsr
unsigned int volatile __ getipsr( void );
Get the value of the IPSR status register.

Returns: the value of the status register IPSR

@ This intrinsic is only available for the ARMv6-M and ARMv7-M (M-profile architectures).
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svc

void volatile _ svc(int number);

Generates a supervisor call (software interrupt). Number must be a constant value.

Returns: nothing.

1.8.5 Interrupt Functions / Exception Handlers

The TASKING C compiler supports a number of function qualifiers and keywords to program exception handlers. An exception
handler (or: interrupt function) is called when an exception occurs.

The ARM supports seven types of exceptions. The next table lists the types of exceptions and the processor mode that is used
to process that exception. When an exception occurs, execution is forced from a fixed memory address corresponding to the

type of exception. These fixed addresses are called the exception vectors.

Exception type Mode Normal address High vector address | Function type
qualifier

Reset Supervisor 0x00000000 OxFFFF0000

Undefined instructions Undefined 0x00000004 OxFFFF0004 __interrupt_und

Supervisor call (software | Supervisor 0x00000008 0xFFFF0008 __interrupt_svc

interrupt)

Prefetch abort Abort 0x0000000C O0xFFFF000C __interrupt iabt

Data abort Abort 0x00000010 OxFFFF0010 __interrupt dabt

IRQ (interrupt) IRQ 0x00000018 OxFFFF0018 __interrupt irqg

FIQ (fast interrupt) FlQ 0x0000001C OxFFFF001C __interrupt fiq

Table 1-6: Exception processing modes

@ ARMv6-M and ARMv7-M (M-profile architectures) have a different exception model. Read the ARM Architecture
Reference Manual for details.

1.8.5.1 Defining an Exception Handler: __interrupt keywords

You can define six types of exception handlers with the function type qualifiers __interrupt und, _ interrupt_svc,
__interrupt iabt, _interrupt_dabt, interrupt irgand __ interrupt_ fig. You can also use the general
___interrupt () function qualifier.

Interrupt functions and other exception handlers cannot return anything and must have a void argument type list:

void __ interrupt xxx

isr( void )

{

}

void _ interrupt(n)
isr2( void )

{

}

Example

void __ interrupt irq serial receive( void )

{
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Vector symbols

When you use one or more of these __interrupt xxx function qualifiers, the compiler generates a corresponding vector
symbol to designate the start of an execption handler function. The linker uses this symbol to automatically generate the
exception vector.

Function type qualifier Vector symbol Vector symbol
M-profile
__interrupt_und _vector_1 -
__interrupt_svc _vector_2 _vector_11
__interrupt_iabt _vector_3 -
__interrupt_dabt _vector_4 -
___interrupt irqg _vector_6 -
___interrupt fiq _vector 7 -
__interrupt(n) _vector_n _vector_n

Note that the reset handler is designated by the symbol _START instead of _vector 0 (_vector_1 for M-profile
architectures).

You can prevent the compiler from generating the _vector_n symbol by specifying the function qualifier __novector. This
can be necessary if you have more than one interrupt handler for the same exception, for example for different IRQ’s or for
different run-time phases of your application. Without the _ novector function qualifier the compiler generates the
_vector_n symbol multiple times, which results in a link error.

void __ interrupt_irqg _ novector another_handler( void )

{

// used __ novector to prevent multiple _vector 6 symbols

}

Enable interrupts in exception handlers (not for M-profile architectures)

Normally interrupts are disabled when an exception handler is entered. With the function qualifier __nesting enabled you
can force that the link register (LR) is saved and that interrupts are enabled. For example:

void _ interrupt svc _ nesting enabled svc( int n )

{
if ((n == 2 )
{
__svec(3);
}
}
1.8.5.2 Interrupt Frame: __frame()

With the function type qualifier _ frame () can specify which registers and SFRs must be saved for a particular interrupt
function. Only the specified registers will be pushed and popped from the stack. If you do not specify the function qualifier
___frame( ), the C compiler determines which registers must be pushed and popped. The syntax is:

void __ interrupt_xxx

__frame(reg[, reg]...) isr( void )

{

oo

}

where, reg can be any register defined as an SFR. The compiler generates a warning if some registers are missing which are
normally required to be pushed and popped in an interrupt function prolog and epilog to avoid run-time problems.
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Example

__interrupt irq _ frame(R4,R5,R6) void alarm( void )

{

}

1.9 Libraries

The TASKING compilers come with standard C libraries (ISO/IEC 9899:1999) and header files with the appropriate prototypes
for the library functions. All standard C libraries are available in object format and in C or assembly source code.

A number of standard operations within C are too complex to generate inline code for (too much code). These operations are
implemented as run-time library functions to save code.

% See section 3.2, Library Functions, in Chapter Libraries, for an extensive description of all standard C library functions.

1.9.1 Printf and Scanf Routines

The C library functions printf (), fprintf (), vEprintf(), vsprintf (), ... call one single function, _doprint (), that
deals with the format string and arguments. The same applies to all scanf type functions, which call the function _doscan(),
and also for the wprintf and wscanf type functions which call _dowprint () and _dowscan() respectively. The C library
contains three versions of these routines: int, long and long long versions. If you use floating-point the formatter function
for floating-point _dof1lt () or _dowflt () is called. Depending on the formatting arguments you use, the correct routine is
used from the library. Of course the larger the version of the routine the larger your produced code will be.

Note that when you call any of the printf/scanf routines indirect, the arguments are not known and always the 1long long
version with floating-point support is used from the library.

Example
#include <stdio.h>
long L;
void main(void)
{

printf( ”"This is a long: %1d\n”, L );
}

The linker extracts the 1ong version without floating-point support from the library.

% See also the description of #pragma weak in section 1.5, Pragmas to Control the Compiler in the user’s manual.



2 C++ Language

Summary This chapter describes the C++ language implementation and some specific
features.

2.1 Introduction

The TASKING C++ compiler offers a new approach to high-level language programming for your target processor. The C++
compiler accepts the C++ language as defined by the ISO/IEC 14882:1998 standard and modified by TC1 for that standard. It
also accepts the language extensions of the C compiler (see Chapter 1, C Language).

Note that the C++ language itself is not described in this document. For more information on the C++ language, see the
following publications.

* The C++ Programming Language (second edition) by Bjarne Straustrup (1991, Addison Wesley)
* ISO/IEC 14882:1998 C++ standard [ANSI] More information on the standards can be found at http://www.ansi.org/.

2.2 C++ Language Extension Keywords

The C++ compiler supports the same language extension keywords as the C compiler. When option --strict is used, the
extensions will be disabled.

Additionally the following language extensions are supported:

attributes

Attributes, introduced by the keyword __attribute_, can be used on declarations of variables, functions, types, and fields.
The alias, aligned, cdecl, const, constructor, deprecated, destructor, format, format_arg, init priority,
malloc, mode, naked, no_check memory usage, no_instrument function, nocommon, noreturn, packed, pure,
section, sentinel, stdcall, transparent union, unused, used, visibility, volatile, and weak attributes are
supported.

pragmas

The C++ compiler supports the same pragmas as the C compiler and some extra pragmas as explained in section 2.9, Pragmas
to Control the C++ Compiler. Pragmas give directions to the code generator of the compiler.

2.3 C++ Dialect Accepted

The C++ compiler accepts the C++ language as defined by the ISO/IEC 14882:1998 standard and modified by TC1 for that
standard.

Command line options are also available to enable and disable anachronisms and strict standard-conformance checking.

2.3.1 Standard Language Features Accepted

The following features not in traditional C++ (the C++ language of "The Annotated C++ Reference Manual’ by Ellis and

Stroustrup (ARM)) but in the standard are implemented:

* The dependent statement of an if, while, do-while, or for is considered to be a scope, and the restriction on having
such a dependent statement be a declaration is removed.

* The expression tested in an if, while, do-while, or for, as the first operand of a ”?” operator, or as an operand of the
"&&”,”:”, or ”1”operators may have a pointer-to-member type or a class type that can be converted to a pointer-to-member
type in addition to the scalar cases permitted by the ARM.
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* Qualified names are allowed in elaborated type specifiers.
* A global-scope qualifier is allowed in member references of the form x.: :A: :Band p->::A: :B.
* The precedence of the third operand of the ”?” operator is changed.

* |f control reaches the end of the main () routine, and main () has an integral return type, it is treated as if a return 0;
statement were executed.

* Pointers to arrays with unknown bounds as parameter types are diagnosed as errors.

* A functional-notation cast of the form A () can be used even if A is a class without a (nontrivial) constructor. The temporary
created gets the same default initialization to zero as a static object of the class type.

* A cast can be used to select one out of a set of overloaded functions when taking the address of a function.
* Template friend declarations and definitions are permitted in class definitions and class template definitions.
* Type template parameters are permitted to have default arguments.

* Function templates may have nontype template parameters.

* Areference to const volatile cannot be bound to an rvalue.

¢ Qualification conversions, such as conversion from T* *
to T const * const * are allowed.

* Digraphs are recognized.

* Operator keywords (e.g., not, and, bitand, etc.) are recognized.

» Static data member declarations can be used to declare member constants.

*  When option --wchar_t-keyword is set, wchar_t is recognized as a keyword and a distinct type.
* Dbool is recognized.

* RTTI (run-time type identification), including dynamic_cast and the typeid operator, is implemented.
* Declarations in tested conditions (in if, switch, for, and while statements) are supported.

* Array new and delete are implemented.

* New-style casts (static_cast, reinterpret_cast, and const_cast) are implemented.

» Definition of a nested class outside its enclosing class is allowed.

* mutable is accepted on non-static data member declarations.

* Namespaces are implemented, including using declarations and directives. Access declarations are broadened to match
the corresponding using declarations.

* Explicit instantiation of templates is implemented.

* The typename keyword is recognized.

* explicit is accepted to declare non-converting constructors.

* The scope of a variable declared in the for-init-statement of a for loop is the scope of the loop (not the surrounding
scope).

* Member templates are implemented.

* The new specialization syntax (using "template <>") is implemented.

* Cv-qualifiers are retained on rvalues (in particular, on function return values).

* The distinction between trivial and nontrivial constructors has been implemented, as has the distinction between PODs and
non-PODs with trivial constructors.

* The linkage specification is treated as part of the function type (affecting function overloading and implicit conversions).
* extern inline functions are supported, and the default linkage for inline functions is external.

* Atypedef name may be used in an explicit destructor call.

* Placement delete is implemented.

* An array allocated via a placement new can be deallocated via delete.

* Covariant return types on overriding virtual functions are supported.

* enum types are considered to be non-integral types.

* Partial specialization of class templates is implemented.

* Partial ordering of function templates is implemented.

* Function declarations that match a function template are regarded as independent functions, not as "guiding declarations”
that are instances of the template.

* |tis possible to overload operators using functions that take enum types and no class types.
* Explicit specification of function template arguments is supported.
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Unnamed template parameters are supported.
The new lookup rules for member references of the form x.A: : B and p->A: : B are supported.
The notation : : template (and ->template, etc.) is supported.

In a reference of the form £ ()->g (), with g a static member function, £ () is evaluated. The ARM specifies that the left
operand is not evaluated in such cases.

enum types can contain values larger than can be contained in an int.

Default arguments of function templates and member functions of class templates are instantiated only when the default
argument is used in a call.

String literals and wide string literals have const type.
Class name injection is implemented.
Argument-dependent (Koenig) lookup of function names is implemented.

Class and function names declared only in unqualified friend declarations are not visible except for functions found by
argument-dependent lookup.

A void expression can be specified on a return statement in a void function.

Function-try-blocks, i.e., try-blocks that are the top-level statements of functions, constructors, or destructors, are
implemented.

Universal character set escapes (e.g., \uabcd) are implemented.

On a call in which the expression to the left of the opening parenthesis has class type, overload resolution looks for
conversion functions that can convert the class object to pointer-to-function types, and each such pointed-to "surrogate
function” type is evaluated alongside any other candidate functions.

Dependent name lookup in templates is implemented. Nondependent names are looked up only in the context of the
template definition. Dependent names are also looked up in the instantiation context, via argument-dependent lookup.

Value-initialization is implemented. This form of initialization is indicated by an initializer of ”()” and causes zeroing of certain
POD-typed members, where the usual default-initialization would leave them uninitialized.

A partial specialization of a class member template cannot be added outside of the class definition.
Qualification conversions may be performed as part of the template argument deduction process.
The export keyword for templates is implemented.

2.3.2 C++0x Language Features Accepted

The following features added in the working paper for the next C++ standard (expected to be completed in 2009 or later) are
enabled in C++0x mode (with option --c++0x). Several of these features are also enabled in default (nonstrict) C++ mode.

A ’right shift token” (>>) can be treated as two closing angle brackets. For example:

template<typename T> struct S {};
S<S<int>> s; // OK. No whitespace needed
// between closing angle brackets.

The friend class syntax is extended to allow nonclass types as well as class types expressed through a typedef or without an
elaborated type name. For example:

typedef struct S ST;
class C {

friend S; // OK (requires S to be in scope).
friend ST; // OK (same as "friend S;").
friend int; // OK (no effect).

friend S const; // Error: cv-qualifiers cannot
// appear directly.
}i
Mixed string literal concatenations are accepted (a feature carried over from C99):

wchar t *str = "a” L"b"”; // OK, same as L"ab".

Variadic macros and empty macro arguments are accepted, as in C99.
A trailing comma in the definition of an enumeration type is silently accepted (a feature carried over from C99):

enum E { e, };
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If the command line option --long-long is specified, the type long long is accepted. Unsuffixed integer literals that
cannot be represented by type long, but could potentially be represented by type unsigned long, have type long long
instead (this matches C99, but not the treatment of the long long extension in C89 or default C++ mode).

The keyword typename followed by a qualified-id can appear outside a template declaration.

struct S { struct N {}; };
typename S::N *p; // Silently accepted in C++0x mode

2.3.3 Anachronisms Accepted

The following anachronisms are accepted when anachronisms are enabled (with --anachronisms):

overload is allowed in function declarations. It is accepted and ignored.

Definitions are not required for static data members that can be initialized using default initialization. The anachronism does
not apply to static data members of template classes; they must always be defined.

The number of elements in an array may be specified in an array delete operation. The value is ignored.

A single operator++ () and operator-- () function can be used to overload both prefix and postfix operations.

The base class name may be omitted in a base class initializer if there is only one immediate base class.

Assignment to this in constructors and destructors is allowed. This is allowed only if anachronisms are enabled and the
"assignment to this” configuration parameter is enabled.

A bound function pointer (a pointer to a member function for a given object) can be cast to a pointer to a function.

A nested class name may be used as a non-nested class name provided no other class of that name has been declared.
The anachronism is not applied to template classes.

A reference to a non-const type may be initialized from a value of a different type. A temporary is created, it is initialized
from the (converted) initial value, and the reference is set to the temporary.

A reference to a non-const class type may be initialized from an rvalue of the class type or a derived class thereof. No
(additional) temporary is used.

A function with old-style parameter declarations is allowed and may participate in function overloading as though it were
prototyped. Default argument promotion is not applied to parameter types of such functions when the check for compatibility
is done, so that the following declares the overloading of two functions named £:

int f(int);

int f(x) char x; { return x; }

Note that in C this code is legal but has a different meaning: a tentative declaration of £ is followed by its definition.

When option --nonconst-ref-anachronism is set, a reference to a non-const class can be bound to a class rvalue of the
same type or a derived type thereof.

struct A {
A(int);
A operator=(A&);
A operator+(const A&);

}i
main () {

A b(1);

b = A(1l) + A(2); // Allowed as anachronism
}

2.3.4 Extensions Accepted in Normal C++ Mode

The following extensions are accepted in all modes (except when strict ANSI/ISO violations are diagnosed as errors or were
explicitly noted):

A friend declaration for a class may omit the class keyword:

class A {
friend B; // Should be "friend class B”
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Constants of scalar type may be defined within classes:

class A {
const int size = 10;
int a[sizel;
}i
In the declaration of a class member, a qualified name may be used:

struct A {

int A::£(); // Should be int £();
}i
The restrict keyword is allowed.

Implicit type conversion between a pointer to an extern ”C” function and a pointer to an extern ”C++" function is
permitted. Here’s an example:

extern ”C” void f(); // f's type has extern "C” linkage
void (*pf)() // pf points to an extern "C++"” function
= &f; // error unless implicit conversion is
// allowed

This extension is allowed in environments where C and C++ functions share the same calling conventions. It is enabled by
default.

A "?” operator whose second and third operands are string literals or wide string literals can be implicitly converted to "char
*” or "'wchar_t *”. (Recall that in C++ string literals are const. There is a deprecated implicit conversion that allows
conversion of a string literal to char *”, dropping the const. That conversion, however, applies only to simple string
literals. Allowing it for the result of a ”?” operation is an extension.)

char *p = x ? "abc” : "def”;

Default arguments may be specified for function parameters other than those of a top-level function declaration (e.g., they
are accepted on typedef declarations and on pointer-to-function and pointer-to-member-function declarations).
Non-static local variables of an enclosing function can be referenced in a non-evaluated expression (e.g., a sizeof
expression) inside a local class. A warning is issued.

In default C++ mode, the friend class syntax is extended to allow nonclass types as well as class types expressed through a
typedef or without an elaborated type name. For example:

typedef struct S ST;
class C {

friend S; // OK (requires S to be in scope).
friend ST; // OK (same as "friend S;").
friend int; // OK (no effect).

friend S const; // Error: cv-qualifiers cannot
// appear directly.

}i
In default C++ mode, mixed string literal concatenations are accepted. (This is a feature carried over from C99 and also
available in GNU modes).
wchar t *str = "a” L"b"; // OK, same as L"ab”.
In default C++ mode, variadic macros are accepted. (This is a feature carried over from C99 and also available in GNU
modes.)
In default C++ mode, empty macro arguments are accepted (a feature carried over from C99).
A trailing comma in the definition of an enumeration type is silently accepted (a feature carried over from C99):

enum E { e, };

24 GNU Extensions

The C++ compiler can be configured to support the GNU C++ mode (command line option —--g++). In this mode, many
extensions provided by the GNU C++ compiler are accepted. The following extensions are provided in GNU C++ mode.

Extended designators are accepted
Compound literals are accepted.
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* Non-standard anonymous unions are accepted

* The typeof operator is supported. This operator can take an expression or a type (like the sizeof operator, but
parentheses are always required) and expands to the type of the given entity. It can be used wherever a typedef name is
allowed

typeof(2*2.3) d; // Declares a "double”
typeof (int) i; // Declares an ”"int”

This can be useful in macro and template definitions.

* The _extension__ keyword is accepted preceding declarations and certain expressions. It has no effect on the meaning
of a program.
__extension__ _ inline__ int f(int a) {
return a > 0 ? a/2 : f(__extension__ 1-a);
}
* Inall GNU C modes and in GNU C++ modes with gnu_version < 30400, the type modifiers signed, unsigned, long and short
can be used with typedef types if the specifier is valid with the underlying type of the typedef in ANSI C. E.g.:

typedef int I;
unsigned I *pui; // OK in GNU C++ mode;
// same as "unsigned int *pui”

* Ifthe command line option --long-long is specified, the extensions for the long long and unsigned long long types
are enabled.
* Zero-length array types (specified by [0]) are supported. These are complete types of size zero.

* (C99-style flexible array members are accepted. In addition, the last field of a class type have a class type whose last field is
a flexible array member. In GNU C++ mode, flexible array members are treated exactly like zero-length arrays, and can
therefore appear anywhere in the class type.

* The C99 _Pragma operator is supported.

* The gcc built-in <stdarg.h> and <varargs.h> facilities (__builtin_va_list, __ builtin_va_arg, ...) are accepted.

* The sizeof operator is applicable to void and to function types and evaluates to the value one.

* Variables can be redeclared with different top-level cv-qualifiers (the new qualification is merged into existing qualifiers). For
example:

extern int volatile x;
int const x = 32; // x is now const volatile

* The "assembler name” of variables and routines can be specified. For example:
int counter __ _asm__ (”counter_vl”) = 0;
* Register variables can be mapped on specific registers using the asm keyword.

register int i asm(”eax"”);
// Map "i" onto register eax.
* The keyword inline is ignored (with a warning) on variable declarations and on block-extern function declarations.
* Excess aggregate initializers are ignored with a warning.
struct S { int a, b; };
struct S al = { 1, 2, 3 };
// "3" ignored with a warning; no error
int a2[(2] = { 7, 8, 9 };
// "9" ignored with a warning; no error
* Expressions of types void*, void const*, void volatile* and void const volatile* can be dereferenced; the
result is an Ivalue.
e The restrict__ keyword is accepted. It is identical to the C99 restrict keyword, except for its spelling.

* Out-of-range floating-point values are accepted without a diagnostic. When IEEE floating-point is being used, the "infinity”
value is used.

* Extended variadic macros are supported.
¢ Dollar signs ($) are allowed in identifiers.
* Hexadecimal floating point constants are recognized.
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The __asm__ keyword is recognized and equivalent to the asm token. Extended syntax is supported to indicate how

assembly operands map to C/C++ variables.
asm(”fsinx %1,%0” : "=f"(x) : "f"(a));
// Map the output operand on "x",
// and the input operand on "a”.
The \e escape sequence is recognized and stands for the ASCII "ESC” character.

The address of a statement label can be taken by use of the prefix "&&” operator, e.g., void *a = &&L. A transfer to the
address of a label can be done by the "goto *” statement, e.g., goto *a.

Multi-line strings are supported, e.g.,

char *p = "abc

def”;

ASCII "NULL” characters are accepted in source files.

A source file can end with a backslash ("\") character.

Case ranges (e.g., "case 'a’ ... 'z"”) are supported.

A number of macros are predefined in GNU mode. See section 2.10, Predefined Macros.

A predefined macro can be undefined.

A large number of special functions of the form _ builtin xyz (e.g., _ builtin_alloca) are predeclared.

Some expressions are considered to be constant-expressions even though they are not so considered in standard C and
C++. Examples include ”( (char *)&((struct S *)0)->c[0]) - (char *)0”and”(int)”Hello” & 0".

The macro __ GNUC___is predefined to the major version number of the emulated GNU compiler. Similarly, the macros
__GNUC_MINOR__ and __ GNUC_PATCHLEVEL___ are predefined to the corresponding minor version number and patch
level. Finally, _ VERSION__is predefined to a string describing the compiler version.

The __ thread specifier can be used to indicate that a variable should be placed in thread-local storage (requires
gnu_version >= 30400).

An extern inline function that is referenced but not defined is permitted (with a warning).

Trigraphs are ignored (with a warning).

Non-standard casts are allowed in null pointer constants, e.g., (int) (int *)0 is considered a null pointer constant in
spite of the pointer cast in the middle.

Statement expressions, e.g., ({int j; j = £(); 3J;)} are accepted. Branches into a statement expression are not
allowed. In C++ mode, branches out are also not allowed. Variable-length arrays, destructible entities, try, catch, local
non-POD class definitions, and dynamically-initialized local static variables are not allowed inside a statement expression.
Labels can be declared to be local in statement expressions by introducing them witha __1abel  declaration.

({ __label 1lab; int i = 4; lab: i = 2*i-1; if (!(i%17)) goto lab; i; })

Not-evaluated parts of constant expressions can contain non-constant terms:

int i;

int a[ 1 || 1 1; // Accepted in gcc/g++ mode

Casts on an Ivalue that don’t fall under the usual "lvalue cast” interpretation (e.g., because they cast to a type having a
different size) are ignored, and the operand remains an Ivalue. A warning is issued.

int i;

(short)i = 0; // Accepted,cast is ignored; entire int is set

Variable length arrays (VLAs) are supported. GNU C also allows VLA types for fields of local structures, which can lead to

run-time dependent sizes and offsets. The C++ compiler does not implement this, but instead treats such arrays as having
length zero (with a warning); this enables some popular programming idioms involving fields with VLA types.

void f(int n) {

struct {

int a[n]; // Warning: n ignored and
// replaced by zero

}i
}
Complex type extensions are supported (these are the same as the C99 complex type features, with the elimination of
_Imaginary and the addition of _complex, real, imag, the use of "~” to denote complex conjugation, and complex
literals such as "1.21i").
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* If an explicit instantiation directive is preceded by the keyword extern, no (explicit or implicit) instantiation is for the
indicated specialization.

* An explicit instantiation directive that names a class may omit the class keyword, and may refer to a typedef.

* An explicit instantiation or extern template directive that names a class is accepted in an invalid namespace.

* std::type_info does not need to be introduced with a special pragma.

* A special keyword _ null expands to the same constant as the literal "0, but is expected to be used as a null pointer
constant.

* When gnu_version < 30400, names from dependent base classes are ignored only if another name would be found by the
lookup.

const int n = 0;
template <class T> struct B {

static const int m = 1; static const int n = 2;
}i
template <class T> struct D : B<T> {

int £() { return m + n; }

// B::m + ::n in g++ mode
}i
* A non-static data member from a dependent base class, which would usually be ignored as described above, is found if the

lookup would have otherwise found a nonstatic data member of an enclosing class (when gnu_version is < 30400).
template <class T> struct C {

struct A { int i; };

struct B: public A {

void £() {
i =0; // g++ uses A::1i not C::i

}i
int 1i;
}i
* A new operation in a template is always treated as dependent (when gnu_version >= 30400).
template <class T > struct A {
void f£() {
void *p = 0;
new (&p) int(0); // calls operator new
// declared below

}i

void* operator new(size_ t, void* p);
* When doing name lookup in a base class, the injected class name of a template class is ignored.

namespace N {
template <class T> struct A {};

}

struct A {
int 1i;

}i

struct B : N::A<int> {
B() { A x; x.i =1; } // g++ uses ::A, not N::A
}i
* The injected class name is found in certain contexts in which the constructor should be found instead.
struct A {
A(int) {};
}i
A::A a(l);
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In a constructor definition, what should be treated as a template argument list of the constructor is instead treated as the
template argument list of the enclosing class.

template <int ul> struct A { };
template <> struct A<1> {

template<class T> A(T i, int j);
}i

template <> A<1>::A<1>(int i, int j) { }
// accepted in g++ mode

A difference in calling convention is ignored when redeclaring a typedef.

typedef void F();

extern "C” {
typedef void F(); // Accepted in GNU C++ mode
// (error otherwise)

}

The macro __GNUG___is defined identically to __ GNUC___ (i.e., the major version number of the GNU compiler version that
is being emulated).

The macro _GNU_SOURCE is defined as "1”.

Guiding declarations (a feature present in early drafts of the standard, but not in the final standard) are disabled.
Namespace std is predeclared.

No connection is made between declarations of identical names in different scopes even when these names are declared
extern "C".E.g,

extern ”"C” { void f(int); }
namespace N {
extern "C” {
void £() {} // Warning (not error) in g++ mode

}
int main() { £(1); }

This example is accepted by the C++ compiler, but it will emit two conflicting declarations for the function f£.

When a using-directive lookup encounters more than one extern ”C” declaration (created when more than one
namespace declares an extern ”C” function of a given name, as described above), only the first declaration encountered
is considered for the lookup.

extern “C” int f(void);

extern ”"C” int g(void);

namespace N {
extern "C” int f(void); // same type
extern "C"” void g(void); // different type

}i

using namespace N;

int i = £(); // calls ::f

int j = g(); // calls ::f

The definition of a member of a class template that appears outside of the class definition may declare a nontype template
parameter with a type that is different than the type used in the definition of the class template. A warning is issued (GNU
version 30300 and below).

template <int I> struct A { void f(); };
template <unsigned int I> void A<I>::f(){}

A class template may be redeclared with a nontype template parameter that has a type that is different than the type used in
the earlier declaration. A warning is issued.

template <int I> class A;
template <unsigned int I> class A {};
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* A friend declaration may refer to a member typedef.

class A {
class B {};
typedef B my b;
friend class my_b;
}i
* When afriend class is declared with an unqualified name, the lookup of that name is not restricted to the nearest enclosing
namespace scope.

struct S;
namespace N {

class C {

friend struct S; // ::S in g++ mode,
// N::S in default mode

}i

}
* Afriend class declaration can refer to names made visible by using-directives.

namespace N { struct A { }; }
using namespace N;
struct B {
void f() { A a; }
friend struct A; // in g++ mode N::A,
}s // not a new declaration of ::A

* Aninherited type name can be used in a class definition and later redeclared as a typedef.

struct A { typedef int I; };
struct B : A {

typedef I J; // Refers to A::I
typedef double I; // Accepted in g++ mode
Y // (introduces B::I)

* In a catch clause, an entity may be declared with the same name as the handler parameter.

try { }

catch(int e) {
char e;

}

* The diagnostic issued for an exception specification mismatch is reduced to a warning if the previous declaration was found
in a system header.

* The exception specification for an explicit template specialization (for a function or member function) does not have to match
the exception specification of the corresponding primary template.

* Atemplate argument list may appear following a constructor name in constructor definition that appears outside of the class
definition:
template <class T> struct A {

A();

}i
template <class T> A<T>::A<T>(){}

* When gnu_version < 30400, an incomplete type can be used as the type of a nonstatic data member of a class template.

class B;

template <class T> struct A {
B b;

}i
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A constructor need not provide an initializer for every nonstatic const data member (but a warning is still issued if such an
initializer is missing).
struct S {

int const ic;

S() {} // Warning only in GNU C++ mode

// (error otherwise).

}i
Exception specifications are ignored on function definitions when support for exception handling is disabled (normally, they
are only ignored on function declarations that aren’t definitions).
A friend declaration in a class template may refer to an undeclared template.

template <class T> struct A {
friend void f<>(A<T>);
}i
When gnu_version is < 30400, the semantic analysis of a friend function defined in a class template is performed only if the
function is actually used and is done at the end of the translation unit (instead of at the point of first use).

A function template default argument may be redeclared. A warning is issued and the default from the initial declaration is
used.

template<class T> void f(int i = 1);
template<class T> void f(int i 2){}
int main() {

f<void>();

}
A definition of a member function of a class template that appears outside of the class may specify a default argument.

template <class T> struct A { void £(T); };
template <class T> void A<T>::f(T value = T() ) { }

Function declarations (that are not definitions) can have duplicate parameter names.
void f(int i, int i); // Accepted in GNU C++ mode

Default arguments are retained as part of deduced function types.

A namespace member may be redeclared outside of its namespace.
A template may be redeclared outside of its class or namespace.
namespace N {

template< typename T > struct S {};
}

template< typename T > struct N::S;
The injected class name of a class template can be used as a template template argument.

template <template <class> class T> struct A {};
template <class T> struct B {
A<B> a;
}i
A partial specialization may be declared after an instantiation has been done that would have used the partial specialization
if it had been declared earlier. A warning is issued.

template <class T> class X {};
X<int*> xi;
template <class T> class X<T*> {};

The ”.” or ”->” operator may be used in an integral constant expression if the result is an integral or enumeration constant:

struct A { enum { el =1 }; };

int main () {
A a;
int x[a.el]; // Accepted in GNU C++ mode
return 0;
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» Strong using-directives are supported.
using namespace debug __ attribute_ ((strong));
* Partial specializations that are unusable because of nondeductible template parameters are accepted and ignored.

template<class T> struct A {class C { };};
template<class T> struct B {enum {e = 1}; };
template <class T> struct B<typename A<T>::C> {enum {e = 2}; };
int main(int argc, char **argv) {
printf(”%d\n”, B<int>::e);
printf(”%d\n”, B<A<int>::C>::e);
}

* Template parameters that are not used in the signature of a function template are not ignored for partial ordering purposes
(i.-e., the resolution of core language issue 214 is not implemented) when gnu_version is < 40100.

template <class S, class T> void f£(T t);
template <class T> void f(T t);
int main() {
f<int>(3); // not ambiguous when gnu_version
// is < 40100
}

* Prototype instantiations of functions are deferred until the first actual instantiation of the function to allow the compilation of
programs that contain definitions of unusable function templates (gnu_version 30400 and above). The example below is
accepted when prototype instantiations are deferred.

class A {};
template <class T> struct B {

B () {}; // error: no initializer for

// reference member “B<T>::a”

A& a;

}i
* When doing nonclass prototype instantiations (e.g., gnu_version 30400 and above), the severity of the diagnostic issued if a

const template static data member is defined without an initializer is reduced to a warning.

template <class T> struct A {
static const int i;
}i
template <class T> const int A<T>::i;
* When doing nonclass prototype instantiations (e.g., gnu_version 30400 and above), a template static data member with an
invalid aggregate initializer is accepted (the error is diagnosed if the static data member is instantiated).
struct A {
A(double val);

}i

template <class T> struct B {
static const A I[1];

}i

template <class T> const A B<T>::I[1]= {
{1.,0.,0.,0.}

}i

The following GNU extensions are not currently supported:

* The forward declaration of function parameters (so they can participate in variable-length array parameters).
* GNU-style complex integral types (complex floating-point types are supported)
* Nested functions
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2.5 Namespace Support

Namespaces are enabled by default. You can use the command line option --no-namespaces to disable the features.

When doing name lookup in a template instantiation, some names must be found in the context of the template definition while
others may also be found in the context of the template instantiation. The C++ compiler implements two different instantiation
lookup algorithms: the one mandated by the standard (referred to as "dependent name lookup”), and the one that existed before
dependent name lookup was implemented.

Dependent name lookup is done in strict mode (unless explicitly disabled by another command line option) or when dependent
name processing is enabled by either a configuration flag or command line option.

Dependent Name Processing

When doing dependent name lookup, the C++ compiler implements the instantiation name lookup rules specified in the
standard. This processing requires that non-class prototype instantiations be done. This in turn requires that the code be written
using the typename and template keywords as required by the standard.

Lookup Using the Referencing Context

When not using dependent name lookup, the C++ compiler uses a name lookup algorithm that approximates the two-phase lookup
rule of the standard, but does so in such a way that is more compatible with existing code and existing compilers.

When a name is looked up as part of a template instantiation but is not found in the local context of the instantiation, it is looked
up in a synthesized instantiation context that includes both names from the context of the template definition and names from
the context of the instantiation. Here’s an example:

namespace N {
int g(int);
int x = 0;
template <class T> struct A {
T £(T t) { return g(t); }
T £() { return x; }
bi
}

namespace M {
int x = 99;
double g(double);
N::A<int> ai;

int 1 = ai.f(0); // N::A<int>::f(int) calls
// N::g(int)

int i2 = ai.f(); // N::A<int>::f() returns
// 0 (= N::x)

N: :A<double> ad;

double d = ad.f(0); // N::A<double>::f(double)
// calls M::g(double)

double d2 = ad.f(); // N::A<double>::f() also
// returns 0 (= N::x)

}
The lookup of names in template instantiations does not conform to the rules in the standard in the following respects:

* Although only names from the template definition context are considered for names that are not functions, the lookup is not
limited to those names visible at the point at which the template was defined.

* Functions from the context in which the template was referenced are considered for all function calls in the template.
Functions from the referencing context should only be visible for "dependent” function calls.

Argument Dependent Lookup

When argument-dependent lookup is enabled (this is the default), functions made visible using argument-dependent lookup
overload with those made visible by normal lookup. The standard requires that this overloading occurs even when the name
found by normal lookup is a block extern declaration. The C++ compiler does this overloading, but in default mode,
argument-dependent lookup is suppressed when the normal lookup finds a block extern.
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This means a program can have different behavior, depending on whether it is compiled with or without argument-dependent
lookup --no-arg-dep-lookup, even if the program makes no use of namespaces. For example:

struct A { };
A operator+(A, double);
void f() {
A al;
A operator+(A, int);
al + 1.0; // calls operator+(A, double)
// with arg-dependent lookup enabled but
// otherwise calls operator+(A, int);

2.6 Template Instantiation

The C++ language includes the concept of templates. A template is a description of a class or function that is a model for a
family of related classes or functions.! For example, one can write a template for a Stack class, and then use a stack of
integers, a stack of floats, and a stack of some user-defined type. In the source, these might be written Stack<int>,
Stack<float>, and Stack<x>. From a single source description of the template for a stack, the compiler can create
instantiations of the template for each of the types required.

The instantiation of a class template is always done as soon as it is needed in a compilation. However, the instantiations of
template functions, member functions of template classes, and static data members of template classes (hereafter referred to as
template entities) are not necessarily done immediately, for several reasons:

* One would like to end up with only one copy of each instantiated entity across all the object files that make up a program.
(This of course applies to entities with external linkage.)

* The language allows one to write a specialization of a template entity, i.e., a specific version to be used in place of a version
generated from the template for a specific data type. (One could, for example, write a version of Stack<int>, or of just
Stack<int>: :push, that replaces the template-generated version; often, such a specialization provides a more efficient
representation for a particular data type.) Since the compiler cannot know, when compiling a reference to a template entity, if
a specialization for that entity will be provided in another compilation, it cannot do the instantiation automatically in any
source file that references it.

* C++ templates can be exported (i.e., declared with the keyword export). Such templates can be used in a translation unit
that does not contain the definition of the template to instantiate. The instantiation of such a template must be delayed until
the template definition has been found.

* The language also dictates that template functions that are not referenced should not be compiled, that, in fact, such
functions might contain semantic errors that would prevent them from being compiled. Therefore, a reference to a template
class should not automatically instantiate all the member functions of that class.

(It should be noted that certain template entities are always instantiated when used, e.g., inline functions.)
From these requirements, one can see that if the compiler is responsible for doing all the instantiations automatically, it can only

do so on a program-wide basis. That is, the compiler cannot make decisions about instantiation of template entities until it has
seen all the source files that make up a complete program.

This C++ compiler provides an instantiation mechanism that does automatic instantiation at link time. For cases where you want
more explicit control over instantiation, the C++ compiler also provides instantiation modes and instantiation pragmas, which can
be used to exert fine-grained control over the instantiation process.

2.6.1 Automatic Instantiation

The goal of an automatic instantiation mode is to provide painless instantiation. You should be able to compile source files to
object code, then link them and run the resulting program, and never have to worry about how the necessary instantiations get
done.

In practice, this is hard for a compiler to do, and different compilers use different automatic instantiation schemes with different
strengths and weaknesses:

1 Since templates are descriptions of entities (typically, classes) that are parameterizable according to the
types they operate upon, they are sometimes called parameterized types.
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* AT&T/USL/Novell’s cfront product saves information about each file it compiles in a special directory called ptrepository.
It instantiates nothing during normal compilations. At link time, it looks for entities that are referenced but not defined, and
whose mangled names indicate that they are template entities. For each such entity, it consults the ptrepository
information to find the file containing the source for the entity, and it does a compilation of the source to generate an object
file containing object code for that entity. This object code for instantiated objects is then combined with the "normal” object
code in the link step.

If you are using cfront you must follow a particular coding convention: all templates must be declared in . h files, and for each
such file there must be a corresponding . cc file containing the associated definitions. The compiler is never told about the

. cc files explicitly; one does not, for example, compile them in the normal way. The link step looks for them when and if it
needs them, and does so by taking the . h filename and replacing its suffix.2

This scheme has the disadvantage that it does a separate compilation for each instantiated function (or, at best, one
compilation for all the member functions of one class). Even though the function itself is often quite small, it must be
compiled along with the declarations for the types on which the instantiation is based, and those declarations can easily run
into many thousands of lines. For large systems, these compilations can take a very long time. The link step tries to be smart
about recompiling instantiations only when necessary, but because it keeps no fine-grained dependency information, it is
often forced to "recompile the world” for a minor change in a . h file. In addition, cfront has no way of ensuring that
preprocessing symbols are set correctly when it does these instantiation compilations, if preprocessing symbols are set other
than on the command line.

* Borland’s C++ compiler instantiates everything referenced in a compilation, then uses a special linker to remove duplicate
definitions of instantiated functions.

If you are using Borland’s compiler you must make sure that every compilation sees all the source code it needs to
instantiate all the template entities referenced in that compilation. That is, one cannot refer to a template entity in a source
file if a definition for that entity is not included by that source file. In practice, this means that either all the definition code is
put directly in the .h files, or that each .h file includes an associated .cc (actually, .cpp) file.

Our approach is a little different. It requires that, for each instantiation of a non-exported template, there is some (normal,
top-level, explicitly-compiled) source file that contains the definition of the template entity, a reference that causes the
instantiation, and the declarations of any types required for the instantiation.3 This requirement can be met in various ways:

* The Borland convention: each .h file that declares a template entity also contains either the definition of the entity or
includes another file containing the definition.

* Implicit inclusion: when the compiler sees a template declaration in a .h file and discovers a need to instantiate that entity, it
is given permission to go off looking for an associated definition file having the same base name and a different suffix, and it
implicitly includes that file at the end of the compilation. This method allows most programs written using the cfront
convention to be compiled with our approach. See section 2.6.4, Implicit Inclusion.

* The ad hoc approach: you make sure that the files that define template entities also have the definitions of all the available
types, and add code or pragmas in those files to request instantiation of the entities there.

Exported templates are also supported by our automatic instantiation method, but they require additional mechanisms explained
further on.

The automatic instantiation mode is enabled by default. It can be turned off by the command line option
--no-auto-instantiation. If automatic instantiation is turned off, the extra information about template entities that could be
instantiated in a file is not put into the object file.

2.6.2 Instantiation Modes

Normally, when a file is compiled, template entities are instantiated everywhere where they are used. The overall instantiation
mode can, however, be changed by a command line option:

--instantiate=used

Instantiate those template entities that were used in the compilation. This will include all static data members for which there
are template definitions. This is the default.

2 The actual implementation allows for several different suffixes and provides a command line option to
change the suffixes sought.

3 Isn’t this always the case? No. Suppose that file A contains a definition of class x and a reference to
Stack<X>: :push, and that file B contains the definition for the member function push. There would be no
file containing both the definition of push and the definition of x.
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--instantiate=all

Instantiate all template entities declared or referenced in the compilation unit. For each fully instantiated template class, all of
its member functions and static data members will be instantiated whether or not they were used. Non-member template
functions will be instantiated even if the only reference was a declaration.

--instantiate=local

Similar to --instantiate=used except that the functions are given internal linkage. This is intended to provide a very simple
mechanism for those getting started with templates. The compiler will instantiate the functions that are used in each
compilation unit as local functions, and the program will link and run correctly (barring problems due to multiple copies of
local static variables.) However, one may end up with many copies of the instantiated functions, so this is not suitable for
production use. --instantiate=local cannot be used in conjunction with automatic template instantiation. If automatic
instantiation is enabled by default, it will be disabled by the —-instantiate=local option.

In the case where the control program is called with a single file to compile and link, e.g.,
ccarm test.cc

the compiler knows that all instantiations will have to be done in the single source file. Therefore, it uses the
--instantiate=used mode and suppresses automatic instantiation.

2.6.3 Instantiation #pragma Directives

Instantiation pragmas can be used to control the instantiation of specific template entities or sets of template entities. There are
three instantiation pragmas:
* The instantiate pragma causes a specified entity to be instantiated.

* The do_not_instantiate pragma suppresses the instantiation of a specified entity. It is typically used to suppress the
instantiation of an entity for which a specific definition will be supplied.

* The can_instantiate pragma indicates that a specified entity can be instantiated in the current compilation, but need not be;
it is used in conjunction with automatic instantiation, to indicate potential sites for instantiation if the template entity turns out
to be required.

The argument to the instantiation pragma may be:

* atemplate class name A<int>

* atemplate class declaration class A<int>

* amember function name A<int>::f

* astatic data member name A<int>::i

* astatic data declaration int A<int>::i

e a member function declaration void A<int>::f(int,char)
* atemplate function declaration char* f(int, float)

A pragma in which the argument is a template class name (e.g., A<int> or class A<int>) is equivalent to repeating the
pragma for each member function and static data member declared in the class. When instantiating an entire class a given
member function or static data member may be excluded using the do_not_instantiate pragma. For example,

#pragma instantiate A<int>
#pragma do_not_instantiate A<int>::f

The template definition of a template entity must be present in the compilation for an instantiation to occur. If an instantiation is
explicitly requested by use of the instantiate pragma and no template definition is available or a specific definition is provided,
an error is issued.

template <class T> void f1(T); // No body provided
template <class T> void gl(T); // No body provided
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void fl(int) {} // Specific definition
void main()

{
int i;
double d;
f1(i);
£l(d);
gl(i);
gl(d);
}
#pragma instantiate void fl(int) // error - specific
// definition
#pragma instantiate void gl(int) // error - no body

// provided

f1(double) and gl (double) will not be instantiated (because no bodies were supplied) but no errors will be produced during
the compilation (if no bodies are supplied at link time, a linker error will be produced).

A member function name (e.g., A<int>:: f) can only be used as a pragma argument if it refers to a single user defined
member function (i.e., not an overloaded function). Compiler-generated functions are not considered, so a name may refer to a
user defined constructor even if a compiler-generated copy constructor of the same name exists. Overloaded member functions
can be instantiated by providing the complete member function declaration, as in

#pragma instantiate char* A<int>::f(int, char¥)

The argument to an instantiation pragma may not be a compiler-generated function, an inline function, or a pure virtual function.

2.6.4 Implicit Inclusion

When implicit inclusion is enabled, the C++ compiler is given permission to assume that if it needs a definition to instantiate a
template entity declared in a . h file it can implicitly include the corresponding . cc file to get the source code for the definition.
For example, if a template entity ABC: : £ is declared in file xyz.h, and an instantiation of ABC: : £ is required in a compilation
but no definition of ABC: : £ appears in the source code processed by the compilation, the compiler will look to see if a file
xyz.cc exists, and if so it will process it as if it were included at the end of the main source file.

To find the template definition file for a given template entity the C++ compiler needs to know the path name specified in the
original include of the file in which the template was declared and whether the file was included using the system include syntax
(e.g., #include <file.h>). This information is not available for preprocessed source containing #1ine directives.
Consequently, the C++ compiler will not attempt implicit inclusion for source code containing #1ine directives.

The file to be implicitly included is found by replacing the file suffix with each of the suffixes specified in the instantiation file suffix
list. The normal include search path mechanism is then used to look for the file to be implicitly included.

By default, the list of definition-file suffixes tried is .c, .cc, .cpp, and . cxx.

Implicit inclusion works well alongside automatic instantiation, but the two are independent. They can be enabled or disabled
independently, and implicit inclusion is still useful when automatic instantiation is not done.

The implicit inclusion mode can be turned on by the command line option --implicit-include. If this option is turned on, you
cannot use exported templates.

Implicit inclusions are only performed during the normal compilation of a file, (i.e., not when doing only preprocessing). A
common means of investigating certain kinds of problems is to produce a preprocessed source file that can be inspected. When
using implicit inclusion it is sometimes desirable for the preprocessed source file to include any implicitly included files. This may
be done using the command line option --no-preprocessing-only. This causes the preprocessed output to be generated as
part of a normal compilation. When implicit inclusion is being used, the implicitly included files will appear as part of the
preprocessed output in the precise location at which they were included in the compilation.
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2.6.5 Exported Templates

Exported templates are templates declared with the keyword export. Exporting a class template is equivalent to exporting each
of its static data members and each of its non-inline member functions. An exported template is special because its definition
does not need to be present in a translation unit that uses that template. In other words, the definition of an exported (non-class)
template does not need to be explicitly or implicitly included in a translation unit that instantiates that template. For example, the
following is a valid C++ program consisting of two separate translation units:

// File 1:
#include <stdio.h>
static void trace() { printf(”File 1\n”); }

export template<class T> T const& min(T const&, T const&);
int main()

{

trace();

return min(2, 3);
}
// File 2:

#include <stdio.h>
static void trace() { printf(”File 2\n”); }

export template<class T> T const& min(T const &a, T const &b)
{

trace();

return a<b? a: b;

}

Note that these two files are separate translation units: one is not included in the other. That allows the two functions trace ()
to coexist (with internal linkage).

Support for exported templates is enabled by default, but you can turn it off with command line option --no-export.

You cannot use exported templates together with the command line option --implicit-include.

2.6.5.1 Finding the Exported Template Definition

The automatic instantiation of exported templates is somewhat similar (from a user’s perspective) to that of regular (included)
templates. However, an instantiation of an exported template involves at least two translation units: one which requires the
instantiation, and one which contains the template definition.

When a file containing definitions of exported templates is compiled, a file with a . et suffix is created and some extra
information is included in the associated . t1i file. The .et files are used later by the C++ compiler to find the translation unit that
defines a given exported template.

When a file that potentially makes use of exported templates is compiled, the compiler must be told where to look for . et files
for exported templates used by a given translation unit. By default, the compiler looks in the current directory. Other directories
may be specified with the command line option --template-directory. Strictly speaking, the . et files are only really needed
when it comes time to generate an instantiation. This means that code using exported templates can be compiled without having
the definitions of those templates available. Those definitions must be available when explicit instantiation is done.

The . et files only inform the C++ compiler about the location of exported template definitions; they do not actually contain those
definitions. The sources containing the exported template definitions must therefore be made available at the time of
instantiation. In particular, the export facility is not a mechanism for avoiding the publication of template definitions in source
form.
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2.6.5.2 Secondary Translation Units

An instantiation of an exported template can be triggered by an explicit instantiation directive, or by the command line option
--instantiate=used. In each case, the translation unit that contains the initial point of instantiation will be processed as the
primary translation unit. Based on information it finds in the . et files, the C++ compiler will then load and parse the translation
unit containing the definition of the template to instantiate. This is a secondary translation unit. The simultaneous processing of
the primary and secondary translation units enables the C++ compiler to create instantiations of the exported templates (which
can include entities from both translation units). This process may reveal the need for additional instantiations of exported
templates, which in turn can cause additional secondary translation units to be loaded?.

When secondary translation units are processed, the declarations they contain are checked for consistency. This process may
report errors that would otherwise not be caught. Many these errors are so-called "ODR violations” (ODR stands for
“one-definition rule”). For example:

// File 1:
struct X {
int x;

}i

int main() {
return min(2, 3);

}
// File 2:
struct X {

unsigned x; // Error: X::x declared differently

// in File 1

}i
export template<class T> T const& min(T const &a, T const &b)
{

return a<b? a: b;
}

If there are no errors, the instantiations are generated in the output associated with the primary translation unit. This may also
require that entities with internal linkage in secondary translation units be "externalized” so they can be accessed from the
instantiations in the primary translation unit.

2.6.5.3 Libraries with Exported Templates

Typically a (non-export) library consists of an include directory and a 1ib directory. The include directory contains the
header files required by users of the library and the 1ib directory contains the object code libraries that client programs must
use when linking programs.

With exported templates, users of the library must also have access to the source code of the exported templates and the
information contained in the associated . et files. This information should be placed in a directory that is distributed along with
the include and 1ib directories: This is the export directory. It must be specified using the command line option
--template-directory when compiling client programs.

The recommended procedure to build the export directory is as follows:
1. For each . et file in the original source directory, copy the associated source file to the export directory.

2. Concatenate all of the . et files into a single . et file (e.g., mylib.et) in the export directory. The individual . et files
could be copied to the export directory, but having all of the . et information in one file will make use of the library more
efficient.

3. Create an export_info file in the export directory. The export_info file specifies the include search paths to be used
when recompiling files in the export directory. If no export_info file is provided, the include search path used when
compiling the client program that uses the library will also be used to recompile the library exported template files.

4 As a consequence, using exported templates may require considerably more memory that similar uses of
regular (included) templates.
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The export_info file consists of a series of lines of the form
include=x

or
sys_include=x

where X is a path name to be placed on the include search path. The directories are searched in the order in which they are
encountered in the export_info file. The file can also contain comments, which begin with a "#”, and blank lines. Spaces are
ignored but tabs are not currently permitted. For example:

# The include directories to be used for the xyz library

include = /diskl/xyz/include
sys_include = /disk2/abc/include
include=/disk3/jkl/include

The include search path specified for a client program is ignored by the C++ compiler when it processes the source in the export
library, except when no export_info file is provided. command line macro definitions specified for a client program are also
ignored by the C++ compiler when processing a source file from the export libary; the command line macros specified when the
corresponding . et file was produced do apply. All other compilation options (other than the include search path and command
line macro definitions) used when recompiling the exported templates will be used to compile the client program.

When a library is installed on a new system, it is likely that the export_info file will need to be adapted to reflect the location
of the required headers on that system.

2.7 Inlining Functions

The C++ compiler supports a minimal form of function inlining. When the C++ compiler encounters a call of a function declared
inline it can replace the call with the body of the function with the parameters replaced by the corresponding arguments.
When a function call occurs as a statement, the statements of the function body are inserted in place of the call. When the
function call occurs within an expression, the body of the function is rewritten as one large expression and that expression is
inserted in the proper place in the containing expression. It is not always possible to do this sort of inlining: there are certain
constructs (e.g. loops and inline assembly) that cannot be rendered in expression form. Even when inlining is done at the
statement level, there are certain constructs that are not practical to inline. Calls that cannot be inlined are left in their original
call form, and an out-of-line copy of the function is used. When enabled, a remark is issued.

A function is disqualified for inlining immediately if any of the following are true:
* The function has local static variables.

* The function has local constants.

e The function has local types.

* The function has block scopes.

e The function includes pragmas.

* The function has a variable argument list.

2.8 Extern Inline Functions

Depending on the way in which the C++ compiler is configured, out-of-line copies of extern inline functions are either
implemented using static functions, or are instantiated using a mechanism like the template instantiation mechanism. Note that
out-of-line copies of inline functions are only required in cases where the function cannot be inlined, or when the address of the
function is taken (whether explicitly by the user, by implicitly generated functions, or by compiler-generated data structures such
as virtual function tables or exception handling tables).

When static functions are used, local static variables of the functions are promoted to global variables with specially encoded
names, so that even though there may be multiple copies of the code, there is only one copy of such global variables. This
mechanism does not strictly conform to the standard because the address of an extern inline function is not constant across
translation units.
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When the instantiation mechanism is used, the address of an extern inline function is constant across translation units, but at the
cost of requiring the use of one of the template instantiation mechanisms, even for programs that don’t use templates.
Definitions of extern inline functions can be provided either through use of the automatic instantiation mechanism or by use of
the --instantiate=used or --instantiate=all instantiation modes. There is no mechanism to manually control the definition of
extern inline function bodies.

2.9 Pragmas to Control the C++ Compiler

Pragmas are keywords in the C++ source that control the behavior of the compiler. Pragmas overrule compiler options.
The syntax is:
#pragma pragma-spec

The C++ compiler supports the following pragmas and all C compiler pragmas that are described in section 1.5, Pragmas to
Control the Compiler.

instantiate / do_not_instantiate /can_instantiate

These are template instantiation pragmas. They are described in detail in section 2.6.3, Instantiation #pragma Directives.

hdrstop /no_pch

These are precompiled header pragmas. They are described in detail in section 2.11, Precompiled Headers.

once

When placed at the beginning of a header file, indicates that the file is written in such a way that including it several times has
the same effect as including it once. Thus, if the C++ compiler sees #pragma once at the start of a header file, it will skip over
it if the file is #included again.

A typical idiom is to place an #ifndef guard around the body of the file, with a #define of the guard variable after the #ifndef:

#pragma once // optional
#ifndef FILE_H

#define FILE H

... body of the header file ...
#endif

The #pragma once is marked as optional in this example, because the C++ compiler recognizes the #ifndef idiom and does
the optimization even in its absence. #pragma once is accepted for compatibility with other compilers and to allow the
programmer to use other guard-code idioms.

ident

This pragma is given in the form:
#pragma ident "string”

or

#ident "string”
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2.10 Predefined Macros

The C++ compiler defines a number of preprocessing macros. Many of them are only defined under certain circumstances. This
section describes the macros that are provided and the circumstances under which they are defined.

Macro Description

__ ABI_COMPATIBILITY VERSION Defines the ABI compatibility version being used. This macro is set to

9999, which means the latest version. This macro is used when
building the C++ library.

___ABI CHANGES FOR RTTI

This macro is set to TRUE, meaning that the ABI changes for RTTI
are implemented. This macro is used when building the C++ library.

__ABI_CHANGES_FOR_ARRAY NEW_AND DELETE

This macro is set to TRUE, meaning that the ABI changes for array
new and delete are implemented. This macro is used when building
the C++ library.

___ABI CHANGES FOR PLACEMENT DELETE

This macro is set to TRUE, meaning that the ABI changes for
placement delete are implemented. This macro is used when
building the C++ library.

__ARRAY_OPERATORS

Defined when array new and delete are enabled. This is the
default.

_ BASE_FILE_ Similarto __FILE__ but indicates the primary source file rather than
the current one (i.e., when the current file is an included file).

__ BIG_ENDIAN_ Expands to 1 if big-endian mode is selected (--endianness=big),
otherwise unrecognized as macro.

_BOOL Defined when bool is a keyword. This is the default.

__BUILD Identifies the build number of the C++ compiler, composed of

decimal digits for the build number, three digits for the major branch
number and three digits for the minor branch number. For example, if
you use build 1.22.1 of the compiler, _ BUILD__ expands to
1022001. If there is no branch number, the branch digits expand to
zero. For example, build 127 results in 127000000.

__CHAR MIN / _ CHAR_MAX

Used in 1imits.h to define the minimum/maximum value of a plain
char respectively.

__CPARM Identifies the C++ compiler. You can use this symbol to flag parts of
the source which must be recognized by the C++ compiler only. It
expands to 1.

__cplusplus Always defined.

__CPU__ Expands to a string with the CPU supplied with the option --cpu.
When no --cpu is supplied, this symbol is not defined.

__ DATE Defined to the date of the compilation in the form "Mmm dd yyyy”.

__ DELTA_TYPE Defines the type of the offset field in the virtual function table. This
macro is used when building the C++ library.

_ DOUBLE_FP___ Expands to 1 if you did not use option --no-double (Treat 'double’

as ‘float’), otherwise unrecognized as macro.

___embedded_cplusplus

Defined as 1 in Embedded C++ mode.

___EXCEPTIONS Defined when exception handling is enabled (--exceptions).
__ FILE Expands to the current source file name.
_ func__ Same as _ FUNCTION__ in GNU mode.

___IMPLICIT USING_STD

Defined when the standard header files should implicitly do a
using-directive on the std namespace (--using-std).

__JMP_BUF_ELEMENT_ TYPE

Specifies the type of an element of the setjmp buffer. This macro is
used when building the C++ library.

__JMP_BUF_NUM_ELEMENTS

Defines the number of elements in the setjmp buffer. This macro is
used when building the C++ library.

__LINE _

Expands to the line number of the line where this macro is called.
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Macro

Description

__ LITTLE_ENDIAN

Expands to 1 if little-endian mode is selected (--endianness=little),
otherwise unrecognized as macro. This is the default.

__ NAMESPACES

Defined when namespaces are supported (this is the default, you
can disable support for namespaces with -—-no-namespaces).

__NO_LONG_LONG

Defined when the 1long long type is not supported. This is the
default.

__NULL_EH REGION NUMBER

Defines the value used as the null region number value in the
exception handling tables. This macro is used when building the C++
library.

__ PLACEMENT DELETE

Defined when placement delete is enabled.

__PRETTY FUNCTION

Defined to the name of the current function. This includes the return
type and parameter types of the function. An error is issued if it is
used outside of a function.

__PTRDIFF MIN / _ PTRDIFF_MAX

Used in stdint.h to define the minimum/maximum value of a
ptrdiff t type respectively.

__ REGION_NUMBER TYPE

Defines the type of a region number field in the exception handling
tables. This macro is used when building the C++ library.

__REVISION Expands to the revision number of the C++ compiler. Digits are
represented as they are; characters (for prototypes, alphas, betas)
are represented by -1. Examples: v1.0r1 -> 1, v1.0rb -> -1
__RTTI Defined when RTTl is enabled (--rtti).

__RUNTIME USES_NAMESPACES

Defined when the run-time uses namespaces.

__SIGNED CHARS

Defined when plain char is signed.

__ SINGLE_FP__

Expands to 1 if you used option --no-double (Treat 'double’ as
‘float’), otherwise unrecognized as macro.

__SIZE MIN / _ SIZE_MAX

Used in stdint.h to define the minimum/maximum value of a
size_t type respectively.

_ STDC___

Always defined, but the value may be redefined.

__STDC_VERSION

Identifies the ISO-C version number. Expands to 199901L for ISO
C99, but the value may be redefined.

_STLP_NO_IOSTREAMS

Defined when option --io-streams is not used. This disables 1/0
stream functions in the STLport C++ library.

__ TASKING_ Always defined for the TASKING C++ compiler.

___THUMB___ Expands to 1 if you used option —-thumb, otherwise unrecognized
as mactro.

__ TIME Expands to the compilation time: "nh:mm:ss”

__TYPE_TRAITS_ENABLED

Defined when type traits pseudo-functions (to ease the
implementation of ISO/IEC TR 19768; e.g., __is union) are
enabled. This is the default in C++ mode.

__VAR_HANDLE_ TYPE

Defines the type of the variable-handle field in the exception
handling tables. This macro is used when building the C++ library.

__VERSION__

Identifies the version number of the C++ compiler. For example, if
you use version 2.1r1 of the compiler, _ VERSION__ expands to
2001 (dot and revision number are omitted, minor version number in
3 digits).

__ VIRTUAL_FUNCTION_INDEX_ TYPE

Defines the type of the virtual function index field of the virtual
function table. This macro is used when building the C++ library.

__ VIRTUAL_FUNCTION_ TYPE

Defines the type of the virtual function field of the virtual function
table. This macro is used when building the C++ library.

__WCHAR_MIN / _ WCHAR_MAX

Used in stdint.h to define the minimum/maximum value of a
wchar_t type respectively.

_WCHAR T

Defined when wchar_t is a keyword.

Table 2-1: Predefined macros
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2.11 Precompiled Headers

It is often desirable to avoid recompiling a set of header files, especially when they introduce many lines of code and the primary
source files that #include them are relatively small. The C++ compiler provides a mechanism for, in effect, taking a snapshot
of the state of the compilation at a particular point and writing it to a disk file before completing the compilation; then, when
recompiling the same source file or compiling another file with the same set of header files, it can recognize the “snapshot
point”, verify that the corresponding precompiled header (PCH) file is reusable, and read it back in. Under the right
circumstances, this can produce a dramatic improvement in compilation time; the trade-off is that PCH files can take a lot of
disk space.

2.11.1 Automatic Precompiled Header Processing

When --pch appears on the command line, automatic precompiled header processing is enabled. This means the C++
compiler will automatically look for a qualifying precompiled header file to read in and/or will create one for use on a subsequent
compilation.

The PCH file will contain a snapshot of all the code preceding the "header stop” point. The header stop point is typically the first
token in the primary source file that does not belong to a preprocessing directive, but it can also be specified directly by
#pragma hdrstop (see below) if that comes first. For example:

#include "xxx.h"”

#include "yyy.h"

int i;
The header stop point is int (the first non-preprocessor token) and the PCH file will contain a snapshot reflecting the inclusion
of xxx.h and yyy.h. If the first non-preprocessor token or the #pragma hdrstop appears within a #1if block, the header
stop point is the outermost enclosing #i£. To illustrate, heres a more complicated example:

#include "xxx.h”

#ifndef YYY H

#define YYY H 1

#include "yyy.h"

#endif

#if TEST

int 1i;

#endif
Here, the first token that does not belong to a preprocessing directive is again int, but the header stop point is the start of the
#1f block containing it. The PCH file will reflect the inclusion of xxx.h and conditionally the definition of YYY H and inclusion of
yyy - h; it will not contain the state produced by #if TEST.

A PCH file will be produced only if the header stop point and the code preceding it (mainly, the header files themselves) meet
certain requirements:

* The header stop point must appear at file scope -- it may not be within an unclosed scope established by a header file. For
example, a PCH file will not be created in this case:

// xxx.h
class A {

// xxx.C
#include "xxx.h"”
int i; };
* The header stop point may not be inside a declaration started within a header file, nor (in C++) may it be part of a declaration
list of a linkage specification. For example, in the following case the header stop point is int, but since it is not the start of a
new declaration, no PCH file will be created:

// yyy.h
static

// yyy.C
#include "yyy.h"
int i;

* Similarly, the header stop point may not be inside a #1 £ block or a #def ine started within a header file.
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* The processing preceding the header stop must not have produced any errors. (Note: warnings and other diagnostics will
not be reproduced when the PCH file is reused.)

* No references to predefined macros __ DATE __or _TIME _ may have appeared.

* No use of the #1ine preprocessing directive may have appeared.

* f#pragma no_pch (see below) must not have appeared.

* The code preceding the header stop point must have introduced a sufficient number of declarations to justify the overhead
associated with precompiled headers. The minimum number of declarations required is 1.

When the host system does not support memory mapping, so that everything to be saved in the precompiled header file is
assigned to preallocated memory (MS-Windows), two additional restrictions apply:

* The total memory needed at the header stop point cannot exceed the size of the block of preallocated memory.

* No single program entity saved can exceed 16384, the preallocation unit.

When a precompiled header file is produced, it contains, in addition to the snapshot of the compiler state, some information that
can be checked to determine under what circumstances it can be reused. This includes:

* The compiler version, including the date and time the compiler was built.

* The current directory (i.e., the directory in which the compilation is occurring).

* The command line options.

* The initial sequence of preprocessing directives from the primary source file, including #include directives.

* The date and time of the header files specified in #include directives.

This information comprises the PCH prefix. The prefix information of a given source file can be compared to the prefix
information of a PCH file to determine whether the latter is applicable to the current compilation.

As an illustration, consider two source files:

// a.cc

#include "xxx.h"”

cen // Start of code
// b.cc

#include "xxx.h"”

ce // Start of code

When a.cc is compiled with ——pch, a precompiled header file named a.pch is created. Then, when b. cc is compiled (or
when a. cc is recompiled), the prefix section of a.pch is read in for comparison with the current source file. If the command line
options are identical, if xxx . h has not been modified, and so forth, then, instead of opening xxx .h and processing it line by line,
the C++ compiler reads in the rest of a.pch and thereby establishes the state for the rest of the compilation.

It may be that more than one PCH file is applicable to a given compilation. If so, the largest (i.e., the one representing the most
preprocessing directives from the primary source file) is used. For instance, consider a primary source file that begins with

#include "xxx.h"”
#include "yyy.h"
#include "zzz.h"”

If there is one PCH file for xxx.h and a second for xxx.h and yyy . h, the latter will be selected (assuming both are applicable
to the current compilation). Moreover, after the PCH file for the first two headers is read in and the third is compiled, a new PCH
file for all three headers may be created.

When a precompiled header file is created, it takes the name of the primary source file, with the suffix replaced by an
implementation-specified suffix (pch by default). Unless —--pch-dir is specified (see below), it is created in the directory of the
primary source file.

When a precompiled header file is created or used, a message such as
"test.cc”: creating precompiled header file "test.pch”
is issued. The user may suppress the message by using the command line option --no-pch-messages.

When the option --pch-verbose is used, the C++ compiler will display a message for each precompiled header file that is
considered that cannot be used giving the reason that it cannot be used.
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In automatic mode (i.e., when —--pch is used) the C++ compiler will deem a precompiled header file obsolete and delete it under
the following circumstances:

* if the precompiled header file is based on at least one out-of-date header file but is otherwise applicable for the current
compilation; or

* if the precompiled header file has the same base name as the source file being compiled (e.g., xxx.pch and xxx.cc) but is
not applicable for the current compilation (e.g., because of different command line options).

This handles some common cases; other PCH file clean-up must be dealt with by other means (e.g., by the user).

Support for precompiled header processing is not available when multiple source files are specified in a single compilation: an
error will be issued and the compilation aborted if the command line includes a request for precompiled header processing and
specifies more than one primary source file.

2.11.2 Manual Precompiled Header Processing
Command line option --create-pch=filename specifies that a precompiled header file of the specified name should be created.

Command line option —-use-pch=filename specifies that the indicated precompiled header file should be used for this
compilation; if it is invalid (i.e., if its prefix does not match the prefix for the current primary source file), a warning will be issued
and the PCH file will not be used.

When either of these options is used in conjunction with --pch-dir, the indicated file name (which may be a path name) is
tacked on to the directory name, unless the file name is an absolute path name.

The options --create-pch, --use-pch, and --pch may not be used together. If more than one of these options is specified,
only the last one will apply. Nevertheless, most of the description of automatic PCH processing applies to one or the other of
these modes -- header stop points are determined the same way, PCH file applicability is determined the same way, and so
forth.

2.11.3 Other Ways to Control Precompiled Headers

There are several ways in which the user can control and/or tune how precompiled headers are created and used.

* #pragma hdrstop may be inserted in the primary source file at a point prior to the first token that does not belong to a
preprocessing directive. It enables you to specify where the set of header files subject to precompilation ends. For example,

#include "xxx.h"”
#include "yyy.h"
#pragma hdrstop
#include ”zzz.h"”

Here, the precompiled header file will include processing state for xxx.h and yyy.h but not zzz.h. (This is useful if the
user decides that the information added by what follows the #pragma hdrstop does not justify the creation of another PCH
file.)

* #pragma no_pch may be used to suppress precompiled header processing for a given source file.

e Command line option —-pch-dir=directory-name is used to specify the directory in which to search for and/or create a PCH
file.

Moreover, when the host system does not support memory mapping and preallocated memory is used instead, then one of the
command line options --pch, --create-pch, or --use-pch, if it appears at all, must be the first option on the command line.

2.11.4 Performance Issues

The relative overhead incurred in writing out and reading back in a precompiled header file is quite small for reasonably large
header files.

In general, it does not cost much to write a precompiled header file out even if it does not end up being used, and if it is used it
almost always produces a significant speedup in compilation. The problem is that the precompiled header files can be quite
large (from a minimum of about 250K bytes to several megabytes or more), and so one probably does not want many of them
sitting around.
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Thus, despite the faster recompilations, precompiled header processing is not likely to be justified for an arbitrary set of files with
nonuniform initial sequences of preprocessing directives. Rather, the greatest benefit occurs when a number of source files can
share the same PCH file. The more sharing, the less disk space is consumed. With sharing, the disadvantage of large
precompiled header files can be minimized, without giving up the advantage of a significant speedup in compilation times.

Consequently, to take full advantage of header file precompilation, users should expect to reorder the #include sections of
their source files and/or to group #include directives within a commonly used header file.

Below is an example of how this can be done. A common idiom is this:

#include "comnfile.h”
#pragma hdrstop
#include ...

where comnfile.h pulls in, directly and indirectly, a few dozen header files; the #pragma hdrstop is inserted to get better
sharing with fewer PCH files. The PCH file produced for comnfile.h can be a bit over a megabyte in size. Another idiom, used
by the source files involved in declaration processing, is this:

#include ”"comnfile.h”
#include “decl_hdrs.h”
#pragma hdrstop
#include ...

decl_hdrs.h pulls in another dozen header files, and a second, somewhat larger, PCH file is created. In all, the source files of
a particular program can share just a few precompiled header files. If disk space were at a premium, you could decide to make
comnfile.h pullin all the header files used -- then, a single PCH file could be used in building the program.

Different environments and different projects will have different needs, but in general, users should be aware that making the
best use of the precompiled header support will require some experimentation and probably some minor changes to source
code.
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3 Libraries

Summary This chapter lists all library functions that you can call in your C source.

3.1 Introduction

This chapter contains an overview of all library functions that you can call in your C source. This includes all functions of the
standard C library (ISO C99) and some functions of the floating-point library.

A number of standard operations within C are too complex to generate inline code for (too much code). These operations are
implemented as run-time library functions to save code.

Section 3.2, Library Functions, gives an overview of all library functions you can use, grouped per header file. A number of
functions declared in wchar . h are parallel to functions in other header files. These are discussed together.

C Library
Libraries Description
carm.lib C library, for ARM and Thumb instructions repectively
cthumb.lib (some functions also need the floating-point library)
carms.lib Single precision C library
cthumbs.lib (some functions also need the floating-point library)
fparm.lib Floating-point library
fpthumb.lib
rtarm.lib Run-time library
rtthumb.lib
pbarm.lib Profiling libraries: pb = block/function counter
pbthumb.lib pc = call graph
pcarm.lib pct = call graph and timing
pcthumb.lib pd = dummy
pctarm.lib pt = function timing
pctthumb.lib
pdarm.lib
pdthumb.lib
ptarm.lib
ptthumb.lib

Table 3-1: Overview of libraries

C++ Library

The TASKING C++ compiler supports the STLport C++ libraries. STLport is a multiplatform ISO C++ Standard Library
implementation. It is a free, open-source product, which is delivered with the TASKING C++ compiler. The library supports
standard templates and 1/O streams.

The include files for the STLport C++ libraries are present in directory include.st1 relative to the product installation directory.
You can find more information on the STLport library on the following site: http://stiport.sourgeforge.net/

Also read the license agreement on hitp://stlport.sourgeforge.net/License.shiml. This license agreement is applicable to the
STLport C++ library only. All other product components fall under the TASKING license agreement.

For an STL Programmer’s Guide you can see http://www.sgi.com/tech/stl/index.html.
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The following C++ libraries are delivered with the product:

Libraries Description

cparm[s][x].lib C++ libraries for ARM and Thumb
cpthumbis][x].lib s = single precision floating-point
X = exception handling

sttarmx.lib STLport C++ libraries for ARM and Thumb (with exception handling)
stithumbx.lib
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3.2 Library Functions

The following sections list all library functions, grouped per header file in which they are declared. Some functions are not
completely implemented because their implementation depends on the context where your application will run. These functions
are for example all 1/O related functions. Where possible, these functions are implemented using file system simulation (FSS).
This system can be used by the debugger to simulate an I/O environment which enables you to debug your application.

A number of wide-character functions are available as C source code, but have not been compiled with the C library. To use
complete wide-character functionality, you must recompile the libraries with the macro WCHAR_SUPPORT_ENABLED and
keep this macro also defined when compiling your own sources. (See C compiler option --define (-D) in section 6.1, C
Compiler Options, in Chapter 6, Tool options.)

3.2.1 assert.h

assert(expr) Prints a diagnostic message if NDEBUG is not defined.
(Implemented as macro)

3.2.2 complex.h

The complex number z is also written as x+yi where x (the real part) and y (the imaginary part) are real numbers of types
float, double or long double. The real and imaginary part can be stored in structs or in arrays. This implementation uses
arrays because structs may have different alignments.

The header file complex.h also defines the following macros for backward compatibility:

complex _Complex /* C99 keyword */
imaginary _Imaginary /* C99 keyword */

Parallel sets of functions are defined for double, float and long double. They are respectively named function, function£,
functionl. All 1long type functions, though declared in complex.h, are implemented as the double type variant which nearly
always meets the requirement in embedded applications.

This implementation uses the obvious implementation for complex multiplication; and a more sophisticated implementation for
divison and absolute value calculations which handles underflow, overflow and infinities with more care. The ISO C99 #pragma
CX_LIMITED_ RANGE therefore has no effect.

Trigonometric functions

csin  csinf csinl Returns the complex sine of z.

ccos ccosf ccosl Returns the complex cosine of z.

ctan ctanf ctanl Returns the complex tangent of z.

casin casinf casinl Returns the complex arc sine sin~1(z).
cacos cacosf cacosl Returns the complex arc cosine cos™1(z).
catan catanf catanl Returns the complex arc tangent tan=1(z).
csinh c¢sinhf csinhl Returns the complex hyperbolic sine of z.
ccosh ccoshf ccoshl Returns the complex hyperbolic cosine of z.

ctanh ctanhf ctanhl Returns the complex hyperbolic tangent of z.
casinh casinh cfasinhl Returns the complex arc hyperbolic sinus of z.
cacosh cacosh cfacoshl Returns the complex arc hyperbolic cosinus of z.

catanh catanhfcatanhl Returns the complex arc hyperbolic tangent of z.
Exponential and logarithmic functions

cexp cexpf cexpl Returns the result of the complex exponential function eZ.
clog clogf clogl Returns the complex natural logarithm.
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Power and absolute-value functions

cabs cabsf cabsl Returns the complex absolute value of z (also known as norm, modulus or magnitude).
cpow cpowf cpowl Returns the complex value of z raised to the power w (z%) where both z and w are complex
numbers.

csgrt csqrtf csqrtl Returns the complex square root of z.

Manipulation functions

carg cargf cargl Returns the argument of z (also known as phase angle).

cimag cimagf cimagl Returns the imaginary part of z as a real (respectively as a double, float, long double)
conj conjf conjl Returns the complex conjugate value (the sign of its imaginary part is reversed).

cproj cprojf cprojl Returns the value of the projection of z onto the Riemann sphere.

creal crealf creall Returns the real part of z (respectively as a double, float, long double)

3.2.3 ctype.h and wctype.h

The header file ctype . h declares the following functions which take a character ¢ as an integer type argument. The header file
wctype.h declares parallel wide-character functions which take a character ¢ of the wchar_t type as argument.

ctype.h wctype.h Description

isalnum iswalnum Returns a non-zero value when ¢ is an alphabetic character or a number ([A-Z][a-2z][0-9]).

isalpha iswalpha Returns a non-zero value when c is an alphabetic character ([A-Z][a-Z]).

isblank iswblank Returns a non-zero value when c is a blank character (tab, space...)

iscntrl iswentrl Returns a non-zero value when c is a control character.

isdigit iswditit Returns a non-zero value when c is a numeric character ([0-9]).

isgraph iswgraph Returns a non-zero value when c is printable, but not a space.

islower iswlower Returns a non-zero value when c is a lowercase character ([a-Zz]).

isprint iswprint Returns a non-zero value when c is printable, including spaces.

ispunct iswpunct Returns a non-zero value when c is a punctuation character
(suchas’’,’, ).

isspace iswspace Returns a non-zero value when c is a space type character (space, tab, vertical tab,
formfeed, linefeed, carriage return).

isupper iswupper Returns a non-zero value when c is an uppercase character ([A-Z]).

isxdigit iswxdigit Returns a non-zero value when c is a hexadecimal digit ([0-9][A-F][a-f]).

tolower towlower Returns ¢ converted to a lowercase character if it is an uppercase character, otherwise c is
returned.

toupper towupper Returns ¢ converted to an uppercase character if it is a lowercase character, otherwise c is
returned.

_tolower - Converts c to a lowercase character, does not check if c really is an uppercase character.
Implemented as macro. This macro function is not defined in ISO C99.

_toupper - Converts c to an uppercase character, does not check if ¢ really is a lowercase character.
Implemented as macro. This macro function is not defined in ISO C99.

isascii Returns a non-zero value when c is in the range of 0 and 127.
This function is not defined in ISO C99.

toascii Converts c to an ASCII value (strip highest bit).

This function is not defined in ISO C99.
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3.2.4 dbg.h

The header file dbg. h contains the debugger call interface for file system simulation. It contains low level functions. This header
file is not defined in ISO C99.

_dbg_trap Returns a non-zero value when c is in the range of 0 and 127.
This function is not defined in ISO C99.

_argcv(const char *buf, Converts c to an ASCII value (strip highest bit).
size t size) This function is not defined in ISO C99.

3.2.5 errno.h

int errno External variable that holds implementation defined error codes.

The following error codes are defined as macros in errno.h:

EPERM 1 Not owner

ENOENT 2 No such file or directory
EINTR 3 Interrupted system call
EIO 4 I/O error

EBADF 5 Bad file number
EAGAIN 6 No more processes
ENOMEM 7 Not enough core
EACCES 8 Permission denied
EFAULT 9 Bad address

EEXIST 10 File exists

ENOTDIR 11 Not a directory

EISDIR 12 Is a directory

EINVAL 13 Invalid argument
ENFILE 14 File table overflow
EMFILE 15 Too many open files
ETXTBSY 16 Text file busy

ENOSPC 17 No space left on device
ESPIPE 18 lllegal seek

EROFS 19 Read-only file system
EPIPE 20 Broken pipe

ELOOP 21 Too many levels of symbolic links
ENAMETOOLONG 22 File name too long
Floating-point errors

EDOM 23 Argument too large
ERANGE 24 Result too large

Errors returned by prinff/scanf

ERR_FORMAT 25 lllegal format string for printf/scanf
ERR_NOFLOAT 26 Floating-point not supported
ERR_NOLONG 27 Long not supported
ERR_NOPOINT 28 Pointers not supported

Encoding error stored in errno by functions like fgetwc, getwc, mbrtowec, efc ...

EILSEQ 29 Invalid or incomplete multibyte or wide character
Errors set by RTOS

EILSEQ 30 Operation canceled

ENODEV 31 No such device
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3.2.6 fentl.h

The file fentl.h contains the function open (), which calls the low level function _open (), and definitions of flags used by the
low level function _open (). This header file is not defined in ISO C99.

open Opens a file for reading or writing. Calls _open.
(FSS implementation)

3.2.7 fenv.h

Contains mechanisms to control the floating-point environment. The functions in this header file are not implemented.

fegetenv Stores the current floating-point environment. (Not implemented)

feholdexept Saves the current floating-point environment and installs an environment that ignores all floating-point
exceptions. (Not implemented)

fesetenv Restores a previously saved (fegetenv or feholdexcept) floating-point environment. (Not implemented)

feupdateenv Saves the currently raised floating-point exceptions, restores a previousely saved floating-point environ-

ment and finally raises the saved exceptions. (Not implemented)

feclearexcept Clears the current exception status flags corresponding to the flags specified in the argument. (Not im-
plemented)

fegetexceptflag Stores the current setting of the floating-point status flags. (Not implemented)

feraiseexcept Raises the exceptions represented in the argument. As a result, other exceptions may be raised as well.
(Not implemented)

fesetexceptflag Sets the current floating-point status flags. (Not implemented)
fetestexcept Returns the bitwise-OR of the exception macros corresponding to the exception flags which are current-
ly set and are specified in the argument. (Not implemented)

For each supported exception, a macro is defined. The following exceptions are defined:

FE_DIVBYZERO FE_INEXACT FE_INVALID
FE_OVERFLOW FE_UNDERFLOW FE_ALL_EXCEPT
fegetround Returns the current rounding direction, represented as one of the values of the rounding direction mac-

ros. (Not implemented)
fesetround Sets the current rounding directions. (Not implemented)

Currently no rounding mode macros are implemented.

3.2.8 float.h

The header file £1oat . h defines the characteristics of the real floating-point types £1oat, double and long double.

@ Float.h used to contain prototypes for the functions copysign(f), isinf(f), isfinite(f), isnan(f) and scalb(f).
These functions have accordingly to the ISO C99 standard been moved to the header file math.h. See also section
3.2.15, math.h and tgmath.h.

3.2.9 inttypes.h and stdint.h

The header files stdint.h and inttypes.h provide additional declarations for integer types and have various characteristics.
The stdint.h header file contains basic definitions of integer types of certain sizes, and corresponding sets of macros. This
header file clearly refers to the corresponding sections in the ISO C99 standard.

The inttypes.h header file includes stdint.h and adds portable formatting and conversion functions. Below the conversion
functions from inttypes.h are listed.

intmax_t imaxabs(intmax t j); Returns the absolute value of j

imaxdiv_t imaxdiv(intmax_t numer, Computes numer/denom and numer % denom. The result is stored in the quot
intmax_t denom); and rem components of the imaxdiv_t structure type.
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intmax_t strtoimax(const char * Convert string to maximum sized integer. (Compare strtol)
restrict nptr, char ** restrict
endptr, int base);

uintmax_t strtoumax(const char *  Convert string to maximum sized unsigned integer. (Compare strtoul)
restrict nptr, char ** restrict
endptr, int base);

intmax_t westoimax(const wchar t  Convert wide string to maximum sized integer. (Compare wctol)
* restrict nptr, wchar t ** re-
strict endptr, int base);

uintmax t westoumax(const wchar_t Convert wide string to maximem sized unsigned integer. (Compare wctoul)
* restrict nptr, wchar t ** re-
strict endptr, int base);

3.2.10 io.h

The header file io.h contains definitions and prototypes for low level I/O functions. This header file is not defined in
ISO/IEC9899.

_close(fd) Used by the functions close and fclose.
(FSS implementation)

_lseek(fd,offset,whence) Used by all file positioning functions: fgetpos, fseek, fsetpos, ftell, rewind. (FSS imple-
mentation)

_open(fd,flags) Used by the functions fopen and freopen.

(FSS implementation)

_read(fd,*buff,cnt) Reads a sequence of characters from a file.
(FSS implementation)

_unlink(*name) Used by the function remove.
(FSS implementation)

_write(fd,*buffer,cnt) Writes a sequence of characters to a file.
(FSS implementation)

3.2.11 is0646.h

The header file iso646.h adds tokens that can be used instead of regular operator tokens.

#define and &&
#define and_eq &=
#define bitand &
#define bitor |
#define compl ~
#define not !
#define not_eq !=
#define or ||
#define or_eq |=
#define xor
#define xor _eq "=

3.2.12 limits.h

Contains the sizes of integral types, defined as macros.

3.2.13 locale.h

To keep C code reasonable portable accross different languages and cultures, a number of facilities are provided in the header
file local.h.

char *setlocale( int category, const char *locale )

The function above changes locale-specific features of the run-time library as specified by the category to change and the
name of the locale.
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The following categories are defined and can be used as input for this function:

LC_ALL 0 LC_NUMERIC 3
LC_COLLATE 1 LC_TIME 4
LC_CTYPE 2 LC_MONETARY 5

struct lconv *localeconv( void )

Returns a pointer to type stuct lconv with values appropriate for the formatting of numeric quantities according to the
rules of the current locale. The struct lconv in this header file is conforming the ISO standard.

3.2.14 malloc.h

The header file malloc.h contains prototypes for memory allocation functions. This include file is not defined in ISO C99, it is
included for backwards compatibility with ISO C90. For ISO C99, the memory allocation functions are part of stdlib.h. See
section 3.2.23, stdlib.h and wchar.h.

malloc(size) Allocates space for an object with size size. The allocated space is not initialized. Returns a point-
er to the allocated space.

calloc(nobj,size) Allocates space for n objects with size size. The allocated space is initialized with zeros. Returns
a pointer to the allocated space.

free(*ptr) Deallocates the memory space pointed to by ptr which should be a pointer earlier returned by the
malloc or calloc function.

realloc(*ptr,size) Deallocates the old object pointed to by ptr and returns a pointer to a new object with size size,
while preserving its contents. If the new size is smaller than the old size, some contents at the
end of the old region will be discarded. If the new size is larger than the old size, all of the old
contents are preserved and any bytes in the new object beyond the size of the old object will have
indeterminate values.

3.2.15 math.h and tgmath.h

The header file math.h contains the prototypes for many mathematical functions. Before ISO C99, all functions were computed
using the double type (the float was automatically converted to double, prior to calculation). In this ISO C99 version, parallel sets
of functions are defined for double, float and long double. They are respectively named function, functionf, functionl. All long
type functions, though declared in math.h, are implemented as the double type variant which nearly always meets the
requirement in embedded applications.

The header file tgmath.h contains parallel type generic math macros whose expansion depends on the used type. tgmath.h
includes math.h and the effect of expansion is that the correct math.h functions are called. The type generic macro, if
available, is listed in the second column of the tables below.

Trigonometric and hyperbolic functions

math.h tgmath.h Description

sin sinf sinl sin Returns the sine of x.

cos cosf cosl cos Returns the cosine of x.

tan tanf  tanl tan Returns the tangent of x.

asin  asinf asinl asin Returns the arc sine sin~'(x) of x.

acos acosf acosl acos Returns the arc cosine cos™1(x) of x.
atan  atanf atanl atan Returns the arc tangent tan-1(x) of x.
atan2 atan2f atan2l atan2 Returns the result of: tan~1(y /x).

sinh  sinhf sinhl  sinh Returns the hyperbolic sine of x.

cosh  coshf coshl cosh Returns the hyperbolic cosine of x.
tanh  tanhf tanhl  tanh Returns the hyperbolic tangent of x.
asinh asinhf asinhl asinh Returns the arc hyperbolic sinus of x.
acosh acoshf acoshl acosh Returns the non-negative arc hyperbolic cosinus of x.
atanh atanhf atanhl atanh Returns the arc hyperbolic tangent of x.
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Exponential and logarithmic functions

All of these functions are new in ISO C99, except for exp, 1log and 1og10.

math.h tgmath.h Description
exp expf expl exp Returns the result of the exponential function eX.
exp2 exp2f exp2l exp2 Returns the result of the exponential function 2X.
(Not implemented)
expml expmlf expmll expml Returns the result of the exponential function eX-1
(Not implemented)
log logf logl log Returns the natural logarithm 1n(x), x>0.
logl0 1logl0f logl0l 1loglo0 Returns the base-10 logarithm of x, x>0.
loglp loglpf loglpl 1loglp Returns the base-e logarithm of (1+x).x <> -1.
(Not implemented)
log2 log2f log2l log2 Returns the base-2 logarithm of x. x>0.
(Not implemented)
ilogb ilogbf ilogbl ilogb Returns the signed exponent of x as an integer. x>0.
(Not implemented)
logb  logbf logbl logb Returns the exponent of x as a signed integer in value in floating-point notation. x
> 0.
(Not implemented)
frexp, Idexp, modf, scalbn, scalbln
math.h tgmath.h Description
frexp frexpl frexpf frexp Splits a float x into fraction f and exponent n, so that:
f=0.00r0.5<|f|<1.0and 2" = x. Returns f, stores n.
ldexp ldexpl ldexpf ldexp Inverse of frexp. Returns the result of x*2n.
(x and n are both arguments).
modf  modfl modff - Splits a float x into fraction f and integer n, so that:
| f| < 1.0 and f+n=x. Returns f, stores n.
scalbn scalbnl scalbnf  scalbn Computes the result of x*FLT RADIX". efficiently, not normally by computing
FLT RADIX" explicitly.
scalblnscalblnl scalblnf scalbln Same as scalbn but with argument n as long int.
Rounding functions
math.h tgmath.h Description
ceil  ceilf ceill ceil Returns the smallest integer not less than x, as a double.
floor floorf floorl floor Returns the largest integer not greater than x, as a double.
rint rintl rintf rint Returns the rounded integer value as an int according to the current rounding
direction. See fenv.h. (Not implemented)
lrint 1lrintf 1lrintl lrint Returns the rounded integer value as a 1ong int according to the current
rounding direction. See fenv . h. (Not implemented)
llrint lrintf 1lrintl llrint Returns the rounded integer value as a 1ong long int according to the
current rounding direction. See fenv . h. (Not implemented)
nearbyint nearbyintf nearbyint Returns the rounded integer value as a floating-point according to the current
nearbyintl rounding direction. See fenv . h. (Not implemented)
round roundl roundf round Returns the nearest integer value of x as int. (Not implemented)
lround lroundl lroundf  lround Returns the nearest integer value of x as long int. (Not implemented)
llroundllroundl llroundf 1llround Returns the nearest integer value of x as long long int. (Not implemented)
trunc truncl truncf trunc Returns the truncated integer value x. (Not implemented)
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Remainder after devision

math.h tgmath.h Description
fmod fmodl fmodf fmod Returns the remainder r of x-ny. n is chosen as trunc (x/). r has the same
sign as x.
remainder remainderl remainder Returns the remainder r of x-ny. n is chosen as trunc (x/y). r may not have
remainderf the same sign as x. (Not implemented)
remquo remquol remquof remguo Same as remainder. In addition, the argument *quo is given a specific value

(see 1SO). (Not implemented)

Power and absolute-value functions

math.h tgmath.h Description

cbrt  cbrtl cbrtf cbrt Returns the real cube root of x (=x1/3).
(Not implemented)

fabs fabsl fabsf fabs Returns the absolute value of x (| x|). (abs, labs, 11labs, div, 1div, 11div
are defined in stdlib.h)

fma fmal fmaf fma Floating-point multiply add. Returns x*y+z.
(Not implemented)

hypot hypotl hypotf hypot Returns the square root of x2+y2.

pow powl powf power Returns x raised to the power y (xY).

sqrt sqrtl sqrtf sqgrt Returns the non-negative square root of x. x# 0.

Manipulation functions: copysign, nan, nextafter, nexttoward

math.h tgmath.h Description
copysign copysignl copysign Returns the value of x with the sign of y.
copysignf
nan nanl nanf - Returns a quiet NaN, if available, with content indcated through tagp. (Not
implemented)

nextafter nextafterl nextafter Returns the next representable value in the specified format after x in the
nextafterf direction of y. Returns y is x=y. (Not implemented)

nexttoward nexttowardl nexttoward Same as nextafter, exceptthatthe second argument in all three variants is
nexttowardf of type long double. Returns y if x=y. (Not implemented)

Positive difference, maximum, minimum

math.h tgmath.h Description

fdim  fdiml  fdimf fdim Returns the positive difference between: |x-y|.
(Not implemented)

fmax fmax1l fmaxf fmax Returns the maximum value of their arguments.
(Not implemented)

fmin fminl fminf fmin Returns the minimum value of their arguments.
(Not implemented)
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Error and gamma (Not implemented)

math.h tgmath.h Description
erf erfl erff erf Computes the error function of x.
(Not implemented)
erfc erfcl erfcf erc Computes the complementary error function of x.
(Not implemented)
lgamma lgammal lgammaf lgamma Computes the *loge | (%) |
(Not implemented)
tgamma tgammal tgammaf tgamma Computes I (x)
(Not implemented)

Comparison macros

The next are implemented as macros. For any ordered pair of numeric values exactly one of the relationships - less, greater,
and equal - is true. These macros are type generic and therefor do not have a parallel function in tgmath.h. All arguments
must be expressions of real-floating type.

math.h tgmath.h Description

isgreater - Returns the value of (x) > (y)

isgreaterequal - Returns the value of (x) >= (y)

isless - Returns the value of (x) < (y)

islessequal - Returns the value of (x) <= (y)

islessgreater - Returns the value of (x) < (y) || (x) > (y)
isunordered - Returns 1 if its arguments are unordered, 0 otherwise.

Classification macros

The next are implemented as macros. These macros are type generic and therefor do not have a parallel function in tgmath.h.
All arguments must be expressions of real-floating type.

math.h tgmath.h Description
fpclassify - Returns the class of its argument:

FP_INFINITE, FP_NAN, FP_NORMAL, FP_SUBNORMAL Or FP_ZERO
isfinite - Returns a nonzero value if and only if its argument has a finite value
isinf - Returns a nonzero value if and only if its argument has an infinit value
isnan - Returns a nonzero value if and only if its argument has NaN value.
isnormal - Returns a nonzero value if an only if its argument has a normal value.
signbit - Returns a nonzero value if and only if its argument value is negative.

3.2.16 setjmp.h

The setjmp and longjmp in this header file implement a primitive form of nonlocal jumps, which may be used to handle
exceptional situations. This facility is traditionally considered more portable than signal.h.

int setjmp(jmp buf env) Records its caller’s environment in env and returns 0.

void longjmp(jmp_buf env, Restores the environment previously saved with a call to setjmp( ).
int status)

3-11



ARM Embedded Tools Reference

3.2.17 signal.h

Signals are possible asynchronous events that may require special processing. Each signal is named by a number. The
following signals are defined:

SIGINT 1 Receipt of an interactive attention signal

SIGILL 2 Detection of an invalid function message

SIGFPE 3 An errouneous arithmetic operation (for example, zero devide, overflow)
SIGSEGV 4 Aninvalid access to storage

SIGTERM 5 Atermination request sent to the program

SIGABRT 6 Abnormal terminiation, such as is initiated by the abort function.

The next function sends the signal sig to the program:
int raise(int sig)

The next function determines how subsequent signals will be handled:
signalfunction *signal (int, signalfunction *);

The first argument specifies the signal, the second argument points to the signal-handler function or has one of the following
values:

SIG_DFL Default behaviour is used
SIG_IGN The signal is ignored

The function returns the previous value of signalfunction for the specific signal, or SIG_ERR if an error occurs.

3.2.18 stdarg.h

The facilities in this header file gives you a portable way to access variable arguments lists, such as needed for as fprintf
and vEprintf. va_copy is new in ISO C99. This header file contains the following macros:

va_arg(ap,type) Returns the value of the next argument in the variable argument list. It’s return type has the type
of the given argument type. A next call to this macro will return the value of the next argument.

va_copy(va_list dest, This macro duplicates the current state of src in dest, creating a second pointer into the
va_list src) argument list. After this call, va_arg() may be used on src and dest independently.

va_end(va_list ap) This macro must be called after the arguments have been processed. It should be called before
the function using the macro 'va_start’ is terminated (ANSI specification).

va_start( va_list ap, This macro initializes ap. After this call, each call to va_arg() will return the value of the next
lastarg ); argument. In our implementation, va_1ist cannot contain any bit type variables. Also the
given argument lastarg must be the last non-bit type argument in the list.

3.2.19 stdbool.h

This header file contains the following macro definitions. These names for boolean type and values are consistent with C++. You
are allowed to #undefine or redefine the macros below.

#define bool _Bool
#define true 1
#define false 0
#define  bool true false are defined 1

3.2.20 stddef.h

This header file defines the types for common use:

ptrdiff t signed integer type of the result of subtracting two pointers.
size_t unsigned integral type of the result of the sizeof operator.
wchar_t integer type to represent character codes in large character sets.

Besides these types, the following macros are defined:
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NULL

expands to the null pointer constant

offsetof (_type,_member) expands to an integer constant expression with type size_t thatis the offset in bytes of

3.2.21 stdint.h

_member within structure type _type.

% See section 3.2.9, inttypes.h and stdint.h

3.2.22 stdio.h and wchar.h

Types

The header file stdio.h contains functions for performing input and output. A number of functions also have a parallel wide
character function or macro, defined in wchar . h. The header file wchar . h also includes stdio.h.

In the C language, many /O facilities are based on the concept of streams. The stdio.h header file defines the data type
FILE which holds the information about a stream. An FILE object is created with the function fopen. The pointer to this object
is used as an argument in many of the in this header file. The FILE object can contain the following information:

* the current position within the stream

* pointers to any associated buffers

¢ indications of for read/write errors

¢ end of file indication

The header file also defines type fpos_t as an unsigned long.

Macros

stdio.h / wchar.h

Description

NULL
BUFSIZ
EOF

WEOF

FOPEN_MAX
FILENAME MAX

_IOFBF
_IOLBF
_TONBF

L tmpnam
TMP MAX

SEEK CUR
SEEK_END
SEEK_SET

stderr
stdin
stdout

expands to the null pointer constant
Size of the buffer used by the setbuf/setvbuf function: 512
End of file indicator. Expands to -1.

End of file indicator. Expands to UINT MAX (defined in 1imits.h)
NOTE: WEOF need not to be a negative number as long as its value does not correspond to a member
of the wide character set. (Defined in wchar.h).

Number of files that can be opened simultaneously: 10
Maximum length of a filename: 100
Expand to an integer expression, suitable for use as argument to the setvbuf function.

Size of the string used to hold temporary file names: 8 (tmpxxxxx)
Maximum number of unique temporary filenames that can be generated: 0x8000

Expand to an integer expression, suitable for use as the third argument to the £seek function.

Expressions of type "pointer to FILE” that point to the FILE objects associated with standard error, input
and output streams.
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File access

stdio.h Description

fopen (name, mode) Opens a file for a given mode. Available modes are:

r read; open text file for reading

[

W write; create text file for writing; if the file already exists its contents is discarded

a append; open existing text file or create new text file for writing at end of file
? open text file for update; reading and writing

»

r+

»”, ”»

W+ create text file for update; previous contents if any is discarded

append; open or create text file for update, writes at end of file

» ”»

a+

fclose(name) Flushes the data stream and closes the specified file that was previously opened with

fopen.

fflush(name) If stream is an output stream, any buffered but unwritten date is written. Else, the effect is

undefined.

freopen(name,mode, stream)  Similar to fopen, but rather then generating a new value of type FILE *, the existing value

is associated with a new stream.

setbuf (stream,buffer) If buffer is NULL, buffering is turned off for the stream.

Otherwise, setbuf is equivalent to:
(void) setvbuf(stream,buf, IOFBF, BUFSIZ).

setvbuf (stream,buffer, Controls buffering for the stream; this function must be called before reading or writing.

mode,size) Mode can have the following values:

_IOFBF causes full buffering
_IOLBF causes line buffering of text files
_IONBF causes no buffering

If buffer is not NULL, it will be used as a buffer; otherwise a buffer will be allocated. size
determines the buffer size.

Character input/output

The format string of print £ related functions can contain plain text mixed with conversion specifiers. Each conversion
specifier should be preceded by a %’ character. The conversion specifier should be build in order:

Flags (in any order):
- specifies left adjustment of the converted argument.

+ a number is always preceded with a sign character.
+ has higher precedence than space.

space  a negative number is preceded with a sign, positive numbers with a space.
specifies padding to the field width with zeros (only for numbers).

# specifies an alternate output form. For o, the first digit will be zero. For x or X, "0x” and "0X” will be prefixed to the
number. For e, E, f, g, G, the output always contains a decimal point, trailing zeros are not removed.

A number specifying a minimum field width. The converted argument is printed in a field with at least the length specified
here. If the converted argument has fewer characters than specified, it will be padded at the left side (or at the right when the
flag ’-’ was specified) with spaces. Padding to numeric fields will be done with zeros when the flag '0’ is also specified (only
when padding left). Instead of a numeric value, also ’*’ may be specified, the value is then taken from the next argument,
which is assumed to be of type int.

A period. This separates the minimum field width from the precision.

A number specifying the maximum length of a string to be printed. Or the number of digits printed after the decimal point
(only for floating-point conversions). Or the minimum number of digits to be printed for an integer conversion. Instead of a
numeric value, also >’ may be specified, the value is then taken from the next argument, which is assumed to be of type
int.

A length modifier 'n’, ’hh’, I, °I’, °L, °j’, ’Z’ or ’t’. ’h’ indicates that the argument is to be treated as a short or unsigned
short. ’hh’ indicates that the argument is to be treated as a char or unsigned char. I’ should be used if the argument is
a long integer, Il for a long long. L indicates that the argument is a long double. j’ indicates a pointer to intmax_t
oruintmax_t, 'z’ indicates a pointer to size_ t and’t’ indicates a pointer to ptrdiff t.
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Flags, length specifier, period, precision and length modifier are optional, the conversion character is not. The conversion
character must be one of the following, if a character following ‘%’ is not in the list, the behavior is undefined.

Character Printed as
d,i int, signed decimal
o] int, unsigned octal
X, X int, unsigned hexadecimal in lowercase or uppercase respectively
u int, unsigned decimal
c int, single character (converted to unsigned char)
S char *, the characters from the string are printed until a NULL character is found. When the given precision is
met before, printing will also stop
f double
e E double
g,G double
a, A double
n int *, the number of characters written so far is written into the argument. This should be a pointer to an inte-
ger in default memory. No value is printed.
p pointer (hexadecimal 24-bit value)
% No argument is converted, a '%’ is printed.

Table 3-2: Printf conversion characters

All arguments to the scanf related functions should be pointers to variables (in default memory) of the type which is specified in
the format string.

The format string can contain :

- Blanks or tabs, which are skipped.

- Normal characters (not '%’), which should be matched exactly in the input stream.
- Conversion specifications, starting with a %’ character.

Conversion specifications should be built as follows (in order) :

- A, meaning that no assignment is done for this field.

- A number specifying the maximum field width.

- The conversion characters d, i, n, o, u and x may be preceded by 'h’ if the argument is a pointer to short rather than int,
or by ’hh’ if the argument is a pointer to char, or by I’ (letter ell) if the argument is a pointer to 1ong, or by ’II’ for a pointer to
long long, j for a pointer to intmax_t or uintmax_t, 'z’ for a pointer to size t or 't for a pointer to ptrdiff t. The
conversion characters e, £, and g may be preceded by 'l if the argument is a pointer to double rather than float, and by
'L for a pointer to a long double.

- A conversion specifier. *’, maximum field width and length modifier are optional, the conversion character is not. The
conversion character must be one of the following, if a character following ‘%’ is not in the list, the behavior is undefined.
Length specifier and length modifier are optional, the conversion character is not. The conversion character must be one of the

following, if a character following '%’ is not in the list, the behavior is undefined.

Character Scanned as

d int, signed decimal.

i int, the integer may be given octal (i.e. a leading 0 is entered) or hexadecimal (leading "0x” or "0X”), or just
decimal.

int, unsigned octal.
int, unsigned decimal.
int, unsigned hexadecimal in lowercase or uppercase.

single character (converted to unsigned char).

w O X < O

char *, a string of non white space characters. The argument should point to an array of characters, large
enough to hold the string and a terminating NULL character.
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Character Scanned as
f float
e E float
g,G float
a, A float
n int *, the number of characters written so far is written into the argument. No scanning is done.
p pointer; hexadecimal 24-bit value which must be entered without Ox- prefix.
[...] Matches a string of input characters from the set between the brackets. A NULL character is added to termi-
nate the string. Specifying []...] includes the ]’ character in the set of scanning characters.
[*...] Matches a string of input characters not in the set between the brackets. A NULL character is added to termi-
nate the string. Specifying [*]...] includes the ]’ character in the set.
% Literal '%’, no assignment is done.

Table 3-3: Scanf conversion characters

wchar.h

Description

stdio.h

fscanf (stream,
format,...)

scanf (format,...)

sscanf (*s,
format,...)

viscanf (stream,
format,arg)

vscanf (format,arg)

vsscanf (s, format,
arqg)

fprintf (stream,
format,...)

printf(format,...)

sprintf(*s,
format,...)

snprintf(*s,n
format,...)

viprintf(stream,
format,arg)

vprintf (format,
arqg)

vsprintf(*s,
format,arq)

fwscanf (stream,
format,...)

wscanf (format,...)

swscanf (*s,
format,...)

viwscanf (stream,
format ,arg)

vwscanf (format,arqg)

vswscanf (s, format,
arqg)

fwprintf (stream,
format,...)

wprintf (format,...)

swprintf(*s,n
format,...)

viwprintf (stream,
format,arg)

vwprintf (format,
arqg)

vswprintf (*s,
format,arqg)

Performs a formatted read from the given stream. Returns the number of
items converted succesfully. (FSS implementation)

Performs a formatted read from the stdin stream. Returns the number
of items converted succesfully. (FSS implementation)

Performs a formatted read from the string s. Returns the number of items
converted succesfully.

Same as fscanf/fwscanf, but extra arguments are given as variable
argument list arg.
(See section 3.2.18, stdarg.h)

Same as scanf/wscanf, but extra arguments are given as variable ar-
gument list arg.
(See section 3.2.18, stdarg.h)

Same as scanf/wscanf, but extra arguments are given as variable ar-
gument list arg.
(See section 3.2.18, stdarg.h)

Performs a formatted write to the given stream. Returns EOF/WEOF on
error.
(FSS implementation)

Performs a formatted write to the stream stdout. Returns EOF/WEOF
on error.
(FSS implementation)

Performs a formatted write to string s. Returns EOF/WEOF on error.

Same as sprintf£, but n specifies the maximum number of characters
(including the terminating null character) to be written.

Same as fprintf/fwprintf, but extra arguments are given as variable
argument list arg. (See section 3.2.18, stdarg.h)
(FSS implementation)

Same as printf/wprintf, but extra arguments are given as variable
argument list arg. (See section 3.2.18, stdarg.h)
(FSS implementation)

Same as sprintf/swprintf, but extra arguments are given as variable
argument list arg. (See section 3.2.18, stdarg.h)
(FSS implementation)
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Character input/output

stdio.h

wchar.h

Description

fgetc(stream)

getc(stream)

getchar(stdin)

fgets(*s,n,

stream)

gets(*s,n,stdin)

ungetc(c,stream)

fputc(c,stream)

putc(c,stream)

putchar(c,stdout)

fputs(*s,stream)

puts(*s)

Direct input/output

stdio.h

fgetwc (stream)

getwc (stream)

getwchar (stdin)

fgetws(*s,n,

stream)

ungetwc (c,stream)

fputwc(c,stream)

putwc(c,stream)

putwchar (c,stdout)

fputws (*s,stream)

Description

Reads one character from stream. Returns the read character, or EOF/
WEOF on error.
(FSS implementation)

Same as fgetc/fgetwc except that is implemented as a macro. (FSS
implementation)

NOTE: Currently #defined as getchar ()/getwchar () because FILE
I/0 is not supported. Returns the read character, or EOF/WEQF on error.

Reads one character from the stdin stream. Returns the character read
or EOF/WEOQF on error. Implemented as macro.
(FSS implementation)

Reads at most the next n-1 characters from the stream into array s until
a newline is found. Returns s or NULL or EOF/WEOF on error.
(FSS implementation)

Reads at most the next n-1 characters from the stdin stream into array
s. A newline is ignored. Returns s or NULL or EOF/WEOF on error.
(FSS implementation)

Pushes character ¢ back onto the input stream. Returns EOF/WEOQOF on
error.

Put character ¢ onto the given stream.
Returns EOF/WEQF on error.
(FSS implementation)

Same as fpuc/fputwc except that is implemented as a macro. (FSS
implementation)

Put character ¢ onto the stdout stream.
Returns EOF/WEQOF on error.
Implemented as macro. (FSS implementation)

Writes string s to the given stream.
Returns EOF/WEOF on error.

Writes string s to the stdout stream.
Returns EOF/WEOF on error.
(FSS implementation)

fread(ptr,size,nobj,stream)

fwrite((ptr,size,nobj,stream)

Random access

stdio.h

Reads nobj members of size bytes from the given stream into the array pointed to by

ptr. Returns the number of elements succesfully read.
(FSS implementation)

Writes nobj members of size bytes from to the array pointed to by pir to the given

stream. Returns the number of elements succesfully written.
(FSS implementation)

Description

fseek(stream,offset,

origin)

Sets the position indicator for stream. (FSS implementation)

When repositioning a binary file, the new position origin is given by the following macros:

SEEK_SET 0
SEEK_CUR 1
SEEK_END 2

offset characters from the beginning of the file
offset characters from the current position in the file
offset characters from the end of the file
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ftell(stream)

rewind (stream)

fgetpos (stream,pos)

fsetpos(stream,pos)

Operations on files

stdio.h

Returns the current file position for stream, or -1L on error.
(FSS implementation)

Sets the file position indicator for the stream to the beginning of the file. This function is
equivalent to:

(void) fseek( stream, OL, SEEK SET );

clearerr( stream );

(FSS implementation)

Stores the current value of the file position indicator for stream in the object pointed to by
pos.
(FSS implementation)

Positions stream at the position recorded by fgetpos in *pos.
(FSS implementation)

Description

remove(file)
rename (old,new)
tmpfile()

tmpnam(buffer)

Error handling

stdio.h

Removes the named file, so that a subsequent attempt to open it fails. Returns a non-zero
value if not succesful.

Changes the name of the file from old name to new name. Returns a non-zero value if not
succesful.

Creates a temporary file of the mode "wb+” that will be automatically removed when
closed or when the program terminates normally. Returns a £ile pointer.

Creates new file names that do not conflict with other file names currently in use. The new
file name is stored in a buffer which must have room for L_tmpnam characters. Returns a

pointer to the temporary name. The file names are created in the current directory and all

start with "tmp”. At most TMP_MAX unique file names can be generated.

Description

clearerr (stream)
ferror(stream)
feof (stream)

perror(*s)

Clears the end of file and error indicators for stream.
Returns a non-zero value if the error indicator for stream is set.
Returns a non-zero value if the end of file indicator for stream is set.

Prints s and the error message belonging to the integer errno.
(See section 3.2.5, errno.h)

3.2.23 stdlib.h and wchar.h

The header file std1lib.h contains general utility functions which fall into the following categories (Some have parallel
wide-character, declared in wchar.h)

* Numeric conversions

e Random number generation

e Memory management

¢ Envirnoment communication

* Searching and sorting

* Integer arithmetic

* Multibyte/wide character and string conversions.

Macros

EXIT SUCCES O
EXIT FAILURE 1

RAND MAX 32767
MB_CUR MAX 1

Predefined exit codes that can be used in the exit function.

Highest number that can be returned by the rand/srand function.

Maximum number of bytes in a multibyte character for the extended character set specified by the
current locale (category LC_CTYPE, see section 3.2.13, locale.h).
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Numeric conversions

The following functions convert the intial portion of a string *s to a double, int, long int and long long int value

respectively.

double atof(*s)
int atoi(*s)
long atol(*s)

long long atoll(*s)

The following functions convert the initial portion of the string *s to a float, double and long double value respectively. *endp will
point to the first character not used by the conversion.

stdlib.h wchar.h

float strtof(*s,**endp) float wcstof (*s,**endp)
double strtod(*s,**endp) double wcstod(*s, **endp)
long double strtold(*s, **endp) long double wcstold(*s,**endp)

The following functions convert the initial portion of the string *s to a 1ong, long long, unsigned long and unsigned
long long respectively. Base specifies the radix. *endp will point to the first character not used by the conversion.

stdlib.h wchar.h

long strtol(*s,**endp,base) long wcstol (*s,**endp,base)
long long strtoll(*s,**endp,base) long long westoll(*s, **endp,base)
unsigned long strtoul(*s, **endp,base) unsigned long wcstoul(*s,**endp,base)

unsigned long long

strtoull(*s, **endp,base)

unsigned long long
wcstoull(*s, **endp,base)

Random number generation

rand

srand(seed)

Memory management

malloc(size)
calloc(nobj,size)
free(*ptr)

realloc(*ptr,size)

Returns a pseudo random integer in the range 0 to RAND_MAX.
Same as rand but uses seed for a new sequence of pseudo random numbers.

Allocates space for an object with size size. The allocated space is not initialized. Returns a
pointer to the allocated space.

Allocates space for n objects with size size. The allocated space is initialized with zeros. Returns
a pointer to the allocated space.

Deallocates the memory space pointed to by ptr which should be a pointer earlier returned by the
malloc or calloc function.

Deallocates the old object pointed to by ptr and returns a pointer to a new object with size size,
while preserving its contents. If the new size is smaller than the old size, some contents at the
end of the old region will be discarded. If the new size is larger than the old size, all of the old
contents are preserved and any bytes in the new object beyond the size of the old object will have
indeterminate values.

Environment communication

abort ()

atexit(*func)

exit(status)

_Exit(status)

Causes abnormal program termination. If the signal SIGABRTis caught, the signal handler may
take over control. (See section 3.2.17, signal.h).

Func points to a function that is called (without arguments) when the program normally
terminates.

Causes normal program termination. Acts as if main () returns with status as the return value.
Status can also be specified with the predefined macros EXIT_SUCCES or EXIT_FAILURE.

Same as exit, but no registered by the atexit function or signal handlers registerd by the
signal function are called.
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getenv(*s) Searches an environment list for a string s. Returns a pointer to the contents of s.
NOTE: this function is not implemented because there is no OS.

system(*s) Passes the string s to the environment for execution.
NOTE: this function is not implemented because there is no OS.

Searching and sorting

bsearch(*key, *base, This function searches in an array of n members, for the object pointed to by key. The initial base
n,size,*cmp) of the array is given by base. The size of each member is specified by size. The given array must
be sorted in ascending order, according to the results of the function pointed to by cmp. Returns a

pointer to the matching member in the array, or NULL when not found.

gsort(*base,n, This function sorts an array of n members using the quick sort algorithm. The initial base of the
size,*cmp) array is given by base. The size of each member is specified by size. The array is sorted in as-
cending order, according to the results of the function pointed to by cmp.

Integer arithmetic
int abs(j) Compute the absolute value of an int, long int, and long long intj resepectively.
long labs(j)
long long llabs(j)
div_t div(x,y) Compute x/y and x%y in a single operation. X and y have respectively type int, long int and
ldiv_t ldiv(x,y) long long int. The result is stored in the members quot and rem of struct div_t,

1lldiv_t  1ldiv(x,y) 1div_t and 11div_t which have the same types.
Multibyte/wide character and string conversions

mblen(*s,n) Determines the number of bytes in the multi-byte character pointed to by s. At most n characters
will be examined. (See also mbrlen in section 3.2.27, wchar.h)

mbtowc (*pwc, *s,n) Converts the multi-byte character in s to a wide-character code and stores it in pwc. At most n
characters will be examined.

wctomb (*s,wc) Converts the wide-character wc into a multi-byte representation and stores it in the string pointed
to by s. At most MB_CUR_MAX characters are stored.

mbstowcs (*pwcs, *s,n)  Converts a sequence of multi-byte characters in the string pointed to by s into a sequence of
wide characters and stores at most n wide characters into the array pointed to by pwces. (See also
mbsrtowcs in section 3.2.27, wchar.h)

wcstombs (*s, *pwes,n)  Converts a sequence of wide characters in the array pointed to by pwcs into multi-byte charac-
ters and stores at most n multi-byte characters into the string pointed to by s. (See also
wcsrtowmb in section 3.2.27, wchar.h)

3.2.24 string.h and wchar.h

This header file provides numerous functions for manipulating strings. By convention, strings in C are arrays of characters with a
terminating null character. Most functions therefore take arguments of type *char. However, many functions have also parallel
wide-character functions which take arguments of type *wchar_ t. These functions are declared in wchar.h.

Copying and concatenation functions

stdio.h wchar.h Description

memcpy (*sl,*s2,n) wmemcpy (*sl1,*s2,n) Copies n characters from *s2 into *s71 and returns *s1. If *s1 and *s2
overlap the result is undefined.

memmove (*sl,*s2,n) wmemmove(*sl,*s2,n) Same as memcpy, but overlapping strings are handled correctly. Returns
*s7.

strcpy(*sl,*s2) wescpy(*sl,*s2) Copies *s2 into *s1 and returns *s7. If *s1 and *s2 overlap the result is
undefined.

strncpy(*sl,*s2,n) wcsncpy(*sl,*s2,n) Copies not more than n characters from *s2 into *s1 and returns *s7. If
*s1 and *s2 overlap the result is undefined.
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stdio.h

wchar.h

Description

strcat(*sl,*s2)

strncat(*sl,*s2,n)

Comparison functions

stdio.h

wcscat(*sl,*s2)

wcsncat(*sl,*s2,n)

wchar.h

Appends a copy of *s2 to *s1 and returns *s71. If *s1 and *s2 overlap the
result is undefined.

Appends not more than n characters from *s2 to *s71 and returns *s7. If
*s1 and *s2 overlap the result is undefined.

Description

memcmp (*s1,*s2,n)

strcmp(*sl,*s2)

strncmp(*sl,*s2,n)

strcoll(*sl,*s2)

strxfrm(*sl,*s2,n)

Search functions

stdio.h

wmemcmp (*s1,*s2,n)

wcscmp(*sl,*s2)

wcsnemp (*s1,*s2,n)

wcscoll(*s1,*s2)

wesxfrm(*sl,*s2,n)

wchar.h

Compares the first n characters of *s7 to the first n characters of *s2.
Returns < 0 if *s7 < *s2, 0 if *s1 = =*s2, or > 0 if *s1 > *s2.

Compares string *s1 to string *s2. Returns < 0 if *s71 < *s2, 0 if *s1 = =
*s2,or > 0if *s1 > *s2.

Compares the first n characters of *s7 to the first n characters of *s2.
Returns < 0 if *s7 < *s2, 0 if *s1 = = *s2, or > 0 if *s1 > *s2.

Performs a local-specific comparison between string *s7 and string *s2
according to the LC_COLLATE category of the current locale. Returns <
0if*s1 <*s2,0if *s1 = =*s2, or > 0 if *s1 > *s2. (See section 3.2.13,
locale.h)

Transforms (a local) string *s2 so that a comparison between
transformed strings with strcmp gives the same result as a comparison
between non-transformed strings with strcoll. Returns the
transformed string *s7.

Description

memchr (*s,c,n)

strchr(*s,c)

strrchr(*s,c)

strspn(*s, *set)

strcspn(*s,*set)

strpbrk(*s, *set)

strstr(*s, *sub)

strtok(*s,*delim)

wmemchr (*s,c,n)

wcschr(*s,c)

wcsrchr(*s,c)

wcsspn(*s, *set)

wcscspn(*s, *set)

wcspbrk(*s, *set)

wcsstr(*s,*sub)

wcstok(*s,*delim)

Miscellaneous functions

stdio.h

wchar.h

Checks the first n characters of *s on the occurence of character c.
Returns a pointer to the found character.

Returns a pointer to the first occurence of character c in string *s or the
null pointer if not found.

Returns a pointer to the last occurence of character c in string *s or the
null pointer if not found.

Searches *s for a sequence of characters specified in *set. Returns the
length of the first sequence found.

Searches *s for a sequence of characters not specified in *set. Returns
the length of the first sequence found.

Same as strspn/wecsspn but returns a pointer to the first character in *s
that also is specified in *set.

Searches for a substring *sub in *s. Returns a pointer to the first
occurence of *sub in *s.

A sequence of calls to this function breaks the string *s into a sequence
of tokens delimited by a character specified in *delim. The token found in
*s is terminated with a null character. The function returns a pointer to the
first position in *s of the token.

Description

memset (*s,c,n)

strerror(errno)

strlen(*s)

wmemset (*s,c,n)

wcslen(*s)

Fills the first n bytes of *s with character ¢ and returns *s.

Typically, the values for errno come from int errno. This function re-
turns a pointer to the associated error message. (See also section 3.2.5,
errno.h)

Returns the length of string *s.
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3.2.25 time.h and wchar.h

The header file time.h provides facilities to retrieve and use the (calendar) date and time, and the process time. Time can be
represented as an integer value, or can be broken-down in components. Two arithmetic data types are defined which are
capable of holding the integer representation of times:

clock_t unsigned long long
time t unsigned long

The type struct tm below is defined according to ISO/IEC9899 with one exception: this implementation does not support leap
seconds. The struct tmtype is defines as follows:

struct tm

{
int tm _sec; /* seconds after the minute - [0, 59] */
int tm min; /* minutes after the hour - [0, 59] */
int tm_hour; /* hours since midnight - [0, 23] */
int tm_mday; /* day of the month - [1, 31] */
int tm_mon; /* months since January - [0, 11] */
int  tm_year; /* year since 1900 */
int  tm_wday; /* days since Sunday - [0, 6] */
int tm_yday; /* days since January 1 - [0, 365] */
int tm_isdst; /* Daylight Saving Time flag */

}i

Time manipulation

clock Returns the application’s best approximation to the processor time used by the program since it was
started. This low-level routine is not implemented because it strongly depends on the hardware. To
determine the time in seconds, the result of clock should be divided by the value defined as

CLOCKS_PER_SEC 12000000
difftime(tl,t0) Returns the difference t71-t0 in seconds.

mktime(tm *tp) Converts the broken-down time in the structure pointed to by fp, to a value of type time t. The
return value has the same encoding as the return value of the time function.

time (*timer) Returns the current calendar time. This value is also assigned to *timer.

Time conversion

asctime(tm *tp) Converts the broken-down time in the structure pointed to by tp into a string in the form Mon Jan
21 16:15:14 2004\n\0. Returns a pointer to this string.
ctime(*timer) Converts the calender time pointed to by timer to local time in the form of a string. This is equivalent

to: asctime(localtime(timer))

gmtime (*timer) Converts the calender time pointed to by timer to the broken-down time, expressed as UTC.
Returns a pointer to the broken-down time.

localtime(*timer) Converts the calendar time pointed to by timer to the broken-down time, expressed as local time.
Returns a pointer to the broken-down time.

Formatted time

The next function has a parallel function defined in wchar . h:

stdio.h wchar.h

strftime(*s,smax,*fmt,tm *tp) wstrftime(*s,smax,*fmt,tm *tp)

Formats date and time information from struct tm *ip into *s according to the specified format *fmt. No more than smax
characters are placed into *s. The formatting of strftime is locale-specific using the LC_TIME category (see section 3.2.13,
locale.h). You can use the next conversion specifiers:
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%a  abbreviated weekday name
%A  full weekday name
%b  abbreviated month name

%B  full month name

%c  local date and time representation (same as %a %b %e %T %Y)
%C last two of the year

%d  day of the month (01-31)

%D  same as %M/%d/%y

%e  day of the month (1-31), with single digits preceded by a space
%F  1SO 8601 date format: %Y-%m-%d

%g last two digits of the week based year (00-99)

%G  week based year (0000¢J9999)

%h same as %b

%H  hour, 24-hour clock (00-23)
%l hour, 12-hour clock (01-12)
%j day of the year (001-366)

%m  month (01-12)
%M  minute (00-59)

%n  replaced by the newline character
%p  local equivalent of AM or PM
%r locale’s 12-hour clock time; same as %1:%M:%S %p

%R same as %H:%M
%S  second (00-59)

%t replaced by horizontal tab character

%T  ISO 8601 time format: %H:%M:%S

%u  I1SO 8601 weekday number (1-7), Monday as first day of the week
%U  week number of the year, Sunday as first day of the week (00-53)
%V  1SO 8601 week number (01-53) in the week-based year

%w  weekday (0-6, Sunday is 0)

%W  week number of the year (00-53), week 1 has the first Monday
%x local date representation

%X local time representation

%y  year without century (00-99)

%Y  year with century

%z ISO 8601 offset of time zone from UTC, or nothing
%Z  time zone name, if any

%% %

3.2.26 unistd.h

The file unistd.h contains standard UNIX I/O functions. These functions are all implemented using the debugger’s file system
simulation. Except for 1stat and £stat which are not implemented. This header file is not defined in ISO C99.

access (*name ,mode)

chdir (*path)

close(fd)

getcwd(*buf,size)

Use the file system simulation of the debugger to check the permissions of a file on the host. mode
specifies the type of access and is a bit pattern constructed by a logical OR of the following values:

R_OK Checks read permission.

W_OK Checks write permission.

X_OK Checks execute (search) permission.
F_OK Checks to see if the file exists.

(FSS implementation)

Use the file system simulation feature of the debugger to change the current directory on the host
to the directory indicated by path.
(FSS implementation)

File close function. The given file descriptor should be properly closed. This function calls
_close().
(FSS implementation)

Use the file system simulation feature of the debugger to retrieve the current directory on the host.
Returns the directory name.
(FSS implementation)
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lseek(fd,offset,
whence)

read(fd,*buff,cnt)

stat (*name, *buff)

lstat(*name, *buff)

fstat (fd, *buff)

unlink (*name)

write(fd,*buff,cnt)

3.2.27 wchar.h

Moves read-write file offset. Calls _1seek().
(FSS implementation)

Reads a sequence of characters from a file. This function calls _read (). (FSS implementation)

Use the file system simulation feature of the debugger to stat() a file on the host platform.
(FSS implementation)

This function is identical to stat (), except in the case of a symbolic link, where the link itself is
‘stat’-ed, not the file that it refers to.
(Not implemented)

This function is identical to stat (), except that it uses a file descriptor instead of a name. (Not
implemented)

Removes the named file, so that a subsequent attempt to open it fails. Calls _unlink().
(FSS implementation)

Write a sequence of characters to a file. Calls _write().
(FSS implementation)

Many in wchar . h represent the wide-character variant of other so these are discussed together. (See sections 3.2.22, stdio.h
and wchar.h, 3.2.23, stdlib.h and wchar.h, 3.2.24, string.h and wchar.h and 3.2.25, time.h and wchar.h).

The remaining are described below. They perform conversions between multi-byte characters and wide characters. In these, ps
points to struct mbstate_t which holds the conversion state information necessary to convert between sequences of multibyte
characters and wide characters:

typedef struct
{

wchar_t

wc_value; /* wide character value solved so far */

unsigned short n_ bytes; /* number of bytes of solved multibyte */
unsigned short encoding; /* encoding rule for wide character <=>

} mbstate_t;

multibyte conversion */

When multibyte characters larger than 1 byte are used, this struct will be used to store the conversion information when not all
the bytes of a particular multibyte character have been read from the source. In this implementation, multi-byte characters are 1
byte long (MB_CUR_MAX and MB_LEN_MAX are defined as 1) and this will never occur.

mbsinit(*ps)

Determines whether the object pointed to by ps, is an initial conversion state. Returns
a non-zero value if so.

mbsrtowcs (*pwes, **src,n,*ps)  Restartable version of mbstowcs. See section 3.2.23, stdlib.h and wchar.h. The initial

conversion state is specified by ps. The input sequence of multibyte charactersis
specified indirectly by src.

wcsrtombs (*s, **src,n, *ps) Restartable version of westombs. See section 3.2.23, stdlib.h and wchar.h. The initial

conversion state is specified by ps. The input wide string is specified indirectly by src.

mbrtowc (*pwc, *s,n, *ps) Converts a multibyte character *s to a wide character *pwc according to conversion state

wcrtomb (*s,wc, *ps)

btowc (c)

wctob(c)

mbrlen(*s,n,*ps)
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ps. See also mbtowc in section 3.2.23, stdlib.h and wchar.h.

Converts a wide character wc to a multi-byte character according to conversion state
ps and stores the multi-byte character in *s.

Returns the wide character corresponding to character c. Returns WEOF on error.

Returns the multi-byte character corresponding to the wide character c. The returned
multi-byte character is represented as one byte. Returns EOF on error.

Inspects up to n bytes from the string *s to see if those characters represent valid
multibyte characters, relative to the conversion state held in *ps.
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3.2.28 wctype.h

Most in wetype . h represent the wide-character variant of declared in ctype.h and are discussed in section 3.2.3, ctype.h and
wctype.h. In addition, this header file provides extensible, locale specific, wide character classification.

wctype (*property)

iswctype (wc,desc)

Constructs a value of type wctype t that describes a class of wide characters identified by the
string *property. If property identifies a valid class of wide characters according to the LC_TYPE
category (see section 3.2.13, locale.h) of the current locale, a non-zero value is returned that can
be used as an argument in the iswctype function.

Tests whether the wide character we is a member of the class represented by wetype t desc.
Returns a non-zero value if tested true.

Function Equivalent to locale specific test
iswalnum(wc) iswctype(wc,wctype(”alnum”))
iswalpha (wc) iswctype(wc,wctype(”alpha”))
iswecntrl (we) iswctype(wc,wctype(”cntrl”))
iswdigit (wc) iswctype(wc,wctype(”digit”))
iswgraph (wc) iswctype(wc,wctype(”graph”))
iswlower (wc) iswctype(wc,wctype(”lower”))
iswprint (wc) iswctype(wc,wctype(”print”))
iswpunct (wc) iswctype(wc,wctype(”punct”))
iswspace(wc) iswctype(wc,wctype(”space”))
iswupper (wc) iswctype(wc,wctype (”upper”))

iswxditig(wc) iswctype(wc,wctype (”xdigit”))

wctrans (*property)

towctrans (wc,desc)

Constructs a value of type wctype_t that describes a mapping between wide characters identi-
fied by the string *property. If property identifies a valid mapping of wide characters according to
the LC_TYPE category (see section 3.2.13, locale.h) of the current locale, a non-zero value is
returned that can be used as an argument in the towctrans function.

Transforms wide character wc into another wide-character, described by desc.

Function Equivalent to locale specific transformation
towlower (wc) towctrans (wc,wctrans(”tolower”)
towupper (wc) towctrans (wc,wctrans (”toupper”)
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Altlum 4 Assembly Language

Summ ary This chapter describes the most important aspects of the TASKING assembly

language and contains a detailed description of all built-in assembly functions and
assembler directives. For a complete overview of the architecture you are using and
a description of the assembly instruction set, refer to the target’'s Core Reference
Manual.

4.1 Assembly Syntax

An assembly program consists of zero or more statements. A statement may optionally be followed by a comment. Any source
statement can be extended to more lines by including the line continuation character (\) as the last character on the line. The
length of a source statement (first line and continuation lines) is only limited by the amount of available memory.

Mnemonics and directives are case insensitive. Labels, symbols, directive arguments, and literal strings are case sensitive.

The syntax of an assembly statement is:

[labell:]] [instruction | directive | macro_call] [;comment]

label

instruction

directive

macro_call

A label is a special symbol which is assigned the value and type of the current program location counter. A label
can consist of letters, digits and underscore characters (_). The first character cannot be a digit. The label can
also be a number. A label which is prefixed by whitespace (spaces or tabs) has to be followed by a colon (:). The
size of an identifier is only limited by the amount of available memory.

number is a number ranging from 1 to 255. This type of label is called a numeric label or local label. To refer to a
numeric label, you must put an n (next) or p (previous) immediately after the label. This is required because the
same label number may be used repeatedly.

Examples:

LABl: ; This label is followed by a colon and
; can be prefixed by whitespace
LAB1 ; This label has to start at the beginning
; of a line

l1: b 1p ; This is an endless loop
; using numeric labels

An instruction consists of a mnemonic and zero, one or more operands. It must not start in the first column.

All instructions of the ARM Unified Assembler Language (UAL) are supported. With assembler option
--old-syntax you can specify to use the pre-UAL syntax. VFP instructions are only supported in the UAL
syntax.

Operands are described in section 4.3, Operands of an Assembly Instruction. The instructions are described in
the target’s Core Reference Manual.

The instruction can also be a so-called ‘generic instruction’. Generic instructions are pseudo instructions (no
instructions from the instruction set). Depending on the situation in which a generic instruction is used, the
assembler replaces the generic instruction with appropriate real assembly instruction(s). For a complete list, see
section 4.10, Generic Instructions.

With directives you can control the assembler from within the assembly source. Except for preprocessing
directives, these must not start in the first column. Directives are described in section 4.8, Assembler Directives.

A call to a previously defined macro. It must not start in the first column. See section 4.9 Macro Operations.
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comment Comment, preceded by a ; (semicolon).

You can use empty lines or lines with only comments.

4.2 Assembler Significant Characters

You can use all ASCII characters in the assembly source both in strings and in comments. Also the extended characters from
the ISO 8859-1 (Latin-1) set are allowed.

Some characters have a special meaning to the assembler. Special characters associated with expression evaluation are
described in section 4.6.3, Expression Operators. Other special assembler characters are:

Character Description
; Start of a comment
\ Line continuation character or

Macro operator: argument concatenation

? Macro operator: return decimal value of a symbol
% Macro operator: return hex value of a symbol
» Macro operator: override local label

" Macro string delimiter or
Quoted string .DEFINE expansion character

' String constants delimiter
e Start of a built-in assembly function
$ Location counter substitution

Note that macro operators have a higher precedence than expression operators.

4.3 Operands of an Assembly Instruction

In an instruction, the mnemonic is followed by zero, one or more operands. An operand has one of the following types:

Operand Description

symbol A symbolic name as described in section 4.4, Symbol Names. Symbols can also occur in expressions.
register Any valid register as listed in section 4.5, Registers.

expression Any valid expression as described in section 4.6, Assembly Expressions.

address A combination of expression, register and symbol.

4.4 Symbol Names

User-defined symbols

A user-defined symbol can consist of letters, digits and underscore characters (). The first character cannot be a digit. The size
of an identifier is only limited by the amount of available memory. The case of these characters is significant. You can define a
symbol by means of a label declaration or an equate or set directive.

Predefined preprocessor symbols

These symbols start and end with two underscore characters, __symbol__, and you can use them in your assembly source to
create conditional assembly. See section 4.4.1, Predefined Preprocessor Symbols.

Labels
Symbols used for memory locations are referred to as labels.

It is allowed to use reserved symbols as labels as long as the label is followed by a colon or starts at the first column
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Reserved symbols

Symbol names and other identifiers beginning with a period (.) are reserved for the system (for example for directives or section
names). Instructions are also reserved. The case of these built-in symbols is insignificant.

Examples
Valid symbol names:

loop 1
ENTRY
aBc
_aBC

Invalid symbol names:
1 _loop (starts with a number)

.DEFINE (reserved directive name)

441 Predefined Preprocessor Symbols

The TASKING assembler knows the predefined symbols as defined in the table below. The symbols are useful to create
conditional assembly.

Macro Description
__ASARM Expands to 1 for the ARM toolset, otherwise unrecognized as macro.
__BUILD _ Identifies the build number of the assembler, composed of decimal digits for the build number,

three digits for the major branch number and three digits for the minor branch number. For
example, if you use build 1.22.1 of the compiler, _ BUILD__ expands to 1022001. If there is no
branch number, the branch digits expand to zero. For example, build 127 results in 127000000.

_ REVISION_ Identifies the revision number of the assembler. For example, if you use version 1.0r2 of the
compiler, __REVISION__ expands to 2.

__ TASKING__ Identifies the assembler as a TASKING assembler. Expands to 1 if a TASKING compiler is used.

__ VERSION__ Identifies the version number of the assembler. For example, if you use version 1.0r2 of the

assembler,  VERSION__ expands to 1000 (dot and revision number are omitted, minor version
number in 3 digits).

Table 4-1: Assembler predefined preprocessor symbols

4.5 Registers

The following register names, either upper or lower case, should not be used for user-defined symbol names in an assembly
language source file:

ARM registers

RO .. R15
IP (alias for R12) SP (alias for R13)
LR (alias for R14) PC (alias for R15)

4.6 Assembly Expressions

An expression is a combination of symbols, constants, operators, and parentheses which represent a value that is used as an
operand of an assembler instruction (or directive).

Expressions may contain user-defined labels (and their associated integer values), and any combination of integers or ASCI|I
literal strings.

Expressions follow the conventional rules of algebra and boolean arithmetic.
Expressions that can be evaluated at assembly time are called absolute expressions. Expressions where the result is unknown

until all sections have been combined and located, are called relocatable or relative expressions.
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When any operand of an expression is relocatable, the entire expression is relocatable. Relocatable expressions are emitted in
the object file and evaluated by the linker.

The assembler evaluates expressions with 64-bit precision in two’s complement.

The syntax of an expression can be any of the following:

- numeric contant

- string

- symbol

- expression binary_operator expression
- unary_operator expression

- (expression)

- function call

All types of expressions are explained in separate sections.

4.6.1 Numeric Constants

Numeric constants can be used in expressions. If there is no prefix, by default the assembler assumes the number is a decimal
number.

Base Description Example

Binary A 0b prefix followed by binary digits (0,1). Or use a b suffix o b
0x12FF

Hexadecimal A 0x prefix followed by a hexadecimal digits (0-9, A-F, a-f). Or use a h suffix 0x45
0falOh

Decimal, . - 12

integer Decimal digits (0-9). 1245

Table 4-2: Numeric constants

4.6.2 Strings

ASCII characters, enclosed in single (*) or double (") quotes constitue an ASCII string. Strings between double quotes allow
symbol substitution by a . DEFINE directive, whereas strings between single quotes are always literal strings. Both types of
strings can contain escape characters.

Strings constants in expressions are evaluated to a number (each character is replaced by its ASCII value). Strings in
expressions can have a size of up to 8 characters or less depending on the operand of an instruction or directive; any
subsequent characters in the string are ignored. In this case the assembler issues a warning. An exception to this rule is when a
string is used in a . DB assembler directive; in that case all characters result in a constant value of the specified size. Null strings
have a value of 0.

Examples
'ABCD’ ; (0x41424344)
rrrq9f ; to enclose a quote double it
"A\"BC" ; or to enclose a quote escape it
'AB’'+1 ; (0x4143) string used in expression
r ; null string

4.6.3 Expression Operators

The next table shows the assembler operators. They are ordered according to their precedence. Operators of the same
precedence are evaluated left to right. Parenthetical expressions have the highest priority (innermost first).

Valid operands include numeric constants, literal ASCII strings and symbols.
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Type Oper | Name Description
ator
() parenthesis Expressions enclosed by parenthesis are evaluated first.
Unary + plus Returns the value of its operand.
- minus Returns the negative of its operand.
~ complement Returns complement, integer only
! logical negate Returns 1 if the operands’ value is 0; otherwise 0. For example, if buf is 0 then
tbuf is 1.
Arithmetic * multiplication Yields the product of two operands.
/ division Yields the quotient of the division of the first operand by the second.
With integers, the divide operation produces a truncated integer.
% modulo Integer only: yields the remainder from a division of the first operand by the
second.
+ addition Yields the sum of its operands.
- subtraction Yields the difference of its operands.
Shift << shift left Integer only: shifts the left operand to the left (zero-filled) by the number of bits
specified by the right operand.
>> shift right Integer only: shifts the left operand to the right (sign bit extended) by the number
of bits specified by the right operand.
Relational < less than
<= less or equal Returns:
> greater than an integer 1 if the indicated condition is TRUE.
>= greater or equal an integer 0 if the indicated condition is FALSE.
== equal
I= not equal
Bitwise & AND Integer only: yields bitwise AND
| OR Integer only: yields bitwise OR
" exclusive OR Integer only: yields bitwise exlusive OR
Logical && logical AND Returns an integer 1 if both operands are non-zero; otherwise, it returns an
integer 0.
I logical OR Bfturns1an integer 1 if either of the operands is non-zero; otherwise, it returns an
integer

Table 4-3: Assembly expression operators

4.7 Built-in Assembly Functions

The TASKING assemblers have several built-in functions to support data conversion, string comparison, and math
computations. You can use functions as terms in any expression.

Syntax of an assembly function

@function_name([argument[,argument]...])
Functions start with '@’ character and have zero or more arguments, and are always followed by opening and closing
parentheses. White space (a blank or tab) is not allowed between the function name and the opening parenthesis and between
the (comma-separated) arguments.

4.7.1 Overview of Built-in Assembly Functions

The following table provides an overview of all built-in assembly functions. Next all functions are described into more detail. expr
can be any assembly expression resulting in an integer value. Expressions are explained in section 4.6, Assembly Expressions.

4-5



ARM Embedded Tools Reference

Overview of assembly functions

Function

Description

@ALUPCREL (expr,group|[ ,check])
@ARG('symbol’ |expr)
@BIGENDIAN( )

@CNT( )

@CPU(String)

@DEFINED('symbol’ | symbol)

PC-relative ADD/SUB with operand split

Test whether macro argument is present

Test if assembler generates code for big-endian mode
Return number of macro arguments

Test if current CPU matches string

Test whether symbol exists

@LSB(expr) Least significant byte of the expression

@LSH(expr) Least significant half word of the absolute expression

@LSW(expr) Least significant word of the expression

@MSB(expr) Most significant byte of the expression

@MSH(expr) Most significant half word of the absolute expression

@MSW(expr) Most significant word of the expression

@PRE_UAL( ) Test if the assembler runs in pre-UAL syntax mode or in UAL syntax mode by

default (option --old-syntax)
@STRCAT(Strl,str2) Concatenate str1 and str2
@STRCMP (Strl,str2) Compare str1 with str2
@STRLEN(Str) Return length of string

@STRPOS(strl,str2[,start]) Return position of str1 in str2

@THUMB () Test if the assembler runs in Thumb mode or in ARM mode by default (option
--thumb)
4.7.2 Detailed Description of Built-in Assembly Functions

@ALUPCREL (expression,group[,check])

This function is used internally by the assembler with the generic instructions ADR, ADRL and ADRLL. This function returns the
PC-relative address of the expression for use in these generic instructions. group is 0 for ADR,1 for ADRL or 2 for ADRLL.

With check you can specify to check for overflow (1 means true, 0 means false). If check is omitted, the default is 1.
Example:

; The instruction ”ADRAL R1l,label” expands to
ADRAL R1,PC,Q@ALUPCREL(label,0,1)

@ARG(’'symbol’ | expression)
Returns integer 1 if the macro argument represented by symbol or expression is present, 0 otherwise.

You can specify the argument with a symbol name (the name of a macro argument enclosed in single quotes) or with expression
(the ordinal number of the argument in the macro formal argument list).

If you use this function when macro expansion is not active, the assembler issues a warning.
Example:

.IF @ARG('TWIDDLE’) ;is argument twiddle present?
.IF QARG(1) ;is first argument present?

@BIGENDIAN()

Returns 1 if the assembler generates code for big-endian mode, returns 0 if the assembler generates code for little-endian
mode (this is the default).
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@CNT()

Returns the number of macro arguments of the current macro expansion as an integer.

If you use this function when macro expansion is not active, the assembler issues a warning.
Example:

ARGCOUNT .SET @CNT() ; reserve argument count

@CPU(’processor_type’)

With the @cPU function you can check whether the source code is being assembled for a certain processor type. The function
evaluates to TRUE when the specified processor_type matches the processor type that was specified with the option
—--cpu=cpu.

This function is useful to create conditional code for several targets as shown in the example.
Example:

.IF @CPU('ARMvV4') ; true if you specified option --cpu=ARMv4
; code for the ARMv4

.ELIF @CPU('ARMV6M’) ; true if you specified option --cpu=ARMv6M
; code for the ARMv6-M

.ELSE
; code for other architectures

.ENDIF

% C compiler option —-cpu (Select architecture) in section 6.1, C Compiler Options, of Chapter Tool Options.

@DEFINED(symbol’ | symbol)

Returns 1 if symbol has been defined, 0 otherwise. If symbol is quoted, it is looked up as a . DEFINE symbol; if it is not quoted, it
is looked up as an ordinary symbol, macro or label.

Example:
.IF @DEFINED('ANGLE’) ;is symbol ANGLE defined?
.IF @DEFINED (ANGLE) ;does label ANGLE exist?
@LSB(expression)

Returns the least significant byte of the result of the expression.
The result of the expression is calculated as 16 bits.

@LSH(expression)

Returns the least significant half word (bits 0..15) of the result of the absolute expression.
The result of the expression is calculated as a word (32 bits).

@LSW(expression)

Returns the least significant word (bits 0..31) of the result of the expression.
The result of the expression is calculated as a double-word (64 bits).

@MSB(expression)

Returns the most significant byte of the result of the expression.
The result of the expression is calculated as16 bits.

@MSH (expression)

Returns the most significant half word (bits 16..31) of the result of the absolute expression.
The result of the expression is calculated as a word (32 bits). @MSH(expression) is equivalentto ( (expression>>16) &
OXEfff).
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@MSW(expression)

Returns the most significant word (bits 32..63) of the result of the expression.
The result of the expression is calculated as a double-word (64 bits).

@PRE_UAL()

Returns1 if the assembler runs in pre-UAL syntax mode by default or 0 if the assembler runs in UAL syntax mode (default). This
function reflects the setting of the option --old-syntax.

Example:
.IF @PRE_UAL() ; true if you specified option --old-syntax
; old code
.ELSE
; new code, UAL syntax
.ENDIF

@STRCAT (string1,string2)

Concatenates string1 and string2 and returns them as a single string.
You must enclose string1 and string2 either with single quotes or with double quotes.

Example:

.DEFINE ID ”"@STRCAT('TAS’,'KING’')” ; ID = 'TASKING’

@STRCMP(string1,string2)

Compares string1 with string2 by comparing the characters in the string. The function returns the difference between the
characters at the first position where they disagree, or zero when the strings are equal:

<0 if string1 < string2

0 if string1 == string2

>0 if string1 > string2
Example:

.IF (@STRCMP(STR,'MAIN’))==0 ; does STR equal ’'MAIN’?

@STRLEN(string)
Returns the length of string as an integer.
Example:

SLEN SET @STRLEN('string’) ; SLEN = 6

@STRPOS(string1,string2[,start])
Returns the position of string2 in string1 as an integer. If string2 does not occur in string1, the last string postition + 1 is returned.

With start you can specify the starting position of the search. If you do not specify start, the search is started from the beginning
of string7.

Example:

ID .set @STRPOS('TASKING’,’'ASK’) ; ID
ID .set @STRPOS('TASKING'’,’'BUG’) ; ID =7

@THUMBY()

Returns1 if the assembler runs in Thumb mode by default or 0 if the assembler runs in ARM mode (default). This function
reflects the setting of the option —-thumb (-T). So, it does not depend on the .CODE16, .CODE32, .ARM or . THUMB directive.

If you are in a . CODE32 part and you specified =T, @ THUMB ( ) still returns 1.
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4.8 Assembler Directives

An assembler directive is simply a message to the assembler. Assembler directives are not translated into machine instructions,
but can produce data. There are three types of assembler directives.

Assembler directives that tell the assembler how to go about translating instructions into machine code. This is the most
typical form of assembly directives. Typically they tell the assembler where to put a program in memory, what space to
allocate for variables, and allow you to initialize memory with data. When the assembly source is assembled, a location
counter in the assembler keeps track of where the code and data is to go in memory.

The following directives fall under this group:

Assembly control directives

Symbol definition directives

Data definition / Storage allocation directives
- HLL directives

Directives that are interpreted by the macro preprocessor. These directives tell the macro preprocessor how to manipulate
your assembly code before it is actually being assembled. You can use these directives to write macros and to write
conditional source code. Parts of the code that do not match the condition, will not be assembled at all. Unlike other
directives, preprocesssor directives can start in the first column.

Some directives act as assembler options and most of them indeed do have an equivalent assembler (command line) option.
The advantage of using a directive is that with such a directive you can overrule the assembler option for a particular part of
the code. A typical example is to tell the assembler with an option to generate a list file while with the directives .NOLIST
and .LIST you overrule this option for a part of the code that you do not want to appear in the list file. Directives of this kind
sometimes are called controls.

Each assembler directive has its own syntax. Some assembler directives can be preceded with a label. If you do not precede an
assembler directive with a label, you must use white space instead (spaces or tabs). You can use assembler directives in the
assembly code as pseudo instructions.

4.8.1 Overview of Assembler Directives

The following tables provide an overview of all assembler directives. For a detailed description of these directives, refer to
section 4.8.2, Detailed Description of Assembler Directives.

Overview of assembly control directives

Directive Description

.END Indicates the end of an assembly module
. INCLUDE Include file

.MESSAGE Programmer generated message

Overview of symbol definition directives

Directive Description

-EQU Set permanent value to a symbol

.EXTERN Import global section symbol

.GLOBAL Declare global section symbol
.SECTION/.ENDSEC Start a new section

.SET Set temporary value to a symbol

.SIZE Set size of symbol in the ELF symbol table
. SOURCE Specify name of original C source file
.TYPE Set symbol type in the ELF symbol table
.WEAK Mark a symbol as ‘weak’
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Overview of data definition / storage allocation directives

.DS/.DSB/.DSH/
.DSW/.DSD

.FLOAT/ .DOUBLE

.OFFSET

Directive Description

.ALIGN Align location counter
.BS/.BSB/.BSH/ Define block storage (initialized)
.BSW/.BSD

.DB Define byte

.DH Define half word

.DW Define word

.DD Define double-word

Define storage

Define a 32-bit / 64-bit floating-point constant

Move location counter forwards

Overview of macro and conditional assembly directives

.REPEAT/ . ENDREP
.FOR/ .ENDFOR
.IF/.ELIF/.ELSE
.ENDIF
.MACRO/ . ENDM

.UNDEF

Directive Description
.DEFINE Define substitution string
.BREAK Break out of current macro expansion

Repeat sequence of source lines
Repeat sequence of source lines n times
Conditional assembly directive

End of conditional assembly directive
Define macro

Undefine .pEFINE symbol or macro

Overview of listing control assembly directives

Directive

Description

.LIST/.NOLIST
.PAGE

.TITLE

Print / do not print source lines to list file
Set top of page/size of page

Set program title in header of assembly list file

Overview of HLL directives

Directive

Description

.CALLS

Pass call tree information

ARM specific directives

Directive

Description

.CODE16/.CODE32
.THUMB/ .ARM

.LTORG

Treat instructions as Thumb or ARM instructions using pre-UAL syntax
Treat instructions as Thumb or ARM instructions using UAL syntax

Assemble current literal pool immediately
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4.8.2 Detailed Description of Assembler Directives

.ALIGN

Syntax
.ALIGN expression

Description
With the .ALIGN directive you tell the assembler to align the location counter.

When the assembler encounters the . ALIGN directive, it moves the location counter forwards to an address that is aligned as
specified by expression and places the next instruction or directive on that address. The alignment is in minimal addressable
units (MAUSs). The assembler fills the ‘gap’ with NOP instructions for code sections or with zeros for data sections. If the location
counter is already aligned on the specified alignment, it remains unchanged. The location of absolute sections will not be
changed.

The expression must be a power of two: 2, 4, 8, 16, ... If you specify another value, the assembler changes the alignment to the
next higher power of two and issues a warning.

Examples

.SECTION .text

.ALIGN 16 ; the assembler aligns

instruction ; this instruction at 16 MAUs and

fills the ’‘gap’ with NOP instructions.

4
.SECTION .text
.ALIGN 12 ; WRONG: not a power of two, the
instruction ; assembler aligns this instruction at
; 16 MAUs and issues a warning.

.ENDSEC
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.BREAK

Syntax
.BREAK

Description
The .BREAK directive causes immediate termination of a macro expansion, a . FOR loop exansion or a . REPEAT loop
expansion. In case of nested loops or macros, the . BREAK directive returns to the previous level of expansion.

The .BREAK directive is, for example, useful in combination with the . IF directive to terminate expansion when error conditions
are detected.

Example

.FOR MYVAR IN 10 TO 20

7
; assembly source lines
. ;
.IF MYVAR > 15
.BREAK
.ENDIF
.ENDREP
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.BS/.BSB/.BSH/.BSW/.BSD

Syntax

[label] .BS expression1|,expression2]
[labell .BSB expression1[,expression2]
[labell .BSH expressioni[,expression2]
[label] .BSW expression1[,expression2]

[label] .BSD expression1[,expression2]

Description

With the .Bs directive (Block Storage) the assembler reserves a block of memory. The reserved block of memory is initialized to
the value of expression2, or zero if omitted.

With expression1 you specify the number of minimum addressable units (MAUs) you want to reserve, and how much the
location counter will advance. The expression must be an integer greater than zero and cannot contain any forward references
to address labels (labels that have not yet been defined).

With expression2 you can specify a value to initialize the block with. Only the least significant MAU of expression2 is used. If
you omit expression2, the default is zero.

If you specify label, it gets the value of the location counter at the start of the directive processing.
@ You cannot initialize of a block of memory in sections with prefix . bss. In those sections, the assembler issues a warning
and only reserves space, just as with .DS.

The .BSB, .BSH, .BSW and .BSD directives are variants of the .BS directive:

.BSB The expression1 argument specifies the number of bytes to reserve.

.BSH The expression1 argument specifies the number of half words to reserve (one half word is16 bits).

.BSW The expression1 argument specifies the number of words to reserve (one word is 32 bits).

.BSD The expression1 argument specifies the number of double-words to reserve (one double-word is 64 bits).
Example

The .BsB directive is for example useful to define and initialize an array that is only partially filled:

.section .data
.DB 84,101,115,116 ; initialize 4 bytes
.BSB 96, 0xXFF ; reserve another 96 bytes, initialized with OxFF

.ENDSEC

Related information

% .DS (Define Storage)
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.CALLS

Syntax
.CALLS ’caller’, ’callee’
or

.CALLS ’caller’, ”,stackO_usage|,stack1_usagel]...

Description

The first syntax creates a call graph reference between caller and callee. The linker needs this information to build a call graph.
If applicable the call graph is used to create a static stack overlay. caller and callee are names of functions.

The second syntax specifies stack information. When callee is an empty name, this means we define the stack usage of the
function itself. The values specified are the stack usage in bytes at the time of the call including the return address. This
information is used by the linker to compute the used stack within the application. The information is found in the generated
linker map file within the Memory Usage.

Normally .cALLS directives are automatically generated by the compiler. Use the . CALLS directive in hand coded assembly
when the assembly code calls a C function. If you manually add .CALLS directives, make sure they connect to the compiler
generated .CALLS directives: the name of the caller must also be named as a callee in another directive.

Example
.CALLS ’'main’, 'nfunc’

Indicates that the function main calls the function nfunc
.CALLS 'main’,’’,8

The function main uses 8 bytes on the stack.
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.CODE16/.CODE32/.THUMB/.ARM

Syntax
.CODE16
.THUMB
.CODE32
.ARM

Description

With the .CODE16 directive you instruct the assembler to interpret subsequent instructions as 16-bit Thumb instructions using
the pre-UAL syntax until it encounters another mode directive or till it reaches the end of the active section. This directive
causes an implicit alignment of two bytes. The assembler issues an error message if . CODE16 is used in combination with
option —--cpu=ARMv4.

The .THUMB directive is the same as the .CODE16 directive except that the UAL syntax is expected.

With the .CODE32 directive you instruct the assembler to interpret subsequent instructions as 32-bit ARM instructions using the
pre-UAL syntax until it encounters another mode directive or till it reaches the end of the active section. This directive causes an
implicit alignment of four bytes. The assembler issues an error message if . CODE32 is used in combination with option
--cpu=ARMvV7M.

The .ARM directive is the same as the .CODE32 directive except that the UAL syntax is expected.

These directives are useful when you have files that contain both ARM and Thumb instructions. The directive must appear
before the instruction change and between a .. SECTION/ .ENDSEC. The default instruction set at the start of a section depends
on the use of assembler option --thumb.

Example

.section .text

.code32
;following instructions are ARM instructions
7

.endsec

Related information

% Assembler option --thumb (Treat input as Thumb instructions) in Section 6.3, Assembler Options, of Chapter Tool
Options.
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.DB

Syntax

[label] .DB argument[,argument]...

Description
With the .DB directive (Define Byte) the assembler allocates and initializes one byte of memory for each argument.

An argument can be:

* asingle or multiple character string constant

* aninteger expression

e NULL (indicated by two adjacent commas: ,,)

If you specify label, it gets the value of the location counter at the start of the directive processing.

Multiple arguments are stored in successive address locations. If an argument is NULL, its corresponding address location is
flled with zeros.

Integer arguments are stored as is, but must be byte values (within the range 0-255); floating-point numbers are not allowed. If
the evaluated expression is out of the range [-256, +255] the assembler issues an error. For negative values within that range,
the assembler adds 256 to the specified value (for example, -254 is stored as 2).

In case of single and multiple character strings, each character is stored in consecutive bytes whose lower seven bits represent
the ASCII value of the character. The standard C escape sequences are allowed:

= 0x52
0x41420043 (second argument is empty)

.DB 'R’
.DB 'AB’,,'D’

~e  ~e

Example

TABLE: .DB 14,253,0x62, 'ABCD’
CHARS: .DB 'A’,’'B’,,’'C’,'D’

Related information

% .BS (Block Storage)
.DS

(Define Storage)
.DH (Define Half Word)
.DW (Define Word)
.DD (Define Double-Word)
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.DD

Syntax

[label] .DD argument[,argument]...

Description
With the . DD directive (Define Double-Word) you allocate and initialize one double-word of memory for each argument.
One double-word is 64 bits.

An argument is:

* asingle or multiple character string constant

* an expression

e NULL (indicated by two adjacent commas: ,,)

If you specify label, it gets the value of the location counter at the start of the directive processing.

Multiple arguments are stored in sets of eight bytes. If an argument is NULL, its corresponding address locations are flled with
zeros.

Double-word arguments are stored as is. Floating-point values are not allowed. If the evaluated argument is too large to be
represented in a double-word, the assembler issues a warning and truncates the value.

In case of character strings, each ASCII value of the character is stored in successive locations starting at the most significant
byte of a double-word:

.DD 'AB’,,’'D’ => 0x4241000000000000
0x0000000000000000 (second argument is empty)
0x4400000000000000
Example
TABLE: .DD 14,253,0x62,'ABCD’

CHARS: .DD 'A’,'B’,,’'C’,'D’
Related information

% .BS (Block Storage)
.DS

(Define Storage)
.DB (Define Byte)
.DH (Define Half Word)
.DW (Define Word)
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.DEFINE

Syntax
.DEFINE symbol string

Description

With the .DEFINE directive you define a substitution string that you can use on all following source lines. The assembler
searches all succeeding lines for an occurrence of symbol, and replaces it with string. If the symbol occurs in a double quoted
string it is also replaced. Strings between single quotes are not expanded.

This directive is useful for providing better documentation in the source program. A symbol can consist of letters, digits and
underscore characters (_), and the first character cannot be a digit.

The assembler issues a warning if you redefine an existing symbol.

Example

Suppose you defined the symbol LEN with the substitution string "32”:
.DEFINE LEN ”32"

Then you can use the symbol LEN for example as follows:

.DS LEN
.MESSAGE I "“The length is: LEN”

The assembler preprocessor replaces LEN with “32” and assembles the following lines:

.DS 32
.MESSAGE I "The length is: 32~

Related information

% .UNDEF (Undefine a .DEFINE symbol or macro)
.MACRO/.ENDM (Define a macro)



Assembly Language

.DH

Syntax

[labell .DH argument[,argument]...

Description
With the . DH directive (Define Half Word) you allocate and initialize a half word of memory for each argument.
A half word is 16 bits.

An argument is:

* asingle or multiple character string constant
* an expression
e NULL (indicated by two adjacent commas: ,,)

If you specify label, it gets the value of the location counter at the start of the directive processing.

Multiple arguments are stored in successive half word address locations. If an argument is NULL, its corresponding address
location is filled with zeros.

Half word arguments are stored as is. Floating-point values are not allowed.
If the evaluated argument is too large to be represented in a half word, the assembler issues a warning and truncates the value.

In case of single and multiple character strings, each ASCII value of the character is stored in successive locations starting at
the most significant byte of a half word. The standard C escape sequences are allowed:

.DH 'AB’,,'D’ => 0x4241
0x0000 (second argument is empty)
0x4400

Example
TABLE: .DH 14,253,0x62,'ABCD’
CHARS: .DH 'A’,’'B’,,’'C’,'D’

Related information
Block Storage)

b =
.DS (Define Storage)

(
(
.DB (Define Byte)
.DW (Define Word)
.DD (Define Double-Word)
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.DS/.DSB/.DSH/.DSW/.DSD

Syntax

[label] .DS expression
[label] .DSB expression
[labell .DSH expression
[label] .DSW expression
[label] .DSD expression

Description

With the .Ds directive (Define Storage) the assembler reserves a block of memory. The reserved block of memory is not
initialized to any value.

With the expression you specify the number of minimum addressable units (MAUs) that you want to reserve. The expression
must evaluate to an integer larger than zero and cannot contain references to symbols that are not yet defined in the assembly
source.

If you specify label, it gets the value of the location counter at the start of the directive processing.
@ You cannot use the . DS directive in sections with attribute init. If you need to reserve initialized space in an init section,
use the .Bs directive instead.

The .DSB, .DSH, .DSW and .DSD directives are variants of the . DS directive:

.DSB The expression argument specifies the number of bytes to reserve.

.DSH The expression argument specifies the number of half words to reserve (one half word is16 bits).

.DSW The expression argument specifies the number of words to reserve (one word is 32 bits).

.DSD The expression argument specifies the number of double-words to reserve (one double-word is 64 bits).
Example

RES: .DS 5+3 ; allocate 8 bytes
Related information
% .BS (Block Storage)
.DB (Define Byte)
.DH (Define Half Word)

.DW (Define Word)
.DD (Define Double-Word)
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.DW

Syntax

[labell .DW argument{,argument]...

Description
With the . Dw directive (Define Word) you allocate and initialize one word of memory for each argument.
One word is 32 bits.

An argument is:

* asingle or multiple character string constant

* an expression

e NULL (indicated by two adjacent commas: ,,)

If you specify label, it gets the value of the location counter at the start of the directive processing.

Multiple arguments are stored in sets of four bytes. If an argument is NULL, its corresponding address locations are flled with
zeros.

Word arguments are stored as is. Floating-point values are not allowed. If the evaluated argument is too large to be represented
in a word, the assembler issues a warning and truncates the value.

In case of single and multiple character strings, each ASCII value of the character is stored in successive locations starting at
the most significant byte of a word. The standard C escape sequences are allowed:

.DW 'AB’,,'D’ => 0x42410000
0x00000000 (second argument is empty)
0x44000000
Example
TABLE: .DW 14,253,0x62, 'ABCD’

CHARS: .DW 'A’,’'B’,,’'C’,'D’

Related information

b es ¢
.DS (Define Storage)
(

.DB (Define Byte)
.DH (Define Half Word)
.DD (Define Double-Word)

Block Storage)
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.END

Syntax
.END

Description

With the . END directive you tell the assembler that the end of the module is reached. If the assembler finds assembly source
lines beyond the .END directive, it ignores those lines and issues a warning.

Example

.section .text
; source lines
.endsec
.END ; End of assembly module
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.EQU

Syntax

symbol .EQU expression

Description

With the .EQU directive you assign the value of expression to symbol permanently. Once defined, you cannot redefine the
symbol. With the .GLOBAL directive you can define the symbol global.

Example
To assign the value 0x4000 permanently to the symbol MYSYMBOL:
MYSYMBOL .EQU 0x4000

You cannot redefine the used symbols.

Related information

% .SET (Set temporary value to a symbol)
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.EXTERN

Syntax
.EXTERN symbol[,symbol]...
Description

With the .EXTERN directive you define an external symbol. It means that the symbol is referenced in the current module while it
is defined outside the current module.

You must define the symbols either outside any module or declare it as globally accessible within another module with the
.GLOBAL directive.

If you do not use the . EXTERN directive and the symbol is not defined within the current module, the assembler issues a
warning and inserts the .EXTERN directive.

Example

.EXTERN AA,CC,DD ; defined elsewhere

Related information

% .GLOBAL (Declare global section symbol)
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.FLOAT/.DOUBLE

Syntax
[label] .FLOAT expression[,expression]...

[labell] .DOUBLE expression[,expression]...

Description

With the . FLOAT or .DOUBLE directive the assembler allocates and initializes a floating-point number (32 bits) or a double (64
bits) in memory for each argument.

An expression can be:

* afloating-point expression
e NULL (indicated by two adjacent commas: ,,)

You can represent a constant as a signed whole number with fraction or with the ’e’ format as used in the C language. 12.457
and +0.27E-13 are legal floating-point constants.

If you specify label, it gets the value of the location counter at the start of the directive processing.

If the evaluated argument is too large to be represented in a single word / double-word, the assembler issues an error and
truncates the value.

Example

FLT: .FLOAT 12.457,+0.27E-13

DBL: .DOUBLE 12.457,+0.27E-13

Related information

% .DS (Define Storage)
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.FOR/.ENDFOR

Syntax

[label] .FOR var IN expression[,expression]...

.ENDFOR
or:

[label] .FOR var IN start TO end [STEP step]

.ENDFOR

Description

With the . FOR/ . ENDFOR directive you can repeat a sequence of assembly source lines with an iterator. As shown by the
syntax, you can use the .FOR/ .ENDFOR in two ways.

1. In the first mehod, the loop is repeated as many times as the number of arguments following IN. If you use the symbol var in
the assembly lines between .FOR and . ENDFOR, for each repetition the symbol var is substituted by a subsequent
expression from the argument list. If the argument is a null, then the loop is repeated with each occurrence of the symbol var
removed.

2. Inthe second method, the loop is repeated using the symbol var as a counter. The counter passes all integer values from
start to end with a step. If you do not specify step, the counter is increased by one for every repetition.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

In the following example the loop is repeated 4 times (there are four arguments). With the . DB directive you allocate and
initialize a byte of memory for each repetition of the loop (a word for the . Dw directive). Effectively, the preprocessor duplicates
the .DB and .Dw directives four times in the assembly source.

.FOR VARl IN 1,2+3,4,12
.DB VAR1
.DW (VAR1*VARI)
.ENDFOR

In the following example the loop is repeated 16 times. With the . Dw directive you allocate and initialize four bytes of memory for
each repetition of the loop. Effectively, the preprocessor duplicates the . Dw directive16 times in the assembled file, and
substitutes VAR2 with the subsequent numbers.

.FOR VAR2 IN 1 to 0x10
.DW (VAR1*VAR1)
.ENDFOR

Related information

% .REPEAT/.ENDREP (Repeat sequence of source lines)
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.GLOBAL

Syntax
.GLOBAL symbol[,symbol]...

Description

All symbols or labels defined in the current section or module are local to the module by default. You can change this default
behavior with assembler option -ig.

With the . GLOBAL directive you declare one of more symbols as global. It means that the specified symbols are defined within
the current section or module, and that those definitions should be accessible by all modules.

To access a symbol, defined with . GLOBAL, from another module, use the . EXTERN directive.

Only program labels and symbols defined with . EQU can be made global.

Example

LOOPA .EQU 1 ; definition of symbol LOOPA
.GLOBAL LOOPA ; LOOPA will be globally
; accessible by other modules

Related information

% .EXTERN (Import global section symbol)
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IF/.ELIF/.ELSE/.ENDIF

Syntax

AF expression

[.ELIF expression] (the .ELIF directive is optional)
[.ELSE] (the .ELSE directive is optional)
.ENDIF

Description

With the . IF/.ENDIF directives you can create a part of conditional assembly code. The assembler assembles only the code
that matches a specified condition.

The expression must evaluate to an integer and cannot contain forward references. If expression evaluates to zero, the
IF-condition is considered FALSE, any non-zero result of expression is considered as TRUE.

You can nest . IF directives to any level. The .ELSE and .ELIF directive always refer to the nearest previous . IF directive.
Example

Suppose you have an assemble source file with specific code for a test version, for a demo version and for the final version.
Within the assembly source you define this code conditionally as follows:

.IF TEST

... ; code for the test version
.ELTF DEMO

... ; code for the demo version
.ELSE

... ; code for the final version
.ENDIF

Before assembling the file you can set the values of the symbols TEST and DEMO in the assembly source before the . IF
directive is reached. For example, to assemble the demo version:

TEST .SET 0
DEMO .SET 1

You can also define the symbols in Altium Designer as preprocessor macros in dialog Project » Project Options » Assembler
» Preprocessing (assembler option --define).

Related information

% Assembler option --define (Define preprocessor macro) in Section 6.3, Assembler Options, of Chapter Tool Options.
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INCLUDE

Syntax

.INCLUDE *filename” | <filename>

Description

With the . INCLUDE directive you include another file at the exact location where the . INCLUDE occurs. This happens before
the resulting file is assembled. The . INCLUDE directive works similarly to the #include statement in C. The source from the
include file is assembled as if it followed the point of the . INCLUDE directive. When the end of the included file is reached,
assembly of the original file continues.

The string specifies the filename of the file to be included. The filename must be compatible with the operating system
(forward/backward slashes) and can contain a directory specification. If you omit a filename extension, the assembler assumes
the extension .asm.

If an absolute pathname is specified, the assembler searches for that file. If a relative path is specified or just a filename, the
order in which the assembler searches for include files is:

1. The current directory if you use the "filename” construction.
The current directory is not searched if you use the <filename> syntax.
2. The path that is specified with the assembler option --include-directory (-I).
3. The path that is specified in the environment variable AStargetINC when the product was installed.

4. The default directory . . .\ctarget\include.

Example

Suppose that your assembly source file test.src contains the following line:
.INCLUDE "“c:\myincludes\myinc.inc”

The assembler issues an error if it cannot find the file at the specified location.
.INCLUDE "myinc.inc”

The assembler searches the file myinc . inc according to the rules described above.

Related information

% Assembler option --include-directory (Add directory to include file search path) in Section 6.3, Assembler Options, of
Chapter Tool Options.
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.LIST/.NOLIST

Syntax
.NOLIST

. ; assembly source lines

.LIST

Description

If you generate a list file (see assembler option --list-file), you can use the .LIST and .NOLIST directives to specify which
source lines the assembler must write to the list file.

The assembler prints all source lines to the list file, untill it encounters a . NOLIST directive. The assembler does not print the
.NOLIST directive and subsequent source lines. When the assembler encounters the .LIST directive, it resumes printing to the
list file, starting with the .LIST directive itself.

It is possible to nest the .LIST/.NOLIST directives.

Example
Suppose you assemble the following assembly code with the assembler option --list-file:

.SECTION .text

... ; source line 1
.NOLIST

... ; source line 2
.LIST

... ; source line 3
.ENDSEC

.END

The assembler generates a list file with the following lines:

.SECTION .text

... ; source line 1
.LIST

... ; source line 3
.ENDSEC

.END

Related information

% Assembler option --list-file (Generate list file) in Section 6.3, Assembler Options, of Chapter Tool Options.
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.LTORG

Syntax
.LTORG

Description
With this directive you force the assembler to generate a literal pool (data pocket) at the current location.

All literals from the LDR= pseudo-instructions (except those which could be translated to MOV or MVN instructions) between
the previous literal pool and the current location will be assembled in a new literal pool using . DW directives.

By default, the assembler generates a literal pool at the end of a code section, i.e. the . ENDSEC directive at the end of a code
section causes an implicit . LTORG directive. However, the default literal pool may be out-of-reach of one or more LDR=
pseudo-instructions in the section. In that case the assembler issues an error message and you should insert . LTORG directives
at proper locations in the section.

Example

.section .text
7

LDR rl1,=0x12345678

; code

.ltorg ; literal pool contains the literal &0x12345678
7

.endsec ; default literal pool is empty

Related information

% LDR= ARM generic
LDR= Thumb generic
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.MACRO/.ENDM

Syntax

macro_name .MACRO [argument[,argument]...]
macro_definition_statements

.ENDM

Description

With the . MACRO directive you define a macro. Macros provide a shorthand method for handling a repeated pattern of code or
group of instructions. You can define the pattern as a macro, and then call the macro at the points in the program where the
pattern would repeat.

The definition of a macro consists of three parts:

* Header, which assigns a name to the macro and defines the arguments.

* Body, which contains the code or instructions to be inserted when the macro is called.

* Terminator, which indicates the end of the macro definition (. ENDM directive).

The arguments are symbolic names that the macro processor replaces with the literal arguments when the macro is expanded
(called). Each formal argument must follow the same rules as symbol names: the name can consist of letters, digits and
underscore characters (_). The first character cannot be a digit. Argument names cannot start with a percent sign (%).

Macro definitions can be nested but the nested macro will not be defined until the primary macro is expanded.

You can use the following operators in macro definition statements:

Operator | Name Description

\ Macro argument | Concatenates a macro argument with adjacent alphanumeric characters.
concatenation

? Return decimal Substitutes the ?symbol sequence with a character string that represents the decimal value
value of symbol of the symbol.

% Return hex Substitutes the %symbol sequence with a character string that represents the hexadecimal
value of symbol value of the symbol.

” Macro string Allows the use of macro arguments as literal strings.
delimiter

Macro local label | Prevents name mangling on labels in macros.
override

Example

The macro definition:

macro_a .MACRO argl,arg2 ;header
.db argl ;body
.dw (argl*arg2)
.ENDM ;terminator

The macro call:

.section .data
macro_a 2,3

.endsec
The macro expands as follows:

.db 2
.dw (2%3)
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Related information

% .DEFINE (Define a substitution string)
Section 4.9, Macro Operations.
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.MESSAGE

Syntax
.MESSAGE type [{strlexp|symbol}[,{str|exp|symbol}]...]

Description

With the .MESSAGE directive you tell the assembler to print a message to stdout during the assembling process.

With type you can specify the following types of messages:

I Information message. Error and warning counts are not affected and the assembler continues the assembling process.
W Warning message. Increments the warning count and the assembler continues the assembling process.

E Error message. Increments the error count and the assembler continues the assembling process.

F Fatal error message. The assembler immediately aborts the assembling process and generates no object file or list file.

The .MESSAGE directive is for example useful in combination with conditional assembly to indicate which part is assembled.

Example
.MESSAGE I ’'Generating tables’

ID .EQU 4
.MESSAGE E ’'The value of ID is ’,ID

.DEFINE LONG "”SHORT"”
.MESSAGE I 'This is a LONG string’
.MESSAGE I "This is a LONG string”

Within single quotes, the defined symbol LONG is not expanded. Within double quotes the symbol LONG is expanded so the
actual message is printed as:

This is a LONG string
This is a SHORT string
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.OFFSET

Syntax

.OFFSET expression

Description

With the .OFFSET directive you tell the assembler to give the location counter a new offset relative to the start of the section.

When the assembler encounters the .OFFSET directive, it moves the location counter forwards to the specified address, relative
to the start of the section, and places the next instruction on that address. If you specify an address equal to or lower than the
current position of the location counter, the assembler issues an error.

Example

.SECTION .text
nop

nop

nop

.OFFSET 0x20
nop

.endsec

.SECTION .text
nop

nop

nop

.OFFSET 0x02
nop

.endsec

.
4

~e

the assembler places
this instruction at address 0x20

relative to the start of the section.

WRONG: the current position of the
location counter is 0x0C.
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.PAGE

Syntax

.PAGE [width,length,blanktop,blankbtm,blankleft]

Description

If you generate a list file (see assembler option --list-file), you can use the . PAGE directive to format the generated list file.

width Number of characters on a line (1-255). Default is 132.

length Number of lines per page (10-255). Default is 66.

blanktop Number of blank lines at the top of the page. Default = 0.
Specify a value so that blanktop + blankbtm < length - 10.

blankbtm Number of blank lines at the bottom of the page. Default = 0.
Specify a value so that blanktop + blankbtm < length - 10.

blankleft Number of blank columns at the left of the page. Default = 0. Specify a value smaller than width.

If you use the . PAGE directive without arguments, it causes a ‘formfeed’: the next source line is printed on the next page in the

list file.

You can omit an argument by using two adjacent commas. If the remaining arguments after an argument are all empty, you can

omit them.

A label is not allowed with this directive.

Example

.PAGE :

I
.PAGE 96 ;
7

.PAGE ,,5

.
’
.
’

formfeed, the next source line is printed

; on the next page in the list file.

set pagewidth to 96. Note that you can
omit the last four arguments

insert five blank lines at the top. Note
that you can omit the last two arguments.

Related information

% .TITLE (Set program title in header of assembler list file)

Assembler option --list-file (Generate list file) in Section 6.3, Assembler Options, of Chapter Tool Options.
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-REPEAT/.ENDREP

Syntax
[label]l .REPEAT expression

.ENDREP

Description

With the . REPEAT/ . ENDREP directive you can repeat a sequence of assembly source lines. With expression you specify the
number of times the loop is repeated.

If you specify label, it gets the value of the location counter at the start of the directive processing.
Example

In this example the loop is repeated 3 times. Effectively, the preprocessor repeats the source lines (.DB 10) three times, then
the assembler assembles the result:

.REPEAT 3
.DB 10 ; assembly source lines
.ENDREP

Related information

% .FOR/.ENDFOR (Repeat sequence of source lines n times)
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.SECTION

Syntax
.SECTION name [,at(address)]

.ENDSEC

Description

With the . SECTION directive you define a new section. Each time you use the . SECTION directive, a new section is created. It
is possible to create multiple sections with exactly the same name.

If you define a section, you must always specify the section name. The names have a special meaning to the locating process
and have to start with a predefined name, optionally extended by a dot ’.’ and a user defined name. The predefined section
name also determines the type of the section (code, data or debug). Optionally, you can specify the at () attribute to locate a
section at a specific address.

You can use the following predefined section names:

Section Name | Description Section Type
text Code sections code

.data Initialized data data

.bss Uninitialized data (cleared) data

.rodata ROM data (constants) data

.debug Debug sections debug

Table 4-4: Predefined section names

Sections of a specified type are located by the linker in a memory space. The space names are defined in a so-called ’linker
script file’ (files with the extension . 1s1) delivered with the product in the directory \Program Files\Altium
Designer\System\Tasking\include.1lsl.

You can specify the following section attributes:

Example

.SECTION .data ; Declare a .data section
i

.ENDSEC

.SECTION .data.abs, at(0x0) ; Declare a .data.abs section at
; an absolute address

rr

.ENDSEC
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SET

Syntax
symbol  .SET expression

.SET symbol expression

Description

With the . SET directive you assign the value of expression to symbol temporarily. If a symbol was defined with the . SET
directive, you can redefine that symbol in another part of the assembly source, using the . SET directive again. Symbols that you
define with the . SET directive are always local: you cannot define the symbol global with the . GLOBAL directive.

The . SET directive is useful in establishing temporary or reusable counters within macros. expression must be absolute and
cannot include a symbol that is not yet defined (no forward references are allowed).

Example

COUNT .SET O ; Initialize count. Later on you can
; assign other values to the symbol

Related information

% .EQU (Set a permanent value to a symbol)
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.SIZE

Syntax

.SIZE symbol, expression

Description
With the . SIZE directive you set the size of the specified symbol to the value represented by expression.

The . SIZE directive may occur anywhere in the source file unless the specified symbol is a function. In this case, the . SIZE
directive must occur after the function has been defined.

Example

.section .text
.global main
.code32
.align 4
; Function main
main: .type func
7
.SIZE main,$-main
.endsec

Related information

% .TYPE (Set Symbol Type)
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.SOURCE
Syntax
.SOURCE string

Description

With the . SOURCE directive you specify the name of the original C source module. This directive is generated by the C compiler.
You do not need this directive in hand-written assembly.

Example

.SOURCE "test.c”

Related information

@ﬂi§ _
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.TITLE

Syntax
.TITLE [title]

Description

If you generate a list file (see assembler option --list-file), you can use the . TITLE directive to specify the program title which
is printed at the top of each page in the assembler list file.

If you use the . TITLE directive without the argument, the title becomes empty. This is also the default. The specified title is valid
until the assembler encouters a new . TITLE directive.

Example
.TITLE "The best program”

In the header of each page in the assembiler list file, the title of the progam is printed. In this case: The best program

Related information

% .PAGE (Format the assembler list file)
Assembler option --list-file (Generate list file) in Section 6.3, Assembler Options, of Chapter Tool Options.
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.TYPE
Syntax
symbol .TYPE typeid

Description

With the . TYPE directive you set a symbol’s type to the specified value in the ELF symbol table. Valid symbol types are:

FUNC The symbol is associated with a function or other executable code.
OBJECT The symbol is associated with an object such as a variable, an array, or a structure.
FILE The symbol name represents the filename of the compilation unit.

Labels in code sections have the default type FUNC. Labels in data sections have the default type OBJECT.

Example

Afunc: .TYPE FUNC

Related information

% .SIZE (Set Symbol Size)
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.UNDEF

Syntax
.UNDEF symbol
Description

With the . UNDEF directive you can undefine a substitution string that was previously defined with the . DEFINE directive. The
substitution string associated with symbol is released, and symbol will no longer represent a valid . DEFINE substitution.

The assembler issues a warning if you redefine an existing symbol.
Example
.UNDEF LEN
Undefines the LEN substitution string that was previously defined with the . DEFINE directive.

Related information

% .DEFINE (Define substitution string)
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WEAK

Syntax
.WEAK symbol[,symbol]...

Description

With the .WEAK directive you mark one or more symbols as 'weak’. The symbol can be defined in the same module with the
.GLOBAL directive or the .EXTERN directive. If the symbol does not already exist, it will be created.

A’weak’ external reference is resolved by the linker when a global (or weak) definition is found in one of the object files.
However, a weak reference will not cause the extraction of a module from a library to resolve the reference.

You can overrule a weak definition with a . GLOBAL definition in another module. The linker will not complain about the duplicate
definition, and ignore the weak definition.

Only program labels and symbols defined with . EQU can be made weak.

Example

LOOPA .EQU 1 definition of symbol LOOPA
.GLOBAL LOOPA ; LOOPA will be globally
; accessible by other modules
.WEAK LOOPA ; mark symbol LOOPA as weak

~e

Related information

% .EXTERN (Import global section symbol)
.GLOBAL (Declare global section symbol)
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4.9 Macro Operations

Macros provide a shorthand method for inserting a repeated pattern of code or group of instructions. You can define the pattern
as a macro, and then call the macro at the points in the program where the pattern would repeat.

Some patterns contain variable entries which change for each repetition of the pattern. Others are subject to conditional
assembly.

When a macro is called, the assembler executes the macro and replaces the call by the resulting in-line source statements.
‘In-line’ means that all replacements act as if they are on the same line as the macro call. The generated statements may
contain substitutable arguments. The statements produced by a macro can be any processor instruction, almost any assembler
directive, or any previously-defined macro. Source statements resulting from a macro call are subject to the same conditions
and restrictions as any other statements.

Macros can be nested. The assembler processes nested macros when the outer macro is expanded.

4.9.1 Defining a Macro
The first step in using a macro is to define it.

The definition of a macro consists of three parts:

* Header, which assigns a name to the macro and defines the arguments.
* Body, which contains the code or instructions to be inserted when the macro is called.
* Terminator, which indicates the end of the macro definition (. ENDM directive).

A macro definition takes the following form:

macro_name .MACRO l[arg[,arg]...] [; comment]
source statements

.ENDM

If the macro name is the same as an existing assembler directive or mnemonic opcode, the assembler replaces the directive or
mnemonic opcode with the macro and issues a warning.

The arguments are symbolic names that the macro preprocessor replaces with the literal arguments when the macro is
expanded (called). Each argument must follow the same rules as global symbol names. Argument names cannot start with a
percent sign (%).

Example

Consider the following macro definition:

RESERV .MACRO val ; reserve space
.DS val
.ENDM

After the following macro call:

.section .text
RESERV 8
.endsec

The macro expands to:

.DS 8

4.9.2 Calling a Macro

To invoke a macro, construct a source statement with the following format:

[label] macro _name [arg[,arg...]] [; comment]
where:
label An optional label that corresponds to the value of the location counter at the start of the macro expansion.
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macro_name The name of the macro. This may not start in the first column.
arg One or more optional, substitutable arguments. Multiple arguments must be separated by commas.
comment An optional comment.

The following applies to macro arguments:

* Each argument must correspond one-to-one with the formal arguments of the macro definition. If the macro call does not
contain the same number of arguments as the macro definition, the assembler issues a warning.

* If an argument has an embedded comma or space, you must surround the argument by single quotes ().
* You can declare a macro call argument as null in three ways:
- enter delimiting commas in succession with no intervening spaces

macroname ARG1l,,ARG3 ; the second argument is a null argument
- terminate the argument list with a comma, the arguments that normally would follow, are now considered null
macroname ARG1, ; the second and all following arguments are null

- declare the argument as a null string
* No character is substituted in the generated statements that reference a null argument.
4.9.3 Using Operators for Macro Arguments

The assembler recognizes certain text operators within macro definitions which allow text substitution of arguments during
macro expansion. You can use these operators for text concatenation, numeric conversion, and string handling.

Operator | Name Description

\ Macro argument | Concatenates a macro argument with adjacent alphanumeric characters.
concatenation

? Return decimal Substitutes the ?symbol sequence with a character string that represents the decimal value
value of symbol of the symbol.

% Return hex Substitutes the %symbol sequence with a character string that represents the hexadecimal
value of symbol | value of the symbol.

” Macro string Allows the use of macro arguments as literal strings.
delimiter

" Macro local label | Prevents name mangling on labels in macros.
override

Example: Argument Concatenation Operator - \
Consider the following macro definition:

MAC_A .MACRO reg,val
sub r\reg,r\reg,#val
. ENDM

The macro is called as follows:
MAC A 2,1

The macro expands as follows:
sub r2,r2,#1

The macro preprocessor substitutes the character 2’ for the argument reg, and the character '1’ for the argument val. The
concatenation operator (\) indicates to the macro preprocessor that the substitution characters for the arguments are to be
concatenated with the characters 'r’.

Without the ’\" operator the macro would expand as:
sub rreg,rreg,#1

which results in an assembler error (invalid operand).
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Example: Decimal Value Operator - ?

Instead of substituting the formal arguments with the actual macro call arguments, you can also use the value of the macro call
arguments.

Consider the following source code that calls the macro MAC_A after the argument AVAL has been set to 1.

AVAL .SET 1
MAC_A 2,AVAL

If you want to replace the argument val with the value of AVAL rather than with the literal string * AVAL’, you can use the ?
operator and modify the macro as follows:

MAC_A .MACRO reg,val
sub r\reg,r\reg,?val
. ENDM

Example: Hex Value Operator - %

The percent sign (%) is similar to the standard decimal value operator (?) except that it returns the hexadecimal value of a
symbol.

Consider the following macro definition:

GEN_LAB .MACRO LAB,VAL,STMT
LAB\%VAL STMT
.ENDM

The macro is called after NUM has been set to 10:

NUM .SET 10
GEN_LAB HEX,NUM, NOP

The macro expands as follows:
HEXA NOP

The $VAL argument is replaced by the character ’A’ which represents the hexadecimal value 10 of the argument VAL.

Example: Argument String Operator - ”
To generate a literal string, enclosed by single quotes ('), you must use the argument string operator () in the macro definition.

Consider the following macro definition:

STR_MAC .MACRO STRING
.DB "STRING"”
.ENDM

The macro is called as follows:
STR_MAC ABCD
The macro expands as follows:
.DB "ABCD’

Within double quotes .DEFINE directive definitions can be expanded. Take care when using constructions with quotes and
double quotes to avoid inappropriate expansions. Since . DEFINE expansion occurs before macro substitution, any . DEFINE
symbols are replaced first within a macro argument string:

.DEFINE LONG 'short’

STR_MAC .MACRO STRING
.MESSAGE I 'This is a LONG STRING’
.MESSAGE I "This is a LONG STRING”
.ENDM

If the macro is called as follows:

STR_MAC sentence
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it expands as:

.MESSAGE I 'This is a LONG STRING’
.MESSAGE I 'This is a short sentence’

Macro Local Label Override Operator - "

If you use labels in macros, the assembler normally generates another unique name for the labels (such as
LOCAL M L000001).

The macro "-operator prevents name mangling on macro local labels.
Consider the following macro definition:

INIT .MACRO addr
LOCAL: 1ldr r0, “addr
.ENDM

The macro is called as follows:

LOCAL:
INIT LOCAL

The macro expands as:
LOCAL M L000001: 1ldr r0,LOCAL

If you would not have used the " operator, the macro preprocessor would choose another name for LOCAL because the label
already exists. The macro would expand like:

LOCAL M L000001: 1dr r0,LOCAL__M L000001

4.9.4 Using the .FOR and .REPEAT Directives as Macros

The .FOR and .REPEAT directives are specialized macro forms to repeat a block of source statements. You can think of them
as a simultaneous definition and call of an unnamed macro. The source statements between the . FOR and . ENDFOR directives
and .REPEAT and .ENDREP directives follow the same rules as macro definitions.

% For a detailed description of these directives, see section 4.8, Assembler Directives.

4.9.5 Conditional Assembly

With the conditional assembly directives you can instruct the macro preprocessor to use a part of the code that matches a
certain condition.

You can specify assembly conditions with arguments in the case of macros, or through definition of symbols via the . DEFINE,
.SET, and .EQU directives.

The built-in functions of the assembler provide a versatile means of testing many conditions of the assembly environment.

You can use conditional directives also within a macro definition to check at expansion time if arguments fall within a range of
allowable values. In this way macros become self-checking and can generate error messages to any desired level of detail.

The conditional assembly directive . IF/.ENDIF has the following form:

.IF expression

[ .ELIF expression] ; (the .ELIF directive is optional)
[ .ELSE] ; (the .ELSE directive is optional)
.ENDIF
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A section of a program that is to be conditionally assembled must be bounded by an . IF-.ENDIF directive pair. If the optional
.ELSE and/or .ELIF directives are not present, then the source statements following the . IF directive and up to the next
.ENDIF directive will be included as part of the source file being assembled only if the expression had a non-zero result.

If the expression has a value of zero, the source file will be assembled as if those statements between the . IF and the .ENDIF
directives were never encountered.

If the .ELSE directive is present and expression has a nonzero result, then the statements between the .IF and .ELSE
directives will be assembled, and the statement between the .ELSE and .ENDIF directives will be skipped. Alternatively, if
expression has a value of zero, then the statements between the . IF and .ELSE directives will be skipped, and the statements
between the .ELSE and .ENDIF directives will be assembled.
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4.10 Generic Instructions

The assembler supports so-called 'generic instructions’. Generic instructions are pseudo instructions (no instructions from the
instruction set). Depending on the situation in which a generic instruction is used, the assembler replaces the generic instruction
with appropriate real assembly instruction(s).

4.10.1 ARM Generic Instructions

The ARM assembler recognizes the following generic instructions in ARM mode:

ADR, ADRL, ADRLL ARM generics

Load a PC-relative address into a register. The address is specified as a target label. The assembler generates one (ADR), two
(ADRL) or three (ADRLL) generic DPR instruction (called ADR) and one, two or three PC-relative relocation types for the target
label. The linker evaluates the relocation types (calculate the PC-relative offset) and generates one, two or three add or sub
instructions each with an 8-bit immediate operand plus a 4-bit rotation. If the offset cannot be encoded the linker generates an
error message.

Instruction Replacement

ADRcond Rd,label ADRcond Rd, PC, @ALUPCREL (/abel,0,1)

ADRLcond Rd,label ADRcond Rd, PC, @ALUPCREL (/abel,0,0)
ADRcond Rd, Rd, @ALUPCREL (label,1,1)

ADRLLcond Rd,label ADRcond Rd, PC, @ALUPCREL (/abel,0,0)
ADRcond Rd, Rd, @ALUPCREL(label,1,0)
ADRcond Rd, Rd, @ALUPCREL (label,2,1)

BX for ARMv4

The ARMv4 architecture does not support the BX instruction in hardware. If the option --cpu=ARMv4 or --cpu=ARMv4T was
specified, the assembler will emit a relocation type at the location of the BX instruction. The linker will replace the BX instruction
by a MOV instruction if the option --cpu=ARMv4 was specified.

Instruction Replacement (by linker) Description

BXcond Rm MOVcond PC,Rm Only if architecture is ARMv4

4.10.2 ARM and Thumb-2 32-bit Generic Instructions

LDR= ARM and Thumb-2 generic

Load an address or a 32-bit constant value into a register. If the constant or its bitwise negation can be encoded, then the
assembler will generate a MOV or a MVN instruction. Otherwise the assembler places the constant or the address in a literal
pool and generates a PC-relative LDR instruction that loads the value from the literal pool.

Instruction Replacement Description
LDRcond Rd,=expr MOVcond Ra, #expr If expr can be encoded
MVNcond Rd,#@LSW/(~(expr)) If ~expr can be encoded
LDRcond Rd,ltpool If expr is external or PC-relative, or cannot be
;; code encoded
Itpool:
.DW expr

The PC-relative offset from the LDR instruction to the value in the literal pool must be positive and less than 4 kB. By default the
assembler will place a literal pool at the end of each code section. If the default literal pool is out-of-range you will have to
ensure that there is another literal pool within range by means of the . LTORG directive.

VLDR= ARM and Thumb-2 generic

Load a 32-bit or 64-bit floating-point constant value into a register. The assembler places the constant in a literal pool and
generates a PC-relative VLDR instruction that loads the value from the literal pool.
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Instruction

Replacement

VLDRcond Sd,=expr

VLDRcond Sd,ltpool
;; code

Itpool:
.FLOAT expr

VLDRcond Dd,=expr

VLDRcond Dd,ltpool
;; code
Itpool:
.DOUBLE expr

MOV32 ARM and Thumb-2 generic

Load an address or a 32-bit constant value into a register.

Instruction

Replacement

Description

MOV32cond Rd,=expr

MOVWcond Rd, #@LSH (expr)
MOVTcond Rd, #@MSH (expr)

If expr is internal and absolute

MOVWcond Rd, #expr
MOVTcond Rd, #expr

If expr is external or relocatable

ARM and Thumb-2 generic DPR inversions for immediate operands

For data processing instructions (DPR) which operate on an immediate operand, the operand value must be encoded as an
8-bit value plus a 4-bit even rotation value. If a value does not fit in such an encoding, it could be possible that the negated
value (-value) or the bitwise negated value (~value) does fit in such an encoding. In that case the assembler will replcace the
DPR instruction by its inverse DPR instruction operating on the negated value.

Instruction

Replacement (if #-imm or #~imm can be encoded)

ADDcond Rd,Rn#imm32

SUBcond Rd,Rn.#-(imm32)

ADDcondS Rd,Rn,#imm32

SUBcondS Rd,Rn,#-(imm32)

ADDWcond Rd,Rn.#imm12

SUBWcond Rd,Rn,#-(imm12)

SUBcond Rd,Rn,#imm32

ADDcond Rd,Rn,#-(imm32)

SUBcondS Rd,Rn,#imm32

ADDcondS Rd,Rn,#-(imm32)

SUBWcond Rd,Rn.#imm12

ADDWcond Rd,Rn,#-(imm12)

ADCcond Rd,Rn#imm32

SBCcond Rd,Rn.#-(imm32)

ADCcondS Rd,Rn,#imm32

SBCcondS Rd,Rn.#-(imm32)

SBCcond Rd,Rn,#imm32

ADCcond Rd,Rn,#-(imm32)

SBCcondS Rd,Rn,#imm32

ADCcondS Rd,Rn,#-(imm32)

ANDcond Rd,Rn,#imm32

BICcond Rd,Rn,#@LSW(~(imm32))

ANDcondS Rd,Rn,#imm32

BICcondS Rd,Rn#@LSW(~(imm32))

BICcond Rd,Rn,#imm32

ANDcond Rd,Rn#@LSW(~(imm32))

BICcondS Rd,Rn,#mm32

ANDcondS Rd,Rn,#@LSW/(~(imm32))

CMNcond Rn,#imm32

CMPcond Rn,#-(imm32)

CMPcond Rn,#mm32

CMNcond Rn #-(imm32)

MOVcond Rd,#imm32

MVNcond Rd,#@LSW(~(imm32))

MOVcondS Rd,#imm32

MVNcondS Rd,#@LSW(~(imm32))

MVNcond Rd,#imm32

MOVcond Rd#@LSW(~(imm32))

MVNcondS Rd,#mm32

MOVcondS Rd #@LSW(~(imm32))

Note that the built-in function @LSW/() must be used on the bitwise negated immediate value because all values are interpreted

by the assembler as 64-bit signed values. The @LSW() function returns the lowest 32 bits.
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4.10.3 Thumb 16-bit Generic Instructions

The ARM assembler recognizes the following generic instructions in Thumb mode:

ADR Thumb 16-bit generic

Load a PC-relative address into a low register. The address is specified as a target label. The PC-relative offset must be less
than 1 kB. The target label must be defined locally, must be word-aligned and must be in the same code section as the
instruction. The assembler will not emit a relocation type for the target label. If the offset is out-of-range or the target label is
external or in another section, then the assembler generates an error message.

LDR= Thumb 16-bit generic

Load an address or a 32-bit constant value into a low register. If the constant is in the range [0,255] the assembler will generate
a MOV instruction. Otherwise the assembler places the constant or the address in a literal pool and generates a PC-relative
LDR instruction that loads the value from the literal pool.

Instruction

Replacement

Description

LDR Rd,=expr

MOV Rd, #expr

If expr is in range

LDR Rd,ltpool
;; code

Itpool:
.DW expr

If expr is external or PC-relative, or not in range

The PC-relative offset from the LDR instruction to the value in the literal pool must be positive and less than 1 kB. By default the
assembler will place a literal pool at the end of each code section. If the default literal pool is out-of-range you will have to
ensure that there is another literal pool within range by means of the . LTORG directive.

Bcond inversion Thumb 16-bit generic

The PC-relative conditional branch instruction has a range of (-256,+255) bytes. The unconditional version has a range of
(-2048,+2047) bytes. If the conditional branch target is out-of-range, the assembler will rewrite the conditional branch
instruction with an inversed conditional branch and an unconditional branch.

Instruction

Replacement

Description

Bcond label

Binv_cond ~1
B label
~1:

If target label out-of-range

ADD, SUB inversions Thumb 16-bit generic

For the following six instructions the assembler accepts negative values for the immediate operand. If a negative value is
specified, the assembler inverts the instruction from ADD to SUB or vice versa. For example: ADD R1,#-4 will be rewritten as

SUB R1,#4.

Instruction Replacement

ADD Rd,Rn.#imm SUB Rd,Rn,#-(imm)
ADD Rd,#imm SUB Rd,#-(imm)
ADD SP#imm SUB SP#-(imm)
SUB Rd,Rn#imm ADD Rd,Rn,#-(imm)
SUB Rd,#imm ADD Rd,#-(imm)
SUB SP#imm ADD SP#-(imm)
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Summary This chapter describes the startup code used by the TASKING ARM C Compiler, the
vector table, the stack layout and the heap.

5.1  Startup Code

You need the run-time startup code to build an executable application. The default startup code consists of the following
components:

* Initialization code. This code is executed when the program is initiated and before the function main () is called.

* Exit code. This controls the closedown of the application after the program’s main function terminates.

The startup code is part of the C library, and the source is present in the file cstart.asm (ARM and Thumb), or

cstart thumb2.asm (Thumb2 specific) in the directory 1ib\src. This code is generic code. It uses linker generated symbols
which you can give target specific or application specific values. These symbols are defined in the linker script file
(include.lsl\arm_arch.1lsl) and you can specify their values in Altium Designer or on the command line with linker option
--define. If the default run-time startup code does not match your configuration, you need to modify the startup code
accordingly.

The entry point of the startup code (reset handler) is label START. This global label should not be removed, since the linker
uses it in the linker script file. It is also used as the default start address of the application.

Initialization code
The following initialization actions are executed before the application starts:
1. Load the 'real’ program address. This assures that the reset handler is immune for any ROM/RAM re-mapping.

2. Initialize the stack pointers for each processor mode. The stack pointers are loaded in memory by the stack address located
at a linker generate symbol (for example _1c_ub_stack). These symbols are defined in the linker script file. See section
5.3, Stack and Heap, for detailed information on the stack.

3. Call a user function which initializes hardware. The startup code calls the function __init hardware. This function has
an empty implementation in the run-time library, which you should change if certain hardware initializations, such as
ROM/RAM re-mapping or MMU configuration, are required before calling the main application.

4. Copy initialized sections from ROM to RAM, using a linker generated table (also known as the 'copy table’) and clear
uninitialized data sections in RAM.

5. Initialize or copy the vector table. The startup code calls the function __init vector_table. This function has a default
implementation in the run-time library, which copies the vector table from ROM to RAM if necessary. You should only change
it in very specific situations. For example, in case position dependent vectors are used (B instructions instead of LDR PC)
and the vector table must be generated in RAM (or copied from ROM to RAM with patched offsets in the B instructions).

6. Switch to the user-defined application mode as defined through the symbol APPLICATION MODE_ in the LSL file. This
symbol is used to set the value of the CPSR status register before calling the function main.

7. Load register r10 with the end of the user/system stack. This is needed in case stack overflow checking is enabled.
8. Switch to Thumb code if you specified compiler option --thumb.

9. Initialize profiling if profiling is enabled. For an extensive description of profiling refer to Chapter 4, Profiling, in the user’s
manual.

10. Initialize the argc and argv arguments to zero.

11. Call the entry point of your application with a call to function main ().
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EXxit code

When the C application 'returns’, which is not likely to happen in an embedded environment, the program ends with an endless
loop, at the assembly label _exit. When you use a debugger, it can be useful to set a breakpoint on this label to indicate that
the program has reached the end, or that the library function exit () has been called.

Macro Preprocessor Symbols

A number of macro preprocessor symbols are used in the startup code. These are enabled when you use a particular option or
you can enable or disable them using the linker command line option —-define with the following syntax:

--define=symbol[=value]

In the startup file (cstart.asmand cstart thumb2.asm) the following macro preprocessor symbols are used:

Define Description
__ PROF_ENABLE If defined, initialize profiling
__POSIX If defined, call posix_main instead of main

Table 5-1: Defines used in cstart.asm

The following table shows the linker labels and other labels used in the startup code.

Define Description

_START Start label, mentioned in LSL file (arm_arch.lsl)
_Next Real program address

main Start label user C program

exit Start label of exit() function

_exit exit() function returns to this place

_1c_ub stack User/system mode stack pointer
_lc_ue_stack End of stack symbol, required by debugger
_lc_ub_stack_und Undefined mode stack pointer (*)
_lc_ub_stack_svc Supervisor mode stack pointer (*)
_lc_ub_stack_abt Abort mode stack pointer (*)
_lc_ub_stack_irg IRQ mode stack pointer (*)
_1c_ub_stack_fiq FIQ mode stack pointer (*)

_1c_ub table ROM to RAM copy table
_APPLICATION_MODE_ Contains the processor mode, and the IRQ/FIQ
interrupts mode (*)

__init_hardware Start label of hardware initialization routine
__init vector table Start label of vector table initialization

Table 5-2: Labels used in cstart.asm and cstart_thumb2.asm

(*) The labels marked with a * are available in cstart.asmonly.

5.2 Reset Handler and Vector Table

Reset handler

As explained in the previous section the entry point of the startup code (reset handler) is label _START. The reset handler can
have a fixed ROM address (run address). If the reset handler is called from the vector table, you do not need the specify a fixed
address. In this case the linker determines the address and patches the vector table. There are however situations were you
have to specify a fixed ROM address:
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* If _START is the entry point upon reset. Typically you would set the ROM address to the address which is mapped at
address 0x00000000. Your initialization code re-maps this address during startup. Note that the reset handler in the
run-time library is immune to this re-mapping because the first instruction in the startup code sets the program counter to
the actual ROM address.

* When the reset handler is called from the vector table with a branch instruction (B _START) and the linker has located the
reset handler at an address that is out-of-range of the branch instruction. When you specify a fixed ROM address you can
make sure that the reset handler can be called from the vector table. Note however that you can prevent out-of-range
branches by using a position independent vector table, which loads the handler addresses into the program counter by
means of a PC-relative load from a literal pool.

To set a fixed ROM address in Altium Designer:
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Processor entry and select Startup code / Vector table.

3. Enter an address in the Force reset handler at ROM address field.

Vector table

The ROM address of the vector table is usually address 0x00000000. You have to specify an address if the vector table will be
copied from ROM to RAM (address 0x00000000 is mapped to RAM) or if the hardware uses high vectors at address
OxFFFF0000. If you forced the reset handler on address 0x00000000 then you also have to specify a vector table ROM address
to prevent overlapping address ranges:

* In the dialog as described above, enter an address in the Vector table ROM address field.
For M-profile architectures also specify the Number of vectors.

The vector table size for M-profile architectures is calculated as 4 times the number of vectors. The default number of vectors is
16, but you can specify another value.

The linker can generate a vector table for you:
* In the Startup code / Vector table page, enable the option Generate vector table in ROM.

You can ask the linker to reserve space in RAM memory for a copy of the vector table at run-time at a certain address in
memory. Typically this would be the address which will be the mapping of address 0x00000000 after ROM/RAM re-mapping. If
you reserve space for a copy you can also let the startup code copy the table automatically from ROM to RAM, but only if
position independent vectors are used.

* In the Startup code / Vector table page, enable the option Reserve space for copy in RAM and fill in the RAM address.
Optionally enable the option Copy vector table to RAM.

Refer to the run-time library implementation ofthe __init vector_ tableroutinein 1ib\src\initvectortable.asmor
initvectortable_ thumb.asmfor more information.

Vector table versions (all architectures except M-profile)
You can select between two versions of the vector table: position dependent or position independent.

The position dependent table contains branch instructions to the handlers. The handlers must be located in-range of the branch
instructions. The size of the table is 32 bytes.

The position independent table contains PC-relative load instructions of the PC. The handler addresses are in a literal pool
(data pocket) following the vector table. There are no range restrictions. The size of the table and pool together is 64 bytes. A
position independent table is recommended if the table is copied from ROM to RAM at run-time or if the ROM table is
re-mapped to address 0x00000000 after startup.

* In the Startup code / Vector table page, select the Vector type: position dependent or position independent.

If you selected a position dependent vector table it is possible to locate the FIQ handler directly at the FIQ vector, since the FIQ
vector is the last vector in the table. Doing so saves a branch instruction when servicing a fast interrupt. The generated vector
table or the space reserved for the table will be 28 bytes instead of 32. This option is not available for a position independent
vector table. Note that you need to use the __at () attribute to specify the actual position of the FIQ handler.

* In the Startup code / Vector table page, enable or disable the option Do not use FIQ vector.
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The linker will look for specific symbols designating the start of a handler function. These symbols are generated by the compiler
when one of the following function qualifiers is used:

Function type qualifier Vector symbol
___interrupt und _vector_1
___interrupt svc _vector_2
___interrupt iabt _vector_3
___interrupt dabt _vector 4
___interrupt irqg _vector_6
___interrupt fiq _vector 7

Table 5-3: Function qualifiers and vector symbols

Note that the reset handler is designated by the symbol _START instead of _vector_0. The fifth vector, with symbol
_vector_5 is reserved. You should use the same vector symbols in hand-coded assembly handlers. You may first want to
generate an idle handler in C with the compiler and than use the result as a starting point for your assembly implementation. If
the linker does not find the symbol for a handler, it will generate a loop for the corresponding vector, i.e. a jump to itself.

Note that if you have more than one handler for the same exception, for example for different IRQ’s or for different run-time
phases of your application, and you are using the __interrupt_type function qualifier of the compiler, you will need to
specify the _ novector attribute in order to prevent the compiler from generating the _vector_ nr symbol multiple times, as
this would lead to a link error.

Execution mode (all architectures except M-profile)

In Altium Designer you can define the execution mode in which the processor should run when your application’s main program
is called, together with the interrupt status (FIQ interrupts enabled/disabled, IRQ interrupts enabled/disabled). Based on these
settings the linker will generate a symbol (_ APPLICATION MODE_) which value is used in the startup code in the run-time
library to set the value of the CPSR status register before calling your main function.

* In the Startup code / Vector table page, select the Main application execution mode. Optionally enable or disable the
options Enable IRQ interrupts and Enable FIQ interrupts.

Preprocessor macros in arm_arch.lsl

The options you select in Altium Designer result in preprocessor macros that are used in the LSL file. Instead of using Altium
Designer you can also define the macros by using the linker option --define.

Define

Description

__START

Reset handler ROM address

_ PROCESSOR MODE

Main application execution mode

__IRQ BIT

Is 0 if IRQ interrupts enabled

__FIQ BIT

Is 0 if FIQ interrupts enabled

__ APPLICATION MODE

Contains the processor mode, and the IRQ/FIQ interrupts mode

__NO_AUTO_VECTORS

If defined, the vector table will not be generated

__NR_OF_VECTORS

Number of vectors for M-profile architectures (default 16)

__PIC_VECTORS

Defined if position independent vectors are used

__FIQ HANDLER_INLINE

Defined if you do not generate/reserve the FIQ vector

__VECTOR_TABLE ROM_ADDR

ROM address of the vector table

__ _VECTOR_TABLE_RAM SPACE

Defined if space must be reserved for a copy of the vector table in
RAM

___VECTOR_TABLE_RAM ADDR

RAM address of the copy of the vector table

__VECTOR_TABLE_RAM COPY

Defined if the linker should copy the vector table to RAM

Table 5-4: Defines used in arm_arch.ls/
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5.3 Stack and Heap

The stack is used for local automatic variables and function parameters. The following diagram shows the structure of a stack
frame.

high memory

incoming
parameters
stack -— Sp
grows down saved on entry
registers

local variables

outgoing
parameters

low memory <— SP
during execution

Figure 5-1: Stack diagram

The ARM hardware has separate stack pointers for each processor mode. These stack pointers should be initialized at
run-time. This is taken care of by the startup code in the run-time library, by means of linker-generated symbols defined in the
LSL file. See section 5.1, Startup Code, for a list of these symbols.

You can define the values of these symbols in Altium Designer as follows.
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Linker entry and select Stack/Heap.
3. Make your changes.

For the user stack (used in USR mode and in SYS mode) you can specify the size and the location, and you can tell the linker to
add unused memory to the stack. You can do the same for the heap. For the other stacks you can only specify their sizes. The
linker will determine their locations, and their sizes are fixed. If you want another stack to be the primary stack, for example the
supervisor stack, you need to change the LSL file.

The stack size is defined in the linker script file (arm_arch.1s1 in directory include.1s1) with macros:

Define Description

__STACK Size of user stack (used in USR mode and in SYS mode)
__STACK_FIQ FIQ mode stack size (*)

___STACK_IRQ IRQ mode stack size (*)

___STACK_SVC Supervisor mode stack size (*)

___STACK_ABT Abort mode stack size (*)

___STACK_UND Undefined mode stack size (¥)

__STACK_FIXED Defined if you do not expand the user stack if space is left
__STACKADDR User stack start address

Table 5-5: Stack macros used in arm_arch.lsl

(*) The defines marked with a * are not used for M-profile architectures.
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Heap allocation

The heap is only needed when you use one or more of the dynamic memory management library functions: malloc (),
calloc(), free() and realloc (). The heap is a reserved area in memory. Only if you use one of the memory allocation
functions listed above, the linker automatically allocates a heap, as specified in the linker script file with the keyword heap.

A special section called heap is used for the allocation of the heap area. The size of the heap is defined in the linker script file
(arm_arch.1sl in directory include.1s1) with the macro _ HEAP, which results in a section called heap. The linker defined
labels 1c_ub heapand 1lc_ue heap (begin and end of heap) are used by the library function sbrk (), which is called by
malloc () when memory is needed from the heap.

Define Description

__HEAP Size of heap

___HEAP_FIXED Defined if you do not expand the heap if space is left
___HEAPADDR Heap start address

Table 5-6: Heap macros used in arm_arch.lsl



6 Tool Options

Summary This chapter provides a detailed description of the options for the C compiler, C++
compiler, assembler, linker, control program, make program and the librarian.

6.1 C Compiler Options

Altium Designer uses a makefile to build your entire project. This means that in Altium Designer you cannot run the compiler
separately. If you compile a single C source file from within Altium Designer, the file is also assembled. However, you can set
options specific for the compiler.

Options in Altium Designer versus options on the command line

Most command line options have an equivalent option in Altium Designer but some options are only available on the command
line (for example in a Windows Command Prompt). If there is no equivalent option in Altium Designer, you can specify a
command line option in Altium Designer as follows:

1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.

3. Enter one or more command line options in the Additional C compiler options field.

Invocation syntax on the command line (Windows Command Prompt)
To call the compiler from the command line, use the following syntax:
carm [ [option]... [file]... 1.

The input file must be a C source file (.c or .ic).
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Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (=) character, long option
names always begin with double minus (--) characters. You can abbreviate long option names as long as the name is unique.
You can mix short and long option names on the command line.

Options can have flags or sub-options. To switch a flag ’on’, use a lowercase letter or a +longflag. To switch a flag off, use an
uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

carm -Oac test.c
carm --optimize=+coalesce,+cse test.c

When you do not specify an option, a default value may become active.
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C Compiler: —--align-composites

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Code Generation.

3. Select the Alignment of composite types: Natural alignment or Optimal alignment

Command line syntax
--align-composites=alignment
You can specify the following alignments:

n Natural alignment (default)
o Optimal alignment

Description
With this option you can set the alignment for composite types (structs, unions and arrays).
Natural alignment (n) uses the natural alignment of the most-aligned member of the composite type.

Optimal alignment (o) sets the alignment to 8, 16, or 32 bits depending on the size of the composite type.

Related information

ﬂj_
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C Compiler: --call (-m)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Code Generation.

3. Set the option Select call mode to Use 26-bit PC-relative calls (default) or
to Use 32-bit indirect calls.

Command line syntax

--call={far|near}
-m{f|n}

Description
To address the memory of the ARM, you can use two different call modes:

far 32-bit indirect calls. Though you can address the full range of memory, the address is first loaded into a register after
which the call is executed.

near 26-bit PC-relative call. The PC-relative call is directly coded into the B instruction. This way of calling results in higher
execution speed. However, not the full range of memory can be addressed with near calls.

@ If you compile your C source with near calls but the called address cannot be reached with a near call, the linker will
generate an error.

It is recommended to use the near addressing mode unless your application needs calls to addresses that fall outside a 256 MB
region.
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C Compiler: --cert

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select CERT C Secure Code Checking.
3. Make a selection from the CERT C secure code checking list.

4. If you select Custom configuration, expand the Custom Configuration entry and enable one or more individual
recommendations/rules.

Command line syntax

--cert={all | name[-name],...}

Description

With this option you can enable one or more checks for CERT C Secure Coding Standard recommendations/rules. When you
omit the argument, all checks are enabled. name is the name of a CERT recommendation/rule, consisting of three letters and
two digits. Specify only the three-letter mnemonic to select a whole category. For the list of names you can use, see Chapter 10,
CERT C Secure Coding Standard.

On the command line you can use --diag=cert to see a list of the available checks, or you can use a three-letter mnemonic to
list only the checks in a particular category. For example, —-diag=pre lists all supported preprocessor checks.

Example
To enable the check for CERT rule STR30-C, enter:

carm --cert=str30 test.c

Related information

% Chapter 10, CERT C Secure Coding Standard
C compiler option —-diag (Explanation of diagnostic messages)
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C Compiler: —--check

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option --check to the Additional C compiler options field.

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your
application because the code will not actually be compiled.

The compiler reports any warnings and/or errors.

Related information

% Assembler option --check (Check syntax)
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C Compiler: —--cpu (-C)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Processor entry and select Processor Definition.

3. Select a processor from the Select processor box.

Command line syntax

--cpu=[ARMv4|ARMv4T|ARMv5T|ARMv5TE|ARMv6M|ARMv7M|XS]
-C[ARMv4|ARMv4T|ARMv5T|ARMv5TE|ARMv6M|ARMv7M|XS]

Description

With this option you specify the ARM architecture for which you create your application. The ARM target supports more than one
architecture and therefore you need to specify for which architecture the compiler should compile. The architecture determines
which instructions are valid and which are not.

The effect of this option is that the compiler uses the appropriate instruction set. You choose one of the following architectures:
ARMv4, ARMv4T, ARMV5T, ARMV5TE, ARMv6-M, ARMv7-M Or XScale.

Example
To compile the file test.c for the ARMv4 processor type, enter the following on the command line:

carm --cpu=ARMv4 test.c

When you call the compiler from the command line, make sure you specify the same core type to the assembler to avoid
conflicts!

Related information

%_
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C Compiler: --debug-info (-g)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Debug Information.
3. Enable the option Generate symbolic debug information.

4. Enable or disable the suboptions.

Command line syntax
--debug-info[=suboption]
-g[suboption]

You can set the following suboptions (when you specify =g without suboption, the default is -gd):

small (1]¢) Emit small set of debug information.

default (2]d) Emit default symbolic debug information.

all (31]a) Emit full symbolic debug information.
Description

With this option you tell the compiler to add directives to the output file for including symbolic information. This facilitates high
level debugging but increases the size of the resulting assembler file (and thus the size of the object file). For the final
application, compile your C files without debug information.

When you specify a high optimization level, debug comfort may decrease. Therefore, the compiler issues a warning if the
chosen optimizations expect to affect ease of debugging.

Small set of debug information

With this suboption only DWARF call frame information and type information are generated. This enables you to inspect
parameters of nested functions. The type information improves debugging. You can perform a stack trace, but stepping is not
possible because debug information on function bodies is not generated. You can use this suboption, for example, to
compact libraries.

Default debug information

This provides all debug information you need to debug your application. It meets the debugging requirements in most cases
without resulting in over-sized assembler/object files.

Full debug information

With this information extra debug information is generated. In extra-ordinary cases you may use this debug information (for
instance, if you use your own debugger which makes use of this information). With this suboption, the resulting
assembler/object file increases significantly.

Related information

%_
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C Compiler: --define (-D)
Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
Expand the C Compiler entry and select Preprocessing.

2

3. Select User macro and click on the down arrow in the right pane to expand macro input.

4. Click on an empty Macro field and enter a macro name. (Then click an empty cell to confirm)
5

. Optionally, click in the Value field and enter a definition. (Then click an empty cell to confirm)

Command line syntax

--define=macro_name[=macro_definition]
-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro name (no macro
definition), the macro expands as ’1’. You can specify as many macros as you like.

On the command line, you can use the option —-define (-D) multiple times. If the command line exceeds the length limit of the
operating system, you can define the macros in an option file which you then must specify to the compiler with the option
--option-file=file (-f).

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional C source as shown in
the example below.

Example
Consider the following C program with conditional code to compile a demo program and a real program:

void main( void )

{
#if DEMO ==
demo_func(); /* compile for the demo program */
#else
real func(); /* compile for the real program */
#endif
}
You can now use a macro definition to set the DEMO flag:
Macro Value
DEMO 1 (or empty)

On the command line, use the option as follows:

carm --define=DEMO test.c
carm --define=DEMO=1 test.c

Note that both invocations have the same effect.

The next example shows how to specify a macro with arguments. Macro definitions follow exactly the same rules as the
#define statement in the C language.

Macro Value
MAX(A,B) ((A) > (B) 2 (A) : (B))
On the command line, use the option -D as follows:

carm -D"MAX(A,B)=((A) > (B) ? (A) : (B))” test.c



ARM Embedded Tools Reference

Note that the macro name and definition are placed between double quotes because otherwise the spaces would indicate a new
option.

Related information

C compiler option —--undefine (Undefine preprocessor macro)
C compiler option —-option-file (Read options from file)
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C Compiler: --dep-file

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option --dep-file to the Additional C compiler options field.
Command line syntax

--dep-file[=file]
Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In contrast to the option
--preprocess=+make (-Em), the dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension .d (one for every input file). When you specify a filename, all
dependencies will be combined in the specified file.

Example
carm --dep-file=test.dep test.c

The compiler compiles the file test.c, which results in the output file test.src, and generates dependency lines in the file
test.dep.

Related information

% C compiler option —--preprocess=+make (Generate dependencies for make)
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C Compiler: --diag

Menu entry

1. From the View menu, select Workspace » Panels » System Messages.
The Message pannel appears.

2. Inthe Message panel, right-click on the message you want more information on.
A popup menu appears.

3. Select More Info.

A Message Info box appears with additional information.

Command line syntax

--diag=[format:]{alljmsg[-msg],...}

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to
stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default).
To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given (except for the CERT checks). If you want the
description of one or more selected error messages, you can specify the error message numbers, separated by commas, or you
can specify a range.

With --diag=cert you can see a list of the available CERT checks, or you can use a three-letter mnemonic to list only the
checks in a particular category. For example, --diag=pre lists all supported preprocessor checks.

With this option the compiler does not compile any files.

Example

To display an explanation of message number 282, enter:
carm --diag=282

This results in the following message and explanation:
E282: unterminated comment

Make sure that every comment starting with /* has a matching */. Nested comments are not
possible.

To write an explanation of all errors and warnings in HTML format to file cerrors.html, use redirection and enter:

carm --diag=html:all > cerrors.html

Related information

% C compiler option —-cert (Enable individual CERT checks)
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C Compiler: —--endianness

Menu entry
1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Processor entry and select Processor Definition.

3. Enable the option Big-endian mode.

Command line syntax
--endianness=endianness

-B
--big-endian

You can specify the following endianness:

big (b) Big endian
little (1) Little endian (default)
Description

By default, the compiler generates code for a little-endian target (least significant byte of a word at lowest byte address). With
--endianness=big the compiler generates code for a big-endian target (most significant byte of a word at lowest byte

address). =B is an alias for option —--endianness=big.

Related information

ﬂj_
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C Compiler: —-error-file

Menu entry

Command line only.
Command line syntax
--error-file[=file]

Description

With this option the compiler redirects error messages to a file.

If you do not specify a filename, the error file will be named after the input file with extension .err.
Example

To write errors to errors.err instead of stderr, enter:

carm --error-file=errors.err test.c

Related information

ﬂﬁ'
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C Compiler: --fpu

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Floating-Point.

3. Select an option from the Floating-point unit (FPU) support field.

Command line syntax
--fpu=fpu
You can specify the following arguments:

VFPv2  Compile for VFPv2 architecture
VFPv3  Compile for VFPv3 architecture
none Compile for software FPU library

Description

With this option you define the kind of FPU support with which you create your application.

Related information

ﬂﬁ'
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C Compiler: --global-type-checking

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C Compiler entry and select Diagnostics.

3. Enable the option Perform global type checking on C code.

Command line syntax

--global-type-checking

Description

The C compiler already performs type checking within each module. Use this option when you want the linker to perform type
checking between modules.

Related information

ﬂi'
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C Compiler: --help (-?)

Menu entry
Command line only.

Command line syntax

--help[=item,...]
-?

You can specify the following arguments:

intrinsics (i) Show the list of intrinsic functions

options (0) Show extended option descriptions

pragmas (p) Show the list of supported pragmas

typedefs ® Show the list of predefined typedefs
Description

Displays an overview of all command line options. With an argument you can specify which extended information is shown.

Example

The following invocations all display a list of the available command line options:

carm -?
carm --help
carm

The following invocation displays a list of the available pragmas:

carm --help=pragmas
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C Compiler: --include-directory (-I)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Select Build Options.

3. Add a pathname in the Include files path field.

If you enter multiple paths, separate them with a semicolon (;).

Command line syntax
--include-directory=path,...
=lpath,...

Description

With this option you can specify the path where your include files are located. A relative path will be relative to the current
directory.

The order in which the compiler searches for include files is:

1. The pathname in the C source file and the directory of the C source
(only for #include files that are enclosed in ™).

2. The path that is specified with this option.
3. The path that is specified in the environment variable CARMINCwhen the product was installed.
4. The default include directory relative to the installation directory
(unless you specified option —-no-stdinc).
Example
Suppose that the C source file test . c contains the following lines:

#include <stdio.h>
#include "myinc.h”

You can specify the include directory myinclude to the C compiler:
carm --include-directory=myinclude test.c

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory. If it was not found, the
compiler searches in the environment variable and then in the default include directory.

The compiler now looks for the file myinc.h, in the directory where test.c is located. If the file is not there the compiler
searches in the directory myinclude. If it was still not found, the compiler searches in the environment variable and then in the
default include directory.

Related information

C compiler option —-include-file (Include file at the start of a compilation)
C compiler option --no-stdinc (Skip standard include files directory)
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C Compiler: --include-file (-H)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Preprocessing.

3. Enter the name of the file in the Include this file before source field or click ... and select a file.

Command line syntax

--include-file=file,...
-Hfile,...

Description

With this option (set at project level) you include one extra file at the beginning of each C source file in your project. On a
document level (Project » Document Options), you can overrule this option with another file or no file at all.

The specified include file is included before all other includes. This is the same as specifying #include ”file" atthe very
beginning of (each of) your C source files.

Example
carm --include-file=stdio.h testl.c test2.c

The file stdio.his included at the beginning of both testl.c and test2.c.

Related information

% C compiler option =-include-directory (Add directory to include file search path)

Section 2.4, How the Compiler Searches Include Files, in chapter Using the Compiler of the user’s manual.
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C Compiler: —-inline

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Optimization.

3. Enable the option Always inline function calls.
Command line syntax
--inline

Description

With this option you instruct the compiler to inline calls to functions without the __noinline function qualifier whenever
possible. This option has the same effect as a #pragma inline at the start of the source file.

Related information

ﬂi'
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C Compiler: —-inline-max-incr / —--inline-max-size

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Optimization.
3. Set the option Maximum code size increase caused by inlining to a value.

4. Set the option Maximum size for functions to always inline to a value.

Command line syntax
--inline-max-incr=percentage  (Default: -1)
--inline-max-size=threshold (Default: -1)
Description
With these options you can control the automatic function inlining optimization process of the compiler. These options have only
effect when you have enabled the inlining optimization (option -Oi).
Regardless of the optimization process, the compiler always inlines all functions that have the function qualifier inline.

With the option --inline-max-size you can specify the maximum size of functions that the compiler inlines as part of the
optimization process. The compiler always inlines all functions that are smaller than the specified threshold. The threshold is
measured in compiler internal units and the compiler uses this measure to decide which functions are small enough to inline.
The default threshold is -1, which means that the threshold depends on the option —-tradeoff.

After the compiler has inlined all functions that have the function qualifier inline and all functions that are smaller than the
specified threshold, the compiler looks whether it can inline more functions without increasing the code size too much. With the
option --inline-max-incr you can specify how much the code size is allowed to increase. The default value is -1, which
means that the value depends on the option --tradeoff.

Example
carm --inline-max-incr=40 --inline-max-size=15 test.c

The compiler first inlines all functions with the function qualifier inline and all functions that are smaller than the specified
threshold of 15. If the code size has still not increased with 40%, the compiler decides which other functions it can inline.

Related information

% C compiler option —-optimize=+inline (Optimization: automatic function inlining)
Section 1.8.3, Inlining Functions, in chapter C Language.

Section 2.6.3, Optimize for Size or Speed, in chapter Using the Compiler of the user’s manual.
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C Compiler: —-interwork

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Code Generation.

3. Enable the option Compile for ARM-Thumb interworking.

Command line syntax

—--interwork

Description
With this option the compiler generates code which supports calls between functions with the ARM and Thumb instruction set.
Use this option if your program consists of both ARM and Thumb functions.

By default this option is disabled, since it produces slightly larger code.

Related information

% C compiler option —-thumb (use Thumb instruction set)
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C Compiler: —-iso (-c)

Menu entry
1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Language.

3. Select the ISO C standard C90 or C99.

Command line syntax

--is0={90|99}
-c{90|99}

Description

With this option you select the ISO C standard. The compiler checks the C source against this standard and may generate

warnings or errors if you use C language that is not defined in the standard.

C90 is also referred to as the "ANSI C standard”. C99 refers to the newer ISO/IEC 9899:1999 (E) standard. C99 is the default.

carm --iso=90 test.c

Related information

% C compiler option --language (Language extensions)
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C Compiler: --keep-output-files (-k)

Menu entry
Altium Designer always removes the . src file when errors occur during compilation.

Command line syntax

--keep-output-files
-k

Description

If an error occurs during compilation, the resulting . src file may be incomplete or incorrect. With this option you keep the
generated output file (. src) when an error occurs.

By default the compiler removes the generated output file (. src) when an error occurs. This is useful when you use the make
utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to inspect the generated assembly source. Even if it is incomplete or incorrect.

Related information

ﬂﬁ'
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C Compiler: --language (-A)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C Compiler entry and select Language.

3. Enable or disable the following options:

* Allow GNU C extensions

e Allow C++ style comments in ISO C90 mode (only available when ISO C 90 is selected)
* Check assignment of string literal to non-const string pointer

* Allow optimization across volatile access

Command line syntax

--language=[flags]
-Al[flags]

You can set the following flags:

+/-gcc (9/G) Enable a number of gcc extensions
+/-comments (p/P) Allow C++ style comments in C source code
+/-volatile (v/V) Do not optimize across volatile access
+/-strings (x/X) Relaxed const check for string literals

The option —-language (-A\) is the equivalent of ~AGPVX which disables all language extensions.
The default is ~AGpVx.

Description

With this option you control the language extensions the compiler accepts. Default the C compiler allows all language
extensions.

With Allow C++ style comments in ISO C90 mode (--language=+comments), you tell the compiler to allow C++ style
comments (//) in ISO C90 mode (option —¢90). In ISO C99 mode this style of comments is always accepted.

With Check assignment of string literal to non-const string pointer (--language=-strings) you tell the compiler to
generate a warning when you assign a constant string to a non-constant string pointer. When you disable this option the
following example produces no warning:

char *p;
void main( void ) { p = "hello”; }

With option Allow GNU C extensions (--language=+gcc) you tell the compiler to enable the following gcc languages
extensions:

e The identifier __ FUNCTION__ expands to the current function name
* Alternative syntax for variadic macros

* Alternative syntax for designated initializers

* Allow zero sized arrays

* Allow empty struct/union

* Allow empty initializer list

* Allow initialization of static objects by compound literals

* The middle operand of a ? : operator may be omitted

* Allow a compound statement inside braces as expression

* Allow arithmetic on void pointers and function pointers

* Allow a range of values after a single case label

* Additional preprocessor directive #warning

* Allow comma operator, conditional operator and cast as Ivalue

* Aninline function without "static” or “extern” will be global
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* An’extern inline” function will not be compiled on its own
* An __ attribute__ directly following a struct/union definition relates to that tag instead of to the objects in the declaration.

For an exact description of these gcc extensions, please refer to the gcc info pages (info gcc).

When you disable the option Allow optimization across volatile access (with --language=+volatile), you tell the compiler to
block optimizations when reading or writing a volatile object, by treating the access as a call to an unknown function. This way
you can prevent for example that code below the volatile object is optimized away to somewhere above the volatile object.

Example:
extern unsigned int variable;

extern volatile unsigned int access;

void TestFunc( unsigned int flag )

{
access = 0;
variable |= flag;
if( variable == 3 )
{

variable = 0;

}
variable |= 0x8000;
access = 1;

}

Result with --language=-volatile (default):

TestFunc: .type func
str lr,[sp,#-4]!
ldr rl,.L3
1dr lr, .L3+4
1ldr r2,[rl,#0] ; <== Moved across volatile access
mov r3,#0
orr r0,r2,r0
cmp r0,#3
str r3,[1lr,#0] ; <== Volatile access
bne L2
mov r0,r3

LL2:
orr r0,r0,#32768
mov r2,#1
str r2,[1lr,#0] ; <== Volatile access
str r0,[rl,#0] ; <== Moved across volatile access
1ldr pc, [spl,#4
.size TestFunc, $-TestFunc
.align 4

.L3:
.dw variable
.dw access
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Result with --language=+volatile:

TestFunc: .type func
str lr,[sp,#-4]!
1dr r3,.L3
1ldr r2,.L3+4
1dr 1r,[r3,#0]
mov rl,#0
orr r0,1lr,r0
cmp r0,#3
str rl,[r2,#0] ; <== Volatile access
str r0,[r3,#0]
bne L2
str rl,[r3,#0]

.L2:
1dr r0,[r3,#0]
orr r0,r0,#32768
str r0,[r3,#0]
mov r0,#1
str r0,[r2,#0] ; <== Volatile access
1dr pc, [sp],#4
.size TestFunc, $-TestFunc
.align 4

.L3:
.dw variable
.dw access

Example

carm -AGPx -c90 test.c
carm --language=-ggc,-comments,+strings --iso=90 test.c

% C compiler option --iso (ISO C standard)
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C Compiler: --make-target

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.
3. Add the option --make-target to the Additional C compiler options field.
Command line syntax
--make-target=name
Description

With this option you can overrule the default target name in the make dependencies generated by the options
--preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input file, with extension . obj.

Related information

% C compiler option —-preprocess=+make (Generate dependencies for make)
C compiler option —-dep-file (Generate dependencies in a file)
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C Compiler: —-mil / —-mil-split

Menu entry

Command line only.

Command line syntax
--mil

—-mil-split[=file,..]

Description

With option —-mil the C compiler skips the code generator phase and writes the optimized intermediate representation (MIL) to
a file with the suffix .mi1. The C compiler accepts .mil files as input files on the command line.

Option --mil-split does the same as option --mil, but in addition, the C compiler splits the MIL representation and writes it to
separate files with suffix .ms. One file is written for each input file or MIL library specified on the command line. The .ms files
are only updated on a change. The C compiler accepts .ms files as input files on the command line.

With option --mil-split you can perform application-wide optimizations during the frontend phase by specifying all modules at
once, and still invoke the backend phase one module at a time to reduce the total compilation time.

Optionally, you can specify another filename for the .ms file the C compiler generates. Without an argument, the basename of
the C source file is used to create the .ms filename. Note that if you specify a flename, you have to specify one filename for
every input file.

Related information

% Control program option —-mil-link / —-mil-split
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C Compiler: —--misrac

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select MISRA-C.
3. Inthe MISRA-C checking box select a MISRA-C configuration.
If you select Custom MISRA-C configuration:
4. Inthe left pane, expand the MISRA-C entry and select Custom 2004 or Custom 1998.

5. Enable or disable the individual rules.
Command line syntax
--misrac={alljnumber[-number],... }

Description

With this option you specify to the compiler which MISRA-C rules must be checked. With the option --misrac=all the compiler
checks for all supported MISRA-C rules.

Example
carm --misrac=9-13 test.c

The compiler generates an error for each MISRA-C rule 9, 10, 11, 12 or 13 violation in file test.c.

Related information

% C compiler option --misrac-advisory-warnings
C compiler option —-misrac-required-warnings

Linker option --misrac-report
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C Compiler: --misrac-advisory-warnings / --misrac-required-warnings

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select MISRA-C.
3. Enable one or both options Turn advisory rule violation into warning and Turn required rule violation into warning.
Command line syntax
--misrac-advisory-warnings
--misrac-required-warnings
Description

Normally, if an advisory rule or required rule is violated, the compiler generates an error. As a consequence, no output file is
generated. With this option, the compiler generates a warning instead of an error.

Related information

% C compiler option —=-misrac

Linker option --misrac-report
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C Compiler: —-misrac-version

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog appears.

2. Expand the C Compiler entry and select MISRA-C.

3. Select the MISRA-C standard: 1998 or 2004.

Command line syntax
--misrac-version={1998|2004}

Description

MISRA-C rules exist in two versions: MISRA-C:1998 and MISRA-C:2004. By default, the C source is checked against the
MISRA-C:2004 rules. With this option you can specify to check against the MISRA-C:1998 rules.

Related information

% See Chapter 11, MISRA-C Rules, for a list of all supported MISRA-C rules.

C compiler option —=-misrac
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C Compiler: --no-double (-F)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Floating-Point.

3. Enable the option Use single precision floating-point only.

Command line syntax
--no-double

-F

Description

With this option you tell the compiler to treat variables of the type double as float. Because the float type takes less space,
execution speed increases and code size decreases, both at the cost of less precision.

Related information

ﬂﬁ'
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C Compiler: --no-stdinc

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.
3. Add the option --no-stdinc to the Additional C compiler options field.
Command line syntax
--no-stdinc
Description

With this option you tell the compiler not to look in the default include directory relative to the installation directory, when
searching for include files. This way the compiler only searches in the include file search paths you specified.

Related information

% C compiler option —-include-directory (Add directory to include file search path)
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C Compiler: -—no-warnings (-w)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Diagnostics.

3. Inthe Error reporting field, select one of the following options:

* Report all warnings
* Suppress all warnings
e Suppress specific warningsn

If you select Suppress specific warnings:

4. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress.

Command line syntax

--no-warnings[=number[-number],...]
-w[number[-number],...]

Description
With this option you can suppress all warning messages or specific warning messages.

On the command line this option works as follows:

* If you do not specify this option, all warnings are reported.
* If you specify this option but without numbers, all warnings are suppressed.

* If you specify this option with a number or a range, only the specified warning is suppressed.
You can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter 135, 136 in the Specific warnings to suppress field, or enter the following on the
command line:

carm test.c --no-warnings=135,136

Related information

% C compiler option —-warnings-as-errors (Treat warnings as errors)
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C Compiler: --optimize (-0)

Menu entry

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

. Expand the C Compiler entry and select Optimization.

If you select Custom Optimization, enable or disable the optimizations you want.

2
3. Select an optimization level in the Optimization level box.
4
5

In addition, in the Size/speed trade-off field, select a level between fully optimize for size or fully optimize for speed.

Command line syntax

--optimize[=flags]

No optimization
Alias for: -OaBCEFGIKLOPSUY

Few optimizations
Alias for: -OabcefglKLOPSUy

Medium optimization (default)
Alias for: -OabcefglklopsUy

-Offlags]
Use the following options for predefined sets of flags:
—--optimize=0 (-00)
--optimize=1 (-01)
--optimize=2 (-02)
—-optimize=3 (-03)

Full optimization
Alias for: -Oabcefgiklopsuy

You can enable the following individual optimizations:

+/-coalesce (a/A)
+/-ipro (b/B)
+/-cse (c/C)
+/-expression (e/E)
+/-flow (f/F)
+/-glo (9/G)
+/-inline (i/m)
+/-schedule (k/K)
+/-loop (I/L)
+/-forward (0/0O)
+/-propagate (p/P)
+/-subscript (s/S)
+/-unroll (u/U)
+/-peephole (y/Y)

Coalescer (remove unnecessary moves)
Interprocedural Register Optimization
Common subexpression elimination (CSE)
Expression simplification

Control flow simplification (optimization and code reordering)
Generic assembly code optimizations
Function inlining

Instruction scheduler

Loop transformations

Forward store

Constant propagation

Subscript strength reduction

Unroll small loops

Peephole optimizations

For an extensive description of these optimizations, please refer to section 2.6, Compiler Optimizations in chapter Using the

Compiler of the user’s manual.

Description

The TASKING C compilers offer four optimization levels and a custom level, at each level a specific set of optimizations is

enabled.

* No optimization (-00): No optimizations are performed except for the coalescer (to allow better debug information). The
compiler tries to achieve a 1-to-1 resemblance between source code and produced code. Expressions are evaluated in the
order written in the source code, associative and commutative properties are not used.

* Few optimizations (-O1): Enables optimizations that do not affect the debug-ability of the source code. Use this level when
you encounter problems during debugging your source code with optimization level 2.

* Medium optimization (-02): Enables more optimizations to reduce code size and/or execution time. This is the default

optimization level.
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* Full optimization (-03): This is the highest optimization level. Use this level to decrease execution time to meet your
real-time requirements.

e Custom optimization (-Ox/X): you can enable/disable specific optimizations.

With these options you can control the level of optimization. The default optimization level is Medium optimization (option -02
or -0 or -OabcefglklopsUy).

You can overrule these settings in your C source file with the pragma pair #pragma optimize flag and #pragma
endoptimize.

@ In addition to the command line option --optimize (-0), you can specify the option —-tradeoff (-t). With this option you
specify whether the used optimizations should optimize for more speed (regardless of code size) or for smaller code size
(regardless of speed).

Example
The following invocations are equivalent and result all in the default optimization set:

carm test.c

carm -02 test.c

carm --optimize=2 test.c

carm -0 test.c

carm --optimize test.c

carm -OabcefgIklopsUy test.c

carm --optimize=+coalesce,+ipro,+cse,+expression,+flow,+glo,
-inline,+schedule,+loop,+forward, +propagate, +subscript,
-unroll, +peephole test.c

Related information

% Section 2.6, Compiler Optimizations, in chapter Using the Compiler of the user’s manual.
C compiler option --tradeoff (-t) (Trade off between speed (-t0) and size (-t4))

6-37



ARM Embedded Tools Reference

C Compiler: --option-file (-f)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.
3. Add the option --option-file to the Additional C compiler options field.
Be aware that the options in the option file are added to the C compiler options you have set in the other dialogs. Only in
extraordinary cases you may want to use them in combination. Altium Designer automatically saves the options with your
project.
Command line syntax
--option-file=file,...
~f file,...
Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an
option file which contains all options and flags you want to specify. With this option you specify the option file to the compiler.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

You can specify the option —-option-file multiple times.

Format of an option file

e Multiple arguments on one line in the option file are allowed.
* To include whitespace in an argument, surround the argument with single or double quotes.
* |f you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded”
'This has a double quote ” embedded’

'This has a double quote ” and a single quote ’'”’ embedded”
*  When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line”

-> "This is a continuation line”
* ltis possible to nest command line files up to 25 levels.
Example
Suppose the file myoptions contains the following lines:
-9
-DDEMO=1
test.c
Specify the option file to the C compiler:
carm --option-file=myoptions
This is equivalent to the following command line:

carm -g -DDEMO=1 test.c

Related information

$_
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C Compiler: —-output (-0)

Menu entry

Altium Designer names the output file always after the C source file.

Command line syntax

—--output=file
-o file

Description

With this option you can specify another filename for the output file of the compiler. Without this option the basename of the C
source file is used with extension .src.

Example
To create the file output.src instead of test.src, enter:

carm --output=output.src test.c

Related information

ﬂﬁ'
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C Compiler: --preprocess (~E)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Preprocessing.

3. Enable the option Store the C Compiler preprocess output (<file>.pre).

Command line syntax

--preprocess[=flags]
-E[flags]

You can set the following flags (when you specify -E without flags, the default is ~=ECILMP):

+/-comments (c/C) Keep comments from the C source in the preprocessed output
+/-includes (i/l) Generate a list of included source files

+/-list (/L) Generate a list of macro definitions

+/-make (m/M) Generate dependency lines that can be used for the makefile
+/-noline (p/P) Strip #line source position info (lines starting with #1ine)

The compiler sends the preprocessed file to stdout. To capture the information in a file, specify an output file with the option
--output.

Description

When compiling, each file is preprocessed first. With this option you can store the result of preprocessed C files. Altium
Designer stores the preprocessed file in a file called name.pre (where name is the name of the C source file being compiled). C
comments are not preserved (similar to ~ECILMP)

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file in the preprocessed
output.

With --preprocess=+includes the compiler will generate a list of all included source files. The preprocessor output is
discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions. The preprocessor output is discarded.

With --preprocess=+make the compiler will generate dependency lines that can be used in a Makefile. The preprocessor
output is discarded. The default target name is the basename of the input file, with the extension . obj. With the option
--make-target you can specify a target name which overrules the default target name.

With --preprocess=+noline you tell the preprocessor to strip the #line source position information (lines starting with #1ine).
These lines are normally processed by the assembler and not needed in the preprocessed output. When you leave these lines
out, the output is easier to read.

Related information

% C compiler option --make-target (Specify target name for -Em output)
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C Compiler: --profile (-p)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Debug Information.
3. Enable the option Generate profiling information.

4. Enable one or more of the following suboptions to select which profiles should be obtained:

* Block counters (not in combination with with Call graph or Function timers)
e Call graph

* Function counters

* Function timers

@ Note that the more detailled information you request, the larger the overhead in terms of execution time, code size and
heap space needed. The option Generate Debug information (--debug or -g) does not affect profiling, execution time
or code size.

Command line syntax
--profile[=flags]
-plflags]
Use the following option for a predefined set of flags:

--profile=g (-p9) profiling with call graph and function timers
Alias for: -pBcFt

You can set the following flags (when you specify -p without flags, the default is -pBCfST):

+/-block (b/B) block counters

+/-callgraph (c/C) call graph

+/-function (f/F) function counters

+/-static (s/S) static profile generation

+/-time 1) function timers
Description

Profiling is the process of collecting statistical data about a running application. With these data you can analyze which functions
are called, how often they are called and what their execution time is.

Several methods of profiling exist. One method is code instrumentation which adds code to your application that takes care of
the profiling process when the application is executed.

% For an extensive description of profiling refer to Chapter 4, Profiling, in the user’s manual.

With this option, the compiler adds the extra code to your application that takes care of the profiling process. You can obtain the
following profiling data (see flags above):

Block counters (not in combination with Call graph or Function timers)

This will instrument the code to perform basic block counting. As the program runs, it counts the number of executions of
each branch in an if statement, each iteration of a for loop, and so on. Note that though you can combine Block counters
with Function counters, this has no effect because Function counters is only a subset of Block counters.

Call graph (not in combination with Block counters)

This will instrument the code to reconstruct the run-time call graph. As the program runs it associates the caller with the
gathered profiling data.

6-41



ARM Embedded Tools Reference

Function counters
This will instrument the code to perform function call counting. This is a subset of the basic Block counters.
Function timers (not in combination with Block counters/Function counters)

This will instrument the code to measure the time spent in a function. This includes the time spent in all sub functions
(callees).

Static profiling

With this option you do not need to run the application to get profiling results. The compiler generates profiling information at
compile time.

@ If you use the profiling option, you must link the corresponding libraries too! Refer to Section 6.4, Linking with Libraries in
Chapter Using the Linker of the user’s manual, for an overview of the (profiling) libraries. When you use Altium Designer,
automatically the correct libraries are linked.

Example
carm --profile=+block test.c
In this case you must link the library pbarm.1ib.

Related information

dlj Chapter 4, Profiling in the user’s manual.
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C Compiler: --rename-sections (-R)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option --rename-sections to the Additional C compiler options field.

Command line syntax

--rename-sections=[name]={suffix|-f|-m|-fm}
-R[name]={suffix|-f|-m|-fm}

Description

In case a module must be loaded at a fixed address, or a data section needs a special place in memory, you can use this option
to generate different section names. You can then use this unique section name in the linker script file for locating. Because
sections have reserved names, the compiler will not actually change the section name, but will add a suffix to the name.

With the section name you select which sections are renamed. With suffix you specify the suffix part which will be attached to
the existing name. The following name values have special meaning:

With the suboption -f, the compiler uses the function name (only for code).
With the suboption -m, the compiler uses the name of the current module.

With the suboption -fm (or -mf), the compiler uses the name of the current module for data sections and the function name for
code sections.

If you do not specify a section name, all sections will receive the specified suffix.
carm --rename-sections=.data=NEW test.c
To add the name of the current module name as suffix to all data sections, resulting in .data.test):

carm --rename-sections=.data=-m test.c

% Assembler directive .SECTION
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C Compiler: --runtime (-r)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Debug Information.
3. Enable the option Run-time checks.

4. Enable one or more of the following suboptions to select which run-time checks should be performed:
* Bounds checking
* Report unhandled case in a switch
* Malloc consistency checks
* Stack overflow check
* Division by zero check

Command line syntax

--runtime[=flags]
-r[flags]

You can set the following flags (when you specify -r without flags, the default is -rbem):

+/-bounds (b/B) bounds checking

+/-case (c/C) report unhandled case in a switch
+/-malloc (m/M) malloc consistency checks
+/-stack (s/S) check for stack overflow

+/-zero (z/2) check for divide by zero
Description

This option controls a number of run-time checks to detect errors during program execution. Some of these checks require
additional code to be inserted in the original application code, and may therefore slow down the program execution. The
following checks are available:

Bounds checking

Every pointer update and dereference will be checked to detect out-of-bounds accesses, null pointers and uninitialized
automatic pointer variables. This check will increase the code size and slow down the program considerably. In addition, some
heap memory is allocated to store the bounds information. You may enable bounds checking for individual modules or even
parts of modules only (see #pragma runtime).

Report unhandled case in a switch

Report an unhandled case value in a switch without a default part. This check will add one function call to every switch without a
default part, but it will have little impact on the excution speed.

Malloc consistency checks

This option enables the use of wrappers around the functions malloc/realloc/free that will check for common dynamic memory
allocation errors like:

* buffer overflow

e write to freed memory

* multiple calls to free

e passing invalid pointer to free
Enabling this check will extract some additional code from the library, but it will not enlarge your application code. The dynamic
memory usage will increase by a couple of bytes per allocation.
Stack overflow check

The compiler generates extra code within the function prolog that will check the available stack size before allocating. This is
only useful when the processor runs in USR or SYS mode.
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Division by zero check

The compiler generates a call to specific run-time functions for additional division by zero checks. If this situation occurs, an
abort signal is issued. Without this check, a division by zero could lead to unpredictable results.

Related information

ﬂi'
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C Compiler: --signed-bitfields

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C Compiler entry and select Language.

3. Enable the option Treat ’int’ bit-fields as signed.
Command line syntax
--signed-bitfields

Description

For bit-fields it depends on the implementation whether a plain int is treated as signed int orunsigned int. By
default an int bit-field is treated as unsigned int. This offers the best performance. With this option you tell the compiler
to treat int bit-fields as signed int. In this case, you can still add the keyword unsigned to treat a particular int
bit-field as unsigned.

Related information

ﬂﬁ'
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C Compiler: --silicon-bug

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option --silicon-bug to the Additional C compiler options field.

Command line syntax
--silicon-bug[=arg,...]
You can give the following argument:

602117 workaround for 602117

Description

With this option you tell the compiler to use software workarounds for some CPU functional problems.

If you do not specify an argument, then all silicon bug workarounds are enabled.

Related information

ﬂs_
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C Compiler: —--source (-s)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.
3. Enable the option Merge C source code with assembly in output file (.src).
Command line syntax

--source
-S

Description

With this option you tell the compiler to merge C source code with generated assembly code in the output file. The C source
lines are included as comments.

Related information

ﬂﬁ'

6-48



Tool Options - C Compiler

C Compiler: —-static

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.
3. Add the option --static to the Additional C compiler options field.
Command line syntax

--static

Description

With this option, the compiler treats external definitions at file scope (except for main) as if they were declared static. As a
result, unused functions will be eliminated, and the alias checking algorithm assumes that objects with static storage cannot be
referenced from functions outside the current module.

@ On the command line this option only makes sense when you specify all modules of an application on the command line.

Example

carm --static modulel.c module2.c module3.c ...

Related information

ﬂj_
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C Compiler: --stdout (-n)

Menu entry

Command line only.

Command line syntax

--stdout
-n

Description

With this option you tell the compiler to send the output to stdout (usually your screen). No files are created. This option is for
example useful to quickly inspect the output or to redirect the output to other tools.

Related information

ﬂ@‘
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C Compiler: —-thumb

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Code Generation.

3. Enable the option Generate Thumb code.

Command line syntax

—-thumb

Description

With this option you tell the compiler to generate 16-bit thumb instructions.

Related information

% C compiler option --interwork (Generate interworking code)
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C Compiler: —-tradeoff (-t)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Optimization.
3. Inthe Size/speed trade-off field, select a level between fully optimize for size or fully optimize for speed.
Command line syntax

--tradeoff={0|1|2|3|4}
-10[12|3|4}

Description

If the compiler uses certain optimizations (option —-optimize), you can use this option to specify whether the used optimizations
should optimize for more speed (regardless of code size) or for smaller code size (regardless of speed).

By default the compiler optimizes for more speed (--tradeoff=0).

@ If you have not used the option --optimize, the compiler uses the default optimization. In this case it is still useful to
specify a trade-off level.

Related information

% C compiler option —--optimize (Specify optimization level)
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C Compiler: --uchar (-u)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C Compiler entry and select Language.

3. Enable the option Treat ’char’ variables as unsigned.

Command line syntax

—-uchar
-u

Description

By default char is the same as specifying signed char. With this option char is the same as unsigned char.

Related information

ﬂi'
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C Compiler: —--unaligned-access

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option --unaligned-access to the Additional C compiler options field.

Command line syntax
--unaligned-access
Description

With this option you tell the compiler to generate more efficient instructions to access unaligned 16-bit or larger data. Halfword
or word load and store instructions are used instead of byte instructions.

This option is only useful for cores that have support for unaligned access.

Related information

ﬂﬁ'
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C Compiler: —-undefine (-U)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.

3. Add the option --undefine to the Additional C compiler options field.

Command line syntax

--undefine=macro_name
-Umacro_name

Description
With this option you can undefine an earlier defined macro as with #undef.

This option is for example useful to undefine predefined macros.

However, the following predefined ISO C standard macros cannot be undefined:

__FILE__ current source filename
__LINE__  current source line number (int type)
__TIME__  hh:mm:ss

__DATE__  mmm dd yyyy
__STDC__  level of ANSI standard

Example
To undefine the predefined macro _ TASKING__:

carm --undefine= TASKING__ test.c

Related information

% C compiler option —-define (Define preprocessor macro)
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C Compiler: --version (-V)
Menu entry
Command line only.

Command line syntax

--version
'

Description
Displays version information of the compiler. The compiler ignores all other options or input files.

Related information

ﬂ?‘
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C Compiler: --warnings-as-errors

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C Compiler entry and select Diagnostics.

3. Inthe Treat warnings as errors. field, select None, Treat all warnings as errors or Treat specific warnings as errors.
If you select Treat specific warnings as errors:

4. Enter the numbers, separated by commas or as a range, of the warnings you want to treat as errors.

Command line syntax

--warnings-as-errors[=number[-number],...]

Description

If the compiler encounters an error, it stops compiling. When you use this option without arguments, you tell the compiler to treat
all warnings as errors. This means that the exit status of the compiler will be non-zero after one or more compiler warnings. As
a consequence, the compiler now also stops after encountering a warning.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers or ranges.

Related information

% C compiler option --no-warnings (Suppress some or all warnings)
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6.2 C++ Compiler Options

Altium Designer uses a makefile to build your entire project. This means that in Altium Designer you cannot run the C++
compiler separately. If you compile a single C++ source file from within Altium Designer, the file is also compiled and assembled.
However, you can set options specific for the C++ compiler.

Options in Altium Designer versus options on the command line

Most command line options have an equivalent option in Altium Designer but some options are only available on the command
line (for example in a Windows Command Prompt). If there is no equivalent option in Altium Designer, you can specify a
command line option in Altium Designer as follows:

1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Enter one or more command line options in the Additional C++ compiler options field.

Invocation syntax on the command line (Windows Command Prompt)
To call the C++ compiler from the command line, use the following syntax:
cparm [ [option]... [file]... J...

The input file must be a C++ source file (.cc, .cxx or .cpp).

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (=) character, long option
names always begin with double minus (--) characters. You can abbreviate long option names as long as the name is unique.
You can mix short and long option names on the command line.

If a long option requires an argument, the argument may be separated from the keyword by white space, or the keyword may be
immediately followed by =option. When the second form is used there may not be any white space on either side of the equal
sign.

Options can have flags or sub-options. To switch a flag 'on’, use a lowercase letter or a +longflag. To switch a flag off, use an
uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

cparm -Ecp test.cc
cparm --preprocess=+comments,+noline test.cc

When you do not specify an option, a default value may become active.

The priority of the options is left-to-right: when two options conflict, the first (most left) one takes effect. The options --define
and --undefine are not considered conflicting options, so they are processed left-to-right for each source file. You can overrule
the default output file name with the option --output-file.
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C++ Compiler: —--alternative-tokens

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --alternative-tokens to the Additional C++ compiler options field.

Command line syntax

—--alternative-tokens

Description

Enable recognition of alternative tokens. This controls recognition of the digraph tokens in C++, and controls recognition of the
operator keywords (e.g., not, and, bitand, etc).

Example

» o

To enable operator keywords (e.g., "not”, "and”) and digraphs, enter:

cparm --alternative-tokens test.cc

Related information

ﬂ?'
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C++ Compiler: —-—anachronisms

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select C++ Language.
3. Enable the option Anachronisms.
Command line syntax

--anachronisms

Description

Enable C++ anachronisms. This option also enables --nonconst-ref-anachronism. But you can turn this off individually with
option —-no-nonconst-ref-anachronism.

Related information

% C++ compiler option —-nonconst-ref-anachronism (Nonconst reference anachronism)
Section 2.3.3, Anachronisms Accepted in chapter C++ Language.
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C++ Compiler: --base-assign-op-is-default

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --base-assign-op-is-default to the Additional C++ compiler options field.
Command line syntax
--base-assign-op-is-default

Description

Enable the anachronism of accepting a copy assignment operator that has an input parameter that is a reference to a base
class as a default copy assignment operator for the derived class.

Related information

ﬂi'
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C++ Compiler: —-building-runtime

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --building-runtime to the Additional C++ compiler options field.
Command line syntax
—--building-runtime
Description

Special option for building the C++ run-time library. Used to indicate that the C++ run-time library is being compiled. This
causes additional macros to be predefined that are used to pass configuration information from the C++ compiler to the
run-time.

Related information

ﬂﬁ'
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C++ Compiler: --c++0x

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --c++0x to the Additional C++ compiler options field.

Command line syntax

--C++0x

Description

Enable the C++ extensions that are defined by the latest C++ working paper.

Related information

ﬂ?‘
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C++ Compiler: --check

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --check to the Additional C++ compiler options field.

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your
application because the code will not actually be compiled.

The C++ compiler reports any warnings and/or errors.

Related information

C compiler option =-check (Check syntax)
Assembler option --check (Check syntax)
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C++ Compiler: --context-limit

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --context-limit to the Additional C++ compiler options field.

Command line syntax

—-context-limit=number (Default: 10)

Description

Set the context limit to number. The context limit is the maximum number of template instantiation context entries to be
displayed as part of a diagnostic message. If the number of context entries exceeds the limit, the first and last N context entries
are displayed, where N is half of the context limit. A value of zero is used to indicate that there is no limit.

Example
To set the context limit to 5, enter:

cparm —--context-1limit=5 test.cc

Related information

ﬂﬁ'
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C++ Compiler: --cpu (-C)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Processor entry and select Processor Definition.

3. Select a processor from the Select processor box.

Command line syntax

--cpu=[ARMv4|ARMv4T|ARMv5T|ARMv5TE|ARMv6M|ARMv7M|XS]
-C[ARMv4|ARMv4T|ARMv5T|ARMv5TE|ARMv6M|ARMv7M|XS]

Description

With this option you specify the ARM architecture for which you create your application. The ARM target supports more than one
architecture and therefore you need to specify for which architecture the compiler should compile. The architecture determines
which instructions are valid and which are not.

The effect of this option is that the C++ compiler uses the appropriate instruction set. You choose one of the following
architectures: ARMv4, ARMv4T, ARMv5T, ARMV5TE, ARMv6-M, ARMv7-M or XScale.

The macro ___CPU___is set to the string supplied to this option.

Example
To compile the file test . cc for the ARMv4 processor type, enter the following on the command line:

cparm --cpu=ARMv4 test.cc

Related information

ﬂi'
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C++ Compiler: —--create-pch

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Precompiled Headers.

3. Enter a filename in the Create precompiled header file field.

Command line syntax
--create-pch=filename

Description

If other conditions are satisfied, create a precompiled header file with the specified name. If --pch (automatic PCH mode) or
--use-pch appears on the command line following this option, its effect is erased.

Example
To create a precompiled header file with the name test .pch, enter

cparm --create-pch=test.pch test.cc

Related information
% C++ compiler option ——pch (Automatic PCH mode)

C++ compiler option --use-pch (Use precompiled header file)
Section 2.11, Precompiled Headers in chapter C++ Language.
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C++ Compiler: —--define (-D)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
Expand the C++ Compiler entry and select Preprocessing.

2

3. Select User macro and click on the down arrow in the right pane to expand macro input.

4. Click on an empty Macro field and enter a macro name. (Then click an empty cell to confirm)
5

. Optionally, click in the Value field and enter a definition. (Then click an empty cell to confirm)

Command line syntax

--define=macro_name|(parm_list)l[=macro_definition]
-Dmacro_namel[(parm_list)][=macro_definition)

Description

With this option you can define a macro and specify it to the preprocessor, as in #define. If you only specify a macro name (no
macro definition), the macro expands as ’1’. You can specify as many macros as you like.

Function-style macros can be defined by appending a macro parameter list to macro_name.

On the command line, you can use the option —-define (-D) multiple times. If the command line exceeds the length limit of the
operating system, you can define the macros in an option file which you then must specify to the C++ compiler with the option
--option-file=file (-f).

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional C source as shown in
the example below.

The definition can be tested by the preprocessor with #if, #ifdef and #ifndef, for conditional compilations.

Example
Consider the following program with conditional code to compile a demo program and a real program:

void main( void )

{
#1if DEMO ==

demo_func(); /* compile for the demo program */
#else

real func(); /* compile for the real program */
#endif
}

You can now use a macro definition to set the DEMO flag:

cparm --define=DEMO test.cc
cparm --define=DEMO=1 test.cc

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition are placed between
double quotes because otherwise the spaces would indicate a new option.

cparm --define="MAX(A,B)=((A) > (B) ? (A) : (B))" test.cc

Related information

C++ compiler option --undefine (Remove preprocessor macro)
C++ compiler option —-option-file (Specify an option file)
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C++ Compiler: —--dep-file

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --dep-file to the Additional C++ compiler options field.

Command line syntax
--dep-file[=file]
Description

With this option you tell the C++ compiler to generate dependency lines that can be used in a Makefile. In contrast to the option
--preprocess=+make (-Em), the dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension .d (one for every input file). When you specify a filename, all
dependencies will be combined in the specified file.

Example
cparm —--dep-file=test.dep test.cc

The C++ compiler compiles the file test.cc, which results in the output file test. ic, and generates dependency lines in the
file test.dep.

Related information

% C++ compiler option —-preprocess=+make (Generate dependencies for make)
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C++ Compiler: --dollar

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --dollar to the Additional C++ compiler options field.

Command line syntax
--dollar

Default format: No dollar signs are allowed in identifiers.

Description

Accept dollar signs in identifiers. Names like ASVAR are allowed.

Related information

ﬂﬁ'
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C++ Compiler: -—embedded-c++

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select C++ Language.

3. Enable the option Comply to embedded C++ subset.

Command line syntax

--embedded-c++

Description

The "Embedded C++” subset does not support templates, exceptions, namespaces, new-style casts, RTTI, multiple inheritance,
virtual base classes, and the mutable keyword. Select this option when you want the C++ compiler to give an error when you
use any of them in your C++ source.

Related information

ﬂﬁ'
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C++ Compiler: --endianness

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Processor entry and select Processor Definition.

3. Enable the option Big-endian mode.

Command line syntax
--endianness=endianness

-B
--big-endian

You can specify the following endianness:

big (b) Big endian
little (1) Little endian (default)
Description

By default, the C++ compiler generates code for a little-endian target (least significant byte of a word at lowest byte address).
With --endianness=big the C++ compiler generates code for a big-endian target (most significant byte of a word at lowest
byte address). =B is an alias for option --endianness=big.

The macro _ BIG_ENDIAN is defined when this option is specified, otherwise the macro _ LITTLE ENDIAN_ _ is defined.

Related information

ﬂj_
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C++ Compiler: —-error-file

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --error-file to the Additional C++ compiler options field.
Command line syntax
—-error-file[=file]

Description

With this option the C++ compiler redirects error messages to a file. If you do not specify a filename, the error file will be named
after the input file with extension . ecp.

Example
To write errors to errors.ecp instead of stderr, enter:

cparm --error-file=errors.ecp test.cc

Related information

ﬂﬁ'
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C++ Compiler: —-error-limit (-e)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --error-limit to the Additional C++ compiler options field.

Command line syntax

—-error-limit=number (Default: 100)
-enumber

Description

Set the error limit to number. The C++ compiler will abandon compilation after this number of errors (remarks and warnings are
not counted). By default, the limit is 100.

Example
When you want compilation to stop when 10 errors occurred, enter:

cparm —-error-limit=10 test.cc

Related information

ﬂﬁ'

6-74



Tool Options - C++ Compiler

C++ Compiler: —--exceptions (-x)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select C++ Language.

3. Enable the option Support for exception handling.

Command line syntax

--exceptions
-X

Description

With this option you enable support for exception handling in the C++ compiler.

The macro __ EXCEPTIONS is defined when exception handling support is enabled.

Related information

ﬂﬁ'
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C++ Compiler: --exported-template-file

Menu entry

Command line syntax
--exported-template-file=file
Description

This option specifies the name to be used for the exported template file used for processing of exported templates.

This option is supplied for use by the control program that invokes the C++ compiler and is not intended to be used by
end-users.

Related information

ﬂ?‘
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C++ Compiler: --extended-variadic-macros

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --extended-variadic-macros to the Additional C++ compiler options field.

Command line syntax
--extended-variadic-macros

Default: macros with a variable number of arguments are not allowed.

Description

Allow macros with a variable number of arguments (implies --variadic-macros) and allow the naming of the variable argument
list.

Related information

% C++ compiler option —--variadic-macros (Allow variadic macros)
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C++ Compiler: --force-vtbl

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. In the Virtual function tables field, select Force definition of virtual function tables.

Command line syntax

--force-vtbl

Description

Force definition of virtual function tables in cases where the heuristic used by the C++ compiler to decide on definition of virtual
function tables provides no guidance.

Related information

% C++ compiler option --suppress-vtbl (Suppress definition of virtual function tables)
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C++ Compiler: —--friend-injection

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --friend-injection to the Additional C++ compiler options field.
Command line syntax

--friend-injection
Default: £riend names are not injected.

Description

Controls whether the name of a class or function that is declared only in friend declarations is visible when using the normal
lookup mechanisms. When friend names are injected, they are visible to such lookups. When friend names are not injected
(as required by the standard), function names are visible only when using argument-dependent lookup, and class names are
never visible.

Related information

% C++ compiler option --no-arg-dep-lookup (Disable argument dependent lookup)
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C++ Compiler: --g++

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select C++ Language.

3. Enable the option Allow GNU C++ extensions.

Command line syntax

--g++

Description

Enable GNU C++ compiler language extensions.

Related information

% Section 2.4, GNU Extensions in chapter C++ Language.
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C++ Compiler: --gnu-version

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --gnu-version to the Additional C++ compiler options field.

Command line syntax
—-—-gnu-version=version

Default: 30300 (version 3.3.0)

Description

It depends on the GNU C++ compiler version if a particular GNU extension is supported or not. With this option you set the GNU
C++ compiler version that should be emulated in GNU C++ mode. Version x.y.z of the GNU C++ compiler is represented by the
value x*10000+y*100+z.

Example
To specify version 3.4.1 of the GNU C++ compiler, enter:

cparm --g++ --gnu-version=30401 test.cc

Related information

% Section 2.4, GNU Extensions in chapter C++ Language.
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C++ Compiler: —--guiding-decls

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --guiding-decls to the Additional C++ compiler options field.
Command line syntax

--guiding-decls
Description

Enable recognition of "guiding declarations” of template functions. A guiding declaration is a function declaration that matches
an instance of a function template but has no explicit definition (since its definition derives from the function template). For
example:

template <class T> void £(T) { ... }
void f(int);

When regarded as a guiding declaration, £ (int) is an instance of the template; otherwise, it is an independent function for
which a definition must be supplied.

Related information

% C++ compiler option --old-specializations (Old-style template specializations)
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C++ Compiler: —-help (-?)

Menu entry

Command line only.

Command line syntax

--help[=item,...]
-?

You can specify the following arguments:

options Show extended option descriptions

Description

Displays an overview of all command line options. With an argument you can specify which extended information is shown.

Example
The following invocations all display a list of the available command line options:

cparm -=?
cparm --help
cparm

The following invocation displays an extended list of the available options:

cparm --help=options

Related information

ﬂs_
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C++ Compiler: —--implicit-extern-c-type-conversion

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --implicit-extern-c-type-conversion to the Additional C++ compiler options field.
Command line syntax
--implicit-extern-c-type-conversion
Description
Enable the implicit type conversion between pointers to extern ”C” and extern "C++" function types.

Related information

ﬂ?‘
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C++ Compiler: —-implicit-include

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Enable the option Implicit inclusion of source files for finding templates.
Command line syntax

—--implicit-include
Description

Enable implicit inclusion of source files as a method of finding definitions of template entities to be instantiated.

Related information

% C++ compiler option —-instantiate (Instantiation mode)
Section 2.6.4, Implicit Inclusion in chapter C++ Language.
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C++ Compiler: —-incl-suffixes

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --incl-suffixes to the Additional C++ compiler options field.

Command line syntax
--incl-suffixes=suffixes

Default: no extension and . stdh.

Description

Specifies the list of suffixes to be used when searching for an include file whose name was specified without a suffix. If a null
suffix is to be allowed, it must be included in the suffix list. suffixes is a colon-separated list of suffixes (e.g., ”: : stdh”).

Example
To allow only the suffixes .h and . stdh as include file extensions, enter:

cparm —--incl-suffixes=h:stdh test.cc

Related information

C++ compiler option —--include-file (Include file at the start of a compilation)
Section 3.3, How the C++ Compiler Searches Include Files in chapter Using the C++ Compiler of the user’s manual.
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C++ Compiler: —-include-directory (-I)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Select Build Options.

3. Add a pathname in the Include files path field.

If you enter multiple paths, separate them with a semicolon (;).

Command line syntax

--include-directory=path,...
=lpath,...

Description

Add path to the list of directories searched for #include files whose names do not have an absolute pathname. You can
specify multiple directories separated by commas.

Example
To add the directory /proj/include to the include file search path, enter:

cparm --include-directory=/proj/include test.cc

Related information
C++ compiler option --include-file (Include file at the start of a compilation)

C++ compiler option --sys-include (Add directory to system include file search path)
Section 3.3, How the C++ Compiler Searches Include Files in chapter Using the C++ Compiler of the user’s manual.
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C++ Compiler: —--include-file (-H)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Preprocessing.

3. Enter the name of the file in the Include this file before source field or click ... and select a file.

Command line syntax

--include-file=file,...
-Hfile,...

Description

With this option (set at project level) you include one extra file at the beginning of each C++ source file in your project. On a
document level (Project » Document Options), you can overrule this option with another file or no file at all.

The specified include file is included at the beginning of the compilation. This is the same as specifying #include "file" at
the very beginning of (each of) your C++ source files.

All files included with —--include-file are processed after any of the files included with —-include-macros-file.

The filename is searched for in the directories on the include search list.

Example
cparm —--include-file=extra.h testl.cc test2.cc

The file extra.h is included at the beginning of both testl.cc and test2.cc.

Related information

% C++ compiler option --include-directory (Add directory to include file search path)
Section 3.3, How the C++ Compiler Searches Include Files in chapter Using the C++ Compiler of the user’s manual.
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C++ Compiler: --include-macros-file

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --include-macros-file to the Additional C++ compiler options field.
Command line syntax

--include-macros-file=file
Description

Include the macros of the indicated file at the beginning of the compilation. Only the preprocessing directives from the file are
evaluated. All of the actual code is discarded. The effect of this option is that any macro definitions from the specified file will be
in effect when the primary source file is compiled. All of the macro-only files are processed before any of the normal includes
(--include-file). Within each group, the files are processed in the order in which they were specified.

Related information

C++ compiler option --include-file (Include file at the start of a compilation)
Section 3.3, How the C++ Compiler Searches Include Files in chapter Using the C++ Compiler of the user’s manual.
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C++ Compiler: —-init-priority

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --init-priority to the Additional C++ compiler options field.
Command line syntax
--init-priority=number (Default: 0)
Description

Normally, the C++ compiler assigns no priority to the global initialization functions and the exact order is determined by the
linker. This option sets the default priority for global initialization functions. Default value is "0”. You can also set the default
priority with the #pragma init priority.

Values from 1 to 100 are for internal use only and should not be used. Values 101 to 65535 are available for user code. A lower
number means a higher priority.

Example

cparm —--init-priority=101 test.cc

Related information

ﬂj_
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C++ Compiler: --instantiate

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Select an instantiation mode in the Instantiation mode of external template entities box

Command line syntax
--instantiate=mode
~-tmode

You can specify the following modes:

used (default)
all
local

Description

Control instantiation of external template entities. External template entities are external (that is, non-inline and non-static)
template functions and template static data members. The instantiation mode determines the template entities for which code
should be generated based on the template definition. Normally, when a file is compiled, template entities are instantiated
wherever they are used (the linker will discard duplicate definitions). The overall instantiation mode can, however, be changed
with this option. You can specify the following modes:

used Instantiate those template entities that were used in the compilation. This will include all static data members for
which there are template definitions. This is the default.

all Instantiate all template entities declared or referenced in the compilation unit. For each fully instantiated template
class, all of its member functions and static data members will be instantiated whether or not they were used.
Non-member template functions will be instantiated even if the only reference was a declaration.

local Similar to —--instantiate=used except that the functions are given internal linkage. This is intended to provide a
very simple mechanism for those getting started with templates. The compiler will instantiate the functions that are
used in each compilation unit as local functions, and the program will link and run correctly (barring problems due
to multiple copies of local static variables). However, one may end up with many copies of the instantiated
functions, so this is not suitable for production use.

You cannot use --instantiate=local in conjunction with automatic template instantiation.

Related information

C++ compiler option --no-auto-instantiation (Disable automatic C++ instantiation)
Section 2.6, Template Instantiation in chapter C++ Language.
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C++ Compiler: --io-streams

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select C++ Language.

3. Enable the option Support for I/O streams.

Command line syntax
--io-streams
Description

As I/O streams require substantial resources they are disabled by default. Use this option to enable 1/O streams support in the
C++ library.

This option also enables exception handling.

Related information
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C++ Compiler: --late-tiebreaker

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --late-tiebreaker to the Additional C++ compiler options field.

Command line syntax
--late-tiebreaker

Default: early tiebreaker processing.

Description

Select the way that tie-breakers (e.g., cv-qualifier differences) apply in overload resolution. In "early” tie-breaker processing,
the tie-breakers are considered at the same time as other measures of the goodness of the match of an argument value and the
corresponding parameter type (this is the standard approach).

In "late” tie-breaker processing, tie-breakers are ignored during the initial comparison, and considered only if two functions are
otherwise equally good on all arguments; the tie-breakers can then be used to choose one function over another.

Related information
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C++ Compiler: --list-file (-L)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --list-file to the Additional C++ compiler options field.

Command line syntax

--list-file=file
-Lfile

Default: -1

Description

Generate raw listing information in the file. This information is likely to be used to generate a formatted listing. The raw listing file
contains raw source lines, information on transitions into and out of include files, and diagnostics generated by the C++
compiler.

Each line of the listing file begins with a key character that identifies the type of line, as follows:
N: A normal line of source; the rest of the line is the text of the line.

X: The expanded form of a normal line of source; the rest of the line is the text of the line. This line appears following the N line,
and only if the line contains non-trivial modifications (comments are considered trivial modifications; macro expansions, line
splices, and trigraphs are considered non-trivial modifications). Comments are replaced by a single space in the
expanded-form line.

S: Aline of source skipped by an #if or the like; the rest of the line is text. Note that the #else, #elif, or #endif that ends a
skip is marked with an N.

L: An indication of a change in source position. The line has a format similar to the # line-identifying directive output by the C
preprocessor, that is to say

L line_number ”file-name” key
where key is,

1 for entry into an include file;

2 for exit from an include file;
and omitted otherwise.

The first line in the raw listing file is always an L line identifying the primary input file. L lines are also output for #line
directives (key is omitted). L lines indicate the source position of the following source line in the raw listing file.

R, W, E, or C: an indication of a diagnostic (R for remark, W for warning, E for error, and C for catastrophic error). The line has
the form

S ”file-name” line_number column-number message-text

where Sis R, W, E, or C, as explained above. Errors at the end of file indicate the last line of the primary source file and a
column number of zero. Command line errors are catastrophes with an empty file name () and a line and column number of
zero. Internal errors are catastrophes with position information as usual, and message-text beginning with (internal error).
When a diagnostic displays a list (e.g., all the contending routines when there is ambiguity on an overloaded call), the initial
diagnostic line is followed by one or more lines with the same overall format (code letter, file name, line number, column
number, and message text), but in which the code letter is the lower case version of the code letter in the initial line. The
source position in such lines is the same as that in the corresponding initial line.
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Example
To write raw listing information to the file test.1st, enter:

cparm --list-file=test.lst test.cc

Related information

ﬂj_

6-95



ARM Embedded Tools Reference

C++ Compiler: —--long-lifetime-temps

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --long-lifetime-temps to the Additional C++ compiler options field.
Command line syntax
--long-lifetime-temps
Description

Select the lifetime for temporaries: short means to end of full expression; long means to the earliest of end of scope, end of
switch clause, or the next label. Short is the default.

Related information

ﬂi'

6-96



Tool Options - C++ Compiler

C++ Compiler: —--long-long

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --long-long to the Additional C++ compiler options field.

Command line syntax

--long-long

Description

Permit the use of Long long in strict mode in dialects in which it is non-standard.

Related information
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C++ Compiler: --make-target

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Miscellaneous.
3. Add the option --make-target to the Additional C compiler options field.
Command line syntax
--make-target=name
Description

With this option you can overrule the default target name in the make dependencies generated by the options
--preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input file, with extension . obj.

Related information

% C++ compiler option —--preprocess=+make (Generate dependencies for make)
C++ compiler option --dep-file (Generate dependencies in a file)
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C++ Compiler: --multibyte-chars

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --multibyte-chars to the Additional C++ compiler options field.

Command line syntax
--multibyte-chars

Default: multibyte character sequences are not allowed.

Description

Enable processing for multibyte character sequences in comments, string literals, and character constants. Multibyte encodings
are used for character sets like the Japanese SJIS.

Related information
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C++ Compiler: -—-namespaces

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --namespaces to the Additional C++ compiler options field.

Command line syntax
--namespaces
--no-namespaces

Default: namespaces are supported.

Description
With option --no-namespaces you disable support for namespaces.

When you used option --embedded-c++, namespaces are disabled. With option -—namespaces you can enable support for
namespaces in this case.

The macro __ NAMESPACES is defined when namespace support is enabled.

Related information
% C++ compiler option —-embedded-c++ (Embedded C++ compliancy tests)

C++ compiler option --using-std (Implicit use of the std namespace)
Section 2.5, Namespace Support in chapter C++ Language.
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C++ Compiler: --no-arg-dep-lookup

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-arg-dep-lookup to the Additional C++ compiler options field.

Command line syntax

--no-arg-dep-lookup
Default: argument dependent lookup of unqualified function names is performed.
Description

With this option you disable argument dependent lookup of unqualified function names.

Related information
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C++ Compiler: --no-array-new-and-delete

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-array-new-and-delete to the Additional C++ compiler options field.

Command line syntax
--no-array-new-and-delete

Default: array new and delete are supported.

Description
Disable support for array new and delete.

The macro __ ARRAY OPERATORS is defined when array new and delete is enabled.

Related information
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C++ Compiler: --no-auto-instantiation

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-auto-instantiation to the Additional C++ compiler options field.

Command line syntax
--no-auto-instantiation

Default: the C++ compiler automatically instantiates templates.

Description

With this option automatic instantiation of templates is disabled.

Related information

% C++ compiler option --instantiate (Instantiation mode)
Section 2.6, Template Instantiation in chapter C++ Language.
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C++ Compiler: --no-bool

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-bool to the Additional C++ compiler options field.

Command line syntax
--no-bool

Default: bool is recognized as a keyword.

Description
Disable recognition of the bool keyword.

The macro _BOOL is defined when bool is recognized as a keyword.

Related information
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C++ Compiler: —--no-class-name-injection

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-class-name-injection to the Additional C++ compiler options field.

Command line syntax
--no-class-name-injection

Default: the name of a class is injected into the scope of the class (as required by the standard).

Description

Do not inject the name of a class into the scope of the class (as was true in earlier versions of the C++ language).

Related information
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C++ Compiler: —--no-const-string-literals

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-const-string-literals to the Additional C++ compiler options field.

Command line syntax
--no-const-string-literals

Default: C++ string literals and wide string literals are const (as required by the standard).

Description

With this option C++ string literals and wide string literals are non-const (as was true in earlier versions of the C++ language).

Related information
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C++ Compiler: --no-dep-name

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-dep-name to the Additional C++ compiler options field.

Command line syntax
--no-dep-name

Default: dependent name processing is enabled.

Description

Disable dependent name processing; i.e., the special lookup of names used in templates as required by the C++ standard. This
option implies the use of --no-parse-templates.

Related information

% C++ compiler option —-no-parse-templates (Disable parsing of nonclass templates)
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C++ Compiler: --no-distinct-template-signatures

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-distinct-template-signatures to the Additional C++ compiler options field.

Command line syntax

--no-distinct-template-signatures

Description

Control whether the signatures for template functions can match those for non-template functions when the functions appear in
different compilation units. By default a normal function cannot be used to satisfy the need for a template instance; e.g., a
function "void £ (int)” could not be used to satisfy the need for an instantiation of a template "void f(T)” with T set to int.

--no-distinct-template-signatures provides the older language behavior, under which a non-template function can match a
template function. Also controls whether function templates may have template parameters that are not used in the function
signature of the function template.

Related information
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C++ Compiler: --no-double (-F)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-double to the Additional C++ compiler options field.

Command line syntax

--no-double
-F

Description

With this option you tell the C++ compiler to treat variables of the type double as float. Because the float type takes less
space, execution speed increases and code size decreases, both at the cost of less precision.

Example
cparm --no-double test.cc

The file test.cc is compiled where variables of the type double are treated as float.

Related information
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C++ Compiler: --no-enum-overloading

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --no-enum-overloading to the Additional C++ compiler options field.
Command line syntax
--no-enum-overloading
Description
Disable support for using operator functions to overload built-in operations on enum-typed operands

Related information
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C++ Compiler: —--no-explicit

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-explicit to the Additional C++ compiler options field.

Command line syntax
--no-explicit
Default: the explicit specifier is allowed.

Description

Disable support for the explicit specifier on constructor declarations.

Related information
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C++ Compiler: --no-export

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-export to the Additional C++ compiler options field.

Command line syntax
--no-export

Default: exported templates (declared with the keyword export) are allowed.

Description

Disable recognition of exported templates. This option requires that dependent name processing be done, and cannot be used
with implicit inclusion of template definitions.

Related information

% Section 2.6.5, Exported Templates in chapter C++ Language.
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C++ Compiler: --no-extern-inline

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-extern-inline to the Additional C++ compiler options field.

Command line syntax
--no-extern-inline

Default: inline functions are allowed to have external linkage.

Description

Disable support for inline functions with external linkage in C++. When inline functions are allowed to have external linkage
(as required by the standard), then extern and inline are compatible specifiers on a non-member function declaration; the
default linkage when inline appears alone is external (that is, inline means extern inline on non-member functions);
and an inline member function takes on the linkage of its class (which is usually external). However, when inline functions
have only internal linkage (using --no-extern-inline), then extern and inline are incompatible; the default linkage when
inline appears alone is internal (that is, inline means static inline on non-member functions); and inline member
functions have internal linkage no matter what the linkage of their class.

Related information

% Section 2.8, Extern Inline Functions in chapter C++ Language.
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C++ Compiler: —--no-for-init-diff-warning

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --no-for-init-diff-warning to the Additional C++ compiler options field.
Command line syntax
--no-for-init-diff-warning
Description

Disable a warning that is issued when programs compiled without the —-old-for-init option would have had different behavior
under the old rules.

Related information

% C++ compiler option —-old-for-init (Use old for scoping rules)
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C++ Compiler: —--no-implicit-typename

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-implicit-typename to the Additional C++ compiler options field.

Command line syntax
--no-implicit-typename

Default: implicit typename determination is enabled.

Description

Disable implicit determination, from context, whether a template parameter dependent name is a type or nontype.

Related information

% C++ compiler option —-no-typename (Disable the typename keyword)
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C++ Compiler: —-no-inlining

Menu entry
1. From the Project menu, select Project Options...

The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Disable the option Minimal inlining of function calls.
Command line syntax

--no-inlining
Description

Disable minimal inlining of function calls.

Related information
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C++ Compiler: -—-nonconst-ref-anachronism

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --nonconst-ref-anachronism to the Additional C++ compiler options field.

Command line syntax
--nonconst-ref-anachronism
--no-nonconst-ref-anachronism (default)

Description

Enable or disable the anachronism of allowing a reference to nonconst to bind to a class rvalue of the right type. This
anachronism is also enabled by the option --anachronisms.

Related information

C++ compiler option ——anachronisms (Enable C++ anachronisms)
Section 2.3.3, Anachronisms Accepted in chapter C++ Language.
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C++ Compiler: --nonstd-qualifier-deduction

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --nonstd-qualifier-deduction to the Additional C++ compiler options field.

Command line syntax

--nonstd-qualifier-deduction

Description

Controls whether non-standard template argument deduction should be performed in the qualifier portion of a qualified name.
With this feature enabled, a template argument for the template parameter T can be deduced in contexts like A<T>: :B or T: :B.
The standard deduction mechanism treats these as non-deduced contexts that use the values of template parameters that were
either explicitly specified or deduced elsewhere.

Related information
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C++ Compiler: --nonstd-using-decl

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --nonstd-using-decl to the Additional C++ compiler options field.

Command line syntax
--nonstd-using-decl

Default: non-standard using declarations are not allowed

Description

Allow a non-member using declaration that specifies an unqualified name.

Related information
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C++ Compiler: --no-parse-templates

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --no-parse-templates to the Additional C++ compiler options field.
Command line syntax
--no-parse-templates
Default: parsing of nonclass templates is enabled.
Description

Disable the parsing of nonclass templates in their generic form (i.e., even if they are not really instantiated). It is done by default
if dependent name processing is enabled.

Related information

% C++ compiler option —-no-dep-name (Disable dependent name processing)
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C++ Compiler: -—-no-pch-messages

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-pch-messages to the Additional C++ compiler options field.

Command line syntax
--no-pch-messages

Default: a message is displayed indicating that a precompiled header file was created or used in the current compilation. For
example,

"test.cc”: creating precompiled header file "test.pch”
Description

Disable the display of a message indicating that a precompiled header file was created or used in the current compilation.

Related information

C++ compiler option —-pch (Automatic PCH mode)

C++ compiler option --use-pch (Use precompiled header file)

C++ compiler option --create-pch (Create precompiled header file)
Section 2.11, Precompiled Headers in chapter C++ Language.
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C++ Compiler: -—no-preprocessing-only

Menu entry

Altium Designer always does a full compilation.
Command line syntax
--no-preprocessing-only

Description

You can use this option in conjunction with the options that normally cause the C++ compiler to do preprocessing only (e.g.,
--preprocess, etc.) to specify that a full compilation should be done (not just preprocessing). When used with the implicit
inclusion option, this makes it possible to generate a preprocessed output file that includes any implicitly included files.

Example

cparm --preprocess --implicit-include --no-preprocessing-only test.cc

Related information

C++ compiler option —-preprocess (Preprocessing only)
C++ compiler option —-implicit-include (Implicit source file inclusion)
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C++ Compiler: --no-stdinc / --no-stdstlinc

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-stdinc or —--no-stdstlinc to the Additional C++ compiler options field.

Command line syntax

--no-stdinc
--no-stdstlinc

Description

With option --no-stdinc you tell the C++ compiler not to look in the default include directory relative to the installation
directory, when searching for standard include files.

With option --no-stdstlinc you tell the C++ compiler not to look in the default include. st1 directory relative to the
installation directory, when searching for standard STL include files.

This way the C++ compiler only searches in the include file search paths you specified.

Related information

% Section 3.3, How the C++ Compiler Searches Include Files in chapter Using the C++ Compiler of the user’s manual.
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C++ Compiler: --no-typename

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --no-typename to the Additional C++ compiler options field.

Command line syntax
--no-typename

Default: typename is recognized as a keyword.

Description

Disable recognition of the typename keyword.

Related information

% C++ compiler option —-no-implicit-typename (Disable implicit typename determination)
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C++ Compiler: --no-use-before-set-warnings (-j)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Diagnostics.

3. Enable the option Suppress C++ compiler "used before set” warnings.

Command line syntax

--no-use-before-set-warnings
-

Description

Suppress warnings on local automatic variables that are used before their values are set.

Related information

% C++ compiler option ——no-warnings (Suppress all warnings)
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C++ Compiler: --no-warnings (-w)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Diagnostics.
3. Enable the option Suppress all warnings.
Command line syntax

--no-warnings
-w

Description

With this option you suppress all warning messages. Error messages are still issued.

Related information

% C++ compiler option —-warnings-as-errors (Treat warnings as errors)
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C++ Compiler: —-old-for-init

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --old-for-init to the Additional C++ compiler options field.
Command line syntax
--old-for-init

Description

Control the scope of a declaration in a for-init-statement. The old (cfront-compatible) scoping rules mean the declaration
is in the scope to which the for statement itself belongs; the default (standard-conforming) rules in effect wrap the entire for
statement in its own implicitly generated scope.

Related information

% C++ compiler option —-no-for-init-diff-warning (Disable warning for old for-scoping)

6-127



ARM Embedded Tools Reference

C++ Compiler: --old-line-commands

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --old-line-commands to the Additional C++ compiler options field.
Command line syntax

--old-line-commands

Description

When generating source output, put out #line directives in the form # nnn instead of #line nnn.

Example
To do preprocessing only, without comments and with old style line control information, enter:

cparm —--preprocess --old-line-commands test.cc

Related information

% C++ compiler option —-preprocess (Preprocessing only)
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C++ Compiler: —--old-specializations

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --old-specializations to the Additional C++ compiler options field.

Command line syntax

--old-specializations

Description

Enable acceptance of old-style template specializations (that is, specializations that do not use the template<> syntax).

Related information

ﬂ?‘
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C++ Compiler: —-option-file (~f)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --option-file to the Additional C compiler options field.

Be aware that the options in the option file are added to the C++ compiler options you have set in the other dialogs. Only in
extraordinary cases you may want to use them in combination. Altium Designer automatically saves the options with your
project.

Command line syntax
--option-file=file,...
~f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an
option file which contains all options and flags you want to specify. With this option you specify the option file to the C++
compiler.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

You can specify the option —-option-file multiple times.

Format of an option file

* Multiple arguments on one line in the option file are allowed.
* To include whitespace in an argument, surround the argument with single or double quotes.
* If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ' embedded”
'This has a double quote ” embedded’

'This has a double quote ” and a single quote ’'”’ embedded”

When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line”

-> "This is a continuation line”
* |tis possible to nest command line files up to 25 levels.
Example
Suppose the file myoptions contains the following lines:

—-—-embedded-c++
--define=DEMO=1
test.cc

Specify the option file to the C++ compiler:
cparm --option-file=myoptions
This is equivalent to the following command line:

cparm --embedded-c++ --define=DEMO=1 test.cc
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Related information
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C++ Compiler: --output (-0)

Menu entry

Altium Designer names the output file always after the C++ source file.
1. From the Project menu, select Project Options...

The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --old-specializations to the Additional C++ compiler options field.

Command line syntax

--output=file
-o file

Default: module name with . ic suffix.

Description

With this option you can specify another filename for the output file of the C++ compiler. Without this option the basename of the
C++ source file is used with extension . ic.

You can also use this option in combination with the option --preprocess (-E) to redirect the preprocessing output to a file.
Example
To create the file output.ic instead of test.ic, enter:
cparm —--output=output.ic test.cc
To use the file my . pre as the preprocessing output file, enter:

cparm --preprocess --output=my.pre test.cc

Related information

% C++ compiler option —-preprocess (Preprocessing only)
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C++ Compiler: --pch

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Precompiled Headers.

3. Enable the option Automatically use and/or create a precompiled header file.

Command line syntax

--pch

Description

Automatically use and/or create a precompiled header file. If --use-pch or --create-pch (manual PCH mode) appears on the
command line following this option, its effect is erased.

Related information
% C++ compiler option --use-pch (Use precompiled header file)

C++ compiler option —--create-pch (Create precompiled header file)
Section 2.11, Precompiled Headers in chapter C++ Language.
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C++ Compiler: —-pch-dir

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Precompiled Headers.

3. Enter a path in the Precompiled header file directory field.

Command line syntax
--pch-dir=directory-name
Description

Specify the directory in which to search for and/or create a precompiled header file. This option may be used with automatic
PCH mode (--pch) or manual PCH mode (--create-pch or --use-pch).

Example
To use the directory c: \usr\include\pch to automatically create precompiled header files, enter:

cparm --pch-dir=c:\usr\include\pch --pch test.cc

Related information

% C++ compiler option ——pch (Automatic PCH mode)
C++ compiler option --use-pch (Use precompiled header file)
C++ compiler option —-create-pch (Create precompiled header file)
Section 2.11, Precompiled Headers in chapter C++ Language.
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C++ Compiler: --pch-verbose

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --pch-verbose to the Additional C++ compiler options field.

Command line syntax

--pch-verbose

Description

In automatic PCH mode, for each precompiled header file that cannot be used for the current compilation, a message is
displayed giving the reason that the file cannot be used.

Example

cparm --pch --pch-verbose test.cc

Related information

% C++ compiler option --pch (Automatic PCH mode)
Section 2.11, Precompiled Headers in chapter C++ Language.
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C++ Compiler: --pending-instantiations

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --pending-instantiations to the Additional C++ compiler options field.
Command line syntax
--pending-instantiations=n
where n is the maximum number of instantiations of a single template.
Default: 64

Description

Specifies the maximum number of instantiations of a given template that may be in process of being instantiated at a given time.
This is used to detect runaway recursive instantiations. If n is zero, there is no limit.

Example
To specify a maximum of 32 pending instantiations, enter:

cparm --pending-instantiations=32 test.cc

Related information

% Section 2.6, Template Instantiation in chapter C++ Language.
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C++ Compiler: --preprocess (-E)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Preprocessing.

3. Enable the option Store the C++ compiler preprocess output (<file>.pre).

Command line syntax

--preprocess[=flags]
-E[flags]

You can set the following flags (when you specify -E without flags, the default is ~-ECMP):

+/-comments (c/C) Keep comments from the C source in the preprocessed output

+/-make (m/M) Generate dependency lines that can be used for the makefile

+/-noline (p/P) Strip #line source position info (lines starting with #1ine)
Description

With this option you tell the C++ compiler to preprocess the C++ source. Under Altium Designer the C++ compiler sends the
preprocessed output to the file name.pre (where name is the name of the C++ source file to compile). Altium Designer also
compiles the C++ source.

On the command line, the C++ compiler sends the preprocessed file to stdout. To capture the information in a file, specify an
output file with the option --output.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C++ source file in the preprocessed
output.

With --preprocess=+make the C++ compiler will generate dependency lines that can be used in a Makefile. The preprocessor
output is discarded.The default target name is the basename of the input file, with the extension . obj. With the option
--make-target you can specify a target name which overrules the default target name.

When implicit inclusion of templates is enabled, the output may indicate false (but safe) dependencies unless
--no-preprocessing-only is also used.

With --preprocess=+noline you tell the preprocessor to strip the #line source position information (lines starting with #1ine).
These lines are normally processed by the assembler and not needed in the preprocessed output. When you leave these lines
out, the output is easier to read.

Example
cparm --preprocess=+comments,-make,-noline test.cc --output=test.pre

The C++ compiler preprocesses the file test.cc and sends the output to the file test.pre. Comments are included but no
dependencies are generated and the line source position information is not stripped from the output file.

Related information

C++ compiler option —-no-preprocessing-only (Force full compilation)
C++ compiler option --make-target (Specify target name for ~Em output)
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C++ Compiler: —--remarks (-r)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Diagnostics.

3. Enable the option Issue remarks on C++ code.

Command line syntax

—--remarks
-r

Description

Issue remarks, which are diagnostic messages even milder than warnings

Related information

% Section 3.4, C++ Compiler Error Messages in chapter Using the C++ Compiler of the user’'s manual.
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C++ Compiler: --remove-unneeded-entities

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --remove-unneeded-entities to the Additional C++ compiler options field.

Command line syntax
--remove-unneeded-entities
Description

Enable an optimization to remove types, variables, routines, and related constructs that are not really needed. Something may
be referenced but unneeded if it is referenced only by something that is itself unneeded; certain entities, such as global variables
and routines defined in the translation unit, are always considered to be needed.

Related information

ﬂﬁ'
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C++ Compiler: —-rtti

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select C++ Language.

3. Enable the option Support for RTTI (run-time type information).

Command line syntax
——rtti

Default: RTTI (run-time type information) features are disabled.

Description
Enable support for RTTI (run-time type information) features: dynamic_cast, typeid.

The macro __ RTTI is defined when RTTI support is enabled.

Related information

ﬂﬁ'
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C++ Compiler: --schar (-s)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --schar to the Additional C++ compiler options field.

Command line syntax

--schar
-s

Description
With this option char is the same as signed char.

When plain char is signed, the macro _ SIGNED CHARS___is defined.

Related information

% C++ compiler option —-uchar (Plain char is unsigned)
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C++ Compiler: --signed-bitfields

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --signed-bitfields to the Additional C++ compiler options field.
Command line syntax

--signed-bitfields
Description

For bit-fields it depends on the implementation whether a plain int is treated as signed int or unsigned int. By default
an int bit-field is treated as unsigned int. This offers the best performance. With this option you tell the C++ compiler to
treat int bit-fields as signed int. In this case, you can still add the keyword unsigned to treat a particular int bit-field as
unsigned.

Related information

% C compiler option --signed-bitfields
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C++ Compiler: --special-subscript-cost

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --special-subscript-cost to the Additional C++ compiler options field.

Command line syntax

--special-subscript-cost

Description
Enable a special nonstandard weighting of the conversion to the integral operand of the [ ] operator in overload resolution.

This is a compatibility feature that may be useful with some existing code. With this feature enabled, the following code compiles
without error:

struct A {
A();
operator int *();
int operator[](unsigned);

}i
void main() {
A aj;
a[07; // Bmbiguous, but allowed with this option
// operator[] is chosen
}
Related information

ﬂ?‘
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C++ Compiler: —--strict (-A)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select C++ Language.

3. Disable the option Allow non-ANSI/ISO C++ features.

Command line syntax

—-strict
-A

Default: non-ANSI/ISO C++ features are enabled.

Description

Enable strict ANSI/ISO mode, which provides diagnostic messages when non-standard features are used, and disables
features that conflict with ANSI/ISO C or C++. All ANSI/ISO violations are issued as errors.

Example
To enable strict ANSI mode, with error diagnostic messages, enter:

cparm --strict test.cc

Related information

% C++ compiler option --strict-warnings (Strict ANSI/ISO mode with warnings)
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C++ Compiler: —-strict-warnings (-a)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --strict-warnings to the Additional C++ compiler options field.

Command line syntax

--strict-warnings
-a

Default: non-ANSI/ISO C++ features are enabled.

Description

This option is similar to the option --strict, but all violations are issued as warnings instead of errors.

Example
To enable strict ANSI mode, with warning diagnostic messages, enter:

cparm --strict-warnings test.cc

Related information

% C++ compiler option --strict (Strict ANSI/ISO mode with errors)
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C++ Compiler: --suppress-vtbl

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Inthe Virtual function tables field, select Suppress definition of virtual function tables.

Command line syntax

—--suppress-vtbl

Description

Suppress definition of virtual function tables in cases where the heuristic used by the C++ compiler to decide on definition of
virtual function tables provides no guidance. The virtual function table for a class is defined in a compilation if the compilation
contains a definition of the first non-inline non-pure virtual function of the class. For classes that contain no such function, the
default behavior is to define the virtual function table (but to define it as a local static entity). The —--suppress-vtbl option
suppresses the definition of the virtual function tables for such classes, and the --force-vtbl option forces the definition of the
virtual function table for such classes. —-force-vtbl differs from the default behavior in that it does not force the definition to be
local.

Related information

% C++ compiler option —-force-vtbl (Force definition of virtual function tables)
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C++ Compiler: --sys-include

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --sys-include to the Additional C++ compiler options field.

Command line syntax
--sys~include=directory,...
Description

Change the algorithm for searching system include files whose names do not have an absolute pathname to look in directory.

Example
To add the directory c: \proj\include to the system include file search path, enter:

cparm —--sys-include=c:\proj\include test.cc

Related information

% C++ compiler option —-include-directory (Add directory to include file search path)
Section 3.3, How the C++ Compiler Searches Include Files in chapter Using the C++ Compiler of the user’s manual.
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C++ Compiler: --template-directory

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --template-directory to the Additional C++ compiler options field.

Command line syntax

--template-directory=directory,...

Description

Specifies a directory name to be placed on the exported template search path. The directories are used to find the definitions of
exported templates (. et files) and are searched in the order in which they are specified on the command line. The current
directory is always the first entry on the search path.

Example
To add the directory export to the exported template search path, enter:

cparm --template-directory=export test.cc

Related information

% Section 2.6.5, Exported Templates in chapter C++ Language.
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C++ Compiler: —-thumb

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select Code Generation.

3. Enable the option Generate Thumb code.

Command line syntax

—-thumb

Description

Generate code in Thumb mode. The Thumb instruction set is a subset of the ARM instruction set which is encoded using 16-bit
instructions instead of 32-bit instructions.

The macro __ THUMB__is defined when the Thumb mode is enabled.

Related information

ﬂﬁ'
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C++ Compiler: —--timing

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --timing to the Additional C++ compiler options field.
Command line syntax

--timing
Default: no timing information is generated.

Description

Generate compilation timing information. This option causes the C++ compiler to display the amount of CPU time and elapsed
time used by each phase of the compilation and a total for the entire compilation.

Example
cparm --timing test.cc

processed 180 lines at 8102 lines/min

Related information

ﬂﬁ'
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C++ Compiler: --trace-includes

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Diagnostics.

3. Enable the option List all visited #included files.

Command line syntax
--trace-includes

Description

Output a list of the names of files #included to the error output file. The source file is compiled normally (i.e. it is not just
preprocessed) unless another option that causes preprocessing only is specified.

Example
cparm --trace-includes test.cc

iostream.h
string.h

Related information

ﬂﬁ'
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C++ Compiler: --type-traits-helpers

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.
3. Add the option --type-traits-helpers to the Additional C++ compiler options field.
Command line syntax
--type-traits-helpers
--no-type-traits-helpers

Default: in C++ mode type traits helpers are enabled by default. In GNU C++ mode, type traits helpers are never enabled by
default.

Description

Enable or disable type traits helpers (like __is _unionand _ has_virtual_ destructor). Type traits helpers are meant to
ease the implementation of ISO/IEC TR 19768.

The macro __ TYPE TRAITS_ ENABLED is defined when type traits pseudo-functions are enabled.

Related information

ﬂﬁ'
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C++ Compiler: —-uchar (-u)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --uchar to the Additional C++ compiler options field.

Command line syntax

—-uchar
-u

Description

By default char is the same as specifying signed char. With this option char is the same as unsigned char.

Related information

% C++ compiler option —-schar (Plain char is signed)
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C++ Compiler: --undefine (-U)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --undefine to the Additional C++ compiler options field.

Command line syntax

--undefine=macro_name
-Umacro_name

Description

Remove any initial definition of identifier name as in #undef. —--undefine options are processed after all --define options have
been processed.

You cannot undefine a predefined macro as specified in section 2.10, Predefined Macros, except for:

__STDC___
__cplusplus
___SIGNED_CHARS

Example
To undefine the predefined macro ___cplusplus:

cparm --undefine= cplusplus test.cc

Related information

% C++ compiler option —--define (Define preprocessor macro)
Section 2.10, Predefined Macros in chapter C++ Language.
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C++ Compiler: —--use-pch

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Precompiled Headers.

3. Enter afilename in the Use precompiled header file field.

Command line syntax
--use-pch=filename

Description

Use a precompiled header file of the specified name as part of the current compilation. If --pch (automatic PCH mode) or
--create-pch appears on the command line following this option, its effect is erased.

Example
To use the precompiled header file with the name test.pch, enter:

cparm --use-pch=test.pch test.cc

Related information
% C++ compiler option ——pch (Automatic PCH mode)

C++ compiler option --create-pch (Create precompiled header file)
Section 2.11, Precompiled Headers in chapter C++ Language.
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C++ Compiler: --using-std

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --using-std to the Additional C++ compiler options field.

Command line syntax

--using-std
Default: implicit use of the std namespace is disabled.
Description

Enable implicit use of the std namespace when standard header files are included. Note that this does not do the equivalent of
putting a "using namespace std;” in the program to allow old programs to be compiled with new header files; it has a
special and localized meaning related to the TASKING versions of certain header files, and is unlikely to be of much use to
end-users of the TASKING C++ compiler.

Related information

C++ compiler option —-namespaces (Support for namespaces)
Section 2.5, Namespace Support in chapter C++ Language.
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C++ Compiler: --variadic-macros

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --variadic-macros to the Additional C++ compiler options field.

Command line syntax
--variadic-macros

Default: macros with a variable number of arguments are not allowed.

Description

Allow macros with a variable number of arguments.

Related information

% C++ compiler option --extended-variadic-macros (Allow extended variadic macros)
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C++ Compiler: —-version (-V)
Menu entry
Command line only.

Command line syntax

--version
'

Description

Display version information. The C++ compiler ignores all other options or input files.

Related information

ﬂﬁ'
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C++ Compiler: --warnings-as-errors

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Diagnostics.

3. Enable the option Treat warnings as errors.

Command line syntax

—--warnings-as-errors

Description

If the C++ compiler encounters an error, it stops compiling. With this option you tell the C++ compiler to treat all warnings as
errors. This means that the exit status of the C++ compiler will be non-zero after one or more compiler warnings. As a
consequence, the C++ compiler now also stops after encountering a warning.

Related information

% C++ compiler option ——no-warnings (Suppress all warnings)
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C++ Compiler: --wchar_t-keyword

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select C++ Language.

3. Enable the option Allow the 'wchar_t’ keyword.

Command line syntax
--wchar_t-keyword

Default: wchar_t is not recognized as a keyword.

Description
Enable recognition of wchar t as a keyword.

The macro WCHAR T is defined when wchar_ttis recognized as a keyword.

Related information

ﬂﬁ'
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C++ Compiler: —-xref-file (-X)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C++ Compiler entry and select Miscellaneous.

3. Add the option --xref-file to the Additional C++ compiler options field.

Command line syntax

--xref-file=file
-Xfile

Description

Generate cross-reference information in a file. For each reference to an identifier in the source program, a line of the form
symbol_id name X file-name line-number column-number

is written, where X is

D for definition;

d for declaration (that is, a declaration that is not a definition);

M for modification;

A for address taken;

U for used;

C for changed (but actually meaning used and modified in a single operation, such as an increment);
R for any other kind of reference, or

E for an error in which the kind of reference is indeterminate.

symbol-id is a unique decimal number for the symbol. The fields of the above line are separated by tab characters.

Related information

ﬂs_
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6.3 Assembler Options

Altium Designer uses a makefile to build your entire project. This means that in Altium Designer you cannot run the assembler
separately. If you want assembly results, you must compile a single C source file from within Altium Designer, the file is then
also assembled. However, you can set options specific for the assembler.

Options in Altium Designer versus options on the command line

Most command line options have an equivalent option in Altium Designer but some options are only available on the command
line (for example in a Windows Command Prompt). If there is no equivalent option in Altium Designer, you can specify a
command line option in Altium Designer as follows:

1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.

3. Enter one or more command line options in the Additional assembler options field.

Invocation syntax on the command line (Windows Command Prompt)
To call the assembler from the command line, use the following syntax:
asarm [ [option]... [file]... ]...

The input file must be an assembly source file (.asmor .src).

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (=) character, long option
names always begin with double minus (--) characters. You can abbreviate long option names as long as the name is unique.
You can mix short and long option names on the command line.

Options can have flags or sub-options. To switch a flag ‘on’, use a lowercase letter or a +/longflag. To switch a flag off, use an
uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

asarm -0gs test.src
asarm --optimize=+generics,+instr-size test.src

When you do not specify an option, a default value may become active.
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Assembler: --case-insensitive (-c)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.

3. Disable the option Assemble case sensitive.

Command line syntax

--case-insensitive
-c

Description

With this option you tell the assembler not to distinguish between upper and lower case characters. By default the assembler
considers upper and lower case characters as different characters.

@ Disabling the option Assemble case sensitive in Altium Designer is the same as specifying the option
--case-insensitive on the command line.

Assembly source files that are generated by the compiler must always be assembled case sensitive. When you are writing your
own assembly code, you may want to specify the case insensitive mode.

Example

When assembling case insensitive, the label LabelName is the same label as 1abelname.

Related information

ﬂ?‘
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Assembler: --check

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.

3. Add the option --check to the Additional assembler options field.

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your
application.

The assembler reports any warnings and/or errors.

Related information

% C compiler option =-check (Check syntax)
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Assembler: --cpu (-C)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Processor entry and select Processor Definition.

3. Select a processor from the Select processor box.

Command line syntax

--cpu=[ARMv4|ARMv4T|ARMv5T|ARMv5TE|ARMv6M|ARMv7M|XS]
-C[ARMv4|ARMv4T|ARMv5T|ARMv5TE|ARMv6M|ARMv7M|XS]

Description

With this option you specify the ARM architecture for which you create your application. The architecture determines which
instructions are valid and which are not. If the architecture is ARMv4 the linker replaces BX instructions by MOV PC instructions.
The default architecture is ARMv4T and the complete list of supported architectures is: ARMv4, ARMv4T, ARMvV5T, ARMV5TE,
ARMv6-M, ARMv7-MoOr XScale.

Assembly code can check the value of the option by means of the built-in function @CPU ( ). Architecture ARMv4 does not
support the Thumb instruction set. Architecture profile ARMv7-M only supports the Thumb-2 instruction set, i.e. it has no ARM
execution state.

When you call the assembler from the command line, make sure you specify the same core type to the compiler to avoid
conflicts!

Related information

% Assembly function @CPU ()

6-165



ARM Embedded Tools Reference

Assembler: --debug-info (-g)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Debug Information.

3. Select which debug information to include: Automatic HLL or assembly level debug information, Custom debug
information or No debug information.

If you select Custom debug information:

4. Select which Custom debug information to include: Assembler source line information, Pass HLL debug information, or
None.

5. Enable or disable the option Assembler local symbols information.

Command line syntax

--debug-info[=flag]
-g[flag]

You can set the following flags:

+/-asm (a/A) Assembly source line information
+/-hll (h/H) Pass high level language debug information (HLL)
+/-local (L) Assembler local symbols debug information
+/-smart (s/S) Smart debug information

Description

With this option you tell the assembler which kind of debug information to emit in the object file.

If you do not use this option, the default is --debug-info=+hll. If you specify --debug-info without any flags, the default is
--debug-info=+smart.

You cannot specify --debug-info=+asm,+hll. Either the assembler generates assembly source line information, or it passes
HLL debug information.

When you specify --debug-info=+smart, the assembler selects which flags to use. If high level language information is
available in the source file, the assembler passes this information (same as —--debug-info=-asm,+hll,-local). If not, the
assembler generates assembly source line information (same as --debug-info=+asm,-hll,+local).

With --debug-info=AHLS the assembler does not generate any debug information.

Related information

ﬂﬁ'

6-166



Tool Options - Assembler

Assembler: --define (-D)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
Expand the Assembler entry and select Preprocessing.

2

3. Click on User macro, click on the down arrow in the right pane to expand macro input.

4. Click on an empty Macro field and enter a macro name. (Then click outside the cell to confirm)
5

. Optionally, click in the Value field and enter a definition. (Then click outside the cell to confirm)

Command line syntax

--define=macro_name[=macro_definition]
-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the assembler preprocessor. If you only specify a macro name (no
macro definition), the macro expands as '1’.

You can specify as many macros as you like. On the command line you can use the option --define (-D) multiple times. If the
command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify
to the assembler with the option --option-file=file (-f).

Defining macros with this option (instead of in the assembly source) is, for example, useful in combination with conditional
assembly as shown in the example below.

@ This option has the same effect as defining symbols via the .DEFINE, .SET, and .EQU directives. (similar to #define in
the C language). With the .MACRO directive you can define more complex macros.

Example

Consider the following assembly program with conditional code to assemble a demo program and a real program:

.IF DEMO ==

. ; instructions for demo application
.ELSE

e ; instructions for the real application
.ENDIF

You can now use a macro definition to set the DEMO flag:
Macro Value
DEMO 1 (or empty)

asarm --define=DEMO test.src
asarm --define=DEMO=1 test.src

Note that both invocations have the same effect.

Related information

% Assembler option --option-file (Read options from file)
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Assembler: --diag

Menu entry

1. From the View menu, select Workspace Panels » System » Messages.
The Messages panel appears.

2. Inthe Messages panel, right-click on the message you want more information on.
A popup menu appears.

3. Select More Info.

A Message Info box appears with additional information.

Command line syntax

--diag=[format:]{all|nr,...}

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to
stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default).
To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error
messages, you can specify the error message numbers, separated by commas.

With this option the assembler does not assemble any files.

Example
To display an explanation of message number 241, enter:
asarm --diag=241
This results in the following message and explanation:
W241: additional input files will be ignored
The assembler supports only a single input file. All other input files are ignored.
To write an explanation of all errors and warnings in HTML format to file aserrors.html, use redirection and enter:

asarm --diag=html:all > aserrors.html

Related information

%-
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Assembler: --emit-locals

Menu entry

Command line only.

Command line syntax
--emit-locals[=flag,...]

You can set the following flags (when you specify no flags, the default is Es)::

+/-equs (e/E) emit local EQU symbols
+/-symbols (s/S) emit local non-EQU symbols
Description

With the option --emit-locals=+equs the assembler also emits local EQU symbols to the object file. Normally, only global
symbols and non-EQU local symbols are emitted. Having local symbols in the object file can be useful for debugging.

Related information

ﬂ?'
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Assembler: --endianness

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Processor entry and select Processor Definition.

3. Enable the option Big-endian mode.

Command line syntax
--endianness=endianness

-B
--big-endian

You can specify the following endianness:

big (b) Big endian
little (1) Little endian (default)
Description

By default, the assembler generates object files with instructions and data in little-endian format (least significant byte of a word
at lowest byte address). With —-—endianness=big the assembler generates object files in big-endian format (most significant
byte of a word at lowest byte address). =B is an alias for option --endianness=big.

The endianness is reflected in the list file.

Assembly code can check the setting of this option by means of the built-in assembly function @BIGENDIAN( ).

Related information

% Assembly function @BIGENDIAN ()
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Assembler: —-error-file

Menu entry

Command line only.
Command line syntax
--error-file[=file]

Description
With this option the assembler redirects error messages to a file.

If you do not specify a filename, the error file will be named after the input file with extension .ers.

Example
To write errors to errors.err instead of stderr, enter:

asarm --error-file=errors.err test.src

Related information

ﬂﬁ'
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Assembler: --error=limit

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.
3. Add the option --error-limit to the Additional assembler options field.
Command line syntax

——error-limit=number

Description

With this option you tell the assembler to only emit the specified maximum number of errors. Without this option (same as 0) the
assembler emits all errors.

Related information

ﬂﬁ‘

6-172



Tool Options - Assembler

Assembler: --help (-?)

Menu entry

Command line only.

Command line syntax

--help[=options]
-?

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option
descriptions.

Example
The following invocations all display a list of the available command line options:

asarm -?
asarm --help
asarm

To see a detailed description of the available options, enter:

asarm --help=options
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Assembler: --include-directory (-I)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Select Build Options.

3. Add a pathname in the Include Files Path field.

If you enter multiple paths, separate them with a semicolon (;).

Command line syntax

--include-directory=path,...
=lpath,...

Description

With this option you can specify the path where your include files are located. A relative path will be relative to the current
directory.

The order in which the assembler searches for include files is:

1. The pathname in the assembly file and the directory of the assembly source.

2. The path that is specified with this option.

3. The path that is specified in the environment variable ASARMINC when the product was installed.
4

. The default include directory relative to the installation directory.

Example

Suppose that your assembly source file test . src contains the following line:
.INCLUDE ’'myinc.inc’

You can call the assembler as follows:
asarm --include-directory=c:\proj\include test.src

First the assembler looks in the directory where test.src is located for the file myinc. inc. If it does not find the file, it looks in
the directory c: \proj\include for the file myinc. inc (this option). If the file is still not found, the assembler searches in the
environment variable and then in the default include directory.

Related information

% Assembler option --include-file (-H) (Include file before source)
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Assembler: --include-file (-H)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Preprocessing.

3. Enter the name of the file in the Include this file before source field or click ... and select a file.

Command line syntax

--include-file=file,...
-Hfile,...

Description

With this option (set at project level) you include one extra file at the beginning of the assembly source file. The specified include
file is included before all other includes. This is the same as specifying . INCLUDE ’file’ atthe beginning of your assembly
source.

Example
asarm --include-file=myinc.inc testl.src

The file myinc. inc is included at the beginning of test1. src before it is assembled.

Related information

% Assembler option --include-directory (Include files path)

Section 5.4, How the Assembler Searches Include Files, in chapter Using the Assembler of the user’s manual.
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Assembler: --inversions

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.

3. Enable the option Allow instruction inversions.

Command line syntax

—--inversions

Description

With this option you tell the assembiler to try to invert some data processing instructions with an immediate operand. Inversions
are available for MOV/MVN, CMP/CMN, AND/BIC, ADC/SBC, and ADD/SUB.

Example

You can write
add rl,r2,#-4

and the assembler will generate
sub rl,r2,#4

and instead of
mov rl, 0XFFFFFFFF

the assembler will generate

mvn rl,0

Related information

ﬂﬁ'
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Assembler: --keep-output-files (-k)

Menu entry

Altium Designer always removes the object file when errors occur during assembling.

Command line syntax

--keep-output-files
-k

Description

If an error occurs during assembling, the resulting object file (. obj) may be incomplete or incorrect. With this option you keep
the generated object file when an error occurs.

By default the assembler removes the generated object file when an error occurs. This is useful when you use the make utility. If
the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated object. For example when you know that a particular error does not
result in a corrupt object file.

Related information

ﬂﬁ'
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Assembler: --list-file (-I)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Assembler entry and select List File.

3. Enable Generate list file.

4. Inthe List file format section, enable or disable the types of information to be included.

Command line syntax
—-list-file[=file]
-Iffile]

Description

With this option you tell the assembler to generate a list file. A list file shows the generated object code and the relative
addresses. Note that the assembler generates a relocatable object file with relative addresses.

With the optional file you can specify an alternative name for the list file. By default, the name of the list file is the basename of
the source file with the extension . 1st.

Related information

On the command line you can use the option --list-format (L) to specify which types of information should be included
in the list file.

6-178



Tool Options - Assembler

Assembler: --list-format (-L)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Assembler entry and select List File.

3. Enable Generate list file.

4. Inthe List file format section, enable or disable the types of information to be included.

Command line syntax

--list-format=flags
-Lflags

You can set the following flags:

0 Same as ~-LDEGILMNPQRSVWXYZ (all options disabled)

1 Same as -Ldegilmnpqrsvwxyz (all options enabled)

+/-section (d/D) Section directives (.SECTION)

+/-symbol (e/E) Symbol definition directives
+/-generic-expansion (9/G) Generic instruction expansion
+/-generic (im Generic instructions

+/-line (L) C preprocessor #line directives
+/-macro (m/M) Macro/dup definitions (e.g. .MACRO)
+/-empty-line (n/N) Empty source lines (newline)
+/-conditional (p/P) Conditional assembly (.IF, .ELSE, .ENDIF)
+/-equate (9/Q) Assembler .EQU and .SET directives
+/-relocations (r/R) Relocation characters (’r’)

+/-hll (s/S) HLL symbolic debug information (.SYMB)
+/-equate-values (Vv/V) Assembler .EQU and .SET values
+/-wrap-lines (wW/W) Wrapped source lines
+/-macro-expansion (x/X) Macro expansions

+/-cycle-count (y/Y) Cycle counts

+/-macro-expansion (2/2) Define expansions

Default: ~LdEGIIMnPqrsVwXyZ

Description

With this option you specify which information you want to include in the list file.

@ On the command line you must use this option in combination with the option --list-file (-I).

Related information

% Assembler option --list-file (Generate list file)
Assembler option --section-info=+list (Display section information in list file)
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Assembler: --no-warnings (-w)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Assembler entry and select Diagnostics.

3. Enable one of the options:

* Report all warnings
* Suppress all warnings
* Suppress specific warnings

If you select Suppress specific warnings:

4. Enter the numbers, separated by commas, of the warnings you want to suppress.

Command line syntax

--no-warnings[=number,...]
-w[number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

* If you do not specify this option, all warnings are reported.
* If you specify this option but without numbers, all warnings are suppressed.

* If you specify this option with a number, only the specified warning is suppressed.
You can specify the option —-no-warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter 135, 136 in the Specific warnings to suppress field, or enter the following on the
command line:

asarm test.src --no-warnings=135,136

Related information

% Assembler option --warnings-as-errors (Treat warnings as errors)
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Assembler: --old-syntax

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.

3. Disable the option UAL syntax mode.

Command line syntax

--old-syntax

Description

In UAL syntax mode the assembler will not accept instructions which use the pre-UAL syntax and will select encodings based
on the UAL syntax in case both syntaxes are the same.

With this option you can change this default behavior. The assembler will run in pre-UAL mode. The built-in function
@PRE_UAL() will return true, so you can use:

.IF @PRE UAL()
; <old code>
.ELSE
; <new code>
.ENDIF

Related information

ﬂﬁ'
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Assembler: --optimize (-0)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Optimization.

3. Enable or disable the optimization options:

¢ Generic instructions
* Jump chains
¢ Instruction size

Command line syntax

-Oflags
--optimize=flags

You can set the following flags:

+/-generics (9/G) Allow generic instructions
+/-jumpchains (id) Jump chains
+/-instr-size (s/S) Optimize instruction size

Default: --optimize=gJs

Description
Allow generic instructions

If you use generic instructions in your assembly source, the assembler can optimize them by replacing it with the fastest or
shortest possible variant of that instruction. By default this option is enabled. If you turn off this optimization, the assembler
generates an error on generic instructions. Be aware that the compiler also generates generic instructions!

Jump chains

With this optimization, the assembler replaces chained jumps by a single jump instruction. For example, a jump from a to b
immediately followed by a jump from b to ¢, is replaced by a jump from a to c.

Optimize instruction size

With this optimization the assembler tries to find the shortest possible operand encoding for instructions.

Related information

% Section 5.5, Assembler Optimizations in chapter Using the Assembler of the user’s manual.
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Assembler: --option-file (-f)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.
3. Add the option --option-file to the Additional assembler options field.

Be aware that the options in the option file are added to the assembler options you have set in the other dialogs. Only in
extraordinary cases you may want to use them in combination.

Command line syntax
--option-file=file,...
~f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an
option file which contains all options and flags you want to specify. With this option you specify the option file to the assembler.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

Option files can also be generated on the fly, for example by the make utility. You can specify the option --option-file multiple
times.

Format of an option file

e Multiple arguments on one line in the option file are allowed.
* To include whitespace in an argument, surround the argument with single or double quotes.
* |f you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded”
'This has a double quote ” embedded’

'This has a double quote ” and a single quote ’'”’ embedded”
* When atext line reaches its length limit, use a ’to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line”

-> "This is a continuation line”
* ltis possible to nest command line files up to 25 levels.
Example
Suppose the file myoptions contains the following lines:

-gaL
test.src

Specify the option file to the assembler:
asarm —--option-file=myoptions
This is equivalent to the following command line:

asarm -galL test.src

Related information
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Assembler: --output (-0)

Menu entry
Altium Designer names the output file always after the source file.

Command line syntax

—--output=file
-o file

Description

With this option you can specify another filename for the output file of the assembler. Without this option, the basename of the
assembly source file is used with extension . obj.

Example
To create the file relobj.obj instead of asm.obj, enter:

asarm --output=relobj.obj asm.src

Related information

ﬂﬁ'
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Assembler: --page-length

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.

3. Add the option --page-length to the Additional assembler options field.

Command line syntax
--page-length=number

Default: 72

Description

If you generate a list file with the assembler option --list-file, (~I), this option sets the number of lines in a page in the list file.
The default is 72, the minimum is 10. As a special case, a page length of 0 turns off page breaks.

Related information

% Assembler option --list-file (Generate list file)
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Assembler: --page-width

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.
3. Add the option --page-width to the Additional assembler options field.
Command line syntax
--page-width=number
Default: 132
Description

If you generate a list file with the assembler option --list-file, (~I), this option sets the number of columns per line on a page in
the list file. The default is 132, the minimum is 40.

Related information

% Assembler option --list-file (Generate list file)
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Assembler: --preprocess (-E)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.

3. Add the option --preprocess to the Additional assembler options field.

Command line syntax

--preprocess
-E

Description

With this option the assembler will only preprocess the assembly source file. The assembler sends the preprocessed file to
stdout.

Related information

ﬂj_
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Assembler: --preprocessor-type (-m)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.
3. Add the option --preprocessor-type to the Additional assembler options field.
Command line syntax

--preprocessor-type={none|tasking}
-m{n|t} Default: -mt

Description

With this option you select the preprocessor that the assembler will use. By default, the assembler uses the TASKING
preprocessor.

When the assembly source file does not contain any preprocessor symbols, you can specify to the assembler not to use a
preprocessor.

Related information

ﬂs_
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Assembler: --relaxed

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.

3. Enable the option Allow 2-operand form for 3-operand instructions.

Command line syntax

--relaxed

Description

With this option you tell the assembler that a relaxed 2-operand syntax is allowed on 3-operand instructions. If the first two
register operands are equal, you can replace the two registers by one.

Example
Instead of

add rl,rl,#4
you can write

add ri,#4
and instead of

add rl,rl,r2
you can write

add rl,r2

Related information

ﬂﬁ'
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Assembler: --section-info (-t)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Assembler entry and select List File.

3. Enable Generate list file.

4. Enable the option Display section information.

Command line syntax

--section-info[=flags]
~t[flags]

You can set the following flags:

+/-console (c/C) Display section information on stdout.
+/-list (/L) Write section information to the list file.
Description

With this option you tell the assembler to display section information. For each section its memory space, size, total cycle counts
and name is listed on stdout and/or in the list file.

The cycle count consists of two parts: the total accumulated count for the section and the total accumulated count for all
repeated instructions. In the case of nested loops it is possible that the total supersedes the section total.

Without arguments this option is the same as --section-info=cl.

With --section-info=I, the assembler writes the section information to the list file. You must specify this option in
combination with the option --list-file (generate list file).

Example
asarm --list-file --section-info=+console,+list test.src

The assembler generates a list file and writes the section information to this file. The section information is also displayed on
stdout.

Related information

% Assembler option --list-file (generate list file)
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Assembler: --symbol-scope (-i)

Menu entry
1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Miscellaneous.

3. Select the default label mode: Local or Global.

Command line syntax

--symbol-scope={global|local}
-i{g|l} (Default: —il)

Description

With this option you tell the assembler how to treat symbols that you have not specified explicitly as global or local. By default

the assembler treats all symbols as local symbols unless you have defined them explicitly as global.

Related information

ﬂﬁ'
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Assembler: —--thumb (-T)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Assembler entry and select Miscellaneous.

3. Add the option --thumb to the Additional assembler options field.

Command line syntax

—-thumb
-T

Description

With this option you tell the assembler that the input file contains Thumb code. By default the assembler assumes that the input
file contains ARM code. The assembler will complain if -—~thumb is used in combination with --cpu=ARMv4. Specifying
--thumb with —-—cpu=ARMv7M is not required.

Note that the input may still contain mixed Thumb and ARM code because the .ARM, . THUMB, .CODE16 and .CODE32
directives overrule the --thumb option. Assembly code can check the setting of the --thumb option by means of the built-in
assembly function @THUMB ( ). So, if you use @THUMB () in a .ARM part and you specified —-thumb, @THUMB ( ) still returns 1.

Related information

% Assembly function @ THUMB ( )
Assembler directives .CODE16/.CODE32/.THUMB/ .ARM
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Assembler: --version (-V)
Menu entry
Command line only.

Command line syntax

--version
'

Description

Displays version information of the assembler. The assembler ignores all other options or input files.

Related information

ﬂ?‘
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Assembler: --verbose (-v)

Menu entry

Command line only.

Command line syntax

--verbose
-V

Description

With this option you put the assembler in verbose mode. The assembler prints the filenames and the assembly passes while it
processes the files so you can monitor the current status of the assembler.

Related information

ﬂ@‘
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Assembler: --warnings-as-errors

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Assembler entry and select Diagnostics.

3. Enable the option Treat warnings as errors.

Command line syntax

—--warnings-as-errors[=number,...]

Description

If the assembler encounters an error, it stops assembling. When you use this option without arguments, you tell the assembler to
treat all warnings as errors. This means that the exit status of the assembler will be non-zero after one or more compiler
warnings. As a consequence, the assembler now also stops after encountering a warning.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

% Assembler option --no-warnings (Suppress some or all warnings)
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6.4 Linker Options

Altium Designer uses a makefile to build your entire project. This means that you cannot run the linker separately. However, you
can set options specific for the linker.

Options in Altium Designer versus options on the command line

Most command line options have an equivalent option in Altium Designer but some options are only available on the
command line (for example in a Windows Command Prompt). If there is no equivalent option in Altium Designer, you can
specify a command line option in Altium Designer as follows:

1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Linker entry and select Miscellaneous.

3. Enter one or more command line options in the Additional Linker options field.

Invocation syntax on the command line (Windows Command Prompt)
The invocation syntax on the command line is:
lkarm [ [option]... [file]... ]...

When you are linking multiple files, either relocatable object files (.obj or .0), .out files or libraries (. 1ib or .a), it is important
to specify the files in the right order. Files with extensions other than .ob3j, .o, .out, .1ib or . a are not recognized as input
files.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (=) character, long option
names always begin with double minus (--) characters. You can abbreviate long option names as long as the name is unique.
You can mix short and long option names on the command line.

Options can have flags or sub-options. To switch a flag 'on’, use a lowercase letter or a +longflag. To switch a flag off, use an
uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

lkarm -mfk test.obj
lkarm --map-file-format=+files,+link test.obj

When you do not specify an option, a default value may become active.
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Linker: —--case-insensitive

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Disable the option Link case sensitive.

Command line syntax

--case-insensitive

Description

With this option you tell the linker not to distinguish between upper and lower case characters in symbols. By default the linker

considers upper and lower case characters as different characters.

@ Disabling the option Link case sensitive in Altium Designer is the same as specifying the option --case-insensitive on
the command line.

Assembly source files that are generated by the compiler must always be assembled and thus linked case sensitive. When you
have written your own assembly code and specified to assemble it case insensitive, you must also link the . ob7j file case
insensitive.

Related information

%_
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Linker: --chip-output (-c)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Output Format.

3. Enable the options Intel HEX records and/or Motorola S-records.

Command line syntax

--chip-output=[basenamel:format[:addr_size],...
-c[basename):format[:addr_sizel,...

You can specify the following formats:

IHEX Intel Hex
SREC Motorola S-records

The addr_size specifies the size of the addresses in bytes (record length). For Intel Hex you can use the values 1, 2 or 4 bytes
(default). For Motorola-S you can specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default). In Altium Designer you
cannot specify the address size because Altium Designer always uses the default values.

Description

With this option you specify the Intel Hex or Motorola S-record output format for loading into a PROM-programmer. The linker
generates a file for each ROM memory defined in the LSL file, where sections are located:

memory memname
{ type=rom; }

The name of the file is the name of the Altium Designer project or, on the command line, the name of the memory device that
was emitted with extension .hex or . sre. Optionally, you can specify a basename which prepends the generated file name.

@ The linker always outputs a debugging file in ELF/DWARF format and optionally an absolute object file in Intel
Hex-format and/or Motorola S-record format.

Example
To generate Intel Hex output files for each defined memory, enter the following on the command line:
lkarm --chip-output=myfile:IHEX testl.obj

In this case, this generates the file myfile memname.hex
Related information

% Linker option —-output (Output file)

Section 8.2, Motorola S-Record Format,
Section 8.3, Intel Hex Record Format, in Chapter Object File Formats.
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Linker: —-cpu (-C)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Processor entry and select Processor Definition.

3. Select a processor from the Select processor box.

Command line syntax
--cpu=[ARMv4|ARMv4T|ARMv5T|ARMv5TE|ARMv6M|ARMv7M|XS]
-C[ARMv4|ARMvA4T|ARMv5T|ARMv5TE|ARMV6M|ARMv7M|XS]

Description

With this option you specify the ARM architecture for which you create your application. The linker uses the architecture to
determine which libraries must be linked and what kind of veneers to generate. If the architecture is ARMv4 the linker will
replace BX instructions in ARMv4T code by MOV PC instructions. If the architecture is ARMv5T, ARMV5TE or XScale the linker
will replace unconditional BL instructions by BLX instructions if the branch target requires a state change between ARM and
Thumb ot vice versa. The default architecture is ARMv4T and the complete list of supported architectures is: ARMv4, ARMvA4T,
ARMV5T, ARMV5TE, ARMV6-M, ARMv7-M, XScale.

Architecture ARMv4 does not support the Thumb instruction set. Architecture ARMv7-M only supports the Thumb-2 instruction
set.

Related information

%_
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Linker: —-define (-D)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.
Expand the Linker entry and select Miscellaneous.

2

3. Click on User macro, click on the down arrow in the right pane to expand macro input.

4. Click on an empty Macro field and enter a macro name. (Then click outside the cell to confirm)
5

. Optionally, click in the Value field and enter a definition. (Then click outside the cell to confirm)

Command line syntax

--define=macro_name[=macro_definition]
-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the linker LSL file preprocessor. If you only specify a macro name (no
macro definition), the macro expands as '1’.

You can specify as many macros as you like; just use the option --define multiple times. If the command line exceeds the limit
of the operating system, you can define the macros in an option file which you then must specify to the linker with the option
--option-file=file (-f).

The definition can be tested by the preprocessor with #if, #ifdef and #ifndef, for conditional locating.
Example

To define the stack size and start address which are used in the linker script file arm. 1s1, enter:

lkarm test.obj -otest.abs -darm.lsl -D__STACK=32k
-D__START=0x00000000

or using the long option names:

lkarm -otest.abs -lsl-file=arm.lsl --define=_STACK=32k
--define=_START=0x00000000

Related information

ﬂj Linker option —--option-file (Read options from file)
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Linker: --diag

Menu entry

1. From the View menu, select Workspace Panels » System » Messages.
The Messages panel appears.

2. Inthe Messages panel, right-click on the message you want more information on.
A popup menu appears.

3. Select More Info.

A Message Info box appears with additional information.

Command line syntax
--diag=[format:]{all|nr,...]

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to
stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default).
To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error
messages, you can specify the error message numbers, separated by commas.

With this option the linker does not link/locate any files.

Example

To display an explanation of message number 106, enter:
lkarm --diag=106

This results in the following message and explanation:
E106: unresolved external: <message>

The linker could not resolve all external symbols. This is an error when the incremental
linking option is disabled. The <message> indicates the symbol that is unresolved.

To write an explanation of all errors and warnings in HTML format to file lerrors.html, enter:

lkarm --diag=html:all > lerrors.html

Related information

ﬂj_
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Linker: --endianness

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Processor entry and select Processor Definition.

3. Enable the option Big-endian mode.

Command line syntax
--endianness=endianness

-B
--big-endian

You can specify the following endianness:

big (b) Big endian
little (1) Little endian (default)
Description

By default, the linker links objects in little-endian mode. With --endianness=big you tell the linker to link the input files in
big-endian mode. The endianess used must be valid for the architecture you are linking for. Depending on the endianess used,
the linker links different libraries.

-B is an alias for option --endianness=big.

Related information

ﬂj_
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Linker: —-error-file

Menu entry

Command line syntax

--error-file[=file]

Description

With this option the linker redirects error messages to a file.

If you do not specify a filename, the error file is 1karm.elk.

Example
To write errors to errors.elk instead of stderr, enter:

lkarm --error-file=errors.elk test.obj

Related information

ﬂﬁ'
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Linker: —-error-limit

Menu entry

Command line syntax

—-error-limit=number

Description

With this option you tell the linker to only emit the specified maximum number of errors. When 0 (null) is specified, the linker
emits all errors. Without this option the maximum number of errors is 42.

Related information

ﬂﬁ'
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Linker: --extern (-e)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option --extern to the Additional linker options field.

Command line syntax

—--extern=symbol
-e symbol

Description

With this option you force the linker to consider the given symbol as an undefined reference. The linker tries to resolve this
symbol, either the symbol is defined in an object file or the linker extracts the corresponding symbol definition from a library.

This option is, for example, useful if the startup code is part of a library. Because your own application does not refer to the
startup code, you can force the startup code to be extracted by specifying the symbol _START as an unresolved external.

Example
Consider the following invocation:
lkarm mylib.lib

Nothing is linked and no output file will be produced, because there are no unresolved symbols when the linker searches
throughmylib.lib.

lkarm --extern=_START mylib.lib

In this case the linker searches for the symbol _START in the library and (if found) extracts the object that contains _START, the
startup code. If this module contains new unresolved symbols, the linker looks again in mylib. 1ib. This process repeats until
no new unresolved symbols are found.

Related information

% Section 6.4, Linking with Libraries, in chapter Using the Linker of the user’s manual.
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Linker: —-first-library first

Menu entry

Command line syntax

—-first-library-first
Description

When the linker processes a library it searches for symbols that are referenced by the objects and libraries processed so far. If
the library contains a definition for an unresolved reference the linker extracts the object that contains the definition from the
library.

By default the linker processes object files and libraries in the order in which they appear on the command line. If you specify the
option --first-library-first the linker always tries to take the symbol definition from the library that appears first on the
command line before scanning subsequent libraries.

This is for example useful when you are working with a newer version of a library that partially overlaps the older version.
Because they do not contain exactly the same functions, you have to link them both. However, when a function is present in
both libraries, you may want the linker to extract the most recent function.

Example
Consider the following example:
lkarm --first-library-first a.lib test.obj b.lib

If the file test.obj calls a function which is both presentin a.1ib and b.1ib, normally the function in b.1ib would be
extracted. With this option the linker first tries to extract the symbol from the first library a. 1ib.

Note that routines in b. 1ib that call other routines that are present in both a.1ib and b.1ib are now also resolved from
a.lib.

Related information

% Linker option --no-rescan (Rescan libraries to solve unresolved externals)
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Linker: --global-type-checking

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option --global-type-checking to the Additional linker options field.

Command line syntax

--global-type-checking

Description

Use this option when you want the linker to check the types of variable and function references against their definitions, using
DWARF 2 or DWARF 3 debug information.

This check should give the same result as the C compiler when you use MIL linking.

Related information

ﬂﬁ'
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Linker: —-help (-?)

Menu entry

Command line syntax

--help[=options]
-?

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option
descriptions.

Example
The following invocations all display a list of the available command line options:

lkarm -?
lkarm --help
lkarm

To see a detailed description of the available options, enter:

lkarm --help=options
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Linker: --hex-format

Menu entry

Command line syntax
--hex-format=flag,...
You can set the following flag:
+/-start-address  (s/S) Emit start address record

Default: --hex-format=s

Description

With this option you can specify to emit or omit the start address record from the hex file.

Related information

% Linker option —-output (Output file)
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Linker: --hex-record-size

Menu entry

Command line syntax
--hex-record-size=size

Default: 32

Description

With this option you can set the size (width) of the Intel Hex data records.

Related information

% Linker option --output (Output file)
Section 8.3, Intel Hex Record Format, in Chapter Object File Formats.
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Linker: --import-object

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add one or more files to the Import the following data object files field.

Command line syntax

--import-object=file,...

Description

With this option the linker imports a binary file containing raw data and places it in a section. The section name is derived from
the filename, in which dots are replaced by an underscore. So, when importing a file called my . jpg, a section with the name
my_Jjpg is created. In your application you can refer to the created section by using linker labels.

Related information

% Section 6.7, Importing Binary Files.
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Linker: —-include-directory (-I)

Menu entry

Command line syntax

--include-directory=path,...
=lpath,...

Description

With this option you can specify the path where your LSL include files are located. A relative path will be relative to the current
directory.

The order in which the linker searches for LSL include files is:

1. The pathname in the LSL file and the directory where the LSL file is located
(only for #include files that are enclosed in ™)

2. The path that is specified with this option.

3. The default directory $ (PRODDIR)\include.lsl.

Example
Suppose that your linker script file my1s1.1s1 contains the following line:
#include "myinc.inc”
You can call the linker as follows:
lkarm --include-directory=c:\proj\include --1lsl-file=mylsl.lsl test.obj

First the linker looks in the directory where myls1.1s1 is located for the file myinc. inc. If it does not find the file, it looks in the
directory c: \proj\include for the file myinc. inc (this option). Finally it looks in the directory $ (PRODDIR)\include.1lsl.

Related information

ﬂﬁ'
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Linker: —-incremental (-r)

Menu entry

Command line syntax
--incremental
=-r

Description

Normally the linker links and locates the specified object files. With this option you tell the linker only to link the specified files.
The linker creates a linker output file . out. You then can link this file again with other object files until you have reached the final
linker output file that is ready for locating.

In the last pass, you call the linker without this option with the final linker output file . out. The linker will now locate the file.

Example
In this example, the files test1l.obj, test2.0bj and test3.obj are incrementally linked:
1. lkarm --incremental testl.obj test2.obj -otest.out
testl.obj and test2.obj are linked
2. lkarm --incremental test3.obj test.out
test3.obj and test.out are linked, taskl.out is created
3. lkarm taskl.out

taskl.out is located

Related information

% Section 6.5, Incremental Linking in chapter Using the Linker of the user’s manual.
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Linker: —--keep-output-files (-k)

Menu entry

Altium Designer always removes the output files when errors occurred.

Command line syntax

--keep-output-files
-k

Description

If an error occurs during linking, the resulting output file may be incomplete or incorrect. With this option you keep the generated
output files when an error occurs.

By default the linker removes the generated output file when an error occurs. This is useful when you use the make uitility. If the
erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated file. For example when you know that a particular error does not result
in a corrupt object file, or when you want to inspect the output file, or send it to Altium support.

Related information

éﬂi§ _
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Linker: —-library (-I)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Libraries.

3. Enable the option Link default C libraries.

Command line syntax

—-library=name
-lname

Description

With this option you tell the linker to use system library name . 1ib, where name is a string. The linker first searches for
system libraries in any directories specified with --library-directory, then in the directories specified with the environment
variable LIBARM, unless you used the option --ignore-default-library-path.

Example
To search in the system library carm.1ib (C library):
lkarm test.obj mylib.lib --library=carm

The linker links the file test.obj and first looks inmylib.1ib (in the current directory only), then in the system library
carm. lib to resolve unresolved symbols.

Related information

% Linker option --library-directory (Additional search path for system libraries)

Section 6.4, Linking with Libraries, in chapter Using the Linker of the user’s manual.
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Linker: —-library-directory (-L) / --ignore-default-library-path

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Open the Build Options page.

3. Add a pathname in the Library files path field.

If you enter multiple paths, separate them with a semicolon (;).

Command line syntax

—-library-directory=dir
~Ldir

--ignore-default-library-path
-L
Description

With this option you can specify the path(s) where your system libraries, specified with the —-library option, are located. If you
want to specify multiple paths, use the option --library-directory for each separate path.

The default path is $ (PRODDIR) \carm\1lib.

If you specify only -L (without a pathname) or the long option --ignore-default-library-path, the linker will not search the
default path and also not in the paths specified in the environment variable LIBARM. So, the linker ignores steps 2 and 3 as
listed below.

The priority order in which the linker searches for system libraries specified with the —-library option is:
1. The path that is specified with the --library-directory option.
2. The path that is specified in the environment variable LIBARM.
3. The default directory $ (PRODDIR)\carm\1lib (or a processor specific sub-directory).
Example
Suppose you call the linker as follows:
lkarm test.obj --library-directory=c:\mylibs --library=carm
First the linker looks in the directory c: \mylibs for library carm. 1ib (this option).
If it does not find the requested libraries, it looks in the directory that is set with the environment variable LIBARM.

Then the linker looks in the default directory $ (PRODDIR) \carm\1ib for libraries.

Related information

% Linker option --library (Link system library)

Section 6.4.1, How the linker searches libraries in chapter Using the Linker of the user’s manual.
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Linker: —-link-only

Menu entry

Command line syntax

--link-only

Description

With this option you suppress the locating phase. The linker stops after linking and informs you about unresolved references.

Related information

% Control program option -cl (Stop after linking)
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Linker: —--long-branch-veneers

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Enable the option Generate long-branch veneers.

Command line syntax

--long-branch-veneers
Description

With this option you enable the linker to generate a long-branch veneer if the target of a B (ARM only, not for Thumb), BL or
BLX instruction is out-of-range. The locating process of the linker may become less efficient if this option is switched on, even if
no long-branch veneers are required after all. Therefore it is better to first see if out-of-range branches are in the code
(unlikely) before switching on this option. You cannot use this option with the ARMv6-M architecture profile.

Related information

ﬂﬁ'
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Linker: --Isl-check

Menu entry

Command line syntax

--Isl-check

Description

With this option the linker just checks the syntax of the LSL file(s) and exits. No linking or locating is performed. Use the option
--lIsl-file=file to specify the name of the Linker Script File you want to test.

Related information

% Linker option --Isl-file (Linker script file)
Linker option --Isl-dump (Dump LSL info)

Section 6.9, Controlling the Linker with a Script, in chapter Using the Linker of the user’s manual.
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Linker: —-Isl-dump

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Enable the option Dump processor and memory info from LSL file.
Command line syntax

--Isl-dumpl=file]
Description

With this option you tell the linker to dump the LSL part of the map file in a separate file, independent of the option --map-file
(generate map file). If you do not specify a filename, the file 1ktarget.1df is used.

Related information

% Linker option --map-file-format (Map file formatting)
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Linker: —-Isl-file (-d)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Enable the option Use project specific LSL file.

4. Inthe LSL file field, type a name or click ... and select an LSL file.

Command line syntax

--Isl-file=file
=dfile

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker script file is coded in LSL
and contains the following types of information:

* the architecture definition describes the core’s hardware architecture.
* the memory definition describes the physical memory available in the system.
* the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file to the linker. If you do not specify this option, the linker uses a default script file.
You can specify the existing file arm. 1s1 or the name of a manually written linker script file. You can use this option multiple
times. The linker processes the LSL files in the order in which they appear on the command line.

Related information

% Linker option --Isl-check (Check LSL file(s) and exit)

Section 6.9, Controlling the Linker with a Script, in chapter Using the Linker of the user’s manual.
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Linker: —-map-file (-M)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Linker entry and select Map File.
3. Enable the option Generate a memory map file (.map).

4. Inthe Map file format section, enable or disable the information you want to be included in the map file.

Command line syntax
--map-file[=file]
-M[file]

Description

With this option you tell the linker to generate a linker map file. If you do not specify a filename and you specfied the -o option,
the linker uses the same basename as the output file with the extension .map. If you did not specify the -o option, the linker
uses the file task1.map. Altium Designer names the .map file after the project.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the various object files
(.obj) to the linked object file. A locate part shows the absolute position of each section. External symbols are listed per space
with their absolute address, both sorted on symbol and sorted on address.

Related information

% With the option --map-file-format (map file formatting) you can specify which parts you want to place in the map file.
Section 7.2, Linker Map File Format, in Chapter List File Formats.
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Linker: --map-file-format (-m)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Map File.

3. Enable the option Generate a map file (.map).

4. Inthe Map file format section, enable or disable the information you want to be included in the map file.

Command line syntax

--map-file-format=flags
-mflags

You can specify the following formats:

0 Same as -mcDfikLMNoQrSU (link information)
1 Same as -mCDfiKIMNoQRSU (locate information)
2 Same as -mcdfikimNoQrSu (most information)
+/-callgraph (c/C) Call graph information
+/-removed (d/D) Removed sections information
+/-files (f/F) Processed files information
+/-invocation (i/l) Invocation and tool information
+/-link (k/K) Link result information
+/-locate (/L) Locate result information
+/-memory (m/M) Memory usage information
+/-nonalloc (n/N) Non alloc information
+/-overlay (0/0) Overlay information
+/-statics (a/Q) Module local symbols
+/-crossref (r/R) Cross references information
+/-lIsl (s/S) Processor and memory information
+/-rules (u/U) Locate rules
Description

With this option you specify which information you want to include in the map file. Use this option in combination with the option
--map-file (-M).

If you do not specify this option, the linker uses the default: --map-file-format=2.

Related information

% Linker option —-map-file (Generate map file)
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Linker: --misra-c-report

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the C Compiler entry and select MISRA-C.
3. Select a MISRA-C configuration.
4. Enable the option Produce a MISRA-C report.
Command line syntax
—--misra-c-report[=file]
Description
With this option you tell the linker to create a MISRA-C Quality Assurance report. This report lists the various modules in the
project with the respective MISRA-C settings at the time of compilation. If you do not specify a filename, the file name .mcr is

used.

Related information

% Compiler option —-misrac
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Linker: -—-munch

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option —-munch to the Additional linker options field.

Command line syntax

—--munch

Description

With this option you tell the linker to activate the muncher in the pre-locate phase.

Related information

ﬂﬁ‘
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Linker: --non-romable

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option --non-romable to the Additional linker options field.

Command line syntax

--non-romable

Description

With this option you tell the linker that the application must not be located in ROM. The linker will locate all ROM sections,
including a copy table if present, in RAM. When the application is started, the data sections are re-initialized and the BSS
sections are cleared as usual.

This option is, for example, useful when you want to test the application in RAM before you put the final application in ROM. This
saves you the time of flashing the application in ROM over and over again.

Related information

ﬂs_
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Linker: --no-rescan

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Libraries.

3. Disable the option Rescan libraries to solve unresolved externals.

Command line syntax

--no-rescan

Description

When the linker processes a library it searches for symbol definitions that are referenced by the objects and libraries processed
so far. If the library contains a definition for an unresolved reference the linker extracts the object that contains the definition from
the library. The linker processes object files and libraries in the order in which they appear on the command line.

When all objects and libraries are processed the linker checks if there are unresolved symbols left. If so, the default behavior of
the linker is to rescan all libraries in the order given at the command line. The linker stops rescanning the libraries when all
symbols are resolved, or when the linker could not resolve any symbol(s) during the rescan of all libraries. Notice that resolving
one symbol may introduce new unresolved symbols.

With this option, you tell the linker to scan the object files and libraries only once. When the linker has not resolved all symbols
after the first scan, it reports which symbols are still unresolved. This option is useful if you are building your own libraries. The
libraries are most efficiently organized if the linker needs only one pass to resolve all symbols.

Related information

% Linker option --first-library—first (Scan libraries in given order)
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Linker: --no-rom-copy (~N)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option --no-rom-copy to the Additional linker options field.

Command line syntax

--no-rom-copy
-N

Description

With this option the linker will not generate a ROM copy for data sections. A copy table is generated and contains entries to
clear BSS section. However, no entries to copy data sections from ROM to RAM are placed in the copy table.

The data sections are initialized when the application is downloaded. The data sections are not re-initialized when the
application is restarted.

Related information

ﬂs_
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Linker: —--no-warnings (-w)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Diagnostics.

3. Set Error reporting to one of the following values:

* Report all warnings
* Suppress all warnings
* Suppress specific warnings.

If you select Suppress specific warnings:

4. Enter the numbers, separated by commas, of the warnings you want to suppress.

Command line syntax

--no-warnings[=number,...]
-w[humber,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

* If you do not specify this option, all warnings are reported.
* If you specify this option but without numbers, all warnings are suppressed.

* If you specify this option with a number, only the specified warning is suppressed. You can specify the option
--no-warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter 135, 136 in the Specific warnings to suppress field, or enter the following on the
command line:

lkarm --no-warnings=135,136 test.obj

Related information

% Linker option —-warnings-as-errors (Treat warnings as errors)
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Linker: —-optimize (-O)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Optimization.

3. Select an optimization level in the Optimization level box.
If you select Custom Optimization:

4. Enable the optimizations you want.

Command line syntax

--optimize[=flags]
-Offlags]

Use the following options for predefined sets of flags:

—--optimize=0 (-00) No optimization
Alias for: ~-OCLTXY

--optimize=1 (-01) Default optimization
Alias for: -OcLtXY

--optimize=2 (-02) All optimizations
Alias for: -Ocltxy

You can set the following flags:

+/-delete-unreferenced-sections (¢/C) Delete unreferenced sections from the output file

+/-first-fit-decreasing (/L)  Use a "first fit decreasing’ algorithm to locate
unrestricted sections in memory.
+/-copytable-compression (t/T) Emit smart restrictions to reduce copy table size
+/-delete-duplicate-code (x/X) Delete duplicate code sections from the output file
+/-delete-duplicate-data (y/Y) Delete duplicate constant data from the output file
Description

With this option you can control the level of optimization the linker performs. If you do not use this option, --optimize=1 is the
default.

Related information

% Section 6.8, Linker Optimizations, in chapter Using the Linker of the user’s manual.

6-230



Tool Options - Linker

Linker: —-option-file (-f)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Linker entry and select Miscellaneous.
3. Add the option --option-file to the Additional linker options field.
Be aware that the options in the option file are added to the linker options you have set in the other dialogs. Only in
extraordinary cases you may want to use them in combination. Altium Designer automatically saves the options with your
project.
Command line syntax
--option-file=file
-f file
Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an
option file which contains all options and flags you want to specify. With this option you specify the option file to the linker.

Use an option file when the length of the command line would exceed the limits of the operating system, or just to store options
and save typing.

You can specify the option —-option-file multiple times.

Format of an option file

e Multiple arguments on one line in the option file are allowed.
* To include whitespace in an argument, surround the argument with single or double quotes.
* |f you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded”
'This has a double quote ” embedded’

'This has a double quote ” and a single quote ’'”’ embedded”
*  When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line”

-> "This is a continuation line”
* ltis possible to nest command line files up to 25 levels.
Example
Suppose the file myoptions contains the following lines:

-Mmymap (generate a map file)
test.obj (input file)
-Lec:\mylibs (additional search path for system libraries)

Specify the option file to the linker:
lkarm --option-file=myoptions
This is equivalent to the following command line:

lkarm -Mmymap test.obj -Lc:\mylibs

Related information

$_
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Linker: --output (-0)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Output Format.

3. Enable one or more output formats

Command line syntax

--output=[filenamel][:format[:addr_size]]...
-offilenamel][:format[:addr_size]]...

You can specify the following formats:

ELF ELF/DWARF
IHEX Intel Hex
SREC Motorola S-records

Description
By default, the linker generates an output file in ELF/DWARF format, named after the first input file with extension . abs.

With this option you can specify an alternative filename, and an alternative output format. The default output format is the format
of the first input file.

You can use the —-output option multiple times. This is useful to generate multiple output formats. With the first occurrence of
the —-output option you specify the basename (the filename without extension), which is used for subsequent --output
options with no filename specified. If you do not specify a filename, or you do not specify the --output option at all, the linker
uses the default basename taskn.

IHEX and SREC formats

If you specify the Intel Hex format or the Motorola S-records format, you can use the argument addr_size to specify the size of
addresses in bytes (record length). For Intel Hex you can use the values: 1, 2, and 4 (default). For Motorola S-records you can
specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default).

The name of the output file will be filename with the extension .hex or .sre and contains the code and data allocated in the
default address space. If they exist, any other address spaces are also emitted whereas their output files are named
filename spacename.hex (.sre).

@ Use option --chip-output (-c) to create Intel Hex or Motorola S-record output files for each chip defined in the LSL file
(suitable for loading into a PROM-programmer).

Example
To create the output file myfile.hex of the default address space:

lkarm test.obj --output=myfile.hex:IHEX

Related information

% Linker option --chip-output (Generate an output file for each chip)
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Linker: --print-mangled-symbols (-P)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option --print-mangled-symbols to the Additional linker options field.

Command line syntax

—--print-mangled-symbols
-P

Description

C++ compilers generate unreadable symbol names. These symbols cannot easily be related to your C++ source file anymore.
Therefore the linker will by default decode these symbols conform the IA64 ABI when printed to stdout. With this option you
can override this default setting and print the mangled names instead.

Related information

ﬂﬁ'
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Linker: —-strip-debug (-S)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Linker entry and select Miscellaneous.
3. Disable the option Include symbolic debug information.
Command line syntax

--strip-debug
-S

Description
With this option you specify not to include symbolic debug information in the resulting output file.

Related information

ﬂi'
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Linker: —--user-provided-initialization-code (-i)

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.

3. Add the option --user-provided-initialization-code to the Additional linker options field.

Command line syntax
--user-provided-initialization-code
-i

Description

It is possible to use your own initialization code, for example, to save ROM space. With this option you tell the linker not to
generate a copy table for initialize/clear sections. Use linker labels in your source code to access the positions of the sections
when located.

If the linker detects references to the TASKING initialization code, an error is emitted: it is either the TASKING initialization
routine or your own, not both.

Note that the options --no-rom-copy and --non-romable, may vary independently. The ’copytable-compression’
optimization (--optimize=t) is automatically disabled when you enable this option.

Related information

ﬂﬁ'
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Linker: —--verbose (-v) / --extra-verbose (-vv)

Menu entry
1. From the Project menu, select Project Options...
The Project Options dialog box appears.
2. Expand the Linker entry and select Miscellaneous.
3. Add the option --verbose or--extra-verbose to the Additional linker options field.
Command line syntax

--verbose / --extra-verbose
-v/=vv

Description

With this option you put the linker in verbose mode. The linker prints the link phases while it processes the files. In the extra
verbose mode, the linker also prints the filenames and it shows which objects are extracted from libraries. With this option you
can monitor the current status of the linker.

Related information

ﬂﬁ'
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Linker: —-version (-V)

Menu entry

Command line syntax

--version
'

Description

Display version information. The linker ignores all other options or input files.

Related information

ﬂﬁ'
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Linker: —--warnings-as-errors

Menu entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Expand the Linker entry and select Diagnostics.

3. Enable the option Treat warnings as errors.

Command line syntax

—--warnings-as-errors[=number,...]

Description

When the linker detects an error or warning, it tries to continue the link process and reports other errors and warnings. When
you use this option without arguments, you tell the linker to treat all warnings as errors. This means that the exit status of the
linker will be non-zero after the detection of one or more linker warnings. As a consequence, the linker will not produce any
output files.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

% Linker option —--no-warnings (Suppress some or all warnings)
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6.5 Control Program Options

The control program is a tool to facilitate use of the toolset from the command line. Therefore you can only call the control
program from the command line. The invocation syntax is:

ccarm [option]... [file]...

Options

The control program processes command line options either by itself, or, when the option is unknown to the control program, it
looks whether it can pass the option to one of the other tools. However, for directly passing an option to the C++ compiler, C
compiler, assembler or linker, it is recommended to use the control program options —--pass-c++, --pass-c,
--pass-assembler, --pass-linker.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (=) character, long option
names always begin with double minus (--) characters. You can abbreviate long option names as long as the name is unique.
You can mix short and long option names on the command line.

Options can have flags or sub-options. To switch a flag ‘on’, use a lowercase letter or a +longflag. To switch a flag off, use an
uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

ccarm -Wc-Oac test.c
ccarm --pass-c=--optimize=+coalescer,+cse test.c

When you do not specify an option, a default value may become active.
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Control Program: --address-size

Command line syntax

--address-size=addr_size

Description

If you specify IHEX or SREC with the control option —-format, you can additionally specify the record length to be emitted in the
output files.

With this option you can specify the size of addresses in bytes (record length). For Intel Hex you can use the values: 1, 2, and 4
(default). For Motorola S-records you can specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default).

If you do not specify addr_size, the default address size is generated.

Example
To create the SREC file test.sre with S1 records, type:

ccarm --format=SREC --address-size=2 test.c

Related information

% Control program option ——format (Set linker output format)

Linker option --output (Specify an output object file)
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Control Program: —--check
Command line syntax
--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your
application.

The compiler/assembler reports any warnings and/or errors.

Related information

% C compiler option —--check (Check syntax)

Assembler option —-check (Check syntax)
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Control Program: --cpu (-C)

Command line syntax
--cpu=[ARMv4|ARMv4T|ARMv5T|ARMv5TE|ARMv6M|ARMV7M)|XS]
-C[ARMv4|ARMv4T|ARMv5T|ARMV5TE|ARMv6M|ARMv7M|XS]

Description

With this option you specify the ARM architecture for which you create your application. The architecture determines which
instructions are valid and which are not. If the architecture is ARMv4 the linker replaces BX instructions by MOV PC instructions.
The default architecture is ARMv4T and the complete list of supported architectures is: ARMv4, ARMv4T, ARMv5T, ARMV5TE,
ARMvV6-M, ARMV7-M Or XScale.

Assembly code can check the value of the option by means of the built-in function @CPU (). Architecture ARMv4 does not
support the Thumb instruction set. Architecture profile ARMv7-M only supports the Thumb-2 instruction set, i.e. it has no ARM
execution state.

Related information

C compiler option —-cpu (Select architecture)
Assembler option --cpu (Select architecture)
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Control Program: --create (-cc/-cl/-cm/-co/-cs)

Command line syntax

--create[=stage]
~c[stage]

You can specify the following stages (if you omit the stage, the default is -~create=object):

intermediate-c (c) Stop after C++ files are compiled to intermediate C files (. ic)

relocatable U} Stop after the files are linked to a linker object file (. out)

mil (m) Stop after C files are compiled to MIL (.mil)

object (0) Stop after the files are assembled to objects (.obj)

assembly (s) Stop after C files are compiled to assembly (. src)
Description

Normally the control program generates an absolute object file of the specified output format from the file you supplied as input.

With this option you tell the control program to stop after a certain number of phases.

Related information

% Linker option ==link-only (Link only, no locating)
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Control Program: --debug-info (-g)

Command line syntax

--debug-info
-9

Description
With this option you tell the control program to include debug information in the generated object file.

Related information

@ﬂi§ _
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Control Program: --define (-D)

Command line syntax

--define=macro_name[=macro_definition]
-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro name (no macro
definition), the macro expands as ’1’.

You can specify as many macros as you like. On the command line, use the option --define multiple times. If the command line
exceeds the length limit of the operating system, you can define the macros in an option file which you then must specify to the
control program with the option --option-file=file (-f).

Defining macros with this option (instead of in the C source) is, for example, useful to compile or assemble conditional source as
shown in the example below.

The control program passes the option —-define (-D) to the compiler and the assembler.

Example
Consider the following C program with conditional code to compile a demo program and a real program:

void main( void )

{
#if DEMO ==

demo_func(); /* compile for the demo program */
#else

real func(); /* compile for the real program */
#endif
}

You can now use a macro definition to set the DEMO flag. With the control program this looks as follows:

ccarm --define=DEMO test.c
ccarm --define=DEMO=1 test.c

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition are placed between
double quotes because otherwise the spaces would indicate a new option.

ccarm -D”MAX(A,B)=((A) > (B) ? (A) : (B))” test.c
Related information

Control Program option —--undefine (Undefine preprocessor macro)
Control Program option --option-file (Read options from file)
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Control Program: --dep-file

Command line syntax
--dep-file[=file]
Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In contrast to the option
--preprocess=+make, the dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension .d (one for every input file). When you specify a filename, all
dependencies will be combined in the specified file.

Example
ccarm --dep-file=test.dep -t test.c

The compiler compiles the file test.c, which results in the output file test.srec, and generates dependency lines in the file
test.dep.

Related information

% Control program option —-preprocess=+make (Generate dependencies for make)
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Control Program: --diag

Command line syntax

--diag=[format:]{all|nr,...]

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to
stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default).
To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error
messages, you can specify the error message numbers, separated by commas.

With this option the control program does not process any files.

Example
To display an explanation of message number 103, enter:
ccarm --diag=103
This results in message 103 with explanation.
To write an explanation of all errors and warnings in HTML format to file ccerrors.html, enter:

ccarm --diag=html:all > ccerrors.html

Related information

ﬂﬁ'
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Control Program: --dry-run (-n)

Command line syntax

--dry-run
-n

Description

With this option you put the control program verbose mode. The control program prints the invocations of the tools it would use
to process the files without actually performing the steps.

Related information

% Control Program option --verbose (-v) (Verbose output)
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Control Program: --endianness

Command line syntax

--endianness=endianness

-B
--big-endian

You can specify the following endianness:

big (b) Big endian
little U] Little endian (default)
Description

By default, the compiler generates code for a little-endian target (least significant byte of a word at lowest byte address). With
--endianness=big the compiler generates code for a big-endian target (most significant byte of a word at lowest byte
address). =B is an alias for option --endianness=big.

Related information

ﬂj_
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Control Program: --error-file

Command line syntax
--error-file
Description

With this option the control program tells the compiler, assembler and linker to redirect error messages to a file.

The error file will be named after the input file with extension . err (for compiler) or .ers (for assembler). For the linker, the
error file is 1karm. elk.

Example
To write errors to error files instead of stderr, enter:

ccarm --error-file -t test.c

Related information

% Control Program option --warnings-as-errors (Treat warnings as errors)
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Control Program: --exceptions
Command line syntax
--exceptions

Description

With this option you enable support for exception handling in the C++ compiler.

Related information

VS
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Control Program: --force-c
Command line syntax

--force-c
Description

With this option you tell the control program to treat all . cc files as C files instead of C++ files. This means that the control
program does not call the C++ compiler and forces the linker to link C libraries.

Related information

% Control program option --force-c++ (Force C++ compilation and linking)
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Control Program: --force-c++
Command line syntax

--force-c++
Description

With this option you tell the control program to treat all . c files as C++ files instead of C files. This means that the control
program calls the C++ compiler prior to the C compiler and forces the linker to link C++ libraries.

Related information

% Control program option --force-c (Treat C++ files as C files)
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Control Program: --force-munch
Command line syntax
--force-munch
Description
With this option you force the control program to activate the muncher in the pre-locate phase.

Related information

ﬂﬁ'
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Control Program: --format

Command line syntax
--format=format
You can specify the following formats:

IEEE |EEE-695

ELF ELF/DWARF
IHEX Intel Hex

SREC Motorola S-records

Description

With this option you specify the output format for the resulting (absolute) object file. The default output format is ELF/DWARF,
which can directly be used by the debugger.

If you choose IHEX or SREC, you can additionally specify the address size of the chosen format (option —-address-size).

Example
To generate an Motorola S-record output file:

ccarm --format=SREC testl.c test2.c --output=test.sre

Related information

% Control program option --address-size (Set address size for linker IHEX/SREC files)

Linker option —-output (Specify an output object file)
Linker option --chip-output (Generate hex file for each chip)
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Control Program: --global-type-checking
Command line syntax

--global-type-checking
Description

The C compiler already performs type checking within each module. Use this option when you want the linker to perform type
checking between modules.

Related information

% C compiler option --global-type-checking (Global type checking)
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Control Program: --help (-?)

Command line syntax
--help[=options]
-?

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option
descriptions.

Example
The following invocations all display a list of the available command line options:

ccarm =-?
ccarm --help
ccarm

To see a detailed description of the available options, enter:

ccarm --help=options

6-257



ARM Embedded Tools Reference

Control Program: --include-directory (-I)

Command line syntax
--include-directory=path, ...
=lpath,...

Description

With this option you can specify the path where your include files are located. A relative path will be relative to the current
directory.

Example
Suppose that the C source file test . c contains the following lines:

#include <stdio.h>
#include "myinc.h”

You can call the control program as follows:
ccarm --include-directory=myinclude test.c

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory. If it was not found, the
compiler searches in the environment variable and then in the default include directory.

The compiler now looks for the file myinc.h, in the directory where test.c is located. If the file is not there the compiler
searches in the directory myinclude. If it was still not found, the compiler searches in the environment variable and then in the
default include directory.

Related information

C compiler option —-include-directory (Add directory to include file search path)
C compiler option —-include-file (Include file at the start of a compilation)

Section 2.4, How the Compiler Searches Include Files, in chapter Using the Compiler of the user’s manual.
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Control Program: --instantiate

Command line syntax
--instantiate=mode
You can specify the following modes:

used (default)
all
local

Description

Control instantiation of external template entities. External template entities are external (that is, non-inline and non-static)
template functions and template static data members. The instantiation mode determines the template entities for which code
should be generated based on the template definition. Normally, when a file is compiled, template entities are instantiated
wherever they are used (the linker will discard duplicate definitions). The overall instantiation mode can, however, be changed
with this option. You can specify the following modes:

used Instantiate those template entities that were used in the compilation. This will include all static data members for
which there are template definitions. This is the default.

all Instantiate all template entities declared or referenced in the compilation unit. For each fully instantiated template
class, all of its member functions and static data members will be instantiated whether or not they were used.
Non-member template functions will be instantiated even if the only reference was a declaration.

local Similar to --instantiate=used except that the functions are given internal linkage. This is intended to provide a
very simple mechanism for those getting started with templates. The compiler will instantiate the functions that are
used in each compilation unit as local functions, and the program will link and run correctly (barring problems due
to multiple copies of local static variables). However, one may end up with many copies of the instantiated
functions, so this is not suitable for production use.

You cannot use --instantiate=local in conjunction with automatic template instantiation.

Related information

Control program option --no-auto-instantiation (Disable automatic C++ instantiation)
Section 2.6, Template Instantiation in chapter C++ Language.
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Control Program: --io-streams

Command line syntax
--io-streams
Description

As I/O streams require substantial resources they are disabled by default. Use this option to enable 1/O streams support in the
C++ library.

This option also enables exception handling.

Related information

ﬂj_
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Control Program: --iso
Command line syntax
--is0={90|99}

Description

With this option you specify to the control program against which ISO standard it should check your C source. C90 is also
referred to as the "ANSI C standard”. C99 refers to the newer ISO/IEC 9899:1999 (E) standard and is the default.

@ Independant of the chosen ISO standard, the control program always links libraries with C99 support.

Example
To compile the file test . c conform the ISO C90 standard:

ccarm --iso=90 test.c

Related information

% C compiler option —-iso (ISO C standard)
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Control Program: --keep-output-files (-k)

Command line syntax

--keep-output-files
-k

Description

If an error occurs during the compilation, assembling or linking process, the resulting output file may be incomplete or incorrect.
With this option you keep the generated output files when an error occurs.

By default the control program removes generated output files when an error occurs. This is useful when you use the make
utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated files. For example when you know that a particular error does not result
in a corrupt file, or when you want to inspect the output file, or send it to Altium support.

Related information

ﬂﬁ'
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Control Program: --keep-temporary-files (-t)

Menu Entry

1. From the Project menu, select Project Options...
The Project Options dialog box appears.

2. Select Build Options.

3. Enable the option Keep temporary files that are generated during a compile.

Command line syntax

--keep-temporary-files
-t

Description

By default, the control program removes intermediate files like the . src file (result of the compiler phase) and the . obj file
(result of the assembler phase).

With this option you tell the control program to keep temporary files it generates during the creation of the absolute object file.

Related information

ﬂﬁ'
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Control Program: --library (-I)

Command line syntax

--library=name
-lname

Description

With this option you tell the linker via the control program to use system library name . 1ib, where name is a string. The
linker first searches for system libraries in any directories specified with --library-directory, then in the directories specified
with the environment variable LIBARM, unless you used the option --ignore-default-library-path.

Example
To search in the system library carm. 1ib (C library):
ccarm test.obj mylib.lib --library=carm

The linker links the file test.obj and first looks in mylib. 1ib (in the current directory only), then in the system library
carm. lib to resolve unresolved symbols.

Related information

% Linker option --library-directory (Additional search path for system libraries)

Section 6.4, Linking with Libraries, in chapter Using the Linker of the user’s manual.
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Control Program:--library-directory (-L) / —--ignore-default-library-path

Command line syntax

--library-directory=dir
-Ldir

--ignore-default-library-path
-L
Description

With this option you can specify the path(s) where your system libraries, specified with the —-library option, are located. If you
want to specify multiple paths, use the option --library-directory for each separate path.

By default path this is $ (PRODDIR) \carm\1lib directory.

If you specify only -L (without a pathname) or the long option --ignore-default-library-path, the linker will not search the
default path and also not in the paths specified in the environment variable LIBARM. So, the linker ignores steps 2 and 3 as
listed below.

The priority order in which the linker searches for system libraries specified with the --library option is:
1. The path that is specified with the --library-directory option.
2. The path that is specified in the environment variable LIBARM.

3. The default directory $ (PRODDIR)\carm\1lib (or a processor specific sub-directory).

Example
Suppose you call the control program as follows:
ccarm test.c --library-directory=c:\mylibs --library=carm
First the linker looks in the directory c: \mylibs for library carm. 1ib (this option).
If it does not find the requested libraries, it looks in the directory that is set with the environment variable LIBARM.

Then the linker looks in the default directory $ (PRODDIR)\carm\1lib for libraries.

Related information

% Linker option --library (Link system library)
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Control Program: --list-files

Command line syntax
--list-files[=name]
Description

With this option you tell the assembler via the control programma to generate a list file for each specified input file. A list file
shows the generated object code and the relative addresses. Note that the assembler generates a relocatable object file with
relative addresses.

With name you can specify a name for the list file. This is only possible if you specify only one input file to the control

program. If you do not specify name, or you specify more than one input files, the control program names the generated list
file(s) after the specified input file(s) with extension . 1st.

Example

This example generates the list files 1.1st and 2.1st for 1.c and 2. c. If in this example also a name had been specified, it
would be ignored because two input files are specified.

ccarm l.c 2.c --list-files

Related information

% Assembler option --list-file (Generate list file)

Assembler option --list-format (List file formatting options)
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Control Program: --Isl-file (-d)

Command line syntax

--Isl-file=file,...
=dfile,...

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker script file is coded in LSL
and contains the following types of information:

» the architecture and derivative definition describe the core’s hardware architecture and its internal memory.
* the board specification describes the physical memory available in the system.
* the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file via the control program to the linker. If you do not specify this option, the linker
does not use a script file. You can specify the existing file arm. 1s1 or the name of a manually written linker script file. You can
use this option multiple times. The linker processes the LSL files in the order in which they appear on the command line.

Related information

% Section 6.9, Controlling the Linker with a Script, in chapter Using the Linker of the user’s manual.
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Control Program: --make-target

Command line syntax
--make-target=name
Description

With this option you can overrule the default target name in the make dependencies generated by the options
--preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input file, with extension . obj.

Example
ccarm --preprocess=+make --make-target=../mytarget.obj test.c
The compiler generates dependency lines with the default target name . . /mytarget.obj instead of test.obj.

Related information

Control program option --preprocess=+make (Generate dependencies for make)
Control program option --dep-file (Generate dependencies in a file)
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Control Program: --mil-link / --mil-split

Command line syntax

—-mil-link
--mil-split
Description

With option —-mil-link the C compiler links the optimized intermediate representation (MIL) of all input files and MIL libraries
specified on the command line in the compiler. The result is one single module that is optimized another time.

Option --mil-split does the same as option --mil-link, but in addition, the resulting MIL representation is written to a file with
the suffix .mi1 and the C compiler also splits the MIL representation and writes it to separate files with suffix .ms. One file is
written for each input file or MIL library specified on the command line. The .ms files are only updated on a change.

With option --mil-split you can perform application-wide optimizations during the frontend phase by specifying all modules at
once, and still invoke the backend phase one module at a time to reduce the total compilation time.

Related information

% C compiler option —-mil / --mil-split
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Control Program: --no-auto-instantiation

Command line syntax
--no-auto-instantiation

Default: the C++ compiler automatically instantiates templates.

Description

With this option automatic instantiation of templates is disabled.

Related information

Control program option --instantiate (Set instantiation mode)
Section 2.6, Template Instantiation in chapter C++ Language.
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Control Program: --no-default-libraries

Command line syntax

--no-default-libraries

Description

By default the control program specifies the standard C libraries (C99) and run-time library to the linker. With this option you tell
the control program not to specify the standard C libraries and run-time library to the linker.

In this case you must specify the libraries you want to link to the linker with the option =llibrary_name. The control program
recognizes the option -l as an option for the linker and passes it as such.

Example

ccarm --no-default-libraries test.c
The control program does not specify any libraries to the linker. In normal cases this would result in unresoved externals.
To specify your own libraries (1ibmy . a) and avoid unresolved externals:

ccarm --no-default-libraries -lmy test.c

Related information

% Linker option --library (=I) (Add library)
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Control Program: --no-double (-F)

Command line syntax
--no-double
-F

Description

With this option you tell the compiler to treat variables of the type double as float. Because the float type takes less space,
execution speed increases and code size decreases, both at the cost of less precision.

Related information

ﬂs_
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Control Program: --no-map-file

Command line syntax
--no-map-file
Description
By default the control program tells the linker to generate a linker map file.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the various object files
(.obj) to the linked object file. A locate part shows the absolute position of each section. External symbols are listed per space
with their absolute address, both sorted on symbol and sorted on address.

With this option you prevent the generation of a map file.

Related information

ﬂ?'
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Control Program: --no-preprocessing-only
Command line syntax
--no-preprocessing-only

Description

On the command line, the control program stops after preprocessing. If you also want to compile the C source you can specify
the option —-no-preprocessing-only. In this case the control program calls the compiler twice, once with option
--preprocess and once for a regular compilation.

Example

ccarm —--preprocess=+comments,-make,-noline --no-preprocessing-only test.c

Related information

% Control program option --preprocess / -E
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Control Program: --no-warnings (-w)

Command line syntax

--no-warnings[=number[-number],...]
-w[number[-number],...]

Description

With this option you can suppress all warning messages or specific C compiler warning messages:

* If you do not specify this option, all warnings are reported.
* If you specify this option but without numbers, all warnings are suppressed.

* If you specify this option with a number or a range, only the specified C compiler warning is suppressed.
You can specify the option --no-warnings=number multiple times.

Related information

ﬂﬁ'
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Control Program: --option-file (-f)

Command line syntax
--option-file=file
~f file

Description

Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to
specify. With this option you specify the option file to the control program.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

You can specify the option --option-file multiple times.

Format of an option file

e Multiple arguments on one line in the option file are allowed.
* To include whitespace in an argument, surround the argument with single or double quotes.
* If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ' embedded”
'This has a double quote ” embedded’

'This has a double quote ” and a single quote ’'”’ embedded”

When a text line reaches its length limit, use a ’to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line”

-> "This is a continuation line”
* Itis possible to nest command line files up to 25 levels.
Example
Suppose the file myoptions contains the following lines:

-DDEMO=1
test.c

Specify the option file to the control program:
ccarm --option-file=myoptions
This is equivalent to the following command line:

ccarm -DDEMO=1 test.c

Related information

%_
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Control Program: --output (-0)

Command line syntax

--output=file
-o file

Description

Default, the control program generates a file with the same basename as the first specified input file. With this option you specify
another name for the resulting absolute object file.

Example

ccarm test.c prog.c
The control program generates an ELF/DWARF object file (default) with the name test . abs.
To generate the file result.abs:

ccarm --output=result.abs test.c prog.c

Related information

ﬂﬁ'
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Control Program: --pass (-W)

Command line syntax

--pass-assembler=option (~Waoption) Pass option directly to the assembler
--pass-c=option (~Wcoption) Pass option directly to the C compiler
--pass-c++=option (~Wepoption) Pass option directly to the C++ compiler
--pass-linker=option (~Wloption) Pass option directly to the linker

Description

With this option you tell the control program to call a tool with the specified option. The control program does not use or interpret
the option itself, but specifies it directly to the tool which it calls.

Related information

ﬂﬁ'
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Control Program: --preprocess (-E)

Command line syntax

—--preprocess[=flags]
-E[flags]

You can set the following flags (when you specify -E without flags, the default is ~=ECILMP):

+/-comments (c/C) Keep comments from the C source in the preprocessed output

+/-includes (i/) Generate a list of included source files

+/-list (/L) Generate a list of macro definitions

+/-make (m/M) Generate dependency lines that can be used for the makefile

+/-noline (p/P) Strip #line source position info (lines starting with #1ine)
Description

With this option you tell the control program to preprocess the C source.

The C compiler sends the preprocessed output to the file name.pre (where name is the name of the C source file being
compiled). Altium Designer also compiles the C source.

On the command line, the control program stops after preprocessing. If you also want to compile the C source you can specify
the option —--no-preprocessing-only. In this case the control program calls the compiler twice, once with option
--preprocess and once for a regular compilation.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C++ source file in the preprocessed
output.

With --preprocess=+includes the compiler will generate a list of all included source files. The preprocessor output is
discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions. The preprocessor output is discarded.

With --preprocess=+make the compiler will generate dependency lines that can be used in a Makefile. The information is
written to a file with extension . d. The preprocessor output is discarded. The default target name is the basename of the input
file, with the extension .obj. With the option --make-target you can specify a target name which overrules the default target
name.

With --preprocess=+noline you tell the preprocessor to strip the #line source position information (lines starting with #1ine).
These lines are normally processed by the assembler and not needed in the preprocessed output. When you leave these lines
out, the output is easier to read.

Example
ccarm —--preprocess=+comments,-make,-noline --no-preprocessing-only test.c

The compiler preprocesses the file test.c and sends the output to the file test.pre. Comments are included but no
dependencies are generated and the line source position information is not stripped from the output file. Next, the control
program calls the compiler, assembler and linker to create the final object file test. abs.

Related information
Control program option —-no-preprocessing-only

Control program option —-make-target (Specify target name for =Em output)
Control program option —--dep-file (Generate dependencies in a file)
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Control Program: --profile (-p)

Command line syntax

--profile[=flags]
-plfiags]

Use the following option for a predefined set of flags:

--profile=g (-p9) profiling with call graph and function timers
Alias for: -pBcFt

You can set the following flags (when you specify -p without flags, the default is -pBCfST):

+/-block (b/B) block counters

+/-callgraph (c/C) call graph

+/-function (f/F) function counters

+/-static (s/S) static profile generation

+/-time (VAD) function timers
Description

Profiling is the process of collecting statistical data about a running application. With these data you can analyze which functions
are called, how often they are called and what their execution time is.

Several methods of profiling exist. One method is code instrumentation which adds code to your application that takes care of
the profiling process when the application is executed.
% For an extensive description of profiling refer to Chapter 4, Profiling in the user’s manual.

With this option, the compiler adds the extra code to your application that takes care of the profiling process. You can obtain the
following profiling data (see flags above):

Block counters (not in combination with Call graph or Time)

This will instrument the code to perform basic block counting. As the program runs, it counts the number of executions of
each branch in an if statement, each iteration of a for loop, and so on. Note that though you can combine Block counters
with Function counters, this has no effect because Function counters is only a subset of Block counters.

Call graph (not in combination with Block counters)

This will instrument the code to reconstruct the run-time call graph. As the program runs it associates the caller with the
gathered profiling data.

Function counters
This will instrument the code to perform function call counting. This is a subset of the basic Block counters.
Time (not in combination with Block counters)
This will instrument the code to measure the time spent in a function. This includes the time spent in all sub functions

(callees).

@ Note that the more detailled information you request, the larger the overhead in terms of execution time, code size and
heap space needed. The option Generate Debug information (-g or --debug) does not affect profiling, execution time
or code size.

@ The control program automatically specifies the corresponding profiling libraries to the linker.

Example
To generate block count information for the module test . c during execution, compile as follows:
ccarm —--profile=+block test.c

In this case the library pbarm.1ib is linked.
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Related information

% Chapter 4, Profiling in the user’s manual.
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Control Program: --show-c++-warnings

Command line syntax
--show-c++-warnings
Description

The C++ compiler may generate a compiled C++ file (. ic) that causes warnings during compilation or assembling. With this
option you tell the control program to show these warnings. By default, warnings in C++ generated files are suppressed.

Related information

ﬂ?‘
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Control Program: --signed-bitfields

Command line syntax

--signed-bitfields

Description

For bit-fields it depends on the implementation whether a plain int is treated as signed int orunsigned int. By default
an int bit-field is treated as unsigned int. This offers the best performance. With this option you tell the compiler to treat
int bit-fields as signed int. In this case, you can still add the keyword unsigned to treat a particular int bit-field as
unsigned.

This option is passed to both the C++ compiler and the C compiler.

Related information

ﬂ?'
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Control Program: --static

Command line syntax

--static

Description
This option is directly passed to the compiler.

With this option, the compiler treats external definitions at file scope (except for main) as if they were declared static. As a
result, unused functions will be eliminated, and the alias checking algorithm assumes that objects with static storage cannot be
referenced from functions outside the current module.

This option only makes sense when you specify all modules of an application on the command line.

Example

ccarm --static modulel.c module2.c module3.c

Related information

ﬂ?'
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Control Program: --thumb
Command line syntax
--thumb

Description

Generate code in Thumb mode. The Thumb instruction set is a subset of the ARM instruction set which is encoded using 16-bit
instructions instead of 32-bit instructions.

Related information

ﬂ?‘
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Control Program: —--uchar (-u)

Command line syntax

-u
--uchar

Description

By default char is the same as specifying signed char. With this option char is the same as unsigned char. This option is
passed to both the C++ compiler and the C compiler.

Related information

ﬂﬁ'
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Control Program: --undefine (-U)

Command line syntax

--undefine=macro_name
-Umacro_name

Description
With this option you can undefine an earlier defined macro as with #undef.

This option is for example useful to undefine predefined macros. However, you cannot undefine predefined ISO C standard
macros.

The control program passes the option —-undefine (-U) to the compiler.

Example
To undefine the predefined macro __ TASKING__:

ccarm --undefine= TASKING _ test.c

Related information

% Control Pogram option —--define (Define preprocessor macro)
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Control Program: --verbose (~v)

Command line syntax

--verbose
-V

Description

With this option you put the control program in verbose mode. With the option =v the control program performs it tasks while it
prints the steps it performs to stdout.

Related information

% Control Program option =n (--dry=-run) (Verbose output and suppress execution)

6-288



Tool Options - Control Program

Control Program: --version (-V)

Command line syntax

--version
'

Description
Display version information. The control program ignores all other options or input files.

Related information

ﬂﬁ'
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Control Program: --warnings-as-errors

Command line syntax

--warnings-as-errors[=number[-number],...]

Description

If one of the tools encounters an error, it stops processing the file(s). With this option you tell the tools to treat warnings as errors
or treat specific control program warning messages as errors:

* If you specify this option but without numbers, all warnings are treated as errors.

* If you specify this option with a number, only the specified control program warning is treated as an error.
You can specify the option —--warnings-as-errors=number multiple times.

Use one of the --pass-tfool options to pass this option directly to a tool when a specific warning for that tool must be treated
as an error. For example, use —-pass-c=--warnings-as-errors=number to treat a specific C compiler warning as an error.

Related information

Control program option --no-warnings (Suppress all warnings)
Control program option —-pass (Pass option to tool)
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6.6 Make Utility Options

When you build a project in Altium Designer, Altium Designer generates a makefile and uses the make utility tmk to build all
your files. However, you can also use the make utility directly from the command line to build your project.

The invocation syntax is:
tmk [option...] [target...] [macro=def]

This section describes all options for the make utility. The make utility is a command line tool so there are no equivalent options
in Altium Designer.
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Defining Macros

Command line syntax

macro=definition

Description
With this argument you can define a macro and specify it to the make utility.

A macro definition remains in existence during the execution of the makefile, even when the makefile recursively calls the make
utility again. In the recursive call, the macro acts as an environment variable. This means that it is overruled by definitions in the
recursive call. Use the option -e to prevent this.

You can specify as many macros as you like. If the command line exceeds the limit of the operating system, you can define the
macros in an option file which you then must specify to the make utility with the option -m file.

Defining macros on the command line is, for example, useful in combination with conditional processing as shown in the
example below.

Example
Consider the following makefile with conditional rules to build a demo program and a real program:

ifdef DEMO # the value of DEMO is of no importance
real.abs : real.obj main.obj
lkarm demo.obj main.obj -darm.lsl -lcarm -lfparm
else
real.abs : real.obj main.obj
lkarm real.obj main.obj -darm.lsl -lcarm -lfparm
endif

You can now use a macro definition to set the DEMO flag:
tmk real.abs DEMO=1

In both cases the absolute object file real. abs is created but depending on the DEMO flag it is linked with demo . obj or with
real.obj.

Related information

Make utility option —e (Environment variables override macro definitions)
Make utility option -m (Name of invocation file)

6-292



Tool Options - Make Utility

Make Utility: -?
Command line syntax
-?
Description
Displays an overview of all command line options.

Example
The following invocation displays a list of the available command line options:

tmk -?

Related information

ﬂﬁ'
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Make Utility: -a

Command line syntax
-a

Description

Normally the make utility rebuilds only those files that are out of date. With this option you tell the make utility to rebuild all files,
without checking whether they are out of date.

Example
tmk -a

Rebuilds all your files, regardless of whether they are out of date or not.

Related information

ﬂﬁ'
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Make Utility: -c

Command line syntax
-C

Description

Altium Designer uses this option for the graphical version of the make utility when you create sub-projects. In this case the
make utility calls another instance of the make utility for the sub-project. With the option -¢, the make utility runs as a child
process of the current make.

The option -c overrules the option -err.

Example
tmk -c

The make utility runs its commands as a child processes.

Related information

ﬂj_
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Make Utility: -D/-DD

Command line syntax

-D
-DD

Description
With the option -D the make ultility prints every line of the makefile to standard output as it is read by tmk.
With the option —-DD not only the lines of the makefile are printed but also the lines of the tmk . mk file (implicit rules).

Example
tmk -D
Each line of the makefile that is read by the make utility is printed to standard output (usually your screen).

Related information

ﬂ?‘
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Make Utility: -d/-dd

Command line syntax
-d
-dd

Description

With the option -d the make utility shows which files are out of date and thus need to be rebuild. The option -dd gives more
detail than the option -d.

Example
tmk -d

Shows which files are out of date and rebuilds them.

Related information

ﬂﬁ'
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Make Utility: -e

Command line syntax
-e
Description
If you use macro definitions, they may overrule the settings of the environment variables.
With the option -e, the settings of the environment variables are used even if macros define otherwise.
Example
tmk -e

The make utility uses the settings of the environment variables regardless of macro definitions.

Related information

ﬂﬁ'
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Make Utility: -err
Command line syntax
-err file

Description
With this option the make utility redirects error messages and verbose messages to a specified file.

With the option -s the make utility only displays error messages.

Example
tmk -err error.txt

The make utility writes messages to the file error.txt.

Related information

% Make utility option -=s (Do not print commands before execution)
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Make Utility: -f

Command line syntax

-f my_makefile

Description
Default the make utility uses the file makefile to build your files.

With this option you tell the make utility to use the specified file instead of the file makefile. Multiple -f options act as if all the
makefiles were concatenated in a left-to-right order.

Example
tmk -f mymake

The make utility uses the file mymake to build your files.

Related information

ﬂﬁ'

6-300



Tool Options - Make Utility

Make Utility: -G

Command line syntax
-G path
Description
Normally you must call the make utility tmk from the directory where your makefile and other files are stored.

With the option -G you can call the make utility from within another directory. The path is the path to the directory where your
makefile and other files are stored and can be absolute or relative to your current directory.

Example

Suppose your makefile and other files are stored in the directory . . \my£files. You can call the make utility, for example, as
follows:

tmk -G ..\myfiles

Related information

ﬂﬁ'
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Make Utility: -i

Command line syntax
—i
Description

When an error occurs during the make process, the make utility exits with a certain exit code.

With the option -i, the make utility exits without an error code, even when errors occurred.

Example
tmk -i

The make utility exits without an error code, even when an error occurs.

Related information

ﬂﬁ'
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Make Utility: -K

Command line syntax
-K
Description

With this option the make utility keeps temporary files it creates during the make process. The make utility stores temporary files
in the directory that you have specified with the environment variable TMPDIR or in the default ‘temp’ directory of your system
when the TMPDIR environment variable is not specified.

Example
tmk -K

The make utility preserves all temporary files.

Related information

ﬂ?‘
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Make Utility: -k

Command line syntax
-k
Description
When during the make process the make utility encounters an error, it stops rebuilding your files.

With the option -k, the make utility only stops building the target that produced the error. All other targets defined in the makefile
are built.

Example
tmk -k

If the make utility encounters an error, it stops building the current target but proceeds with the other targets that are defined in
the makefile.

Related information

% Make utility option =S (Undo the effect of -k)
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Make Utility: -m

Command line syntax

-m file

Description

Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to
specify. With this option you specify the option file to the make utility.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

You can specify the option -m multiple times.

Format of an option file

e Multiple arguments on one line in the option file are allowed.
* To include whitespace in an argument, surround the argument with single or double quotes.
* If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ’ embedded”
'This has a double quote ” embedded’

'This has a double quote ” and a single quote ’'”’ embedded”
* When atext line reaches its length limit, use a '\’ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line”
-> "This is a continuation line”

* ltis possible to nest command line files up to 25 levels.
Example
Suppose the file myoptions contains the following lines:

-k
—-err errors.txt
test.abs

Specify the option file to the make utility:
tmk -m myoptions
This is equivalent to the following command line:

tmk -k -err errors.txt test.abs

Related information

%-
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Make Utility: -n
Command line syntax
-n

Description

With this option you tell the make utility to perform a dry run. The make utility shows what it would do but does not actually
perform these tasks.

This option is for example useful to quickly inspect what would happen if you call the make utility.

Example
tmk -n

The make utility does not perform any tasks but displays what it would do if called without the option -n.

Related information

% Make utility option -=s (Do not print commands before execution)
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Make Utility: -p

Command line syntax
-p
Description

Normally, if a command in a target rule in a makefile returns an error or when the target construction is interrupted, the make
utility removes that target file. With this option you tell the make utility to make all target files precious. This means that
dependency files are never removed.

Example
tmk -p

The make utility never removes target dependency files.

Related information

ﬂ?‘
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Make Utility: -q

Command line syntax
-q
Description

With this option the make utility does not perform any tasks but only returns an exit code. A zero status indicates that all target
files are up to date, a non-zero status indicates that some or all target files are out of date.

Example
tmk -g

The make utility only returns an exit code that indicates whether all target files are up to date or not. It does not rebuild any files.

Related information

ﬂﬁ'
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Make Utility: -r

Command line syntax
-r

Description

When you call the make utility, it first reads the implicit rules from the file tmk . mk, then it reads the makefile with the rules to
build your files. (The file tmk . mk is located in the \etc directory of the toolset.)

With this option you tell the make utility not to read tmk .mk and to rely fully on the make rules in the makefile.

Example
tmk -r

The make utility does not read the implicit make rules in tmk . mk.

Related information

ﬂs_
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Make Utility: -S

Command line syntax
-S

Description

With this option you cancel the effect of the option —k. This is only necessary in a recursive make where the option -k might be
inherited from the top-level make via MAKEFLAGS or if you set the option -k in the environment variable MAKEFLAGS.

Example
tmk -S
The effect of the option -k is cancelled so the make utility stops with the make process after it encounters an error.

The option -k in this example may have been set with the environment variable MAKEFLAGS or in a recursive call to tmk in the
makefile.

Related information

% Make utility option =k (On error, abandon the work for the current target only)
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Make Utility: -s
Command line syntax
-S

Description

With this option you tell the make utility to perform its tasks without printing the commands it executes. Error messages are
normally printed.

Example
tmk -s

The make utility rebuilds your files but does not print the commands it executes during the make process.

Related information

% Make utility option —n (Perform a dry run)
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Make Utility: -t

Command line syntax
-t

Description

With this option you tell the make ultility to touch the target files, bringing them up to date, rather than performing the rules to
rebuild them.

Example
tmk -t
The make utility updates out-of-date files by giving them a new date and time stamp. The files are not actually rebuild.

Related information

ﬂﬁ'
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Make Utility: -time
Command line syntax
-time

Description

With this option you tell the make utility to display the current date and time on standard output.

Example
tmk -time

The make utility displays the current date and time and updates out-of-date files.

Related information

ﬂﬁ'
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Make Utility: -V
Command line syntax
-V
Description
Display version information. The make utility ignores all other options or input files.

Example
tmk -V

The make utility displays the version information but does not perform any tasks.

Related information

ﬂﬁ'
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Make Utility: -W
Command line syntax
-W target

Description

With this option the make utility considers the specified target file always as up to date and will not rebuild it.

Example
tmk -W test.abs

The make utility rebuilds out of date targets in the makefile except the file test . abs which is considered now as up to date.

Related information

ﬂﬁ'
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Make Utility: -x

Command line syntax
=X
Description

With this option the make utility shows extended error messages. Extended error messages give more detailed information
about the exit status of the make utility after errors. Altium Designer uses this option for the graphical version of make.

Example
tmk -x

If errors occur, the make utility gives extended information.

Related information

ﬂﬁ'
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6.7 Librarian Options

The librarian tlb is a tool to build library files and it offers the possibility to replace, extract and remove modules from an existing
library.

You can only call the librarian from the command line. The invocation syntax is:
tlb key option [sub_option...] library [object file]

This section describes all options for the make utility. Suboptions can only be used in combination with certain key options.
Keyoptions and their suboptions are therefor described together. The miscellaneous options can always be used and are also
described separately.

The librarian is a command line tool so there are no equivalent options in Altium Designer.

Description Option Suboption
Main functions (key options)

Replace or add an object module -r -a-b-c-u-v
Extract an object module from the library =X -0 -V
Delete object module from library -d -V

Move object module to another position -m -a-b-v
Print a table of contents of the library -t -s0 -s1
Print object module to standard output -p

Suboptions

Append or move new modules after existing module name -a name

Append or move new modules before existing module name -b name

Create library without notification if library does not exist -c

Preserve last-modified date from the library -0

Print symbols in library modules -s{0|1}

Replace only newer modules -u

Verbose -v

Miscellaneous

Display options -?

Display version header -V

Read options from file -f file

Suppress warnings above level n -wn

Table 6-1: Overview of librarian options and suboptions
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Librarian: -?

Command line syntax

-?
Description
Displays an overview of all command line options.

Example

The following invocations display a list of the available command line options:

tlb -?
tlb
Related information

ﬂﬁ'
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Librarian: -d

Command line syntax
-d [-V]
Description
Delete the specified object modules from a library. With the suboption -v the librarian shows which files are removed.
-v Verbose: the librarian shows which files are removed.
Example
tlb -d mylib.lib objl.obj obj2.obj
The librarian deletes obj1l.0obj and ob3j2.obj from the library mylib. 1lib.
tlb -d -v mylib.1lib objl.obj obj2.obj

The librarian deletes obj1.0bj and obj2.obj from the library mylib.1ib and displays which files are removed.

Related information

ﬂj_
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Librarian: -f

Command line syntax

~f file

Description

Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to
specify. With this option you specify the option file to the librarian tlb.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save
typing.

Option files can also be generated on the fly, for example by the make utility. You can specify the option -f multiple times.

Format of an option file

Multiple arguments on one line in the option file are allowed.
To include whitespace in an argument, surround the argument with single or double quotes.
If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ' embedded”
'This has a double quote ” embedded’
'This has a double quote ” and a single quote ’'”’ embedded”
When a text line reaches its length limit, use a 'to continue the line. Whitespace between quotes is preserved.

"This is a continuation \
line”
-> "This is a continuation line”

It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

-x mylib.lib objl.obj
-w5

Specify the option file to the librarian:

tlb -f myoptions

This is equivalent to the following command line:

tlb -x mylib.lib objl.obj -w5
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Librarian: -m

Command line syntax

-m [-a posname] [-b posname]

Description
Move the specified object modules to another position in the library.

The ordering of members in a library can make a difference in how programs are linked if a symbol is defined in more than one
member.

Default, the specified members are moved to the end of the archive. Use the suboptions —a or -b to move them to a specified
place instead.

—-a posname Move the specified object module(s) after the existing module posname.
-b posname Move the specified object module(s) before the existing module posname.
Example

Suppose the library mylib.1ib contains the following objects (see option -t):

objl.obj
obj2.0bj
obj3.0bj

To move objl.objtothe end of mylib.1lib:
tlb -m mylib.lib objl.obj
To move ob3j3.obj just before obj2.obj:
tlb -m -b obj3.obj mylib.lib obj2.obj
The library mylib. 1ib after these two invocations now looks like:

obj3.0bj
obj2.0bj
objl.obj

Related information

ﬁ]j Librarian option -t (Print library contents)
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Librarian: -p

Command line syntax
-p
Description
Print the specified object module(s) in the library to standard output.

This option is only useful when you redirect or pipe the output to other files or tools that serve your own purposes. Normally you
do not need this option.

Example
tlb -p mylib.lib objl.obj > file.obj

The librarian prints the file obj1.o0bj to standard output where it is redirected to the file f£ile.obj. The effect of this example
is very similar to extracting a file from the library but in this case the ’extracted’ file gets another name.

Related information

ﬂﬁ'

6-322



Tool Options - Librarian

Librarian: -r

Command line syntax

-r [-a posname] [-b posname] [-c] [-u] [-V]
Description

You can use the option -r for several purposes:

* Adding new objects to the library
* Replacing objects in the library with the same object of a newer date
e Creating a new library

The option -r normally adds a new module to the library. However, if the library already contains a module with the specified
name, the existing module is replaced. If you specify a library that does not exist, the librarian creates a new library with the
specified name.

If you add a module to the library without specifying the suboption -a or -b, the specified module is added at the end of the
archive. Use the suboptions -a or -b to insert them to a specified place instead.

-aposname Add the specified object module(s) after the existing module posname.

-b posname Add the specified object module(s) before the existing module posname.

-C Create a new library without checking whether it already exists. If the library already exists, it is overwritten.
-u Insert the specified object module only if it is newer than the module in the library.
-v Verbose: the librarian shows which files are removed.

@ The suboptions -a or -b have no effect when an object is added to the library.

Examples

Suppose the library mylib.1ib contains the following objects (see option -t):
objl.obj

To add obj2.0bjtothe end of mylib.1lib:
tlb -r mylib.lib obj2.o0bj

To insert obj3.0bj just before obj2.obj:
tlb -r -b obj2.obj mylib.lib obj3.obj

The library mylib. 1ib after these two invocations now looks like:

objl.obj
obj3.0bj
obj2.0bj

Creating a new library

To create a new library file, add an object file and specify a library that does not yet exist:
tlb -r objl.obj newlib.lib

The librarian creates the library newlib.1ib and adds the object objl.o0bj to it.

To create a new library file and overwrite an existing library, add an object file and specify an existing library with the supoption
-cC:

tlb -r -c objl.obj mylib.lib
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The librarian overwrites the library mylib.1ib and adds the object objl.o0bj toit. The new library mylib.1ib only contains
objl.obj.
Related information

% Librarian option -t (Print library contents)
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Librarian: -t

Command line syntax

-t [-s0|-s1]

Description
Print a table of contents of the library to standard out. With the suboption -s the librarian displays all symbols per object file.
-s0 Displays per object the library in which it resides, the name of the object itself and all symbols in the object.

-s1 Displays only the symbols of all object files in the library.

Example
tlb -t mylib.lib
The librarian prints a list of all object modules in the libary mylib.1lib.
tlb -t -s0 mylib.lib
The librarian prints per object all symbols in the library. This looks like:
prolog.obj
symbols:
mylib.lib:prolog.obj: Qabi callee_save
mylib.lib:prolog.obj: Qabi callee_restore
div16.0bj
symbols:
mylib.lib:div16.0bj: udivlé
mylib.lib:div16.0bj: divle
mylib.lib:div16.0bj: uremlé
mylib.lib:div16.0bj: remlé

Related information

ﬂj_
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Librarian: -V
Command line syntax
-V
Description
Display version information. The librarian ignores all other options or input files.

Example
tlb -V

The librarian displays version information but does not perform any tasks.

Related information

ﬂﬁ'
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Librarian: -w

Command line syntax
-wlevel
Description
With this suboption you tell the librarian to suppress all warnings above the specified level. The level is a number between 0 - 9.

The level of a message is printed between parentheses after the warning number. If you do not use the —w option, the default
warning level is 8.

Example
To suppresses warnings above level 5:

tlb -x -w5 mylib.lib objl.obj

Related information

ﬂs_
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Librarian: -x

Command line syntax
=X [-0] [-V]
Description
Extract an existing module from the library.
-0 Give the extracted object module the same date as the last-modified date that was recorded in the library.
Without this suboption it receives the last-modified date of the moment it is extracted.
-v Verbose: the librarian shows which files are extracted.
Examples
To extract the file obj1.obj from the library mylib.1lib:
tlb -x mylib.lib objl.obj
If you do not specify an object module, all object modules are extracted:

tlb -x mylib.lib

Related information

ﬂﬁ'
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Summary This chapter describes the format of the assembler list file and the linker map file.

7.1 Assembler List File Format

The assembler list file is an additional output file of the assembler that contains information about the generated code.

The list file consists of a page header and a source listing.

Page header
The page header is repeated on every page:

TASKING target Assembler vx.yrz Build nnn SN 00000000
Title Page 1

ADDR CODE CYCLES LINE SOURCE LINE
The first line contains version information.

The second line can contain a title which you can specify with the assembler directive . TITLE and always contains a page
number. With the assembler directives .LIST/.NOLIST and . PAGE, and with the assembler option -Lflag (--list-format) you
can format the list file.

% See Section 4.8.2, Assembler Directives in Chapter Assembly Language and Section 6.3, Assembler Options in Chapter
Tools Options.

The fourth line contains the headings of the columns for the source listing.

Source listing
The following is a sample part of a listing. An explanation of the different columns follows below.

ADDR CODE CYCLES LINE SOURCE LINE
1 ; Module start

16 1ldr r0,.L2

0000 08009FE5 1 1

0004 001090E5 1 2 17 ldr rl,[r0,#0]
0008 04009FE5 1 3 18 ldr r0,.L2+4
000C rrrrrrEA 3 6 19 b printf
0000 38 .ds 2

| RESERVED
0001

The meaning of the different columns is:

ADDR This column contains the memory address. The address is a hexadecimal number that represents the
offset from the beginning of a relocatable section or the absolute address for an absolute section. The
address only appears on lines that generate object code.
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CODE This is the object code generated by the assembler for this source line, displayed in hexadecimal format.
The displayed code need not be the same as the generated code that is entered in the object module. The
code can also be relocatable code. In this case the letter ’r’ is printed for the relocatable code part in the
listing. For lines that allocate space, the code field contains the text "RESERVED”. For lines that initialize a
buffer, the code field lists one value followed by the word "REPEATS”.

CYCLES The first number in this column is the number of instruction cycles needed to execute the instruction(s) as
generated in the CODE field. The second number is the accumulated cycle count of this section.

LINE This column contains the line number. This is a decimal number indicating each input line, starting from 1
and incrementing with each source line.

SOURCE LINE This column contains the source text. This is a copy of the source line from the assembly source file.

@ For the . SET and . EQU directives the ADDR and CODE columns do not apply. The symbol value is listed instead.

Related information

See section 5.6, Generating a List File, in Chapter Using the Assembler of the user’s manual for more information on
how to generate a list file and specify the amount of list file information.
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7.2 Linker Map File Format

The linker map file is an additional output file of the linker that shows how the linker has mapped the sections and symbols from
the various object files (. obj) to output sections. The locate part shows the absolute position of each section. External symbols
are listed per space with their absolute address, both sorted on symbol and sorted on address.

With the linker option —-map-file-format (map file formatting) you can specify which parts of the map file you want to see.

Example (part of) linker map file

Tool and Invocation

| tool | TASKING ARM object linker vx.yrz Build 062 |
| path | <installation dir>\System\Tasking\carm\bin\Tkarm.exe |
| arguments | -o hello.abs -fmk2052c.tmp |
| task | taskl |

Used Resources

* Memory usage in bytes

| Memory | Code | Data | Reserved | Free | Total |
\ I
| system:xram | 0x0 | 0x00180 | 0x08028 | 0x77e58 | 0x80000 |
| system:xrom | 0x01050 | 0x0010a | 0x0 | OxOeeab | 0x10000 |
\ I
| Total | 0x01050 | 0x0028a | 0x08028 | Ox86cfe | 0x90000 |

* Space usage in bytes

| Space | Native used Rom | Native used Ram | Foreign used | Reserved | Free Rom | Free Ram | Total |
\ [
| system:sw:linear | 0x0115a | 0x00180 | 0x0 |  0x08028 | OxOeeab | 0x77e58 | 0x90000 |
\ I
| Total | 0x0115a | 0x00180 | - -

- - -
| Largest gap | - - - - | OxOeead | 0x77e58 | -

Note:

When spaces share memory with each other, some space can be consumed by sections
Tocated in other spaces. In the table above we call this foreign used space as
opposed to native used space.

* Estimated stack usage

Stack Name | Used

\ |
\ \
| stack 0 0x000000fc |
\ \
\ I

|
recursive | no
Processed Files
| File | From archive | Symbol causing the extraction |
\ \
| cstart.obj | carm.1lib | _START |
| hello.obj | | |
| printf.obj | carm.1lib | printf |
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Link Result

| [in] File | [in] Section | [in] Size (MAU) | [out] Offset | [out] Section | [out] Size (MAU) |
} hello.obj | .text (2) | 0x00000018 | 0x00000000 | .text (2) | 0x00000018 ||
} cstart.obj | .text.cstart (296) | 0x000000d0 | 0x00000000 | .text.cstart (296) | 0x000000d0 ||
} printf.obj | .text.libc (57) | 0x0000004c | 0x00000000 | .text.libc (57) | 0x0000004c ||

Module Local Symbols

* Scope "hello.c"

=
o
3
@

Space addr | Space

hello.c | 0x0 | -

|
\ \
\ |
\ \
| .rodata | 0x000011llc | system:sw:linear |
| .rodata | 0x00001118 |
\ |
\ |

\

.text | 0x00000134 |

.text | 0x00000108 |
Cross References
| Definition file | Definition section | Symbol | Referenced in |
\ \
| cstart.obj | .text.cstart (296) | _START | |
| printf.obj | .text.libc (57) | printf | hello.obj |

* Undefined symbols

| Symbol | Referenced in |
=
| _init | hello.obj |

Call Graph

main

+-- printloop

| 4= printf *

+-— printf *

printf

\

+-— _doprint
[
+-— _doprint_int.c:_emitchar *
[

+-— _doprint_int.c:_putnumber

+-- _doprint_int.c:_emitchar *

\

\
(.

| +-- _doprint_int.c:_putstring *
(.

| 4= strlen *

\

\

\

+-— _doprint_int.c:_Ttoa
+-—— _doprint_int.c:_putstring *

+-- _doflt

7-4



List File Formats

Locate Result

* Task entry address

+ Space system:sw:linear (MAU = 8bit)

| Chip | Group | Section | Size (MAU) | Space addr | Chip addr |
\ I
| system:xrom | | _vector_0 (338) | 0x00000004 | 0x00000020 | 0x00000020 |
| system:xrom | | [.data.libc] (322) | 0x000000c8 | 0x00000040 | 0x00000040 |
| system:xrom | | .text (2) | 0x00000018 | 0x00000134 | 0x00000134 |
| system:xrom | | .rodata (5) | 0x0000000e | 0x000011lc | 0x000011llc |
| system:xrom | | table (321) | 0x00000030 | 0x0000112c | 0x0000112¢c |
| system:xram | | stack fig (315) | 0x00000008 | 0x01000000 | 0xO [
| system:xram | | stack (314) | 0x00008000 | 0x010001a8 | 0x000001a8 |

* Symbols (sorted on name)

Name | Space addr | Space

_APPLICATION_MODE_ | 0x0000001f

\ |
\ I
| system:sw:linear |
| _Exit | 0x00000f34 |
\ |
\ I

|
|
_START | 0x0000038 |
main | 0x00000134 |

* Symbols (sorted on address)

| Space addr | Name | Space |
\ I
| 0x0000001f | _APPLICATION_MODE_ | system:sw:linear |
| 0x00000134 | main | |
| 0x00000f34 | Exit | |
| 0x00000f38 | _START | |

Processor and Memory

Locate Rules

Address space

Type | Properties | Sections |

system:sw:1inear | absolute 0x00000020 | _vector 0 (338)

system:sw:1linear | contiguous stack_fiq (315) | stack_irq (316) | stack_svc (317) | stack_abt (318) | stack_und (319)
system:sw:1inear | clustered .data.libc (65)
system:sw:1inear | clustered [.data.1ibc] (322)

| \
| \
| \
| \
| .text.cstart (296) |
| \
| \
| \

system:sw:Tinear | unrestricted

system:sw:1inear | unrestricted .rodata (5)
system:sw:1inear | unrestricted table (321)
system:sw:1inear | unrestricted stack (314)

Removed Sections
| Section | File | Library | Symbol | Reason |
\ I
| .text.libc (24) | printf_int.obj | carm.lib | dummy | unreferenced |
| .text.libc (76) | fgetc.obj | carm.1ib | fgetc | unreferenced |
| .text.libc (90) | ungetc.obj | carm.1ib | ungetc | unreferenced |
| .text.libc (97) | _filbuf.obj | carm.1ib | _filbuf | unreferenced |
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The meaning of the different parts is:

Tool and Invocation

This part of the map file contains information about the linker, its version header information, binary location and which options

are used to call it.

Used Resources

This part of the map file shows the memory usage at memory level and space level. The largest free block of memory (Largest
gap) is also shown. This part also contains an estimation of the stack usage.

Memory The names of the memory as defined in the linker script file (* . 1s1).

Code The size of all executable sections.

Data The size of all non-executable sections (not including stacks, heaps, debug sections in non-alloc
space).

Reserved The total size of reserved memories, reserved ranges, reserved special sections, stacks, heaps,
alignment protections, sections located in non-alloc space (debug sections). In fact, this size is the
same as the size in the Total column minus the size of all other columns.

Free The free memory area addressable by this core. This area is accessible for unrestricted items.

Total The total memory area addressable by this core.

Space The names of the address spaces as defined in the linker script file (*.Isl). The names are

constructed of the derivative name followed by a colon ’.’, the core name, another colon ’;’ and the
space name.

Native used ... The size of sections located in this space.

Foreign used The size of all sections destined for/located in other spaces, but because of overlap in spaces

consume memory in this space.

Stack Name The name(s) of the stack(s) as defined in the linker script file (* . 1s1).

Used An estimation of the stack usage. The linker calculates the required stack size by using information
(.caLLs directives) generated by the compiler. If for example recursion is detected, the calculated
stack size is inaccurate, therefore this is an estimation only. The calculated stack size is supposed
to be smaller than the actual allocated stack size. If that is not the case, then a warning is given.

Processed Files

This part of the map file shows all processed files. This also includes object files that are extracted from a library, with the
symbol that led to the extraction.

Link Result

This part of the map file shows per object file how the link phase has mapped the sections from the various object files (.ob3j) to
output sections.
[in] File The name of an input object file.
[in] Section A section name and id from the input object file. The number between ’( )’ uniquely identifies the section.
[in] Size The size of the input section.
[out] Offset The offset relative to the start of the output section.
[out] Section  The resulting output section name and id.

[out] Size The size of the output section.

Module Local Symbols

This part of the map file shows a table for each local scope within an object file. Each table has three columns, 1 the symbol
name, 2 the address of the symbol and 3 the space where the symbol resides in. The table is sorted on symbol name within
each space.
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By default this part is not shown in the map file. You have to turn this part on manually with linker option
--map-file-format=+statics (module local symbols).

Cross References

This part of the map file lists all symbols defined in the object modules and for each symbol the object modules that contain a
reference to the symbol are shown. Also, symbols that remain undefined are shown.

Call Graph

This part of the map file contains a schematic overview that shows how (library) functions call each other.

Locate Result: Sections

This part of the map file shows the absolute position of each section in the absolute object file. It is organized per address
space, memory chip and group and sorted on space address.

+ Space The names of the address spaces as defined in the linker script file (* . 1s1). The names are constructed
of the derivative name followed by a colon ’’, the core name, another colon '’ and the space name.

Chip The names of the memory chips as defined in the linker script file (* . 1s1) in the memory definitions.

Group Sections can be ordered in groups. These are the names of the groups as defined in the linker script file
(* . 1s1) with the keyword group in the section_layout definition. The name that is displayed is the
name of the deepest nested group.

Section The name and id of the section. The number between ’()’ uniquely identifies the section. Names within
square brackets [ ] will be copied during initialization from ROM to the corresponding section name in
RAM.

Size (MAU) The size of the section in minimum addressable units.

Space addr The absolute address of the section in the address space.

Chip addr The absolute offset of the section from the start of a memory chip.

Locate Result: Symbols

This part of the map file lists all external symbols per address space name, both sorted on address and sorted on symbol name.

Name The name of the symbol.
Space addr The absolute address of the section in the address space.
Space The names of the address spaces as defined in the linker script file (* . 1s1). The names are constructed

of the derivative name followed by a colon ’?’, the core name, another colon ’:’ and the space name.

Processor and Memory
This part of the map file shows the processor and memory information of the linker script file.

By default this part is not shown in the map file. You have to turn this part on manually with linker option
--map-file-format=+Isl (processor and memory info). You can print this information to a separate file with linker option
—=Isl-dump.

Locate Rules
This part of the map file shows the rules the linker uses to locate sections.

Address space The names of the address spaces as defined in the linker script file (* . 1s1). The names are constructed
of the derivative name followed by a colon ’?’, the core name, another colon "’ and the space name.

Type The rule type:

ordered/contiguous/clustered/unrestricted
Specifies how sections are grouped. By default, a group is unrestricted’ which means that the linker
has total freedom to place the sections of the group in the address space.

absolute The section must be located at the address shown in the Properties column.
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ranged

floating

ranged float

The section must be located anywhere in the address ranges shown in the Properties column; end
addresses are not included in the range.

The sections must be located in some address range with a size not larger than shown in the
Properties column; the first number is the page size, the second part is the address range
restriction within the page.

Both the ranged and the floating restriction apply. In the Properties column the range restriction is
listed first, followed by the floating restriction between parenthesis.

ballooned After locating all sections, the largest remaining gap in the space is used completely for the stack
and/or heap.
Properties The contents depends on the Type column.
Sections The sections to which the rule applies;
restrictions between sections are shown in this column:
< ordered
| contiguous
+ clustered
For contiguous sections, the linker uses the section order as shown here. Clustered sections can be
located in any relative order.
Removed Sections

This part of the map file contains information about the sections that are removed from the absolute object file. For example,
unreferenced sections.

Related information

Section 6.11, Generating a Map File, in Chapter Using the Linker of the user’s manual.
Linker option --map-file (Generate map file)
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8 Object File Formats

Su mmary This chapter describes the formats of several object files.

8.1 ELF/DWARF Object Format

The TASKING ARM toolset by default produces objects in the ELF/DWARF 2 format.
For a complete description of the ELF and DWARF formats, please refer to the Tool Interface Standard (TIS).
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8.2 Motorola S-Record Format

With the linker option -ofilename:SREC option the linker produces output in Motorola S-record format with three types of
S-records: SO, S3 and S7. With the options -ofilename:SREC:2 or -ofilename:SREC:3 option you can force other types of
S-records. They have the following layout:

SO0 - record
'S’ ’0’ <length_byte> <2 bytes 0> <comment> <checksum_byte>
A linker generated S-record file starts with a SO record with the following contents:

length_byte :$08
comment : lkarm
checksum : $EO

lkarm
S00800006C6B61726DEO

The SO record is a comment record and does not contain relevant information for program execution.
The length_byte represents the number of bytes in the record, not including the record type and length byte.

The checksum is calculated by first adding the binary representation of the bytes following the record type (starting with the
length_byte) to just before the checksum. Then the one’s complement is calculated of this sum. The least significant byte of the
result is the checksum. The sum of all bytes following the record type is OFFH.

S1 -record

With the linker option -ofilename:SREC:2, the actual program code and data is supplied with S1 records, with the following
layout:

'S’ ’1’ <length_byte> <address> <code bytes> <checksum_byte>
This record is used for 2-byte addresses.
Example:

S1130250F03EF04DFOACE8A408A2A013EDFCDBOO0OE®6
| | | | checksum
| | |  code
| |_ address
| _ length

The linker has an option that controls the length of the output buffer for generating S1 records. The default buffer length is 32
code bytes.

The checksum calculation of S1 records is identical to SO.

S2 - record

With the linker option -ofilename:SREC:3, the actual program code and data is supplied with S2 records, with the following
layout:

'S’ ’2’ <length_byte> <address> <code bytes> <checksum_byte>
This record is used for 3-byte addresses.
Example:

S213FF002000232222754E00754F04AF4FAE4E22BF
|| | | checksum
| | | code
| |_ address
| _ length

The linker has an option that controls the length of the output buffer for generating S2 records. The default buffer length is 32
code bytes.
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The checksum calculation of S2 records is identical to SO.

S3 - record

With the linker option -ofilename:SREC:4, which is the default, the actual program code and data is supplied with S3 records,
with the following layout:

'S’ '3’ <length_byte> <address> <code bytes> <checksum_byte>
The linker generates 4-byte addresses by default.
Example:

S3070000FFFE6E6825
| | | | checksum
| | | _ code
| |_ address
|  length

The linker has an option that controls the length of the output buffer for generating S3 records.

The checksum calculation of S3 records is identical to SO.

S7 - record

With the linker option -ofilename:SREC:4, which is the default, at the end of an S-record file, the linker generates an S7 record,
which contains the program start address. S7 is the corresponding termination record for S3 records.

Layout:
'S’ ’7’ <length_byte> <address> <checksum_byte>
Example:

S70500000000FA
| | | _checksum
| |_ address
|  length

The checksum calculation of S7 records is identical to SO.

S8 - record

With the linker option -ofilename:SREC:3, at the end of an S-record file, the linker generates an S8 record, which contains the
program start address.

Layout:
'S’ ’8’ <length_byte> <address> <checksum_byte>
Example:

S804FF0003F9
| | | _checksum
| |_ address
| _ length

The checksum calculation of S8 records is identical to SO.

S9 - record

With the linker option -ofilename:SREC:2, at the end of an S-record file, the linker generates an S9 record, which contains the
program start address. S9 is the corresponding termination record for S1 records.

Layout:

'S’’9’ <length_byte> <address> <checksum_byte>
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Example:

S9030210EA
| | | _checksum
| |_ address
| _ length

The checksum calculation of S9 records is identical to SO.
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8.3

Intel Hex Record Format

Intel Hex records describe the hexadecimal object file format for 8-bit, 16-bit and 32-bit microprocessors. The hexadecimal
object file is an ASCII representation of an absolute binary object file. There are six different types of records:

* Data Record (8-, 16, or 32-bit formats)

* End of File Record (8-, 16, or 32-bit formats)

* Extended Segment Address Record (16, or 32-bit formats)

» Start Segment Address Record (16, or 32-bit formats)

* Extended Linear Address Record (32-bit format only)

» Start Linear Address Record (32-bit format only)

By default the linker generates records in the 32-bit format (4-byte addresses).

General Record Format

In the output file, the record format is:

length offset type content checksum

Where:
is the record header.
length is the record length which specifies the number of bytes of the content field. This value occupies one byte (two
hexadecimal digits). The linker outputs records of 255 bytes (32 hexadecimal digits) or less; that is, length is
never greater than FFH.
offset is the starting load offset specifying an absolute address in memory where the data is to be located when loaded
by a tool. This field is two bytes long. This field is only used for Data Records. In other records this field is coded
as four ASCII zero characters ('0000’).
type is the record type. This value occupies one byte (two hexadecimal digits). The record types are:
Byte Type Record type
00 Data
01 End of File
02 Extended segment address (not used)
03 Start segment address (not used)
04 Extended linear address (32-bit)
05 Start linear address (32-bit)
content is the information contained in the record. This depends on the record type.
checksum is the record checksum. The linker computes the checksum by first adding the binary representation of the

previous bytes (from length to content). The linker then computes the result of sum modulo 256 and subtracts the
remainder from 256 (two’s complement). Therefore, the sum of all bytes following the header is zero.

Extended Linear Address Record

The Extended Linear Address Record specifies the two most significant bytes (bits 16-31) of the absolute address of the first
data byte in a subsequent Data Record:

02 0000 04 upper_address checksum
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The 32-bit absolute address of a byte in a Data Record is calculated as:

(address + offset + index ) modulo 4G

where:
address is the base address, where the two most significant bytes are the upper_address and the two least significant
bytes are zero.
offset is the 16-bit offset from the Data Record.
index is the index of the data byte within the Data Record (0 for the first byte).
Example:
:0200000400FFFB

| | | | | _ checksum

| | | |_ upper_address

| | |_ type

| |_ offset

|  length

Data Record

The Data Record specifies the actual program code and data.

length offset 00 data checksum

The length byte specifies the number of data bytes. The linker has an option that controls the length of the output buffer for
generating Data records. The default buffer length is 32 bytes.

The offset is the 16-bit starting load offset. Together with the address specified in the Extended Address Record it specifies an
absolute address in memory where the data is to be located when loaded by a tool.

Example:
:0F00200000232222754E00754F04AF4FAE4E22C3
| | | | checksum
| | | | _data
| | |_ type
| |_ offset
|

_ length
Start Linear Address Record

The Start Linear Address Record contains the 32-bit program execution start address.

Layout:
04 0000 05 address checksum

Example:

:0400000500FF0003F5

| | | ] | checksum

| | | | _address

| I |_ type

| |_ offset

| _ length
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End of File Record
The hexadecimal file always ends with the following end-of-file record:

:00000001FF
| | | |_ checksum
| | |_ type

| |_ offset

| _ length
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Alllum 9 Linker Script Language

Summary This chapter describes the syntax of the linker script language (LSL)

9.1 Introduction

To make full use of the linker, you can write a script with information about the architecture of the target processor and locating
information. The language for the script is called the Linker Script Language (LSL). This chapter first describes the structure of
an LSL file. The next section contains a summary of the LSL syntax. Finally, in the remaining sections, the semantics of the
Linker Script Language is explained.

The TASKING linker is a target independent linker/locator that can simultaneously link and locate all programs for all cores
available on a target board. The target board may be of arbitrary complexity. A simple target board may contain one standard
processor with some external memory that executes one task. A complex target board may contain multiple standard
processors and DSPs combined with configurable IP-cores loaded in an FPGA. Each core may execute a different program,
and external memory may be shared by multiple cores.

LSL serves two purposes. First it enables you to specify the characteristics (that are of interest to the linker) of your specific
target board and of the cores installed on the board. Second it enables you to specify how sections should be located in
memory.

9.2  Structure of a Linker Script File

A script file consists of several definitions. The definitions can appear in any order.

The architecture definition (required)

In essence an architecture definition describes how the linker should convert logical addresses into physical addresses for a
given type of core. If the core supports multiple address spaces, then for each space the linker must know how to perform this
conversion. In this context a physical address is an offset on a given internal or external bus. Additionally the architecture
definition contains information about items such as the (hardware) stack and the vector table.

This specification is normally written by Altium. The architecture definition of the LSL file should not be changed by you unless
you also modify the core’s hardware architecture. If the LSL file describes a multi-core system an architecture definition must be
available for each different type of core.

% See section 9.5, Semantics of the Architecture Definition for detailed descriptions of LSL in the architecture definition.

The derivative definition

The derivative definition describes the configuration of the internal (on-chip) bus and memory system. Basically it tells the linker
how to convert offsets on the buses specified in the architecture definition into offsets in internal memory. A derivative definition
must be present in an LSL file. Microcontrollers and DSPs often have internal memory and 1/O sub-systems apart from one or
more cores. The design of such a chip is called a derivative.

When you design an FPGA together with a PCB, the components on the FPGA become part of the board design and there is no
need to distinguish between internal and external memory. For this reason you probably do not need to work with derivative
definitions at all. There are, however, two situations where derivative definitions are useful:

1. When you re-use an FPGA design for several board designs it may be practical to write a derivative definition for the FPGA
design and include it in the project LSL file.

2. When you want to use multiple cores of the same type, you must instantiate the cores in a derivative definition, since the
linker automatically instantiates only a single core for an unused architecture.
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% See section 9.6, Semantics of the Derivative Definition for a detailed description of LSL in the derivative definition.

The processor definition

The processor definition describes an instance of a derivative. Typically the processor definition instantiates one derivative only
(single-core processor). A processor that contains multiple cores having the same (homogeneous) or different (heterogeneous)
architecture can also be described by instantiating multiple derivatives of the same or different types in separate processor
definitions.

If for a derivative A’ no processor is defined in the LSL file, the linker automatically creates a processor named A’ of derivative
'A. This is why for single-processor applications it is enough to specify the derivative in the LSL file.

% See section 9.7, Semantics of the Board Specification for a detailed description of LSL in the processor definition.

The memory and bus definitions (optional)

Memory and bus definition are used within the context of a derivative definition to specify internal memory and on-chip buses. In
the context of a board specification the memory and bus definitions are used to define external (off-chip) memory and buses.
Given the above definitions the linker can convert a logical address into an offset into an on-chip or off-chip memory device.

% See section 9.7.3, Defining External Memory and Buses, for more information on how to specify the external physical
memory layout. Infernal memory for a processor should be defined in the derivative definition for that processor.

The board specification

The processor definition and memory and bus definitions together form a board specification. LSL provides language constructs
to easily describe single-core and heterogeneous or homogeneous multi-core systems. The board specification describes all
characteristics of your target board’s system buses, memory devices, I/O sub-systems, and cores that are of interest to the
linker. Based on the information provided in the board specification the linker can for each core:

e convert a logical address to an offset within a memory device

* |ocate sections in physical memory

* maintain an overall view of the used and free physical memory within the whole system while locating

The section layout definition (optional)

The optional section layout definition enables you to exactly control where input sections are located. Features are provided
such as: the ability to place sections at a given load-address or run-time address, to place sections in a given order, and to
overlay code and/or data sections.

Which object files (sections) constitute the task that will run on a given core is specified on the command line when you invoke
the linker. The linker will link and locate all sections of all tasks simultaneously. From the section layout definition the linker can
deduce where a given section may be located in memory, form the board specification the linker can deduce which physical
memory is (still) available while locating the section.

See section 9.9, Semantics of the Section Layout Definition, for more information on how to locate a section at a specific
place in memory.

Skeleton of a Linker Script File
The skeleton of a linker script file now looks as follows:

architecture architecture_name

{

architecture definition
}
derivative derivative_name
{

derivative definition
}
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processor processor name

{

processor definition

}
memory definitions and/or bus definitions

section_layout space_name

{

section placement statements

9.3 Syntax of the Linker Script Language

9.3.1 Preprocessing

When the linker loads an LSL file, the linker processes it with a C-style prepocessor. As such, it strips C and C++ comments.
You can use the standard ISO C preprocessor directives, such as #include, #define, #if/#else/#endif.

For example:
#include "arch.lsl”

Preprocess and include the file arch.1s1 at this point in the LSL file.

9.3.2 Lexical Syntax

The following lexicon is used to describe the syntax of the Linker Script Language:

A ::=B = Ais defined as B

A ::= B C = Ais defined as B and C; B is followed by C
A ::=B | C = Ais definedas BorC

<B>0]1 = zero or one occurrence of B

<B>>=0 = zero of more occurrences of B

<B>>=1 = one of more occurrences of B

IDENTIFIER = a character sequence starting with ’a’-’z’, ’A'-"Z’ or’_.
Following characters may also be digits and dots ’.’

STRING = sequence of characters not starting with \n, \r or \t
DQSTRING = " STRING " (double quoted string)
OCT_NUM = octal number, starting with a zero (06, 045)
DEC_NUM = decimal number, not starting with a zero (14, 1024)
HEX NUM = hexadecimal number, starting with ’0x’ (0x0023, 0xFFO00)

OCT_NUM, DEC_NUM and HEX NUM can be followed by a k (kilo), M (mega), or G (giga).

Characters in bold are characters that occur literally. Words in italics are higher order terms that are defined in the same or in
one of the other sections.

To write comments in LSL file, you can use the C style '/* */’ or C++ style '/ /’.
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9.3.3 Identifiers

arch _name ::= IDENTIFIER
bus_name ::= IDENTIFIER
core_name ::= IDENTIFIER
derivative_name ::= IDENTIFIER
file_name ::= DOSTRING
group_name ::= IDENTIFIER
mem_name ::= IDENTIFIER
proc_name ::= IDENTIFIER
section_name ::= DOSTRING
space_name ::= IDENTIFIER
stack_name ::= section_name
symbol name ::= DOSTRING

9.3.4 Expressions
The expressions and operators in this section work the same as in ISO C.

number = OCT_NUM
| DEC_NUM

HEX_NUM

number
symbol name

expr

|
| unary op expr
| expr binary op expr
| expr ? expr : expr
| ( expr)

| function _call

=1 // logical NOT
| ~ // bitwise complement
| - // negative value

unary_op

binary op = 7 // exclusive OR
| * // multiplication
| 7/ // division
| % // modulus
| + // addition
| - // subtraction
| > // right shift
| << // left shift
| == // equal to

| t= // not equal to

|

|

|

|

|

|

|

|

> // greater than

< // less than

>= // greater than or equal to
<= // less than or equal to

& // bitwise AND

| // bitwise OR
&& // logical AND
|| // logical OR
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9.3.5 Built-in Functions

function call absolute ( expr )

| addressof ( addr id )

| exists ( section name )
| max ( expr , expr )

| min ( expr , expr )

| sizeof ( size id )

addr_id ::= sect : section_name
| group : group name

size id sect : section_name

| group : group name
| mem : mem name

* Every space, bus, memory, section or group your refer to, must be defined in the LSL file.

* The addressof () and sizeof () functions with the group or sect argument can only be used in the right hand side of an
assignment. The sizeof () function with the mem argument can be used anywhere in section layouts.

You can use the following built-in functions in expressions. All functions return a numerical value. This value is a 64-bit signed
integer.

absolute()
int absolute( expr )

Converts the value of expr to a positive integer.

absolute( ”labelA”-"labelB” )

addressof()
int addressof( addr id )

Returns the address of addr_id, which is a named section or group. To get the offset of the section with the name asect:

addressof( sect: "asect”)

@ This function only works in assignments.

exists()
int exists( section name )

The function returns 1 if the section section_name exists in one or more object file, 0 otherwise. If the section is not present in
input object files, but generated from LSL, the result of this function is undefined.

To check whether the section mysection exists in one of the object files that is specified to the linker:

exists( "mysection” )

max()
int max( expr, expr )

Returns the value of the expression that has the largest value. To get the highest value of two symbols:

max( ”syml” , "sym2")
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min()
int min( expr, expr )

Returns the value of the expression hat has the smallest value. To get the lowest value of two symbols:

min( “syml” , "sym2”)

sizeof()
int sizeof( size_id )

Returns the size of the object (group, section or memory) the identifier refers to. To get the size of the section "asection”:

sizeof( sect: "asection” )

@ The group and sect arguments only works in assignments. The mem argument can be used anywhere in section
layouts.

9.3.6 LSL Definitions in the Linker Script File

description ::= <definition>>=1

definition ::= architecture_definition
| derivative definition
| board_spec
| section definition
| section setup

* Atleastone architecture_definition must be presentin the LSL file.

9.3.7 Memory and Bus Definitions

mem_def ::= memory mem name { <mem descr ;>>=0 }
* Amem_def defines a memory with the mem_name as a unique name.

mem_descr type = <reserved>°“—mem_type

mau = expr

speed = number
£ill <= fill values>0l1
mapping

* Amem_def contains exactly one type statement.

|
| size = expr
|
|
|

* Amem_def contains exactly one mau statement (non-zero size).

* Amem def contains exactly one size statement.

* Amem_def contains zero or one speed statement (if absent, the default speed value is 1).
* A mem_def contains zero or one £il1 statement.

* Amem_def contains at least one mapping.

mem_type = rom // attrs = rx
| ram // attrs = rw
| nvram // attrs = rwx
fill values t:= expr
| [ expr <, expr>>=0 ]
bus_def ::= bus bus_name { <bus_descr ;>>=0 }

* Abus_def statement defines a bus with the given bus_name as a unique name within a core architecture.
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bus_descr := mau = expr
| width = expr // bus width, nr
|
|

// of data bits
mapping // legal destination
// 'bus’ only
* The mau and width statements appear exactly once in a bus_descr. The default value for width is the mau size.
e The bus width must be an integer times the bus MAU size.
* The MAU size must be non-zero.
* Abus can only have a mapping on a destination bus (through dest = bus: ).

mapping map ( map_descr <, map_descr>>=0 )

map_descr dest = destination

dest_dbits = range

I dest_offset = expr
| size = expr
| src_dbits = range
| src_offset = expr
* A mapping requires at least the size and dest statements.
e Eachmap descr can occur only once.
* You can define multiple mappings from a single source.
* Overlap between source ranges or destination ranges is not allowed.
e Ifthe src_dbits or dest_dbits statement is not present, its value defaults to the width value if the source/destination is

a bus, and to the mau size otherwise.
destination ::= space : space_name

| bus : <proc_name |
core_name :>°|1 bus name

* A space_name refers to a defined address space.
* A proc_name refers to a defined processor.
* A core_name refers to a defined core.
* Abus_name refers to a defined bus.
* The following mappings are allowed (source to destination)

- space => space

- space => bus

- bus =>bus

- memory => bus

range 1:= eXpPr e e €Xpr

* With address ranges, the end address is not part of the range.

9.3.8 Architecture Definition

architecture_definition
::= architecture arch_name
<( parameter list )>0l1
<extends arch name
<( argument_list )>0[1 >0]|1
{ arch_spec>=0 }

* Anarchitecture definition defines a core architecture with the given arch_name as a unique name.
* Atleast one space_def and at least one bus_def have to be presentin an architecture definition.

* Anarchitecture_definition that uses the extends construct defines an architecture that inherits all elements of the
architecture defined by the second arch_name. The parent architecture must be defined in the LSL file as well.

parameter list parameter <, parameter>>=0

parameter IDENTIFIER <= expr>0|1
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argument list expr <, expr>>=0

arch_spec = bus_def
| space def
|

endianness_def

space_def space space_name { <space_descr;>>=0 }

* A space_def defines an address space with the given space_name as a unique name within an architecture.

space_descr = space_property ;
| section_definition //no space ref
| vector table statement

reserved_range

space_property = id = number // as used in object

| mau = expr

| align = expr

| page_size = expr <[ range ] <| [ range ]>>=0 >0]1
| page

| direction = direction
| stack_def

| heap def

| copy table def

| start_address

| mapping

* A space_def contains exactly one id and one mau statement.
* A space_def contains at most one align statement.

* A space_def contains at most one page_size statement.

* A space_def contains at least one mapping.

stack def ::= stack stack name ( stack _heap descr
<, stack_heap_descr >>=0 )

* A stack_def defines a stack with the stack_name as a unique name.

heap def ::= heap heap name ( stack_heap descr
<, stack_heap_descr >>=0 )

* A heap_ def defines a heap with the heap name as a unique name.

stack_heap_descr = min_size = expr
| grows = direction
| align = expr
| fixed
| id = expr
* Themin_size statement must be present.
* You can specify at most one align statement and one grows statement.
* Each stack definition has its own unique id, the number specified corresponds to the index in the . CALLS directive as
generated by the compiler. If the id is omitted, the id is O (zero).
direction ::= low_to_high
| high_to_low
* If you do not specify the grows statement, the stack and grow 1low-to-high.

copy_ table_def ::= copytable <( copy_table descr
<, copy table descr>>=0 )>0]|1
* A space_def contains at most one copytable statement.

* If the architecture definition contains more than one address space, exactly one copy table must be defined in one of the
spaces. If the architecture definition contains only one address space, a copy table definition is optional (it will be generated
in the space).
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copy table_descr

align = expr

copy_unit = expr

dest <space _name>0|1 = space name
page

* The copy_unit is defined by the size in MAUs in which the startup code moves data.

* The dest statement is only required when the startup code initializes memory used by another processor that has no

access to ROM.

* A space_name refers to a defined address space.

start_addr

start_addr descr ::=

start_address ( start_addr descr
<, start_addr_descr>>=0 )

run_addr = expr
symbol = symbol name

* A symbol name refers to the section that contains the startup code.

vector_table_statement

vecttab spec

vector_def $:=

vector_spec =

vector_id_ spec

vector_value

reserved_range $:=

vector_table section_name
( vecttab_spec <, vecttab_ spec>>=0 )
{ <vector_def>>=0 }

vector_size = expr

size = expr

id_symbol_prefix = symbol name
run_addr = addr_absolute
template = section_name
template_symbol = symbol name
vector_prefix = section_name
fill = vector value

no_inline

copy

vector ( vector spec <, vector_spec>>=0 )

id = vector_ id_ spec
fill = vector value

number
[ range ] <, [ range ]1>>=0

symbol_ name
[ number <, number>>=0 ]
loop <[ expr ]>0I1

reserved expr .. expr ;

* The end address is not part of the range.

endianness_def

endianness_type 1=

endianness { <endianness_type;>>=1 }

big
little

9.3.9 Derivative Definition

derivative definition

derivative derivative name
<( parameter list )>0|1
<extends derivative_name
<( argument_list )>0|1 >0|1
{ <derivative spec>>=0 }

* Aderivative definition defines a derivative with the given derivative name as a unique name.
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derivative_spec = core_def

| bus_def

| mem_def

| section_definition // no processor name
| section setup

core_def ::= core core_name { <core descr ;>>0 }

* A core_def defines a core with the given core_name as a unique name.
* Atleast one core_def must be presentin a derivative _definition.
core_descr ::= architecture = arch_name
<( argument list )>0|1
| endianness = ( endianness_type
<, endianness_type>>=0 )
* An arch_name refers to a defined core architecture.
* Exactly one architecture statement must be present in a core_def.

9.3.10 Processor Definition and Board Specification

board_spec proc_def
bus_def

|
| mem_def

proc_def processor proc_name

{ proc_descr ; }

proc_descr derivative = derivative_ name

<( argument list )>0[1
* Aproc_def defines a processor with the proc_name as a unique name.

* If you do not explicitly define a processor for a derivative in an LSL file, the linker defines a processor with the same name as
that derivative.

* Aderivative name refers to a defined derivative.
* A proc_def contains exactly one derivative statement.

9.3.11 Section Layout Definition and Section Setup

section definition ::= section_layout <space ref>0l1

<( locate direction )>0[1

{ <section_statement>>=0 }
* A section definition inside a space definition does not have a space_ref.
* All global section definitions have a space _ref.
space_ref ::= <proc_name>0|1l : <core name>0l!

! space_name
* If more than one processor is present, the proc_name must be given for a global section layout.
* If the section layout refers to a processor that has more than one core, the core_name must be given in the space ref.
* A proc_name refers to a defined processor.
* A core_name refers to a defined core.
* A space_name refers to a defined address space.
locate _direction ::= direction = direction
direction ::= low_to_high

| high_to_low

* A section layout contains at most one direction statement.
* If you do not specify the direction statement, the locate direction of the section layout is low-to-high.

section_statement
:= simple section_statement ;
| aggregate_section_statement
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simple_ section_statement

assignment
select_section_statement
special section_statement

assignment symbol name assign_op expr

assign_op :

select_section_statement
::= select <ref_tree>0|l <section name>0l1
<section selections>0l1

e Either a section_name or at least one section_selection must be defined.

section_selections
:= ( section_selection

<, section_selection>>=0 )

section_selection

::= attributes = < <+|-> attribute>>0
* t+attribute means: select all sections that have this attribute.
e -—attribute means: select all sections that do not have this attribute.

special_ section_statement
heap stack name <size spec>0l1

| stack stack name <size spec>0ll
| copytable
|

reserved section name <reserved specs>0l|1
* Special sections cannot be selected in load-time groups.

size_ spec :1:= ( size = expr )

reserved_specs ::= ( reserved_spec <, reserved_spec>>=0 )

attributes

fill spec

size = expr

alloc_allowed = absolute | ranged

reserved_spec HH

* If a reserved section has attributes r, rw, x, rx or rwx, and no fill pattern is defined, the section is filled with zeros. If no
attributes are set, the section is created as a scratch section (attributes ws, no image).

fill spec ::= fill = fill values

fill values 1:= expr
|

[ expr <, expr>>=0 ]

aggregate section_ statement
{ <section_statement>>=0 }

if statement

| group descr
| section creation statement

group descr ::= group <group name>°ll <( group specs )>0[1
section_ statement

* For every group with a name, the linker defines a label.
* No two groups for address spaces of a core can have the same group _name.

group_specs ::= group spec <, group spec >>=0
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group_spec group_alignment

| attributes

| copy

| nocopy

| group load address

| £ill <= fill values>0|1
| group_page

| group run_address

| group_type

| allow_cross_references
| priority = number

* The allow-cross-references property is only allowed for overlay groups.
e Sub groups inherit all properties from a parent group.

group_alignment ::= align = expr

attributes = <attribute>>=1

attributes

// readable sections

// writable sections

// executable code sections
// initialized sections

// scratch sections

attribute

own kXS K

// blanked (cleared) sections

group_ load_address
:= load_addr <= load or run_addr>0l1

group page ::= page <= expr>0[1
| page_size = expr <[ range ] <| [ range 1>>=0 >0|1

group_run_address run_addr <= load or run_addr>0ll

group_type clustered

| contiguous
| ordered
|

overlay
* For non-contiguous groups, you can only specify group _alignment and attributes.
* The overlay keyword also sets the contiguous property.
* The clustered property cannot be set together with contiguous or ordered on a single group.

load_or run_addr ::= addr_absolute
| addr range <| addr range>>=0

addr absolute 1= expr
| memory reference [ expr ]
* An absolute address can only be set on ordered groups.

addr_range [ expr .. expr ]

| memory reference
| memory reference [ expr .. expr |

* The parent of a group with an addr_range or page restriction cannot be ordered, contiguous or clustered.
* The end address is not part of the range.

memory reference ::= mem : <proc_name :>°|1 mem name

* A proc_name refers to a defined processor.
* A mem name refers to a defined memory.

if statement ::= if ( expr ) section_statement
<else section_statement>0|1
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section_creation_ statement
::= section section_name ( section_specs )
{ <section_statement2>>=0 }

section_specs ::= section spec <, section_spec >>=0
section_spec 1:= attributes
fill_spec

|
size = expr
| P
blocksize = expr
| P
|

overflow = section_name

section_statement2

= select_section_statement ;
| group descr2

| { <section statement2>>=0 }

group_descr2 ::= group <group name>0|1
( group specs2 )
section statement2

group specs2 ::= group_spec2 <, group spec2 >>=0

group_spec2 t:= group_alignment
| attributes
|

load_addr

section_setup ::= section_setup space ref
{ <section_setup_ item>>=0 }

section_setup_item

= vector_table statement
| reserved range

| stack def ;

| heap def ;

9.4 Expression Evaluation

Only constant expressions are allowed, including sizes, but not addresses, of sections in object files.

All expressions are evaluated with 64-bit precision integer arithmetic. The result of an expression can be absolute or
relocatable. A symbol you assign is created as an absolute symbol.
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9.5 Semantics of the Architecture Definition

Keywords in the architecture definition

architecture
extends
endianness big 1little
bus
mau
width
map
space
id
mau
align
page size
page
direction low to high high to low
stack
min_size
grows low_to_high high to low
align
fixed
id
heap
min_size
grows low_to_high high to low
align
fixed
id
copytable
align
copy_unit
dest
page
vector table
vector_size
size
id_symbol prefix
run_addr
template
template symbol
vector prefix
fill
no_inline
copy
vector
id
fill loop
reserved
start_address
run_addr
symbol
map
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map
dest bus space
dest dbits
dest offset
size
src_dbits
src_offset

9.5.1 Defining an Architecture

With the keyword architecture you define an architecture and assign a unique name to it. The name is used to refer to it at
other places in the LSL file:

architecture name

{

definitions

}

If you are defining multiple core architectures that show great resemblance, you can define the common features in a parent
core architecture and extend this with a child core architecture that contains specific features. The child inherits all features of
the parent. With the keyword extends you create a child core architecture:

architecture name_child _arch extends name_parent_arch

{

definitions

}

A core architecture can have any number of parameters. These are identifiers which get values assigned on instantiation or
extension of the architecture. You can use them in any expression within the core architecture. Parameters can have default
values, which are used when the core architecture is instantiated with less arguments than there are parameters defined for it.
When you extend a core architecture you can pass arguments to the parent architecture. Arguments are expressions that set
the value of the parameters of the sub-architecture.

architecture name_child_arch (parml,parm2=1)
extends name parent_ arch (arguments)

definitions

9.5.2 Defining Internal Buses

With the bus keyword you define a bus (the combination of data and corresponding address bus). The bus name is used to
identify a bus and does not conflict with other identifiers. Bus descriptions in an architecture definition or derivative definition
define internal buses. Some internal buses are used to communicate with the components outside the core or processor. Such
buses on a processor have physical pins reserved for the number of bits specified with the width statements.

* The mau field specifies the MAU size (Minimum Addressable Unit) of the data bus. This field is required.

* The width field specifies the width (number of address lines) of the data bus. The default value is the MAU size.

* The map keyword specifies how this bus maps onto another bus (if so). Mappings are described in section 9.5.4, Mappings.

bus bus_name

{

mau = 8;

width = 8;

map ( map_description );
}

9.5.3 Defining Address Spaces

With the space keyword you define a logical address space. The space name is used to identify the address space and does
not conflict with other identifiers.
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The id field defines how the addressing space is identified in object files. In general, each address space has a unique ID.
The linker locates sections with a certain ID in the address space with the same ID. This field is required. In IEEE this ID is
specified explicitly for sections and symbols, ELF sections map by default to the address space with ID 1. Sections with one
of the special names defined in the ABI (Application Binary Interface) may map to different address spaces.

The mau field specifies the MAU size (Minimum Addressable Unit) of the space. This field is required.

The align value must be a power of two. The linker uses this value to compute the start addresses when sections are
concatenated. An align value of n means that objects in the address space have to be aligned on n MAUs.

The page_size field sets the page alignment and page size in MAUs for the address space. It must be a power of 2. The
default value is 1. If one or more page ranges are supplied the supplied value only sets the page alignment. The ranges
specify the available space in each page, as offsets to the page start, which is aligned at the page alignment.

See also the page keyword in subsection Locating a group in section 9.9.2, Creating and Locating Groups of Sections.

With the optional direction field you can specify how all sections in this space should be located. This can be either from
low_to_high addresses (this is the default) or from high_to_low addresses.

The map keyword specifies how this address space maps onto an internal bus or onto another address space. Mappings are
described in section 9.5.4, Mappings.

Stacks and heaps

The stack keyword defines a stack in the address space and assigns a name to it. The architecture definition must contain
at least one stack definition. Each stack of a core architecture must have a unique name. See also the stack keyword in
section 9.9.3, Creating or Modifying Special Sections.

The stack is described in terms of a minimum size (min_size) and the direction in which the stack grows (grows). This
can be either from low_to_high addresses (stack grows upwards, this is the default) or from high_to_low addresses
(stack grows downwards). The min_size is required.

By default, the linker tries to maximize the size of the stacks and heaps. After locating all sections, the largest remaining gap
in the space is used completely for the stacks and heaps. If you specify the keyword fixed, you can disable this so-called
’balloon behavior’. The size is also fixed if you used a stack or heap in the software layout definition in a restricted way. For
example when you override a stack with another size or select a stack in an ordered group with other sections.

The id keyword matches stack information generated by the compiler with a stack name specified in LSL. This value
assigned to this keyword is strongly related to the compiler’s output, so users are not supposed to change this configuration.

Optionally you can specify an alignment for the stack with the argument align. This alignment must be equal or larger than
the alignment that you specify for the address space itself.

The heap keyword defines a heap in the address space and assigns a name to it. The definition of a heap is similar to the
definition of a stack. See also the heap keyword in section 9.9.3, Creating or Modifying Special Sections.

% See section 9.9, Semantics of the Section Layout Definition, for information on creating and placing stack sections.

Copy tables

The copytable keyword defines a copy table in the address space. The content of the copy table is created by the linker
and contains the start address and size of all sections that should be initialized by the startup code. You must define exactly
one copy table in one of the address spaces (for a core).

Optionally you can specify an alignment for the copy table with the argument align. This alignment must be equal or larger
than the alignment that you specify for the address space itself. If smaller, the alignment for the address space is used.

The copy_unit argument specifies the size in MAUs of information chunks that are copied. If you do not specify the copy
unit, the MAU size of the address space itself is used.

The dest argument specifies the destination address space that the code uses for the copy table. The linker uses this
information to generate the correct addresses in the copy table. The memory into where the sections must be copied at
run-time, must be accessible from this destination space.

Sections generated for the copy table may get a page restriction with the address space’s page size, by adding the page
argument.
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Vector table

The vector_table keyword defines a vector table with n vectors of size m (This is an internal LSL object similar to an LSL
group.) The run_addr argument specifies the location of the first vector (id=0). This can be a simple address or an offset in
memory (see the description of the run-time address in subsection Locating a group in section 9.9.2, Creating and Locating
Groups of Sections). A vector table defines symbols _1c_ub_foo and 1lc_ue_ foo pointing to start and end of the table.

vector_table ”"vtable” (vector_size=m, size=n, run_addr=x, ...)
See the following example of a vector table definition:

vector table ”vtable” (vector size = 4, size = 256, run_ addr=0,
template=".text.vector template”,
template_symbol="_lc_vector_target”,
vector prefix="_ vector ”,
id_symbol_ prefix="foo",
no_inline,
/* default: empty, or */
fill="foo"”, /* or */
fill=[1,2,3,4], /* or */

fill=loop)
{
vector (id=0, fill="_ START");
vector (id=12, fill=[Oxab, 0x21, 0x32, 0x43]);
vector (id=[1..11], £ill=[0]);
vector (id=[18..23], fill=loop);
}

The template argument defines the name of the section that holds the code to jump to a handler function from the vector
table. This template section does not get located and is removed when the locate phase is completed. This argument is
required.

The template_symbol argument is the symbol reference in the template section that must be replaced by the address of
the handler function. This symbol name should start with the linker prefix for the symbol to be ignored in the link phase. This
argument is required.

The vector_prefix argument defines the names of vector sections: the section for a vector with id vector_id is
$(vector_prefix)$(vector_id). Vectors defined in C or assembly source files that should be included in the vector table must
have the correct symbol name. The compiler uses the prefix that is defined in the default LSL file(s); if this attribute is
changed, the vectors declared in C source files are not included in the vector table. When a vector supplied in an object file
has exactly one relocation, the linker will assume it is a branch to a handler function, and can be removed when the handler
is inlined in the vector table. Otherwise, no inlining is done. This argument is required.

With the optional no_inline argument the vectors handlers are not inlined in the vector table.
With the optional copy argument a ROM copy of the vector table is made and the vector table is copied to RAM at startup.

With the optional id_symbol_prefix argument you can set an internal string representing a symbol name prefix that may
be found on symbols in vector handler code. When the linker detects such a symbol in a handler, the symbol is assigned the
vector number. If the symbol was already assigned a vector number, a warning is issued.

The £i11 argument sets the default contents of vectors. If nothing is specified for a vector, this setting is used. See below.
When no default is provided, empty vectors may be used to locate large vector handlers and other sections. Only one £ill
argument is allowed.

The vector field defines the content of vector with the number specified by id. If a range is specified for id ([p..q,s..t]) all
vectors in the ranges (inclusive) are defined the same way.

With £i11=symbol name, the vector must jump to this symbol. If the section in which the symbol is defined fits in the vector
table (size may be >m), locate the section at the location of the vector. Otherwise, insert code to jump to the symbol’s value.
A template handler section name + symbol name for the target code must be supplied in the LSL file.

fill=[value(s)], fills the vector with the specified MAU values.

With £il1=1oop the vector jumps to itself. With the optional [offset] you can specify an offset from the vector table entry.
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Reserved address ranges

* The reserved keyword specifies to reserve a part of an address space even if not all of the range is covered by memory.
See also the reserved keyword in section 9.9.3, Creating or Modifying Special Sections.

Start address

* The start_address keyword specifies the start address for the position where the C startup code is located. When a
processor is reset, it initializes its program counter to a certain start address, sometimes called the reset vector. In the
architecture definition, you must specify this start address in the correct address space in combination with the name of the
label in the application code which must be located here.

The run_addr argument specifies the start address (reset vector). If the core starts executing using an entry from a vector
table, and directly jumps to the start label, you should omit this argument.

The symbol argument specifies the name of the label in the application code that should be located at the specified start
address. The symbol argument is required. The linker will resolve the start symbol and use its value after locating for the
start address field in IEEE-695 files and Intel Hex files. If you also specified the run_addr argument, the start symbol
(label) must point to a section. The linker locates this section such that the start symbol ends up on the start address.

space space_name

{
id = 1;
mau = 8;
align = 8;
page_size = 1;
stack name (min_size = 1k, grows = low_to_high);
reserved start_address .. end_address;
start_address ( run_addr = 0x0000,

symbol = "start label” )

map ( map_description );

}

9.5.4 Mappings

You can use a mapping when you define a space, bus or memory. With the map field you specify how addresses from the
source (space, bus or memory) are translated to addresses of a destination (space, bus). The following mappings are possible:
* space => space

* space => bus

* bus =>bus

* memory => bus

With a mapping you specify a range of source addresses you want to map (specified by a source offset and a size), the
destination to which you want to map them (a bus or another address space), and the offset address in the destination.

* The dest argument specifies the destination. This can be a bus or another address space (only for a space to space
mapping). This argument is required.

* The src_offset argument specifies the offset of the source addresses. In combination with size, this specifies the range of
address that are mapped. By default the source offset is 0x0000.

* The size argument specifies the number of addresses that are mapped. This argument is required.
* The dest_offset argument specifies the position in the destination to which the specified range of addresses is mapped.
By default the destination offset is 0x0000.

If you are mapping a bus to another bus, the number of data lines of each bus may differ. In this case you have to specify a
range of source data lines you want to map (src_dbits = begin..end) and the range of destination data lines you want to
map them to (dest_dbits = first..last).

* The src_dbits argument specifies a range of data lines of the source bus. By default all data lines are mapped.

* The dest_dbits argument specifies a range of data lines of the destination bus. By default, all data lines from the source
bus are mapped on the data lines of the destination bus (starting with line 0).
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From space to space

If you map an address space to another address space (nesting), you can do this by mapping the subspace to the containing
larger space. In this example a small space of 64k is mapped on a large space of 16M.

space small

{
id = 2;
mau = 4;
map (src_offset = 0, dest_offset = 0,
dest = space : large, size = 64k);
}

From space to bus

All spaces that are not mapped to another space must map to a bus in the architecture:

space large

{
id = 1;
mau = 4;
map (src_offset = 0, dest_offset = 0,
dest = bus:bus_name, size = 16M );
}

From bus to bus

The next example maps an external bus called e_bus to an internal bus called i_bus. This internal bus resides on a core
called mycore. The source bus has 16 data lines whereas the destination bus has only 8 data lines. Therefore, the keywords
src_dbits and dest_dbits specify which source data lines are mapped on which destination data lines.

architecture mycore

{
bus i _bus
{
mau = 4;
}
space i space
{
map (dest=bus:i bus, size=256);
}
}
bus e bus
{
mau = 16;
width = 16;
map (dest = bus:mycore:i bus, src_dbits = 0..7, dest_dbits = 0..7 )
}

@ It is not possible to map an internal bus to an external bus.
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9.6 Semantics of the Derivative Definition

Keywords in the derivative definition

derivative
extends
core
architecture
bus
mau
width
map
memory
type reserved rom ram nvram
mau
size
speed
fill
map
section_ layout
section_setup

map
dest bus space
dest dbits
dest offset
size
src_dbits
src_offset

9.6.1 Defining a Derivative

With the keyword derivative you define a derivative and assign a unique name to it. The name is used to refer to it at other
places in the LSL file:

derivative name

{

definitions

}

If you are defining multiple derivatives that show great resemblance, you can define the common features in a parent derivative
and extend this with a child derivative that contains specific features. The child inherits all features of the parent (cores and
memories). With the keyword extends you create a child derivative:

derivative name_child deriv extends name_parent_deriv

{

definitions

}

As with a core architecture, a derivative can have any number of parameters. These are identifiers which get values assigned
on instantiation or extension of the derivative. You can use them in any expression within the derivative definition.

derivative name_child deriv (parml,parm2=1)
extends name parent_derivh (arguments)

definitions

9.6.2 Instantiating Core Architectures

With the keyword core you instantiate a core architecture in a derivative.
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With the keyword architecture you tell the linker that the given core has a certain architecture. The architecture name
refers to an existing architecture definition in the same LSL file.

For example, if you have two cores (called mycore 1 and mycore_2) that have the same architecture (called
mycorearch), you must instantiate both cores as follows:

core mycore_ 1

{

architecture = mycorearch;
}
core mycore_2
{

architecture = mycorearch;
}

If the architecture definition has parameters you must specify the arguments that correspond with the parameters. For
example mycorearchl expects two parameters which are used in the architecture definition:

core mycore

{

architecture = mycorearchl (1,2);

}

9.6.3 Defining Internal Memory and Buses

With the memory keyword you define physical memory that is present on the target board. The memory name is used to identify
the memory and does not conflict with other identifiers. It is common to define internal memory (on-chip) in the derivative
definition. External memory (off-chip memory) is usually defined in the board specification (See section 9.7.3, Defining External
Memory and Buses).

The type field specifies a memory type:
- rom: read only memory - it can only be written at load-time

- ram: random access volatile writable memory - writing at run-time is possible
while writing at load-time has no use since the data is not retained after
a power-down

- nvram: non volatile ram - writing is possible both at load-time and run-time

The optional reserved qualifier before the memory type, tells the linker not to locate any section in the memory by default.
You can locate sections in such memories using an absolute address or range restriction (see subsection Locating a group
in section 9.9.2, Creating and Locating Groups of Sections).

The mau field specifies the MAU size (Minimum Addressable Unit) of the memory. This field is required.

The size field specifies the size in MAU of the memory. This field is required.

The speed field specifies a symbolic speed for the memory (1..4): 1 is the fastest, 4 the slowest. The linker uses the relative
speed of the memories in such a way, that optimal speed is achieved. The default speed is 1.

The map field specifies how this memory maps onto an (internal) bus. Mappings are described in section 9.5.4, Mappings.
The optional £i11 field contains a bit pattern that the linker writes to all memory addresses that remain unoccupied during
the locate process. The result of the expression, or list of expressions, is used as values to write to memory, each in MAU.

memory mem_ name

{

type = rom;

mau = 8;

fill = Oxaa;

size = 64k;

speed = 2;

map ( map_description );
}

With the bus keyword you define a bus in a derivative definition. Buses are described in section 9.5.2, Defining Internal Buses.
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9.7 Semantics of the Board Specification

Keywords in the board specification

processor

derivative
bus

mau

width

map
memory

type reserved rom ram nvram

mau

size

speed

fill

map

map
dest bus space
dest_dbits
dest_offset
size
src_dbits
src_offset

9.7.1 Defining a Processor

If you have a target board with multiple processors that have the same derivative, you need to instantiate each individual
processor in a processor definition. This information tells the linker which processor has which derivative and enables the linker
to distinguish between the present processors.

@ If you use processors that all have a unique derivative, you may omit the processor definitions. In this case the linker
assumes that for each derivative definition in the LSL file there is one processor. The linker uses the derivative name also
for the processor.

With the keyword processor you define a processor. You can freely choose the processor name. The name is used to refer to
it at other places in the LSL file:

processor proc_name

{

processor definition

9.7.2 Instantiating Derivatives

With the keyword derivative you tell the linker that the given processor has a certain derivative. The derivative name refers
to an existing derivative definition in the same LSL file.

For examples, if you have two processors on your target board (called myproc_1 and myproc_ 2) that have the same derivative
(called myderiv), you must instantiate both processors as follows:

processor myproc_1

{

derivative = myderiv;
}
processor myproc_2
{

derivative = myderiv;
}
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If the derivative definition has parameters you must specify the arguments that correspond with the parameters. For example
myderivl expects two parameters which are used in the derivative definition:

processor myproc

{

derivative = myderivl (2,4);

}

9.7.3 Defining External Memory and Buses

It is common to define external memory (off-chip) and external buses at the global scope (outside any enclosing definition).
Internal memory (on-chip memory) is usually defined in the scope of a derivative definition.

With the keyword memory you define physical memory that is present on the target board. The memory name is used to identify
the memory and does not conflict with other identifiers. If you define memory parts in the LSL file, only the memory defined in
these parts is used for placing sections.

If no external memory is defined in the LSL file and if the linker option to allocate memory on demand is set then the linker will
assume that all virtual addresses are mapped on physical memory. You can override this behavior by specifying one or more
memory definitions.

memory mem name

{

type = rom;

mau = 8;

fill = Oxaa;

size = 64k;

speed = 2;

map ( map_description );
}

% For a description of the keywords, see section 9.6.3, Defining Internal Memory and Buses.

With the keyword bus you define a bus (the combination of data and corresponding address bus). The bus name is used to
identify a bus and does not conflict with other identifiers. Bus descriptions at the global scope (outside any definition) define
external buses. These are buses that are present on the target board.

bus bus name

{

mau = 8;

width = 8;

map ( map_description );
}

% For a description of the keywords, see section 9.5.2, Defining Internal Buses.

You can connect off-chip memory to any derivative: you need to map the off-chip memory to a bus and map that bus on the
internal bus of the derivative you want to connect it to.
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9.8 Semantics of the Section Setup Definition

Keywords in the section setup definition

section_setup
stack
min_size
grows low_to_high high to low
align
fixed
id
heap
min size
grows low _to _high high to low
align
fixed
id
vector table
vector_size
size
id_symbol prefix
run_addr
template
template_symbol
vector_ prefix
fill
no_inline
copy
vector
id
fill loop
reserved

9.8.1 Setting up a Section

With the keyword section_setup you can define stacks, heaps, vector tables, and/or reserved address ranges outside their
address space definition.

section_setup ::my_space

{
vector table statements
reserved address range
stack definition
heap definition

}

% See the subsections Stacks and heaps, Vector table and Reserved address ranges in section 9.5.3, Defining Address
Spaces, for details on the keywords stack, heap, vector_table and reserved.
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9.9 Semantics of the Section Layout Definition

Keywords in the section layout definition

section layout
direction low_to_high high to low
group
align
attributes + - rwzxbis
copy
nocopy
fill
ordered
contiguous
clustered
overlay
allow_cross_references
load addr
mem
run_addr
mem
page
page size
priority
select
stack
size
heap
size
reserved
size
attributes rwx
fill
alloc_allowed absolute ranged
copytable
section
size
blocksize
attributes rw X
fill
overflow
if
else

9.9.1 Defining a Section Layout

With the keyword section_layout you define a section layout for exactly one address space. In the section layout you can
specify how input sections are placed in the address space, relative to each other, and what the absolute run and load
addresses of each section will be.

You can define one or more section definitions. Each section definition arranges the sections in one address space. You can
precede the address space name with a processor name and/or core name, separated by colons. You can omit the processor
name and/or the core name if only one processor is defined and/or only one core is present in the processor. A reference to a
space in the only core of the only processor in the system would look like ”: :my_space”. A reference to a space of the only
core on a specific processor in the system could be "my_chip: :my_ space”. The next example shows a section definition for
sections in the my_space address space of the processor called my_ chip:
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section_layout my chip::my space ( locate_direction )
{

section statements

}

With the optional keyword direction you specify whether the linker starts locating sections from 1low_to_high (default) or
from high_to_1low. In the second case the linker starts locating sections at the highest addresses in the address space but
preserves the order of sections when necessary (one processor and core in this example).

section_layout ::my space ( direction = high_to_low )
{

section statements

}

@ If you do not explicitly tell the linker how to locate a section, the linker decides on the basis of the section attributes in the
object file and the information in the architecture definition and memory parts where to locate the section.

9.9.2 Creating and Locating Groups of Sections

Sections are located per group. A group can contain one or more (sets of) input sections as well as other groups. Per group you
can assign a mutual order to the sets of sections and locate them into a specific memory part.

group ( group specifications )

{

section_statements

}

With the section_statements you generally select sets of sections to form the group. This is described in subsection Selecting
sections for a group.

Instead of selecting sections, you can also modify special sections like stack and heap or create a reserved section. This is
described in section 9.9.3, Creating or Modifying Special Sections.

With the group_specifications you actually locate the sections in the group. This is described in subsection Locating a group.
Selecting sections for a group

With the select keyword you can select one or more sections for the group. You can select a section by name or by attributes.
If you select a section by name, you can use a wildcard pattern:

il matches with all section names

e matches with a single character in the section name

\? takes the next character literally

"[abc]” matches with a single ’a’, 'b’ or °’c’ character

"[a-z]” matches with any single character in the range 'a’ to ’z’

group ( ... )

{
select "mysection”;
select "*";

}

The first select statement selects the section with the name "mysection”. The second select statement selects all sections
that were not selected yet.

A section is selected by the first select statement that matches, in the union of all section layouts for the address space.
Global section layouts are processed in the order in which they appear in the LSL file. Internal core architecture section layouts
always take precedence over global section layouts.

* The attributes field selects all sections that carry (or do not carry) the given attribute. With +attribute you select sections
that have the specified attribute set. With -attribute you select sections that do not have the specified attribute set. You can
specify one or more of the following attributes:

- r readable sections
- w writable sections
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executable sections

initialized sections

sections that should be cleared at program startup

n o k- A

scratch sections (not cleared and not initialized)

To select all read-only sections:

group ( ... )
{

select (attributes = +r-w);

}

@ Keep in mind that all section selections are restricted to the address space of the section layout in which this group
definition occurs.

* With the ref_tree field you can select a group of related sections. The relation between sections is often expressed by
means of references. By selecting just the 'root’ of tree, the complete tree is selected. This is for example useful to locate a
group of related sections in special memory (e.g. fast memory). The (referenced) sections must meet the following
conditions in order to be selected:

1. The sections are within the section layout’s address space

2. The sections match the specified attributes

3. The sections have no absolute restriction (as is the case for all wildcard selections)
For example, to select the code sections referenced from fool:

group refgrp (ordered, contiguous, run_ addr=mem:ext c)
{
select ref_tree "fool” (attributes=+x);

}

If section fool references foo2 and foo2 references foo3, then all these sections are selected by the selection shown
above.

Locating a group

group group name ( group_specifications )
{
section_statements

}

With the group_specifications you actually define how the linker must locate the group. You can roughly define three things: 1)
assign properties to the group like alignment and read/write attributes, 2) define the mutual order in the address space for
sections in the group and 3) restrict the possible addresses for the sections in a group.

The linker creates labels that allow you to refer to the begin and end address of a group from within the application software.
Labels _lc_gb_group name and _lc_ge_group name mark the begin and end of the group respectively, where the begin is
the lowest address used within this group and the end is the highest address used. Notice that a group not necessarily occupies
all memory between begin and end address. The given label refers to where the section is located at run-time (versus
load-time).

1. Assign properties to the group like alignment and read/write attributes.
These properties are assigned to all sections in the group (and subgroups) and override the attributes of the input sections.

* The align field tells the linker to align all sections in the group and the group as a whole according to the align value. By
default the linker uses the largest alignment constraint of either the input sections or the alignment of the address space.

* The attributes field tells the linker to assign one or more attributes to all sections in the group. This overrules the
default attributes. By default the linker uses the attributes of the input sections. You can set the r, w or rw attributes and
you can switch between the b and s attributes.

* The copy field tells the linker to locate a read-only section in RAM and generate a ROM copy and a copy action in the
copy table. This property makes the sections in the group writable which causes the linker to generate ROM copies for
the sections.
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The effect of the nocopy field is the opposite of the copy field. It prevents the linker from generating ROM copies of the
selected sections.

2. Define the mutual order of the sections in the group.
By default, a group is unrestricted which means that the linker has total freedom to place the sections of the group in the
address space.

&
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The ordered keyword tells the linker to locate the sections in the same order in the address space as they appear in the
group (but not necessarily adjacent).

Suppose you have an ordered group that contains the sections 'A’, 'B’ and 'C’. By default the linker places the sections
in the address space like 'A’' - 'B’ - 'C’, where section 'A’ gets the lowest possible address. With
direction=high_to_lowin the section_layout space properties, the linker places the sections in the address
space like °'C’ - 'B’ - 'A, where section ‘A’ gets the highest possible address.

The contiguous keyword tells the linker to locate the sections in the group in a single address range. Within a
contiguous group the input sections are located in arbitrary order, however the group occupies one contigous range of
memory. Due to alignment of sections there can be ’alignment gaps’ between the sections.

When you define a group that is both ordered and contiguous, this is called a sequential group. In a sequential group
the linker places sections in the same order in the address space as they appear in the group and it occupies a
contiguous range of memory.

The clustered keyword tells the linker to locate the sections in the group in a number of contiguous blocks. It tries to
keep the number of these blocks to a minimum. If enough memory is available, the group will be located as if it was
specified as contiguous. Otherwise, it gets split into two or more blocks.

If a contiguous or clustered group contains alignment gaps, the linker can locate sections that are not part of the group in
these gaps. To prevent this, you can use the £i11 keyword. If the group is located in RAM, the gaps are treated as
reserved (scratch) space. If the group is located in ROM, the alignment gaps are filled with zeros by default. You can
however change the fill pattern by specifying a bit pattern. The result of the expression, or list of expressions, is used as
values to write to memory, each in MAU.

The overlay keyword tells the linker to overlay the sections in the group. The linker places all sections in the address
space using a contiguous range of addresses. (Thus an overlay group is automatically also a contiguous group.) To
overlay the sections, all sections in the overlay group share the same run-time address.

For each input section within the overlay the linker automatically defines two symbols. The symbol
_lc_cb_section_name is defined as the load-time start address of the section. The symbol _lc_ce_section_name
is defined as the load-time end address of the section. C (or assembly) code may be used to copy the overlaid sections.

If sections in the overlay group contain references between groups, the linker reports an error. The keyword
allow_cross_references tells the linker to accept cross-references. Normally, it does not make sense to have
references between sections that are overlaid.

group ovl (overlay)

{
group a
{
select "my ovl _pl”;
select "my_ovl_p2”;
}
group b
{
select "my ovl gl”;
}
}

It may be possible that one of the sections in the overlay group already has been defined in another group where it
received a load-time address. In this case the linker does not overrule this load-time address and excludes the section
from the overlay group.



Linker Script Language

3. Restrict the possible addresses for the sections in a group.
The load-time address specifies where the group’s elements are loaded in memory at download time. The run-time address
specifies where sections are located at run-time, that is when the program is executing. If you do not explicitly restrict the
address in the LSL file, the linker assigns addresses to the sections based on the restrictions relative to other sections in the
LSL file and section alignments. The program is responsible for copying overlay sections at appropriate moment from its
load-time location to its run-time location (this is typically done by the startup code).

The run_addr keyword defines the run-time address. If the run-time location of a group is set explicitly, the given order
between groups specify whether the run-time address propagates to the parent group or not. The location of the sections
a group can be restricted either to a single absolute address, or to a number of address ranges (not including the end
address). With an expression you can specify that the group should be located at the absolute address specified by the
expression:

group (run_addr = 0xa00£0000)
You can use the '[offset]’ variant to locate the group at the given absolute offset in memory:
group (run_addr = mem:A[0x1000])

A range can be an absolute space address range, written as [ expr .. expr ], acomplete memory device, written
as mem:mem_name, Or @ memory address range,
mem:mem_name[expr .o expr]

group (run_addr = mem:my dram)
You can use the ’|’ to specify an address range of more than one physical memory device:
group (run_addr = mem:A | mem:B)

The load_addr keyword changes the meaning of the section selection in the group: the linker selects the load-time
ROM copy of the named section(s) instead of the regular sections. Just like run_addr you can specify an absolute
address or an address range.

The 1load_addr keyword itself (without an assignment) specifies that the group’s position in the LSL file defines its
load-time address.

group (load_addr)
select "mydata”; // select ROM copy of mydata: ”[mydata]”

The load-time and run-time addresses of a group cannot be set at the same time. If the load-time property is set for a
group, the group (only) restricts the positioning at load-time of the group’s sections. It is not possible to set the address of a
group that has a not-unrestricted parent group.

The properties of the load-time and run-time start address are:

At run-time, before using an element in an overlay group, the application copies the sections from their load location to
their run-time location, but only if these two addresses are different. For non-overlay sections this happens at program
start-up.

The start addresses cannot be set to absolute values for unrestricted groups.

For non-overlay groups that do not have an overlay parent, the load-time start address equals the run-time start
address.

For any group, if the run-time start address is not set, the linker selects an appropriate address.

If an ordered group or sequential group has an absolute address and contains sections that have separate page
restrictions (not defined in LSL), all those sections are located in a single page. In other cases, for example when an
unrestricted group has an address range assigned to it, the paged sections may be located in different pages.

For overlays, the linker reserves memory at the run-time start address as large as the largest element in the overlay group.

The page keyword tells the linker to place the group in one page. Instead of specifying a run-time address, you can
specify a page and optional a page number. Page numbers start from zero. If you omit the page number, the linker
chooses a page.

The page keyword refers to pages in the address space as defined in the architecture definition.

With the page_size keyword you can override the page alignment and size set on the address space. When you set the
page size to zero, the linker removes simple (auto generated) page restrictions from the selected sections. See also the
page_size keyword in section 9.5.3, Defining Address Spaces.
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group (page, ... )
group (page = 3, ...)

* With the priority keyword you can change the order in which sections are located. This is useful when some sections
are considered important for good performance of the application and a small amount of fast memory is available. The
value is a number for which the default is 1, so higher priorities start at 2. Sections with a higher priority are located
before sections with a lower priority, unless their relative locate priority is already determined by other restrictions like
run_addr and page.

group (priority=2)
{

select "importantcodel”;
select ”importantcode2”;

9.9.3 Creating or Modifying Special Sections

Instead of selecting sections, you can also create a reserved section or an output section or modify special sections like a stack
or a heap. Because you cannot define these sections in the input files, you must use the linker to create them.

Stack

The keyword stack tells the linker to reserve memory for the stack. The name for the stack section refers to the stack as
defined in the architecture definition. If no name was specified in the architecture definition, the default name is stack.

With the keyword size you can specify the size for the stack. If the size is not specified, the linker uses the size given by
the min_size argument as defined for the stack in the architecture definition. Normally the linker automatically tries to
maximize the size, unless you specified the keyword fixed.

group ( ... )
{
stack "mystack” ( size = 2k );

}

The linker creates two labels to mark the begin and end of the stack, _1e_ub_stack_name for the begin of the stack and
_lc_ue_stack_name for the end of the stack. The linker allocates space for the stack when there is a reference to either of
the labels.

See also the stack keyword in section 9.5.3, Defining Address Spaces.

Heap

The keyword heap tells the linker to reserve a dynamic memory range for the malloc () function. Optionally you can assign
a name to the heap section. With the keyword size you can change the size for the heap. If the size is not specified, the
linker uses the size given by the min_size argument as defined for the heap in the architecture definition. Normally the
linker automatically tries to maximize the size, unless you specified the keyword fixed.

group ( ... )
{

heap "myheap” ( size = 2k );
}

The linker creates two labels to mark the begin and end of the heap, _lc_ub_heap name for the begin of the heap and
_lc_ue_heap name for the end of the heap. The linker allocates space for the heap when a reference to either of the
section labels exists in one of the input object files.

Reserved section

The keyword reserved tells the linker to create an area or section of a given size. The linker will not locate any other
sections in the memory occupied by a reserved section, with some exceptions. Optionally you can assign a name to a
reserved section. With the keyword size you can specify a size for a given reserved area or section.

group ( ... )
{

reserved "myreserved” ( size = 2k );
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The optional £i11 field contains a bit pattern that the linker writes to all memory addresses that remain unoccupied during
the locate process. The result of the expression, or list of expressions, is used as values to write to memory, each in MAU.
The first MAU of the fill pattern is always the first MAU in the section.

By default, no sections can overlap with a reserved section. With alloc_allowed=absolute sections that are located at
an absolute address due to an absolute group restriction can overlap a reserved section. The same applies for reserved
sections with alloc_allowed=ranged set. Sections restricted to a fixed address range can also overlap a reserved
section.

With the attributes field you can set the access type of the reserved section. The linker locates the reserved section in its
space with the restrictions that follow from the used attributes, r, w or x or a valid combination of them. The allowed
attributes are shown in the following table. A value between < and > in the table means this value is set automatically by the
linker.

Properties set in LSL Resulting section properties

attributes filled access memory content

X yes <rom> executable
r yes r <rom> data

r no r <rom> scratch

rx yes r <rom> executable
rw yes rw <ram> data

rw no rw <ram> scratch
rwx yes rw <ram> executable

group ( ... )
{
reserved "myreserved” ( size = 2k,
attributes = rw, fill = Oxaa );

}

If you do not specify any attributes, the linker will reserve the given number of maus, no matter what type of memory lies
beneath. If you do not specify a fill pattern, no section is generated.

The linker creates two labels to mark the begin and end of the section, _1c_ub_name for the start, and _lc_ue_name for
the end of the reserved section.

Output sections

The keyword section tells the linker to accumulate sections obtained from object files ("input sections”) into an output
section of a fixed size in the locate phase. You can select the input sections with select statements. You can use groups
inside output sections, but you can only set the align, attributes and load_addr attributes.

The £i11 field contains a bit pattern that the linker writes to all unused space in the output section. When all input sections
have an image (code/data) you must specify a fill pattern. If you do not specify a fill pattern, all input sections must be
scratch sections. The fill pattern is aligned at the start of the output section.

As with a reserved section you can use the attributes field to set the access type of the output section.

group ( ... )

{
section "myoutput” ( size = 4k, attributes = rw, fill = Oxaa )
{
select "myinputl”;
select "myinput2”;
}
}
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The available room for input sections is determined by the size, blocksize and overflow fields. With the keyword size
you specify the fixed size of the output section. Input sections are placed from output section start towards higher addresses
(offsets). When the end of the output section is reached and one or more input sections are not yet placed, an error is
emitted. If however, the overflow field is set to another output section, remaining sections are located as if they were
selected for the overflow output section.

group ( ... )
{
section "tskl data” (size=4k, attributes=rw, £fill=0,
overflow = "overflow_data”)
{
select ”.data.tskl.*”
}
section "tsk2 data” (size=4k, attributes=rw, £ill=0,
overflow = "overflow_data”)
{
select ”.data.tsk2.*”
}
section "overflow data” (size=4k, attributes=rx,
£il1=0)
{
}

}
With the keyword blocksize , the size of the output section will adapt to the size of its content. For example:

group flash area (run_addr = 0x10000)

{
section ”"flash code” (blocksize=4k, attributes=rx,
£il11=0)
{
select "*.flash”;
}
}

If the content of the section is 1 mau, the size will be 4k, if the content is 11k, the section will be 12k, etc. If you use size in
combination with blocksize, the size value is used as default (minimal) size for this section. If it is omitted, the default
size will be of blocksize. It is not allowed to omit both size and blocksize from the section definition.

The linker creates two labels to mark the begin and end of the section, _1c_ub_name for the start, and _lc_ue_name for
the end of the output section.

Copy table

The keyword copytable tells the linker to select a section that is used as copy table. The content of the copy table is
created by the linker. It contains the start address and length of all sections that should be initialized by the startup code.

The linker creates two labels to mark the begin and end of the section, _1c_ub_table for the start, and _lc_ue_table
for the end of the copy table. The linker generates a copy table when a reference to either of the section labels exists in one
of the input object files.

9.9.4 Creating Symbols

You can tell the linker to create symbols before locating by putting assignments in the section layout definition. Symbol names
are represented by double-quoted strings. Any string is allowed, but object files may not support all characters for symbol
names. You can use two different assignment operators. With the simple assignment operator ’=’, the symbol is created
unconditionally. With the ’:=" operator, the symbol is only created if it already exists as an undefined reference in an object file.

The expression that represents the value to assign to the symbol may contain references to other symbols. If such a referred
symbol is a special section symbol, creation of the symbol in the left hand side of the assignment will cause creation of the
special section.
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section_layout

{
" lc_bs” := "_lc_ub_ stack”;
// when the symbol _1lc bs occurs as an undefined reference
// in an object file, the linker allocates space for the stack
}

9.9.5 Conditional Group Statements

Within a group, you can conditionally select sections or create special sections.

With the if keyword you can specify a condition. The succeeding section statement is executed if the condition evaluates to
TRUE (1).

The optional else keyword is followed by a section statement which is executed in case the if-condition evaluates to FALSE

0).

group ( ... )
{
if ( exists ( "mysection” ) )
select “"mysection”;
else

reserved "myreserved” ( size=2k );

9-33



ARM Embedded Tools Reference

9-34



10 CERT C Secure Coding Standard

Summ ary This chapter contains an overview of the CERT C Secure Coding Standard
recommendations and rules that are supported by the TASKING VX-toolset.

The CERT C Secure Coding Standard provides rules and recommendations for secure coding in the C programming language.
The goal of these rules and recommendations is to eliminate insecure coding practices and undefined behaviors that can lead to
exploitable vulnerabilities. The application of the secure coding standard will lead to higher-quality systems that are robust and
more resistant to attack.

% For details see the CERT C Secure Coding Standard web site. For general information about CERT secure coding, see
www.cert.org/secure-coding.

Identifiers

Each rule and recommendation is given a unique identifier. These identifiers consist of three parts:

* athree-letter mnemonic representing the section of the standard
* atwo-digit numeric value in the range of 00-99
* the letter "C” indicates that this is a C language guideline

The three-letter mnemonic is used to group similar coding practices and to indicate to which category a coding practice belongs.

The numeric value is used to give each coding practice a unique identifier. Numeric values in the range of 00-29 are reserved
for recommendations, while values in the range of 30-99 are reserved for rules.

C compiler invocation

With the C compiler option —-cert you can enable one or more checks for the CERT C Secure Coding Standard
recommendations/rules. With --diag=cert you can see a list of the available checks, or you can use a three-letter mnemonic to
list only the checks in a particular category. For example, —-diag=pre lists all supported checks in the preprocessor category.

10.1 Preprocessor (PRE)

PREO1-C Use parentheses within macros around parameter names
Parenthesize all parameter names in macro definitions to avoid precedence problems.
PREO02-C Macro replacement lists should be parenthesized

Macro replacement lists should be parenthesized to protect any lower-precedence operators from the
surrounding expression. The example below is syntactically correct, although the != operator was
omitted. Enclosing the constant -1 in parenthesis will prevent the incorrect interpretation and force a
compiler error:

#define EOF -1 // should be (-1)
int getchar(void);
void f(void)

{
if (getchar() EOF) // != operator omitted
{ /* oo %/
}

}
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PRE10-C

PRE11-C

Wrap multi-statement macros in a do-while loop

When multiple statements are used in a macro, enclose them in a do-while statement, so the macro
can appear safely inside if clauses or other places that expect a single statement or a statement block.
Braces alone will not work in all situations, as the macro expansion is typically followed by a semicolon.

Do not conclude a single statement macro definition with a semicolon

Macro definitions consisting of a single statement should not conclude with a semicolon. If required, the
semicolon should be included following the macro expansion. Inadvertently inserting a semicolon can
change the control flow of the program.

10.2 Declarations and Initialization (DCL)

DCL30-C

DCL31-C

DCL32-C

DCL35-C

Declare objects with appropriate storage durations

The lifetime of an automatic object ends when the function returns, which means that a pointer to the
object becomes invalid.

Declare identifiers before using them

The ISO C90 standard allows implicit typing of variables and functions. Because implicit declarations
lead to less stringent type checking, they can often introduce unexpected and erroneous behavior or
even security vulnerabilities. The ISO C99 standard requires type identifiers and forbids implicit function
declarations. For backwards compatibility reasons, the VX-toolset C compiler assumes an implicit
declaration and continues translation after issuing a warning message (W505 or W535).

Guarantee that mutually visible identifiers are unique

The compiler encountered two or more identifiers that are identical in the first 31 characters. The ISO
C99 standard allows a compiler to ignore characters past the first 31 in an identifier. Two distinct
identifiers that are identical in the first 31 characters may lead to problems when the code is ported to a
different compiler.

Do not invoke a function using a type that does not match the function definition

This warning is generated when a function pointer is set to refer to a function of an incompatible type.
Calling this function through the function pointer will result in undefined behavior. Example:

void my function(int a);
int main(void)
{
int (*new_function) (int a) = my_ function;
return (*new_function)(10); /* the behavior is undefined */

}

10.3 Expressions (EXP)

EXP01-C

EXP12-C

EXP30-C

EXP32-C

EXP33-C

10-2

Do not take the size of a pointer to determine the size of the pointed-to type

The size of the object(s) allocated by malloc(), calloc() or realloc() should be a multiple of the size of the
base type of the result pointer. Therefore, the sizeof expression should be applied to this base type, and
not to the pointer type.

Do not ignore values returned by functions

The compiler gives this warning when the result of a function call is ignored at some place, although it is
not ignored for other calls to this function. This warning will not be issued when the function result is
ignored for all calls, or when the result is explicitly ignored with a (void) cast.

Do not depend on order of evaluation between sequence points

Between two sequence points, an object should only be modified once. Otherwise the behavior is
undefined.

Do not access a volatile object through a non-volatile reference

If an attempt is made to refer to an object defined with a volatile-qualified type through use of an Ivalue
with non-volatile-qualified type, the behavior is undefined.

Do not reference uninitialized memory

Uninitialized automatic variables default to whichever value is currently stored on the stack or in the
register allocated for the variable. Consequently, uninitialized memory can cause a program to behave in
an unpredictable or unplanned manner and may provide an avenue for attack.
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EXP34-C

EXP37-C

EXP38-C

Ensure a null pointer is not dereferenced

Attempting to dereference a null pointer results in undefined behavior, typically abnormal program
termination.

Call functions with the arguments intended by the API

When a function is properly declared with function prototype information, an incorrect call will be flagged
by the compiler. When there is no prototype information available at the call, the compiler cannot check
the number of arguments and the types of the arguments. This message is issued to warn about this
situation.

Do not call offsetof() on bit-field members or invalid types

The behavior of the offsetof() macro is undefined when the member designator parameter designates a
bit-field.

10.4 Integers (INT)

INT30-C

INT34-C

INT35-C

Ensure that unsigned integer operations do not wrap
A constant with an unsigned integer type is truncated, resulting in a wrap-around.
Do not shift a negative number of bits or more bits than exist in the operand

The shift count of the shift operation may be negative or greater than or equal to the size of the left
operand. According to the C standard, the behavior of such a shift operation is undefined. Make sure the
shift count is in range by adding appropriate range checks.

Evaluate integer expressions in a larger size before comparing or assigning to that size

If an integer expression is compared to, or assigned to a larger integer size, that integer expression
should be evaluated in that larger size by explicitly casting one of the operands.

10.5 Floating Point (FLP)

FLP30-C

FLP35-C

FLP36-C

Do not use floating point variables as loop counters

To avoid problems with limited precision and rounding, floating point variables should not be used as
loop counters.

Take granularity into account when comparing floating point values

Floating point arithmetic in C is inexact, so floating point values should not be tested for exact equality or
inequality.

Beware of precision loss when converting integral types to floating point

Conversion from integral types to floating point types without sufficient precision can lead to loss of
precision.

10.6 Arrays (ARR)

ARRO01-C

ARR34-C

ARR35-C

Do not apply the sizeof operator to a pointer when taking the size of an array

A function parameter declared as an array, is converted to a pointer by the compiler. Therefore, the
sizeof operator applied to this parameter yields the size of a pointer, and not the size of an array.

Ensure that array types in expressions are compatible
Using two or more incompatible arrays in an expression results in undefined behavior.
Do not allow loops to iterate beyond the end of an array

Reading or writing of data outside the bounds of an array may lead to incorrect program behavior or
execution of arbitrary code.
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10.7 Characters and Strings (STR)

STR30-C

STR33-C

STR34-C

STR36-C

Do not attempt to modify string literals

Writing to a string literal has undefined behavior, as identical strings may be shared and/or allocated in
read-only memory.

Size wide character strings correctly

Wide character strings may be improperly sized when they are mistaken for narrow strings or for
multi-byte character strings.

Cast characters to unsigned types before converting to larger integer sizes

A signed character is sign-extended to a larger signed integer value. Use an explicit cast, or cast the
value to an unsigned type first, to avoid unexpected sign-extension.

Do not specify the bound of a character array initialized with a string literal

The compiler issues this warning when the character buffer initialized by a string literal does not provide
enough room for the terminating null character.

10.8 Memory Management (MEM)

MEMO00-C

MEMO08-C

MEM30-C

MEM31-C

MEM32-C

MEMS33-C

MEM34-C

MEM35-C

Allocate and free memory in the same module, at the same level of abstraction

The compiler issues this warning when the result of the call to malloc(), calloc() or realloc() is discarded,
and therefore not free()d, resulting in a memory leak.

Use realloc() only to resize dynamically allocated arrays
Only use realloc() to resize an array. Do not use it to transform an object to an object of a different type.
Do not access freed memory

When memory is freed, its contents may remain intact and accessible because it is at the memory
manager’s discretion when to reallocate or recycle the freed chunk. The data at the freed location may
appear valid. However, this can change unexpectedly, leading to unintended program behavior. As a
result, it is necessary to guarantee that memory is not written to or read from once it is freed.

Free dynamically allocated memory exactly once

Freeing memory multiple times has similar consequences to accessing memory after it is freed. The
underlying data structures that manage the heap can become corrupted. To eliminate double-free
vulnerabilities, it is necessary to guarantee that dynamic memory is freed exactly once.

Detect and handle memory allocation errors

The result of realloc() is assigned to the original pointer, without checking for failure. As a result, the
original block of memory is lost when realloc() fails.

Use the correct syntax for flexible array members

Use the ISO C99 syntax for flexible array members instead of an array member of size 1.

Only free memory allocated dynamically

Freeing memory that is not allocated dynamically can lead to corruption of the heap data structures.
Allocate sufficient memory for an object

The compiler issues this warning when the size of the object(s) allocated by malloc(), calloc() or realloc()
is smaller than the size of an object pointed to by the result pointer. This may be caused by a sizeof
expression with the wrong type or with a pointer type instead of the object type.

10.9 Environment (ENV)

ENV32-C

10-4

All atexit handlers must return normally

The compiler issues this warning when an atexit() handler is calling a function that does not return. No
atexit() registered handler should terminate in any way other than by returning.
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10.10 Signals (SIG)

SIG30-C Call only asynchronous-safe functions within signal handlers
SIG32-C Do not call longjmp() from inside a signal handler

Invoking the longjmp() function from within a signal handler can lead to undefined behavior if it results in
the invocation of any non-asynchronous-safe functions, likely compromising the integrity of the
program.

10.11 Miscellaneous (MSC)

MSC32-C Ensure your random number generator is properly seeded
Ensure that the random number generator is properly seeded by calling srand().

10-5


http://doc.tasking.com/cert/sig30.html
http://doc.tasking.com/cert/sig32.html
http://doc.tasking.com/cert/msc32.html

ARM Embedded Tools Reference

10-6



Alllum 11 MISRA-C Rules

Summary

This chapter contains an overview of the supported and unsupported MISRA-C
rules.

11.1

MISRA-C:1998

This section lists all supported and unsupported MISRA-C:1998 rules.

% See also section 2.7.2, C Code Checking: MISRA-C, in Chapter Using the Compiler of the User’s Manual.

@ A number of MISRA-C rules leave room for interpretation. Other rules can only be checked in a limited way. In such
cases the implementation decisions and possible restrictions for these rules are listed.

x means that the rule is not supported by the TASKING C compiler.
(R) is a required rule, (A) is an advisory rule.

P
—
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The code shall conform to standard C, without language extensions
Other languages should only be used with an interface standard
Inline assembly is only allowed in dedicated C functions

Provision should be made for appropriate run-time checking

Only use characters and escape sequences defined by ISO C
Character values shall be restricted to a subset of ISO 106460-1
Trigraphs shall not be used

Multibyte characters and wide string literals shall not be used
Comments shall not be nested

Sections of code should not be "commented out”

In general, it is not possible to decide whether a piece of comment is C code that is commented out, or just
some pseudo code. Instead, the following heuristics are used to detect possible C code inside a comment:

- aline ends with ’;’, or

- a line starts with ’}, possibly preceded by white space

Identifiers shall not rely on significance of more than 31 characters

The same identifier shall not be used in multiple name spaces

Specific-length typedefs should be used instead of the basic types

Use ’'unsigned char’ or 'signed char’ instead of plain ‘char’

Floating-point implementations should comply with a standard

The bit representation of floating-point numbers shall not be used

A violation is reported when a pointer to a floating-point type is converted to a pointer to an integer type.
"typedef’ names shall not be reused

Numeric constants should be suffixed to indicate type

A violation is reported when the value of the constant is outside the range indicated by the suffixes, if any.
Octal constants (other than zero) shall not be used

All object and function identifiers shall be declared before use

Identifiers shall not hide identifiers in an outer scope

Declarations should be at function scope where possible
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x 23. (A) Alldeclarations at file scope should be static where possible
24. (R) Identifiers shall not have both internal and external linkage
x 25. (R) Identifiers with external linkage shall have exactly one definition
26. (R) Multiple declarations for objects or functions shall be compatible
x 27. (A External objects should not be declared in more than one file
28. (A)  The "register” storage class specifier should not be used
29. (R) The use of a tag shall agree with its declaration
30. (R) All automatics shall be initialized before being used
This rule is checked using worst-case assumptions. This means that violations are reported not only for
variables that are guaranteed to be uninitialized, but also for variables that are uninitialized on some
execution paths.
31. (R) Braces shall be used in the initialization of arrays and structures
32. (R) Only the first, or all enumeration constants may be initialized
33. (R)  Theright hand operand of && or || shall not contain side effects
34. (R) The operands of a logical && or || shall be primary expressions
35. (R) Assignment operators shall not be used in Boolean expressions
36. (A) Logical operators should not be confused with bitwise operators
37. (R) Bitwise operations shall not be performed on signed integers
38. (R) A shift count shall be between 0 and the operand width minus 1
This violation will only be checked when the shift count evaluates to a constant value at compile time.
39. (R) The unary minus shall not be applied to an unsigned expression
40. (A) ”sizeof” should not be used on expressions with side effects
x  41. (A The implementation of integer division should be documented
42. (R) The comma operator shall only be used in a "for” condition
43. (R) Don’t use implicit conversions which may result in information loss
44. (A) Redundant explicit casts should not be used
45. (R)  Type casting from any type to or from pointers shall not be used
46. (R) The value of an expression shall be evaluation order independent
This rule is checked using worst-case assumptions. This means that a violation will be reported when a
possible alias may cause the result of an expression to be evaluation order dependent.
47. (A) No dependence should be placed on operator precedence rules
48. (A) Mixed arithmetic should use explicit casting
49. (A)  Tests of a (non-Boolean) value against 0 should be made explicit
50. (R) F.P. variables shall not be tested for exact equality or inequality
51. (A) Constant unsigned integer expressions should not wrap-around
52. (R)  There shall be no unreachable code
53. (R)  All non-null statements shall have a side-effect
54. (R) A null statement shall only occur on a line by itself
55. (A) Labels should not be used
56. (R) The "goto” statement shall not be used
57. (R)  The "continue” statement shall not be used
58. (R) The "break” statement shall not be used (except in a "switch”)
59. (R) An’if’ or loop body shall always be enclosed in braces
60. (A) All ”if”, "else if” constructs should contain a final "else”
61. (R) Every non-empty "case” clause shall be terminated with a "break”
62. (R)  All"switch” statements should contain a final "default” case
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63. (A)  A’switch” expression should not represent a Boolean case
64. (R) Every "switch” shall have at least one "case”
65. (R) Floating-point variables shall not be used as loop counters
66. (A)  A’for” should only contain expressions concerning loop control
A violation is reported when the loop initialization or loop update expression modifies an object that is not
referenced in the loop test.
67. (A) Iterator variables should not be modified in a "for” loop
68. (R) Functions shall always be declared at file scope
69. (R) Functions with variable number of arguments shall not be used
70. (R) Functions shall not call themselves, either directly or indirectly
A violation will be reported for direct or indirect recursive function calls in the source file being checked.
Recursion via functions in other source files, or recursion via function pointers is not detected.
71. (R) Function prototypes shall be visible at the definition and call
72. (R)  The function prototype of the declaration shall match the definition
73. (R) Identifiers shall be given for all prototype parameters or for none
74. (R) Parameter identifiers shall be identical for declaration/definition
75. (R) Every function shall have an explicit return type
76. (R) Functions with no parameters shall have a "void” parameter list
77. (R)  Anactual parameter type shall be compatible with the prototype
78. (R)  The number of actual parameters shall match the prototype
79. (R)  The values returned by "void” functions shall not be used
80. (R) Void expressions shall not be passed as function parameters
81. (A) ”const” should be used for reference parameters not modified
82. (A)  Afunction should have a single point of exit
83. (R) Every exit point shall have a "return” of the declared return type
84. (R) For "void” functions, "return” shall not have an expression
85. (A) Function calls with no parameters should have empty parentheses
86. (A) If a function returns error information, it should be tested
A violation is reported when the return value of a function is ignored.
87. (R) #include shall only be preceded by other directives or comments
88. (R) Non-standard characters shall not occur in #include directives
89. (R) #include shall be followed by either <filename> or *filename”
90. (R) Plain macros shall only be used for constants/qualifiers/specifiers
91. (R) Macros shall not be #define’d and #undef’d within a block
92. (A) #undef should not be used
93. (A)  Afunction should be used in preference to a function-like macro
94. (R) A function-like macro shall not be used without all arguments
95. (R) Macro arguments shall not contain pre-preprocessing directives
A violation is reported when the first token of an actual macro argument is '#'.
96. (R) Macro definitions/parameters should be enclosed in parentheses
97. (A) Don’t use undefined identifiers in pre-processing directives
98. (R) A macro definition shall contain at most one # or ## operator
99. (R)  Alluses of the #pragma directive shall be documented
This rule is really a documentation issue. The compiler will flag all #pragma directives as violations.
100. (R) “defined” shall only be used in one of the two standard forms
101. (A) Pointer arithmetic should not be used
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102. (A) No more than 2 levels of pointer indirection should be used
A violation is reported when a pointer with three or more levels of indirection is declared.
103. (R) No relational operators between pointers to different objects

In general, checking whether two pointers point to the same object is impossible. The compiler will only
report a violation for a relational operation with incompatible pointer types.

104. (R) Non-constant pointers to functions shall not be used
105. (R) Functions assigned to the same pointer shall be of identical type
106. (R) Automatic address may not be assigned to a longer lived object
107. (R)  The null pointer shall not be de-referenced
A violation is reported for every pointer dereference that is not guarded by a NULL pointer test.
108. (R)  All struct/union members shall be fully specified
109. (R) Overlapping variable storage shall not be used
A violation is reported for every 'union’ declaration.
110. (R) Unions shall not be used to access the sub-parts of larger types
A violation is reported for a 'union’ containing a ’struct’ member.
111. (R)  bit-fields shall have type "unsigned int” or "signed int”
112. (R)  bit-fields of type "signed int” shall be at least 2 bits long
113. (R)  All struct/union members shall be named
114. (R) Reserved and standard library names shall not be redefined
115. (R)  Standard library function names shall not be reused
x 116. (R) Production libraries shall comply with the MISRA-C restrictions
x 117. (R)  The validity of library function parameters shall be checked
118. (R) Dynamic heap memory allocation shall not be used
119. (R)  The error indicator “errno” shall not be used
120. (R)  The macro "offsetof” shall not be used
121. (R) <locale.h> and the "setlocale” function shall not be used
122. (R) The "setjmp” and "longjmp” functions shall not be used
123. (R)  The signal handling facilities of <signal.h> shall not be used
124. (R) The <stdio.h> library shall not be used in production code
125. (R)  The functions atof/atoi/atol shall not be used
126. (R)  The functions abort/exit/getenv/system shall not be used
127. (R)  The time handling functions of library <time.h> shall not be used

% See also section 2.7.2, C Code Checking: MISRA-C, in Chapter Using the Compiler of the User’s manual.
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11.2 MISRA-C:2004

This section lists all supported and unsupported MISRA-C:2004 rules.

% See also section 2.7.2, C Code Checking: MISRA-C, in Chapter Using the Compiler of the User’s Manual.

@ A number of MISRA-C rules leave room for interpretation. Other rules can only be checked in a limited way. In such
cases the implementation decisions and possible restrictions for these rules are listed.

x means that the rule is not supported by the TASKING C compiler.
(R) is a required rule, (A) is an advisory rule.

Environment
1.1 (R)
12 (R
x 13 (R)
x 1.4 (R
x 15 (A

All code shall conform to ISO 9899:1990 "Programming languages - C”, amended and corrected by
ISO/IEC 9899/COR1:1995, ISO/IEC 9899/AMD1:1995, and ISO/IEC 9899/COR2:1996.

No reliance shall be placed on undefined or unspecified behavior.

Multiple compilers and/or languages shall only be used if there is a common defined interface standard
for object code to which the languages/compilers/assemblers conform.

The compiler/linker shall be checked to ensure that 31 character significance and case sensitivity are
supported for external identifiers.

Floating-point implementations should comply with a defined floating-point standard.

Language extensions

2.1 (R)
2.2 (R)

2.3 (R)

2.4 (A)
Documentation
x 3.1 (R)

x 3.2 (R)

x 3.3 (A)

3.4 (R)

3.5 (R)

x 3.6 (R)
Character sets
4.1 (R)

4.2 (R)

Assembly language shall be encapsulated and isolated.
Source code shall only use /* ... */ style comments.
The character sequence /* shall not be used within a comment.

Sections of code should not be "commented out”.

In general, it is not possible to decide whether a piece of comment is C code that is commented out, or
just some pseudo code. Instead, the following heuristics are used to detect possible C code inside a
comment:

- aline ends with ’;’, or
- a line starts with '}, possibly preceded by white space

All usage of implementation-defined behavior shall be documented.
The character set and the corresponding encoding shall be documented.

The implementation of integer division in the chosen compiler should be determined, documented and
taken into account.

All uses of the #pragma directive shall be documented and explained.

This rule is really a documentation issue. The compiler will flag all #pragma
directives as violations.

The implementation-defined behavior and packing of bit-fields shall be documented if being relied upon.

All libraries used in production code shall be written to comply with the provisions of this document, and
shall have been subject to appropriate validation.

Only those escape sequences that are defined in the ISO C standard shall be used.
Trigraphs shall not be used.
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Identifiers

5.1
5.2

5.3
5.4
x 5.5
5.6

x 5.7
Types

6.1
X 6.2
6.3
6.4
6.5

Constants

71

®)
®)

0 X

,\,\,\,\

®)
®)
GV
(R)
(R)

(R)

Identifiers (internal and external) shall not rely on the significance of more than 31 characters.

Identifiers in an inner scope shall not use the same name as an identifier in an outer scope, and therefore
hide that identifier.

A typedef name shall be a unique identifier.
A tag name shall be a unique identifier.
No object or function identifier with static storage duration should be reused.

No identifier in one name space should have the same spelling as an identifier in another name space,
with the exception of structure and union member names.

No identifier name should be reused.

The plain char type shall be used only for storage and use of character values.

signed and unsigned char type shall be used only for the storage and use of numeric values.
typedefs that indicate size and signedness should be used in place of the basic types.
bit-fields shall only be defined to be of type unsigned int or signed int.

bit-fields of type signed int shall be at least 2 bits long.

Octal constants (other than zero) and octal escape sequences shall not be used.

Declarations and definitions

8.1

8.2
8.3

8.4
8.5
8.6
8.7
x 8.8
x 8.9
x 8.10

8.11

8.12

Functions shall have prototype declarations and the prototype shall be visible at both the function
definition and call.

Whenever an object or function is declared or defined, its type shall be explicitly stated.

For each function parameter the type given in the declaration and definition shall be identical, and the
return types shall also be identical.

If objects or functions are declared more than once their types shall be compatible.

There shall be no definitions of objects or functions in a header file.

Functions shall be declared at file scope.

Objects shall be defined at block scope if they are only accessed from within a single function.
An external object or function shall be declared in one and only one file.

An identifier with external linkage shall have exactly one external definition.

All declarations and definitions of objects or functions at file scope shall have internal linkage unless
external linkage is required.

The static storage class specifier shall be used in definitions and declarations of objects and functions
that have internal linkage.

When an array is declared with external linkage, its size shall be stated explicitly or defined implicitly by
initialization.
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Initialization

9.1

(R)

All automatic variables shall have been assigned a value before being used.

This rule is checked using worst-case assumptions. This means that violations are reported not only for
variables that are guaranteed to be uninitialized, but also for variables that are uninitialized on some
execution paths.

Braces shall be used to indicate and match the structure in the non-zero initialization of arrays and
structures.

»_»

In an enumerator list, the "=" construct shall not be used to explicitly initialize members other than the
first, unless all items are explicitly initialized.

Arithmetic type conversions

10.1

10.2

10.3

10.4
10.5

10.6

(R)

(R)

The value of an expression of integer type shall not be implicitly converted to a different underlying type if:
a) it is not a conversion to a wider integer type of the same signedness, or

b) the expression is complex, or

c) the expression is not constant and is a function argument, or

d) the expression is not constant and is a return expression.

The value of an expression of floating type shall not be implicitly converted to a different type if:
a) it is not a conversion to a wider floating type, or

b) the expression is complex, or

c) the expression is a function argument, or

d) the expression is a return expression.

The value of a complex expression of integer type may only be cast to a type that is narrower and of the
same signedness as the underlying type of the expression.

The value of a complex expression of floating type may only be cast to a narrower floating type.

If the bitwise operators ~ and << are applied to an operand of underlying type unsigned char or
unsigned short, the result shall be immediately cast to the underlying type of the operand.

A ”U” suffix shall be applied to all constants of unsigned type.

Pointer type conversions

111

11.2

11.3
11.4
11.5

Expressions

121
12.2

12.3
12.4
12.5
12.6

12.7

(R)
(R)

(A)
(A)
(R)

33
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Conversions shall not be performed between a pointer to a function and any type other than an integral
type.

Conversions shall not be performed between a pointer to object and any type other than an integral type,
another pointer to object type or a pointer to void.

A cast should not be performed between a pointer type and an integral type.
A cast should not be performed between a pointer to object type and a different pointer to object type.

A cast shall not be performed that removes any const or volatile qualification from the type
addressed by a pointer.

Limited dependence should be placed on C’s operator precedence rules in expressions.

The value of an expression shall be the same under any order of evaluation that the standard permits.

This rule is checked using worst-case assumptions. This means that a violation will be reported when a
possible alias may cause the result of an expression to be evaluation order dependent.

The sizeof operator shall not be used on expressions that contain side effects.
The right-hand operand of a logical && or | | operator shall not contain side effects.
The operands of a logical && or | | shall be primary-expressions.

The operands of logical operators (&&, | | and !) should be effectively Boolean. Expressions that are
effectively Boolean should not be used as operands to operators other than (&, | | and !).

Bitwise operators shall not be applied to operands whose underlying type is signed.
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12.8

12.9
12.10
12.11
1212

12.13

(R)
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=Y

(A)

The right-hand operand of a shift operator shall lie between zero and one less than the width in bits of
the underlying type of the left-hand operand.

This violation will only be checked when the shift count evaluates to a constant value at compile
time.

The unary minus operator shall not be applied to an expression whose underlying type is unsigned.

The comma operator shall not be used.

Evaluation of constant unsigned integer expressions should not lead to wrap-around.

The underlying bit representations of floating-point values shall not be used.

A violation is reported when a pointer to a floating-point type is converted to a pointer to an integer type.

The increment (++) and decrement (--) operators should not be mixed with other operators in an
expression.

Control statement expressions

Control flow

13.1
13.2
13.3
13.4
13.5

13.6

13.7

14.1
14.2

14.3

14.4
14.5
14.6
14.7
14.8

14.9

14.10

Y

III=3

=z

0 X

)

—_ e~~~ =
.y .y
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(R)
(R)

Assignment operators shall not be used in expressions that yield a Boolean value.

Tests of a value against zero should be made explicit, unless the operand is effectively Boolean.
Floating-point expressions shall not be tested for equality or inequality.

The controlling expression of a for statement shall not contain any objects of floating type.

The three expressions of a for statement shall be concerned only with loop control.

A violation is reported when the loop initialization or loop update expression modifies an object that is not
referenced in the loop test.

Numeric variables being used within a for loop for iteration counting shall not be modified in the body of
the loop.

Boolean operations whose results are invariant shall not be permitted.

There shall be no unreachable code.

All non-null statements shall either:
a) have at least one side effect however executed, or
b) cause control flow to change.

Before preprocessing, a null statement shall only occur on a line by itself; it may be followed by a
comment provided that the first character following the null statement is a white-space character.

The goto statement shall not be used.

The continue statement shall not be used.

For any iteration statement there shall be at most one break statement used for loop termination.
A function shall have a single point of exit at the end of the function.

The statement forming the body of a switch, while, do ... while or for statement be a compound
statement.

An if (expression) construct shall be followed by a compound statement. The else keyword shall
be followed by either a compound statement, or another i f statement.

Allif ... else if constructs shall be terminated with an else clause.

Switch statements

15.1

15.2
15.3
15.4
15.5

I3I3I3

A switch label shall only be used when the most closely-enclosing compound statement is the body of a
switch statement.

An unconditional break statement shall terminate every non-empty switch clause.
The final clause of a switch statement shall be the default clause.
A switch expression shall not represent a value that is effectively Boolean.

Every switch statement shall have at least one case clause.
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Functions

16.1 (R)  Functions shall not be defined with variable numbers of arguments.

16.2 (R) Functions shall not call themselves, either directly or indirectly.
A violation will be reported for direct or indirect recursive function calls in the source file being checked.
Recursion via functions in other source files, or recursion via function pointers is not detected.

16.3 (R) Identifiers shall be given for all of the parameters in a function prototype declaration.

16.4 (R) The identifiers used in the declaration and definition of a function shall be identical.

16.5 (R) Functions with no parameters shall be declared with parameter type void.

16.6 (R) The number of arguments passed to a function shall match the number of parameters.

16.7 (A) A pointer parameter in a function prototype should be declared as pointer to const if the pointer is not
used to modify the addressed object.

16.8 (R) Allexit paths from a function with non-void return type shall have an explicit return statement with an
expression.

16.9 (R) A function identifier shall only be used with either a preceding &, or with a parenthesized parameter list,
which may be empty.

16.10 (R) If a function returns error information, then that error information shall be tested.
A violation is reported when the return value of a function is ignored.

Pointers and arrays
x 171 (R) Pointer arithmetic shall only be applied to pointers that address an array or array element.
x 17.2 (R) Pointer subtraction shall only be applied to pointers that address elements of the same array.

17.3 (R) >, >=, <, <=shall not be applied to pointer types except where they point to the same array.
In general, checking whether two pointers point to the same object is impossible. The compiler will only
report a violation for a relational operation with incompatible pointer types.

17.4 (R) Array indexing shall be the only allowed form of pointer arithmetic.

17.5 (A) The declaration of objects should contain no more than 2 levels of pointer indirection.
A violation is reported when a pointer with three or more levels of indirection is declared.

17.6 (R) The address of an object with automatic storage shall not be assigned to another object that may persist

after the first object has ceased to exist.

Structures and unions

18.1
18.2
x 18.3
18.4

23D

(
(
(
(

X

)

All structure or union types shall be complete at the end of a translation unit.
An object shall not be assigned to an overlapping object.

An area of memory shall not be reused for unrelated purposes.

Unions shall not be used.

Preprocessing directives

19.1
19.2
x 19.3
19.4

19.5
19.6
19.7
19.8

Z 2

(
(
R
(

)
)

)
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#include statements in a file should only be preceded by other preprocessor directives or comments.
Non-standard characters should not occur in header file names in #include directives.
The #include directive shall be followed by either a <filename> or "filename” sequence.

C macros shall only expand to a braced initializer, a constant, a parenthesized expression, a type
qualifier, a storage class specifier, or a do-while-zero construct.

Macros shall not be #define’d or #undef’d within a block.

#undef shall not be used.

A function should be used in preference to a function-like macro.

A function-like macro shall not be invoked without all of its arguments.
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19.9 (R)
19.10 (R)
19.11  (R)
19.12 (R)
19.13 (A)
19.14 (R)
19.15 (R)
19.16 (R)
19.17 (R)
Standard libraries
201 (R)
202 (R)
x 203 (R)
204 (R)
205 (R)
206 (R)
207 (R)
208 (R)
209 (R)
20.10 (R)
20.11 (R)
20.12 (R)

Run-time failures

X

11-10

211

(R)

Arguments to a function-like macro shall not contain tokens that look like preprocessing directives.
A violation is reported when the first token of an actual macro argument is '#'.

In the definition of a function-like macro each instance of a parameter shall be enclosed in parentheses
unless it is used as the operand of # or ##.

All macro identifiers in preprocessor directives shall be defined before use, except in #ifdef and
#ifndef preprocessor directives and the defined () operator.

There shall be at most one occurrence of the # or ## preprocessor operators in a single macro definition.
The # and ## preprocessor operators should not be used.

The defined preprocessor operator shall only be used in one of the two standard forms.

Precautions shall be taken in order to prevent the contents of a header file being included twice.
Preprocessing directives shall be syntactically meaningful even when excluded by the preprocessor.

All #else, #elif and #endif preprocessor directives shall reside in the same file as the #if or
#1ifdef directive to which they are related.

Reserved identifiers, macros and functions in the standard library, shall not be defined, redefined or
undefined.

The names of standard library macros, objects and functions shall not be reused.

The validity of values passed to library functions shall be checked.

Dynamic heap memory allocation shall not be used.

The error indicator errno shall not be used.

The macro offsetof, in library <stddef . h>, shall not be used.

The setjmp macro and the longjmp function shall not be used.

The signal handling facilities of <signal.h> shall not be used.

The input/output library <stdio.h> shall not be used in production code.

The library functions atof, atoi and atol from library <stdlib.h> shall not be used.
The library functions abort, exit, getenv and system from library <stdlib.h> shall not be used.
The time handling functions of library <time.h> shall not be used.

Minimization of run-time failures shall be ensured by the use of at least one of:
a) static analysis tools/techniques;

b) dynamic analysis tools/techniques;

¢) explicit coding of checks to handle run-time faults.
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_ CHAR_MAX, 2-22

_ CHAR_MIN, 2-22
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_ DOUBLE_FP__, 1-12,2-22
__embedded_cplusplus, 2-22
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__FILE__,2-22

_ func__, 2-22
__IMPLICIT_USING_STD, 2-22
__interrupt(), 1-18
__interrupt_dabt, 1-18
__interrupt_fig, 1-18
__interrupt_iabt, 1-18
__interrupt_irq, 1-18
__interrupt_svc, 1-18
__interrupt_und, 1-18

_ JMP_BUF_ELEMENT_TYPE, 2-22
__JMP_BUF_NUM_ELEMENTS, 2-22
__LINE__, 2-22
__LITTLE_ENDIAN__, 1-12,2-23
_ NAMESPACES, 2-23
__nesting_enabled, 1-19

_ NO_LONG_LONG, 2-23
__noinline, 1-15

__novector, 1-19

_ NULL_EH_REGION_NUMBER, 2-23
__packed__, 1-2

_ PLACEMENT_DELETE, 2-23
_ PRETTY_FUNCTION__, 2-23
_ PTRDIFF_MAX, 2-23
__PTRDIFF_MIN, 2-23
__REGION_NUMBER_TYPE, 2-23

__ RUNTIME_USES_NAMESPACES, 2-23

__SIGNED_CHARS__, 2-23

__SINGLE_FP__, 1-12, 2-23

__SIZE_MAX, 2-23
__SIZE_MIN, 2-23
__STDC__, 2-23
__STDC_VERSION__, 2-23

__TASKING__, 1-12, 2-23,4-3

__THUMB__, 1-12,2-23
__TIME__, 2-23

__TYPE_TRAITS_ENABLED, 2-23

__unaligned, 1-2

__VAR_HANDLE_TYPE, 2-23
__VERSION__, 1-12, 2-23, 4-3
__VIRTUAL_FUNCTION_INDEX_TYPE, 2-23
__VIRTUAL_FUNCTION_TYPE, 2-23

__WCHAR_MAX, 2-23
__WCHAR_MIN, 2-23
_BOOL, 2-22

_close, 3-7
_Complex, 3-3

_Exit, 3-19
_Imaginary, 3-3
_IOFBF, 3-14

_IOLBF, 3-14
_IONBF, 3-14

_Iseek, 3-7

_open, 3-7

_read, 3-7

_START, 5-1, 5-2

_STLP_NO_IOSTREAMS, 2-23

_tolower, 3-4
_unlink, 3-7
_WCHAR_T, 2-23
_write, 3-7

A

abort, 3-19
abs, 3-20
Absolute Address, 1-3
access, 3-23
acos functions, 3-8
acosh functions, 3-8
Address spaces, 9-15
alias, 1-8
align, 4-11
Alignment, 1-2

composite types, 6-3
Alignment gaps, 9-28
Alternative C++ tokens, 6-59
alupcrel, 4-6
Anachronism, 2-4
Anachronisms, 6-60, 6-117

Architecture definition, 9-1, 9-14
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arg, 4-6
Argument, 3-4
arm, 4-15
array new and delete, 6-102
asctime, 3-22
asin functions, 3-8
asinh functions, 3-8
Assembler directives
.align, 4-11
.arm, 4-15
.break, 4-12
.bs, 4-13
.bsb, 4-13
.bsd, 4-13
.bsh, 4-13
.bsw, 4-13
.calls, 4-14
.code16, 4-15
.code32, 4-15
.db, 4-16
.ad, 4-17
.define, 4-18
.dh, 4-19
.double, 4-25
.ds, 4-20
.dsb, 4-20
.dsd, 4-20
.dsh, 4-20
.dsw, 4-20
.aw, 4-21
.end, 4-22
.equ, 4-23
.extern, 4-24
.float, 4-25
.for/.endfor, 4-26
.global, 4-27
.if/.elif/.else/.endif, 4-28
.include, 4-29
list/.nolist, 4-30
torg, 4-31
.macro/.endm, 4-32
.message, 4-34
.offset, 4-35
.page, 4-36
.repeat/.endrep, 4-37
.section, 4-38
.set, 4-39
.size, 4-40
.source, 4-41
.thumb, 4-15
title, 4-42
.type, 4-43
.undef, 4-44
ARM specific (overview), 4-10
assembly control (overview), 4-9
conditional assembly (overview), 4-10
data definition (overview), 4-10
detailed description, 4-11
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HLL (overview), 4-10

listing control (overview), 4-10
macros (overview), 4-10
overview, 4-9

storage allocation (overview), 4-10
symbol definitions (overview), 4-9

weak, 4-45

Assembler options, 6-162

-?,6-173
--case-insensitive, 6-163
--check, 6-164

--cpu, 6-165

--debug-info, 6-166
--define, 6-167

--diag, 6-168
--emit-locals, 6-169
--endianness, 6-170
--error-file, 6-171
--error-limit, 6-172

--help, 6-173
--include-directory, 6-174
--include-file, 6-175
--inversions, 6-176
--list-file, 6-178
--list-format, 6-179
--no-warnings, 6-180
--old-syntax, 6-181
--optimize, 6-182
--option-file, 6-183
—--output, 6-184
--page-length, 6-185
--page-width, 6-186
--preprocess, 6-187
--preprocessor-type, 6-188
--relaxed, 6-189
--section-info, 6-190
--symbol-scope, 6-191
--thumb, 6-192

—--verbose, 6-194

--version, 6-193
--warnings-as-errors, 6-195
-B (--big-endian), 6-170
-C, 6-165

-c, 6-163

-D, 6-167

-E, 6-187

-f, 6-183

-g, 6-166

-H, 6-175

-1, 6-174

-i, 6-191

-k, 6-177

-k (--keep-output-files), 6-177
-L, 6-179
-1, 6-178
-m, 6-188
-0, 6-182
-0, 6-184
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-T, 6-192

-t, 6-190

-V, 6-193

-v, 6-194

-w, 6-180

debug information, 6-166, 6-169
diagnostics, 6-172, 6-180, 6-195
inverse instructions, 6-176

list file, 6-178, 6-179, 6-190
optimization, 6-182
preprocessing, 6-167, 6-175, 6-187, 6-188
relaxed 2-operand syntax, 6-189
Thumb instructions, 6-192

Assembler significant characters, 4-2
Assembly, Programming in C, 1-4
Assembly expressions, 4-3

Assembly functions, 4-5
@alupcrel, 4-6
@arg, 4-6
@bigendian, 4-6
@cnt, 4-7
@cpu, 4-7
@defined, 4-7
@lsb, 4-7
@Ish, 4-7
@lsw, 4-7
@msb, 4-7
@msh, 4-7
@msw, 4-8
@pre_ual, 4-8
@streat, 4-8
@stremp, 4-8
@strlen, 4-8
@strpos, 4-8
@thumb, 4-8
detailed description, 4-6
overview, 4-5

Assembly syntax, 4-1

atan functions, 3-8

atan2 functions, 3-8

atanh functions, 3-8

atexit, 3-19

atof, 3-19

atoi, 3-19

atol, 3-19

atoll, 3-19

B
bigendian, 4-6
Binary search table, 1-13
binary_switch, 1-10

Board specification, 9-2, 9-22

bool keyword, 6-104
break, 4-12

bs, 4-13

bsb, 4-13

bsd, 4-13

bsearch, 3-20

bsh, 4-13
bsw, 4-13
btowc, 3-24
BUFSIZ, 3-13
Build options, 6-216
include files path, 6-18, 6-34, 6-87, 6-174, 6-212
Bus definition, 9-2
Buses, 9-15

C

C compiler options, 6-1
-?,6-17
--align-composites, 6-3
--big-endian, 6-13
--call, 6-4
--cert, 6-5
--check, 6-6
--cpu, 6-7
--debug-info, 6-8
--define, 6-9
--dep-file, 6-11
--diag, 6-12
--endianness, 6-13
--error file, 6-14
--global-type-checking, 6-16
--help, 6-17
--include-directory, 6-18
--include-file, 6-19
--inline, 6-20
--inline-max-incr, 6-21
--inline-max-size, 6-21
--interwork, 6-22
--iso, 6-23
--keep-output-files, 6-24
--language, 6-25
--make-target, 6-28
--mil, 6-29
—--mil-split, 6-29
--misrac, 6-30
—--misrac-aavisory-warnings, 6-31
—--misrac-required-warnings, 6-31
--no-double, 6-33
--no-stdinc, 6-34
--no-warnings, 6-35
--optimize, 6-36
--option-file, 6-38
--output, 6-39
--preprocess, 6-40
--profile, 6-41
--rename-sections, 6-43
—--runtime, 6-44
--signed-bitfields, 6-46
--silicon-bug, 6-47
--source, 6-48
--static, 6-49
--stdout, 6-50
--thumb, 6-51
--tradeoff, 6-52
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--uchar, 6-53

--unaligned-access, 6-54

--undefine, 6-55

--version, 6-56

—--warnings-as-errors, 6-57

-A, 6-25

-B, 6-13

-C, 6-7

-c, 6-23

-D, 6-9

-E, 6-40

-F, 6-33

-f, 6-38

-f (--option-file), 6-15

-g, 6-8

-H, 6-19

-1, 6-18

-k, 6-24

-m, 6-4

-n, 6-50

-0, 6-36

-0, 6-39

-p, 6-41

-R, 6-43

-r, 6-44

-s, 6-48

-t, 6-52

-U, 6-55

-u, 6-53

-V, 6-56

-w, 6-35

debug information, 6-8

diagnostics, 6-35, 6-57

language, 6-23, 6-25, 6-46, 6-53

MISRA-C, 6-30

optimization, 6-36, 6-52

preprocessing, 6-9, 6-19, 6-40, 6-55
C++, language extensions, 2-1
C++ compiler options, 6-58

-?,6-83

--alternative-tokens, 6-59

--anachronisms, 6-60

--base-assign-op-is-default, 6-61

--big-endian, 6-72

--building-runtime, 6-62

--c++0x, 6-63

--check, 6-64

--context-limit, 6-65

--cpu, 6-66

--create-pch, 6-67

--define, 6-68

--dep-file, 6-69

—-—dollar, 6-70

--embedded-c++, 6-71

--endianness, 6-72

--error-file, 6-73

--error-limit, 6-74

--exceptions, 6-75
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--exported-template-file, 6-76
--extended-variadic-macros, 6-77
--force-vtbl, 6-78
--friend-injection, 6-79

--g++, 6-80

--gnu-version, 6-81
--guiding-decls, 6-82

--help, 6-83

--implicit-extern-c-type-conversion, 6-84

--implicit-include, 6-85
--incl-suffixes, 6-86
--include-directory, 6-87
--include-file, 6-88
--include-macros-file, 6-89
—-init-priority, 6-90

--instantiate, 6-91

--io-streams, 6-92
--late-tiebreaker, 6-93

--list-file, 6-94
--long-lifetime-temps, 6-96
--long-long, 6-97

--make-target, 6-98
--multibyte-chars, 6-99
--namespaces, 6-100
--no-arg-dep-lookup, 6-101
--no-array-new-and-delete, 6-102
--no-auto-instantiation, 6-103
--no-bool, 6-104
--no-class-name-injection, 6-105
--no-const-string-literals, 6-106
--no-dep-name, 6-107
--no-distinct-template-signatures, 6-108
--no-double, 6-109
--no-enum-overloading, 6-110
--no-explicit, 6-111

--no-export, 6-112
--no-extern-inline, 6-113
--no-for-init-diff~-warning, 6-114
--no-implicit-typename, 6-115
--no-inlining, 6-116
--no-nonconst-ref-anachronism, 6-117
--no-parse-templates, 6-120
--no-pch-messages, 6-121
--no-preprocessing-only, 6-122
--no-stdinc, 6-123

--no-stdstlinc, 6-123
--no-type-traits-helpers, 6-152
--no-typename, 6-124
--no-use-before-set-warnings, 6-125
--no-warnings, 6-126
--nonconst-ref-anachronism, 6-117
--nonstd-qualifier-deduction, 6-118
--nonstd-using-decl, 6-119
--old-for-init, 6-127
--old-line-commands, 6-128
--old-specializations, 6-129
--option-file, 6-130

--output, 6-132
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--pch, 6-133

--pch-dir, 6-134

--pch-verbose, 6-135

--pending-instantiations, 6-136

--preprocess, 6-137

--remarks, 6-138

--remove-unneeded-entities, 6-139

—-rtti, 6-140

--schar, 6-141

--signed-bitfields, 6-142

--special-subscript-cost, 6-143

--strict, 6-144

--strict-warnings, 6-145

--suppress-vtbl, 6-146

--sys-include, 6-147

--template-directory, 6-148

--thumb, 6-149

--timing, 6-150

--trace-includes, 6-151

--type-traits-helpers, 6-152

--uchar, 6-153

--undefine, 6-154

--use-pch, 6-155

--using-std, 6-156

--variadic-macros, 6-157

--version, 6-158

—--warnings-as-errors, 6-159

--wchar_t-keyword, 6-160

--xref-file, 6-161

-A, 6-144

-a, 6-145

-B, 6-72

-C, 6-66

-D, 6-68

-E, 6-137

-e, 6-74

-F, 6-109

-f, 6-130

-H, 6-88

-1, 6-87

-j, 6-125

-L, 6-94

-0, 6-132

-r, 6-138

-s, 6-141

-t, 6-91

-U, 6-154

-u, 6-153, 6-158

-V, 6-158

-w, 6-126

-X, 6-161

-X, 6-75

diagnostics, 6-159

preprocessing, 6-68, 6-88, 6-137
C++ dialect, 2-1

accepted, 2-1

anachronisms accepted, 2-4

C++0x language features accepted, 2-3

normal C++ mode extensions, 2-4
standard language features accepted, 2-1
C++ language features
accepted, 2-1
C++0x, 2-3
C++ style comments, 6-25
C++ working paper, 6-63
cabs, 3-4
cacos, 3-3
cacosh, 3-3
call, 1-8
Call graph, 4-14
calloc, 3-8, 3-19
calls, 4-14
carg, 3-4
casin, 3-3
casinh, 3-3
catan, 3-3
catanh, 3-3
cbrt functions, 3-10
ccos, 3-3
ccosh, 3-3
ceil functions, 3-9
CERT C, 10-1
CERT C secure coding, 6-5
cexp, 3-3
chdir, 3-23
Check source code, 6-6, 6-64, 6-164, 6-241
cimag, 3-4
Class name injection, 6-105
clearerr, 3-18
clock, 3-22
clock_t, 3-22
CLOCKS_PER_SEC, 3-22
clog, 3-3
close, 3-23
cnt, 4-7
Code checking, CERT C, 10-1
Code compaction, 6-20
codel6, 4-15
code32, 4-15
Command file, 6-305
Comment, 4-2
Comments, 9-3
compiler options, --misrac-version, 6-32
complex, 3-3
Conditional assembly, 4-49
Conditional make rules, 6-292
conj, 3-4
Conjugate value, 3-4
const, string literals, 6-106
Context limit, 6-65
Control program, passing options, 6-278
Control program options, 6-239
-?,6-257
--adress-size, 6-240
--check, 6-241
--cpu, 6-242
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--create, 6-243 -L, 6-265
--debug-info, 6-244 -1, 6-264

--define, 6-245 -1 (--library), 6-266
--dep-file, 6-246 -n, 6-248

--diag, 6-247 -0, 6-277

—--dry-run, 6-248 -p, 6-280
--endianness, 6-249 -, 6-263

--error file, 6-250 -U, 6-287
--exceptions, 6-251 -u (--uchar), 6-286
--force-c, 6-252 -V, 6-289

--force-c++, 6-253 -v, 6-288
--force-munch, 6-254 -W, 6-278

--format, 6-255 -w, 6-275
--global-type-checking, 6-256 preprocessing, 6-245
--help, 6-257 Copy assignment operator, 6-61
--ignore-default-library-path, 6-265 Copy table, 9-16, 9-32
--include-directory, 6-258 copysign functions, 3-10
--instantiate, 6-259 cos functions, 3-8
--io-streams, 6-260 cosh functions, 3-8
--iso, 6-261 cpow, 3-4
--keep-output-files, 6-262 cproj, 3-4
--keep-temporary-files, 6-263 cpu, 4-7

—-library, 6-264 CPU functional problem workarounds, 6-47
—-library-directory, 6-265 creal, 3-4

--Isl-file, 6-267 Cross-reference file, 6-161
--make-target, 6-268 csin, 3-3

--mil-link, 6-269 csinh, 3-3

—--mil-split, 6-269 csqrt, 3-4
--no-auto-instantiation, 6-270 ctan, 3-3
--no-default-libraries, 6-271 ctanh, 3-3

--no-double, 6-272 ctime, 3-22
--no-map-file, 6-273

--no-preprocessing-only, 6-274 D
--no-warnings, 6-275 Data types, 1-2

--option file, 6-276 db, 4-16

——Output, 6-277 dd, 4-17

--pass, 6-278 Debug info, 6-244
--preprocess, 6-279 Debug information, 6-169
--profile, 6-280 define, 4-18
--show-c++-warnings, 6-282 defined, 4-7
--signed-bitfields, 6-283 Defining a macro, 4-46
--static, 6-284 Dependent name processing, 6-107
--thumb, 6-285 Derivative definition, 9-1, 9-20
--undefine, 6-287 dh, 4-19

--verbose, 6-288 difftime, 3-22

--version, 6-289 Digraph, 6-59
--warnings-as-errors, 6-290 Directives, 4-1

-B (--big-endian), 6-249 div, 3-20

-C, 6-242 Dollar signs, 6-70

-G, 6-243 double, 4-25

-D, 6-245 Double as float, 6-272
-d, 6-267 ds, 4-20

-E 6-279 dsb, 4-20

-F 6-272 dsd, 4-20

-f, 6-276 dsh, 4-20

-g, 6-244 dsw, 4-20

-1, 6-258 dw, 4-21

-k, 6-262
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E

ELF/DWARF object format, 8-1
Embedded C++, 6-71
end, 4-22
Endianness, 6-13, 6-72, 6-170, 6-202, 6-249
endprofile, 1-9
endprotect, 1-10
Entities, remove unneeded, 6-139
enum overloading, 6-110
EOF, 3-13
equ, 4-23
erf functions, 3-11
erfc functions, 3-11
errno, 3-5
Error limit, 6-74
Error output file, 6-73
Exception handler, 1-18

defining, 1-18
Exception handling, 6-75
exit, 3-19
EXIT_FAILURE, 3-18
EXIT_SUCCES, 3-18
exp functions, 3-9
exp2 functions, 3-9
explicit specifier, 6-111
expm1 functions, 3-9
export keyword, 2-18, 6-112
Exported templates, 2-18
Expressions, 4-3

absolute, 4-3

relative, 4-3

relocatable, 4-3
extension isuffix, 1-8
Extensions to C++, 2-1
extern, 1-8, 4-24
extern C, 6-84
extern C++, 6-84
extern inline, 6-113
Extern inline functions, 2-20

F
fabs functions, 3-10
fclose, 3-14

fdim functions, 3-10
FE_ALL_EXCEPT, 3-6
FE_DIVBYZERO, 3-6
FE_INEXACT, 3-6
FE_INVALID, 3-6
FE_OVERFLOW, 3-6
FE_UNDERFLOW, 3-6
feclearexcept, 3-6
fegetenv, 3-6
fegetexceptflag, 3-6
feholdexept, 3-6

feof, 3-18
feraiseexcept, 3-6
ferror, 3-18

fesetenv, 3-6

fesetexceptflag, 3-6

fetestexcept, 3-6

feupdateenv, 3-6

fflush, 3-14

fgetc, 3-17

fgetpos, 3-18

fgets, 3-17

fgetwc, 3-17

fgetws, 3-17

FILENAME_MAX, 3-13

float, 4-25

Floating-point, single precision, 6-109

Floating-point unit, 6-15

floor functions, 3-9

fma functions, 3-10

fmax functions, 3-10

fmin functions, 3-10

fmod functions, 3-10

fopen, 3-14

FOPEN_MAX, 3-13

for-init statement, 6-114, 6-127

for/endfor, 4-26

fpclassify, 3-11

fprintf, 3-16

fputc, 3-17

fputs, 3-17

fputwe, 3-17

fputws, 3-17

fread, 3-17

free, 3-8, 3-19

freopen, 3-14

frexp functions, 3-9

Friend injection, 6-79

fscanf, 3-16

fseek, 3-17

fsetpos, 3-18

fstat, 3-24

ftell, 3-18

Function, syntax, 4-5

Function inlining, 1-15

Function names, unqualified, 6-101

Function qualifiers
__frame(), 1-19
__interrupt(), 1-18
__interrupt_dabt, 1-18
__interrupt_fiq, 1-18
__interrupt_iabt, 1-18
__interrupt_irq, 1-18
__interrupt_svc, 1-18
__interrupt_und, 1-18
__nesting_enabled, 1-19
___novector, 1-19

fwprintf, 3-16

fwrite, 3-17

fwscanf, 3-16

G

Generic instructions, 4-1, 4-51
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getc, 3-17 Implicit inclusion, 2-17
getchar, 3-17 include, 4-29
getcwd, 3-23 Include directory, 6-18, 6-34, 6-87, 6-174, 6-212, 6-258
getenv, 3-20 Include file, 6-19, 6-88, 6-175
gets, 3-17 macros, 6-89
getwc, 3-17 Include files, suffix, 6-86
getwchar, 3-17 Inline assembly, __asm, 1-4
global, 4-27 Inline function, 6-113
Global type checking, 6-16, 6-207 Inline functions, 1-15
gmtime, 3-22 inline/ noinline / smartinline, 1-9
GNU extensions, 2-5, 6-80 Inlining, 6-20, 6-116
compiler version, 6-81 Inlining functions in C++, 2-20
Guiding declarations, 6-82 Input specification, 4-1
Instantiation, 2-14
H pending, 6-136
Header files, 3-3 template, 6-91
alert.h, 3-3 Instantiation mode, 2-15
complex.h, 3-3 Instantiation pragmas, 2-16
ctype.h, 3-4 Instructions, 4-1
dbg.h, 3-5 generic, 4-1, 4-51
errno.h, 3-5 Intel hex, record type, 8-5
fentl.h, 3-6 Intel Hex record format, 8-5
fenv.h, 3-6 Interrupt frame, 1-19
float.h, 3-6 Interrupt functions, 1-18
inttypes.h, 3-6 __frame(), 1-19
io.h, 3-7 __inter